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INTRODUCTION

This document is for Consultant and State Employees responsible for the production or review
of digital contract plans, specifications, supplemental contract documents, and contractor
submittals. This document covers the development, review and commenting, and submission of
digitally signed contract plans in PDF format including revisions, the delivery of specifications in
Microsoft Word format, the delivery of supplemental contract documentation in PDF format,
and the delivery of contractor submittals in PDF format. This manual also includes sections on

the usability of these PDF documents.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.

Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.

Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988
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DEFINITIONS

ACD — The attribute applied to a revision requested by the Processing unit to an ADP discipline
subset.

ACD2 — The attribute applied to a revision requested by the Processing unit to an ACD discipline
subset.

ADP — The attribute applied to an Addendum discipline subset.

Bluebeam — PDF software similar to Adobe Acrobat. Bluebeam software will be required to
package and markup all Shop Drawing Submittals.
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CSI — Construction Specifications Institute

DCD - The attribute applied to a revision requested by the Processing unit to an FDP discipline
subset.

DCD2 —The attribute applied to a revision requested by the Processing unit to a DCD discipline
subset.

Discipline Subset — A multi-page PDF document that includes all the contract plan sheets for a
discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF
document.

DCO —The attribute applied to a design initiated change order discipline subset.

DPD — Digital Project Development Manual.

Engineer of Record — The engineer’s digital signature that is applied to the discipline subsets.
For CTDOT staff this would be the Principal Engineer.

FDP —The attribute applied to a final design plans discipline subset.
FIO — The attribute applied to a “for information only” discipline subset.
FPL — The attribute applied to an advertised FDP discipline subset

Project Manager — Lead designer on the project. For CTDOT staff this would be the TE 3 or
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

Projectwise - CTDOT is currently using Bentley’s ProjectWise as a data management software for
digital projects. Projectwise allows the CTDOT, and authorized business partners to access its
data anywhere internet access is available. Projectwise shall be used by all consultant engineers
delivering digital contract documents.

Set File — Is a consolidated viewer file that is created using Bluebeam. When this file is opened
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the
correct order.

STD — The attribute applied to the “CTDOT Standard Drawings” discipline subsets.

WDP — The attribute applied to working drawing for permanent structures submittals. This
includes the plans, calculations, or any supplemental documents in the submittal.

Issued 01-2016 6 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

Section 1 Digital Document Requirements

1.1 Document Deliverable

The following documents shall be submitted into Projectwise when delivering a digital project,
see Section 3 of this document for submittal procedures for the documents below: For CTDOT
designed projects each discipline is responsible for uploading their own documents into

Projectwise.

Document

Projectwise Folder

Final Contract Plans

100_Contract Plans

Final Signed Contract

110_Contract Documents

Contractor Submittals
e Working Drawings (Permanent and Temporary Structures)
e Shop Drawings
e Product Data

120_Contractor Submittals

e RFI
e RFC

Engineering Reports 130_Engineering Reports
e Hydraulic

o Hydraulic Report and Hydraulic Report Data
o Scour Report and Scour Report Data
o Floodway Report and Floodway Report Data
o Final Drainage Report and Final Drainage Report
Data
e Geotechnical Report
e Environmental Compliance

o Task 110
o Task 220
o Underground Storage Tank System Closure
Reports
e Bridge

o Load Ratings
o Rehabilitation Study Reports
o Structure Type Studies

Executed Agreements
e Sidewalk Maintenance Agreement
e Lighting Agreement

140_Project Administration

Project Schedule

140_Project Administration

Project Correspondence — Signed Copies of the Files

140_Project Administration

ROW Documents
e Property Map (.dgn)
e Property Map (PDF)
e ROW Parcel Files (.dgn and KML)

150_GIS

Project Photos (Engineering and Construction)

151_Project Photos

Design Quantity Computations

210_Construction>Office of Construction

Supplemental Contract Documents
e Proposal Estimate
e Federal Estimate
e Calendar Day Estimate
e Final Design Report
e Categorical Exclusion

240_Contract Development
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e Design Approval Letter

e DBE/SBE Approval with Percentages

e Commitment List

e Proprietary Item Approval

e Standalone Transportation Management Plan Document,
taken from the final design report

Preliminary/Review Documents 310_Review Documents
e Contract Plans
e Contract Specifications
e Other documents for review

Permit Applications and Preliminary Permit Documents 320_Permit Development

Design Computations 330_Design Data/01_Final Design
Calculations

Microstation Design Model 330_Design Data/ Specific Discipline

1.2 Projectwise Project Container

CTDOT uses Bentley’s Projectwise as a document management system for all of our capital
projects. A project container will be created in Projectwise when a project is initiated. CTDOT
employees will have access to all projects, but access for consultants, municipalities or other
agencies must be requested by the Consultant Liaison Engineer. The Consultant Liaison
Engineer can request access for these groups by emailing: Julie.Annino@ct.gov.

1.3 Prerequisites and Policies

1. All contract plans, working drawings, and applicable engineering reports submitted to
the Department shall be digitally signed by a CT licensed Engineer or CT licensed
Architect in accordance with this manual. All contract plans, specifications, and
supplemental contracts documents will only be accepted by the CTDOT if they meet all
the requirements of this manual. Approval for additional development and testing of
digital documents and procedures shall come from the AEC Applications.

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be
digitally signed in conformance with this manual.

a. Digital signatures must meet the requirements of Adobe’s Certified Document
Services (CDS).

b. CDS, and CDS vendor information is provided at the following
website: http://www.adobe.com/security/partners cds.html

c. Trial CDS Signatures will not be accepted by the Department, a signature must
be purchased from one of the CDS Vendors.

d. Bluebeam Revu or Extreme is required for all digital signature processes.

3. After contract plans have been advertised, the digital signature is not allowed to be
removed.

4. Standard Computer Aided Design (CAD) Applications shall conform to those listed
here http://www.ct.gov/dot/digitaldesign..

5. Use of digital signatures not conforming to the requirements of this manual must be
approved by both the Office of Quality Assurance, and the Office of Legal Services.

6. This manual is designed to be used with the latest CTDOT Digital Design Environment.

7. Digital Contract Specifications shall be prepared in accordance with the Departments
policies and procedures for Contract Development.

8. Supplemental contracts documents shall be submitted digitally in PDF format. See
Section 3.2.8 for supplemental contract document list and submission procedures.
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9. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using
the [Digital Submission Procedure set forth in this Manual] has the same force and
effect for the purposes of the Consulting Engineer’s agreement with the State as a
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an
authorization for, or endorsement of, the use of this [Digital Submission Procedure]
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed
Professional Engineer or Architect with respect to other work it performs for the State
or work it performs for other clients.

10. Bluebeam Revu was used in the production of all figures and procedures in this manual.
A license of Bluebeam Revu version 12 or higher must be purchased to perform all the
procedures in this manual.

11. Bluebeam shall be the only PDF software supported by the Connecticut Department of
Transportation for the processes set forth in this manual. Import the Bluebeam profile
as shown in Appendix A. This will place all the tools and tool bars in the correct location.

12. When on call consultants are used for CTDOT projects, the title sheet shall be digitally
signed by CTDOT following the procedure in Section 2.6.1 of this manual.

13. All documents detailed in the processes in the following manual are uploaded to
CTDOT’s Projectwise site. To gain access to CTDOT’s Projectwise site fill out the
following form: CTDOT Projectwise New User Form

14. See section 3.2.1 for instructions on how to set up Projectwise the first time logging in.

1.4 Format

1.4.1 Contract Plans

1. Digital contract plans (preliminary, semifinal, FDP, etc.) shall be in PDF format; PDF Plans
must be sized either 36” x 24” for projects created before 6/2007 or sized 34” x 22" for
projects created after 6/2007; PDF plans shall be measurable to scale in the PDF; PDF
plans shall be able to be printed to paper and scaled appropriately; text must be
searchable; and all levels must have the ability to be displayed on or off, unless
approved otherwise. All information on the digital contract PDF plans shall have been
created from MicroStation or an approved alternate. The only information that shall be
added to the plans using a PDF editing software are as follows:

e Page labels (see Section 1.6.2)

e Sheet numbers (see Section 1.6.2)

e Watermarks and flatten comments(see Section 2.4)
e Any digital signature fields (see Section 2.5)

e Digital Signature (see Section 2.6)

2. Contract plans shall be grouped, by discipline into individual multiple page PDF files
called discipline subsets. Discipline subsets are not to be combined in a PDF
Package/Portfolio. Examples of discipline subsets are: 01_General, 02_Revisions,
03_Highway, 04 _Bridge, etc. See Section 1.11 & 1.12 for more examples of discipline
subsets.

Using a discipline subset format streamlines both the development of contract plans and the

administration of the plans during preliminary design, FDP, DCD, Addenda, DCO and As-Built

submissions. Moreover, it also leverages the ability to digitally sign the individual discipline
based contract plan subsets per designer.

Issued 01-2016 9 Version 3.11


http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf

Connecticut Department of Transportation — Digital Project Development Manual

Index of Drawings

s ™

05 - TRAFFIC
INDEX OF DRAWINGS

Digital Signature form
field place holder
jwth digital signature

Watermark of
Engineer of Record

Figure 1 Discipline Subset Bookmarks, Index of Drawings, and Signature fields

3. See Section 2.5 for digital signature form field place holder cells.

4. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based
on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled;
“For Information Only”. The subset numbers shall be selected by the lead designer so
that the FIO subsets are last. Each sheet shall be numbered correctly, see Section 1.6.2.
Upload and attribute in accordance with Section 3.2.

5. Utility drawings shall be submitted in accordance with the following:

e Utility plans For Information Only (FIO) shall be submitted in a utility subset
based on the utility company, AT&T subset, CL&P subset, etc. These subsets do
not require a digital signature, but each sheet shall be labeled; “For Information
Only”. FIO utility subsets shall be numbered so that they are the last subsets.
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page
labels assigned, see Section 1.6.2

e  Utility company designed plans that include work being done by the State’s
Contractor shall be submitted in a utility subset based on the utility company,
AT&T subset, CL&P subset, etc. These subsets do not require a digital signature.
Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels
assigned, see Section 1.6.2

o  Utility plans that are designed by a Consultant firm that include work being
done by the States Contractor shall be submitted in a utility subset based on the
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in
accordance with this manual. Example Labels; 10 CL&P, 11_AT&T. These
subsets must have page labels assigned, see Section 1.6.2

6. See Section 3.2 for uploading and attributing Utility Plans. See Section 1.11 & 1.12 for
more examples of discipline subsets.

7. CTDOT Standard sheets shall also be delivered digitally. See section 1.8 for how to
prepare and submit CTDOT Standard Sheets.

8. The first and second subsets in the project must always be the 01_General and
02_Revisions respectively. The Project Manager is responsible for determining the
order of all other discipline subsets, Sections 1.11 and 1.12 show examples.

9. Discipline subsets shall contain a maximum of 150 sheets.

10. Discipline subsets shall be published directly from a CAD application. Scanned images or
raster image formats will not be accepted with the exception of For Information Only
sheets, these can be scanned.

11. Footers, displaying the sheet number, shall be placed on each page of each PDF subset.
See Section 1.6.2, “Sheet Numbering”
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12.

13.

14.

15.
16.

17.

18.

19.

20.

21.

22.

23.

Each subset shall contain bookmarks; one for each page. Figure 1 displays an example of
bookmarks. See Publishing MicroStation Content to PDF Format.pdf for more
instructions.
e Figure 1 also displays examples of subgroup folders. While publishing,

subgroups may be created to contain similar sheets. See

Publishing MicroStation Content to PDF Format.pdf for more instructions.
Levels with the appropriate CTDOT names shall have the ability to be displayed on or off
within the PDF document.
The first page of the subset 01_General shall be the CTDOT digital project title sheet
which includes an index of the subsets contained within the project, sheet count totals
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for
applying the digital signature(s) (see section Section 2.5).

Link to digital title sheet: Digital Title Sheet
Consultants will need to delete the CTDOT signature blocks on the title sheet and place
a digital signature placeholder as detailed in section Section 2.5 CTDOT engineers can
find the digital title sheet in the seed files on our W: drive.
The 01-General subset shall include all detailed estimate sheets.
The 02_Revisions subset must be included in each digital project and there shall only be
(1) revisions subset.
Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See
Section 4.3. These revision sheets are used for tracking all sheet changes due to
addenda and design initiated change order (DCO) with respect to the entire project.
These sheets are originally blank and unsigned, and shall be managed and updated as
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained
here:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE Subset
The first page of each subset shall be a subset cover sheet, this includes FIO subsets.
This cover sheet shall contain both; an index of drawings contained within the subset
that includes both drawing numbers and drawing titles and the form field place
holder(s) which receives the digital signatures. The following cell has a table for the
index of drawings and the digital signature cell place holder BDR Discipline Cover Sheet
cell. This table must include the subset name and number displayed as a heading in the
table. See Figure 1 for an example.
As-built information shall be digitally applied to the contract subsets by District
Personnel after the job is complete using Bluebeam. See section 4.5.
Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section,
but do not need to be digitally signed. These review documents shall be uploaded into
the 310_Review Documents folder in Projectwise.
A Bluebeam set file shall be created at FDP and updated for any addendums or change
orders in accordance with section 1.12.
The Contract Plan subsets must be checked by the Discipline Subset PDF Checker in
accordance with section 3.1.

1.4.2 Contract Specifications

Digital Contract Specifications shall be submitted in MS Word format and in accordance
with the Departments policies and procedures for Contract Development. CSI special
provisions shall be submitted in pdf format.
a. For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions submittals shall be submitted in (1)
zipped folder, see section 3.2.6.
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b. For projects where a CTDOT design unit is the Project Manager on the project,
the Specification and CSI special provisions shall be submitted in individual
zipped folders per discipline, see section 3.2.6.

c. Design Initiated Change Orders shall be place in (1) pdf document, with “C#”
and the date in the header. An example would be “Rev. C1 - mm/dd/yy”.

1.4.3 Environmental Permits — Under Development

1.4.4 Supplemental Documents

24. Supplemental documents shall be 8.5” x 11” pdf documents, except the proposal
estimate which shall be in “.est” format. These documents should be uploaded into
Projectwise in accordance with Section 3.2.6

1.4.5 Contractor Submittals

25. See Section 6 for format, submittal and review requirements for Contractor Submittals:
Working Drawings, Shop Drawings, Product Data, RFI, and RFC.

1.4.6 Engineering Reports
26. Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in
accordance with the following:
e Shall be native PDF whenever possible.
e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized

up to 34” x 22",
e Shall be digitally signed and watermarked in accordance with Section 2 of this
manual.

e Any data files that must accompany the PDF report shall be uploaded into
Projectwise in a zipped folder.

e The reports and zipped folder for any data files shall be submitted into the
130_Engineering Reports folder under the applicable project in accordance with
Section 3 of this manual.

e Preliminary reports shall be uploaded into the 310_Review Documents folder in
Projectwise.

27. Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be
formatted in accordance with the following. The content of the report shall be in
accordance with the Scope defined by the Division of Environmental Compliance:

e Shall be native PDF whenever possible.

e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

o All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized
up to 34” x 22",

e Shall be digitally signed in accordance with Section 2 of this manual.

e These reports shall be submitted into the 130_Engineering Reports folder under
the applicable project in accordance with Section 3 of this manual.

e Preliminary reports shall be uploaded into the 310_Review Documents folder in
Projectwise.

28. Rehabilitation Study Reports. Type Study Reports, and Load Ratings: Shall be
formatted in accordance with the Bridge Manual and Load Rating Manual respectively.

e Final reports shall be uploaded into the 130_Engineering Reports folder in
Projectwise.
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e Preliminary reports shall be uploaded into the 310_Review Documents folder in
Projectwise.

1.4.7 GIS Project Location Documents

29. Project location for all projects shall be submitted to CTDOT. See Section 8 for the
format and submission requirements.

1.4.8 ROW (Rights of Way) Documents

30. Property Maps and Parcel Polygon files for acquired property shall be submitted to
CTDOT. See Section 9 for the format and submission requirements.

1.4.9 Project Correspondence

31. Final project correspondence shall be stored in the 140_Project Administration folder
under the project in Projectwise in accordance with the following:
e Shall be in PDF Format
e The document must be attributed in accordance with Appendix E, table 7.
Note: The discipline attribute must match the author of the document. For example, if the
Highway design unit sends out a memo for a design review, the discipline attribute on this
document shall be HW.
e Draft correspondence can also be created and worked on in Projectwise. These
file shall be located under the user’s applicable 330_Design_Data folder under
the project in Projectwise.

1.5 This Section Intentionally Left Blank
1.6 Contract Plan Drawing and Sheet Numbering

1.6.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall
consist of the discipline designator followed by a hyphen and the sheet number. Examples of
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The CTDOT efficiently maintains the drawing numbers in MicroStation using the model
properties and project explorer, See the following workflow Project Explorer to Manage Drawing
Numbers

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

STONINGTON/GROTON | 137-153
/ DRAWING NO.-
DRAWING TITLE; \ HNWD.Y 01
PLAN SHEET

Figure 2 Contract Drawing Numbering

Issued 01-2016 13 Version 3.11


http://www.ct.gov/dot/lib/dot/documents/aec/project_explorer_and_detailing.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/project_explorer_and_detailing.pdf

Connecticut Department of Transportation — Digital Project Development Manual

1.6.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are
published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the
number pages and header and footer tools within Bluebeam. Page labels and sheet numbers
shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic
subset shall be 05.01.

Created in Microstation

a

CITY OF NEW HAVEN M_02-640

F.

05.01

vy [DRAWING TIE i 4[( TRA-01
T Created in Bluebeam N p—
DRAWING INDEX (

Figure 3 - Drawing and Sheet Numbering

The page label and sheet number place holder shall be determined by the total estimated sheet
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100
sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders
shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly
assemble the contract plans into a properly ordered consolidated set that District Construction
takes advantage of during construction of the project.

Single Volume Projects:

The page labels and sheet numbers, for single volume projects shall be a concatenation of the
discipline subset number, a decimal point, and the sheet number. For example; the page labels
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03,
etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline
their corresponding subset number, see section 1.11.

Multi Volume Projects:

For a multi volume project the page labels and sheet numbers shall be a concatenation of the
volume number, a decimal point, the discipline subset number, a decimal point, and finally the
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project
Manager only has to deliver to the other engineers their perspective volume numbers, allowing
them to manage their subset numbers independently of the other discipline volumes and subset
counts, see section 1.12.

Subset numbers shall start at 01 for all volumes.
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BLUEBEAM - Applying Page Labels and Sheet Numbers

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as
shown below, right click on a thumbnail and select Number Pages:

Document Form Markup Measure Window Help

g %

(2) Right Click
on a thumbnail

(N EEEEEEN]

cl+Alt+C

Ctrl+Shift-+N

TLLLITILLLOCT 1

cutishftn (3) Select Number
Pages

Ctrl+Shift+M

Figure 4 - Adding Page Labels

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at
once. In the case where there are 10 or more sheets in the subset the following will have to be
done twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply
to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

+— (1) Select this style
+— (2) Insert correct prefix

(3) Start at 1 for sheets 1-9

Page Rangs and 10 for sheets 10-99
Croos [7oe 16 v ) -— (4) Apply to correct pages
PPly pPag

==~ (5) Click OK

Figure 5- Page Labeling
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3. Now the pages will be labeled:

Document Form Markup Measure Win

= -

CT_CON_FPL_0120_00386_04-

Pages are
now labeled

Figure 6 - Labeled Pages
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4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and
then “Header & Footer”

Document Form Marcup Measure Window Help

Al O v 8§ % R

Pt Ema 9
i l Headers & Footers...

-

B e (3) Select header
(1) Select . Clrl4Shift+1 & footers
Document

: TRAFFIC - LEGENDS &
Ctrl+Shift+X LIST OF DRAWINGS

Ctrl+shift+D
Ctrl+5hift+R.

Ctrl+5hift+C

LIST OF DRAWINGS

Figure 7 - Header Footer Tool

5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted
as necessary. After you select the font, set the margins, and type in <<Pagelabel>> as
shown below. Then click save for save settings. The next time you are going to apply
sheet numbers to a subset, you can simply select the saved settings. Then click OK.

Header and Footer |-_I|E|fz|

—
Save Settngs | NN | Save.. | ) Dete |

Fort,

[] Fit content inside margins

Top: Bottom:

(3) Click
Save :ea:er:e::l Footer x _— \
| esder H ~ = (1) Select these

| Verdana

S 5 | options
| | ( —— (2) Type
Insert: [ Page Number ] [ Date ][ Bates Number ] [ File Data ] <<Page|_abe|>>

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

EEE= .
e .
: : (4) Click OK
CT_CON_FPL_0120_0086_04T b Pl FPages Rance (1) | —
()

Figure 8 - Insert Sheet Numbers
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1.6.3 Addendum and Design Initiated Change
Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A#” at the end and Change
Orders need to have “.C#” at the end (see section 4 for addendum and change order sheet
numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to each sheet in the addendum or change order. This
can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number
Pages:

Document Form Markup

(2) Right Click
on a thumbnail

Cirl+Alt+C

(I EEEEEEN]

Ctrl+Shift-+N

[NNRENRRNANNEARENDY |

Ctrl+5hift+D

culsshitn (3) Select Number
Pages

Ctrl+Shift+M

Figure 9 - Adding Page Labels
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3. Select None for a style, type in the sheet number of the addendum or change order
sheet in the prefix line. Then select which sheet you are labeling. This has to be done
for each sheet in the addendum or change order separately. See below:

Page Numbering and Labeling

N _1 (1) Choose None
L - ﬁ (2) Type in the sheet
:
- number of this sheet
Page Fange -1 (3) Select the
CPases [soectea () v|D / correct sheet
= VIl (4) Select OK

Figure 10 - Applying Addendum Page Labels

4. After all page labels have been applied, the sheet numbers can be applied. From
Bluebeam select the Document tab and then “Header & Footer”

Document Form Markup Measure Window Help

(2) Select Pages

. v (3) Select header
(1) Select Crlsstar & footers
Document

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

LIST OF DRamiNGS

Figure 11 - Header Footer Tool
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5. Select your sheet numbers saved settings from before and click OK. Note the margins
and size may have to be adjusted as necessary.

Header and Footer |Z||E|E|

Save Setting{ |FIESINIE=H v ||)Savey. | | Delete (] Fit cortent inside margins

Font Margins {Inches)

Verdana v||1E v|@ B I U

(1) Select

Header and Foater yo u r s ave

Header Left Center Right -
settings

Footer Left

<<Pagelabel=>

Insert: | Page Number ] l Date ] [ Bates Number ] l File Data

Preview
:

| TRAFFIC - LEGENDS &
LIST OF DRAWINGS

i
H
i
g
i
13
?
i
H
]
H
[
i
i
e

w218

=T

. = (2) Click OK
CT_CON_FPL_0120_0026 04T b B Pages Renge (16
Add Fies || Delete Al | ‘ |

Figure 12 - Applying Addendum or DCO Sheet Numbers

1.7 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For
Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These
sheets shall be placed on a border and numbered in accordance with section 1.6.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.
See Section 3.2 for uploading and attributing FIO Plans. See Section 1.11 & 1.12 for more
examples of discipline subsets. Information only sheets may be scanned, but must conform to
the following specifications; Minimum Size 22”x34”, Minimum dpi = 300.

This link shows a procedure that can be used to create a For Information Only subset using
Bluebeam: Preparing a For Information Only Subset
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1.8 CTDOT Standard Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital
project.

1. Download the latest standards from the following link for the project: CTDOT Standard

Drawings Website

2. Upload the standard subset into Projectwise in accordance with section 3.2.

3. Next open up the standards from Projectwise by double clicking on it. Once it opens
click on the index sheet.

- e :

ctdot_highway_std.pdf =

Double click on
the index sheet

Hu-07 INDEX pdf 17872013 11:19 A

Hi-02INDEX pdf V20131119 AM

Hyw-0506_01.pdf 7B KB V20131119 AM

Figure 13 - Preparing the Standard Subsets

Enter Project Number

“oNLY STANDARD. SHEETS WARKED Wit A v ane i s paiec # mEE | Yneviseo owinco and check drawings
S — . - .
ST - A to be included in Project
| Hwi-6 01| ENOWALLS, SLOPE PAVED INLETS AND OUTLETS 1-26-12 TR
V| w0z | e bo s _enomais . pRTES S ey i i
| wwiofe 03| ewowais rom pie ancn _— Ti805 1 07| MISCELLANEOUS DETAILS FOR BARRIER TRANSITIGNS
FAETE I L' & GROP INLET CiaePBRSIN o ||| -\&z 01 | TEMPORARY PRECAST CONCRETE BARRIER CURD
TR s o RATE TRE 1 11011 | [ Jwsos o1 | rences ano eawavs
TR I DOUBLE GRATE TYPE - 1T Trioas W-310 01 | 'W- BEAM METAL BEAM RAIL NARGVIARE
| g & ROUND PRECAST CONGRETE CB 131011 Vi-510 02 | METAL BEAM RAIL (TYPE R-B 350} GUIDERAIL
e [ CAST CONCRETE CB DOUBLE GRATE TYPE - | 11-10-11 || [Wf] [¥-919-03 | METAL BEAM RALL (TYPE MD-B 350}
| 1wk o6 | Tvee cra rcu ‘AST CONCRETE CB GOUBLE GRATE TYPE - 11 11-10-11 -910.04 | METAL BEAM RAIL (TYPE R-B 350) SYSTEMS 5, 5A. 8 6
| ww-shs 07 | TvPe "C' & G-l CATCH BASIN TOPS AND CURBS 11-10-11 Wi-910-05 | METAL BEAM RAIL R-B 350 SPAN TYPE I, 1, I SECTIONS 10-
/| 1w Sk7 08| CATCH BASIN FRAMES AND GRATES S 1809 V6-310_06 | R-B 350 BRIDGE ATTACHMENT SAFETY SHAPE PARAPET [XTET
Hw-587.09 | HEAVY DUTY LOCK DOWN TOPS 71212 W-910_07 | R-B 350 BRIDGE ATTACHMENT VERTICAL SHAPE PARAPET 60911
| sk 10 | manmoLe - FrAME B cover 6-09-11 Wi-910-08 | R-B 350 BRIDGE ATTACHMENT TRAILING END 609-11
| vw-af1 01 | FIGURES FOR DATES DN BRIDGE PARAPETS 6:09-11 Vi-910_0%a| MISCELLAWEOUS GUIDERAIL TRANSITIONS SHEET 1 1-26-12
| tw-cf1 01 | c.om PivE INSTALLATIONS IN FILL B ROCK SLOPES B CULVERT TRENCH DETAL) 7-12-12 W-910.096 MISCELLANEOUS GUIDERAIL TRANSITIONS SHEET 2 7-25-12
| tw-cf1.0z | sloTED DRAIN PIE 12'- 15°-1824"30° (305-361-457-610-762) 71212 biw-oio 10| WETaL BEaM RAIL 87 (203) X 6 (152) BOX BEAM 72512
| vw-7f1 01| UnpERDRAINS AND UNDERCRAIN OUTLETS 7-12-12 w910 12 MERRITT PARKWAY GUIDERAIL ATTACHMENT - SYSTEM 2 & 3 6-09-11
| twafson | paveD DITCH AND PAVED APRON 7-12-12 W-810.120) MERRITT PARKWAY GUIDERAIL 6-03-11
| vw-ali o] cursime 7-12-12 W-910 12c| MERRITT PARKWAY GUIDERATL TRAILING END ATTACHMENTS 60911
| vl 01| GRAWITE STONE TRAWSITION CURBING 10-18-10 W-910_12d|  MERRITT PARKWAY MEGIAN GUIDERAIL AND END ANCHOR o011
HWw-Ef1 01a| TRAMSITION 45° (1145) F-SHAPE TO 45° (1145] VERTICAL SHAPE SHEET 1 1-26-12 | fri-o10 13 THRiE-BEAM METAL BEAM RAIL HARDWARE B-09-11
v TRANSITION 45% (1145) F-SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 2 10-18-10 W-910 13 THRIE-BEAM TRANSITIONS 6-09-11
TRANSITION 45" (1145) F-SHAPE TO 45" (1L45) VERTICAL SHAPE SHEET 3 1-26-12 Wi-910_ 143 THRIE-BEAM 350 BRIDGE ATTACHMENT 60511
" 457 (1145) F-SHAPE PRECAST CONCRETE BARRIER CURD SHEET 1 1212 W-910 14  THRIEBEAM 350 GUIDERAIL TRANSITION TO R-B 350 GUIDERAIL E0s i1
v 45" (1145) F-SHAPE PAECAST CONCRETE BARRIER CURB SHEET 2 1-26-12 HW-910 15[ MO-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE I 6-08-11
TRANSITION - 32" {813) JERSEY SHAPE TO 457 (1145) VERTICAL SHAPE SHEET L] 1.26-12 HW-910.16] MD-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE II 60911
| sl 03d| TRAnNSTTION - 32% (813) JFRSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 4| 10-18-10 W-510 19a] METAL BEAM RAIL (MODIFIED TYPE R-I) AND END ANCHORAGE TVPE I 7-25-12
HW-BJ1-0dal  MERRITT PARKWAY NARROW MEDIAN BARRIER 6-09-11 W-910_19b] METAL BEAM RAIL (MODIFIED TYPE R-I) AND END ANCHORAGE TYPE II 72512
| Hweh osh]  MERRITT pamiowaY - 2'(610) WIDE MEDIAN BARRIER AND ROADSIDE BAARIFR 6-09-11 HW-911 01| R-8 END ANCHORAGE TYPE 1 AND II 6-00-11
K Hv-el1 05af  TRANSITION - 45" (1145) F-SHAPE TO 54" (1372) VERTICAL SHAPE SHEET 1 1-26-12 HW-911.02| MD-B END ANCHORAGE TYPE I 10-18-10
E @ CTDOT HIGHWAY
T S TENT OF TRANSFORTATION STANDARD SHEET INDEX -

Figure 14 - Enter Project Number and Check Boxes
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5. Delete the standards that are not included in the project as shown below:

ctdot_highway_std.pdf* =

PDF Packzge

412 KB 1782013 11:18 AM
207 KB 1182013 11:18 A
761 KB 1182013 11:18 A

445 KB 1182013 11:18 A

2. nght Click TIBZ013 1119 A
and select delete
on drawings not
included in project

== HW-0507_01.pdf 1782013 11:19 AM

HW-0507_02.pdf

1782013 11:19 AM

HWw-0507_03 pdf 17802013 11:19 AM

h
HWw-0507_04 pdf 17802013 11:19 AM

Hw-0507_05 pdf 17802013 11:19 AM

Figure 15 - Deleting Drawings from Standard Set

6. Next digitally sign all index sheets in accordance with section 2.6.
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in
accordance with section 3.2 of this manual.

1.9 Contract Plan Sheet Publishing

CTDOT currently uses MicroStation V8i Print Organizer to publish contract plans to a PDF format.

The workflow Publishing MicroStation Content to PDF Format.pdf shows the fundamentals
of publishing contract plans to PDF from MicroStation.
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1.10 Example: Typ. Single Volume Digital Contract

Single volume digital contracts are used when each discipline or consulting firm designing the
project is responsible for 3 subsets or less. The following is an example of a single volume
project. Note: The first and second subsets shall always be 01-General and 02-Revisions. The
03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc. The FIO subsets shall be placed at the end of a project right before the STD
subsets.

Label File contents
(Discipline Subset) (but not limited to)
01-General Title Sheet

Detail Estimate Sheet
Index of Revisions Sheets

02-Revisions

Index of Plans Boring Logs
Survey Data Highway Plans
Alignments Breakout Drainage
. ROW Highway Profile
03-Highways** Typ Sections Highway X-
Misc Details Sections
Intersect Grading Landscape Plan

Wetland Mitigation

Index of Drawings

All Structure Sheets

04-Structure Note: Multiple subsets may required for multiple
Sites

Ex: 04_Structure_Br.No.1266

Index of Drawings

Signing

Pavement Markings

MPT

Traffic Signal Plans

Etc.

Index of Drawings

All Environmental Compliance Sheets required

05-Traffic

06-Environmental

IR Utility Design plans. For example 07_AT & T,
07-"Utiltiy 07_CL & P, 07_MDC, efc.
08-CL&P FIO*** CL & P For Information Only plans
09-AT&T FIO*** AT & T For Information Only plans
CTDOT Highway STD * CTDOT Highway Design Standard Index and

Sheets required
* CTDOT Traffic Engineering Standard Index and
Sheets required

CTDOT Traffic STD

Figure 16 Typical Highway Project Discipline Subset Contents

* For using CTDOT Standard Sheets see 1.8 CTDOT Standard Sheets

** |f a discipline has to be broken up into more than one subset See Section 1.11 for splitting up
the discipline subsets.

*** For Information only discipline subset shall be submitted as individual pdf files based on the
entity providing the information only.
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1.11 Example: Multiple Volume Digital Contract

Multiple volumes are used if the project has 1 or more of the following characteristics:

1. The majority of the discipline/firm designers are responsible for more than

3 subsets

each. This allows the individual designers to number their subsets independently of the

other disciplines.

2. There are multiple sites on the project. Splitting these sites up into volumes will provide

better organization of the project.
3. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more
specific. The Project Manager will need to organize the discipline volumes. The subsets shall

be split up by volume and each volume shall be controlled by its assigned designer.

For example,

all the subsets designed by the highway designer shall be in the same volume (02) and each

subset shall have a unique subset number.

Label File contents Designer/

(Discipline Subset) (but not limited to) Firm
01.01-General Title Sheet, Detail Estimate Sheet Lead
01.02-Revisions Index of Revision Sheets Lead
01.03-WtInd Re-establish Wetland Reestablishment plans Designer 1
01.04-Stg Acc. Staging and Access Plans Designer 1
02.01-Typ Sections Typical Sections Designer 2
02.02-Alignments Alignment Geometry Designer 2
02.03-Plan Plans Designer 2
02.04-Profiles Profiles Designer 2
02.05-ROW Brk Right of Way Breakout Designer 2
02.06-Drain Drainage Plans Designer 2
03.01-Retaining Wall 1 Retaining wall details Designer 3
03.02-Retaining Wall 2 Retaining wall details Designer 3
03.03-Bridge 00456 Bridge_456 Designer 3
03.04-Bridge 01983 Bridge_1983 Designer 3
03.05-Bridge 01984 Bridge_1984 Designer 3
04.01-Stage 1 Stage Construction Details 1 Designer 4
04.02-Stage 2 Stage Construction Details 2 Designer 4
04.03-Stage 3 Stage Construction Details 3 Designer 4
05.01-SPM Signing and Pavement Marking Site 1 Designer 5
05.02-SPM Signing and Pavement Marking Site 2 Designer 5
05.03-SPM Signing and Pavement Marking Site 3 Designer 5
06.01-IMS IMS Plans and Details Sitel,2,3 Designer 6
07.01-Env 1 Environmental Details Site 1 Designer 7
07.02-Env 2 Environmental Details Site 2 Designer 7
07.03-Env 3 Environmental Details Site 3 Designer 7
08.01-"Utiltiy” gtgfyogfagré?gzls. For example 07_AT & T, 07_CL Designer 8
09.01-CL&P FIO CL & P For Information Only plans Designer 8
09.02-AT&T FIO AT & T For Information Only plans Designer 8
CTDOT Highway STD *CTDOT Highway Design Standard Index and Designer 1

Sheets required
CTDOT Traffic STD * CTDOT Traffic Engineering Standard Index and Designer 5
Sheets required
Figure 17 — Multiple Design Firms CTDOT Project Subsets
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1.11.1  Combining Multiple Projects

When 2 or more projects are combined into one project, the following shall be done:

e Each project shall be given its own volume.

o The lowest project shall always be volume 1.

e Each project shall have its own title sheet, which reference each other with a note.

o There shall only be (1) Revisions subset. This subset shall be in volume 1 and named
01.02 — Revisions.

e The Revisions subset shall be the responsibility of the project manager on the projects.

e Each project shall have its own detailed estimate sheets.

e There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when
the projects are combined.

e There shall not be any duplicate special provisions after the projects are combined.

1.12 Consolidating Contract Plan Discipline Subsets

The consolidation of the contract plan discipline subsets is accomplished using the Set feature in
Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view
them in order without actually combining the files.

The project manager shall create a Set file for the project at FDP that contains all the discipline
subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or
Change Order is required for the project, the set file shall be updated by the project manager to
include the Addendum or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of
a project.

See Appendix C for general use of a set file.

1.12.1  When a Set File is Created and Updated

Set File Creation
1. The lead designer shall create a set file of all the discipline subsets at FDP, see section

1.12.2

Set File Updates
2. If any FDP subsets need to be revised during the DCD process, the set file shall be

updated to remove the FDP subsets that were changed and add the DCD subsets.

3. If any Addendum subsets are required for the project, these Addendum subsets shall be
added to the set file.

4. |If any Design Imitated Change Order subsets are required for the project, these Design
Imitated Change Order subsets shall be added to the set file.

See section 1.12.3 for updating the set file.
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1.12.2 Creating a Set File

After all the discipline subsets have been submitted into Projectwise for FDP the lead designer
shall create the project’s set file in accordance with the following:
1. Launch Bluebeam from the desktop icon on your computer.

2. Next Click on the Set Icon and select New Set as shown below:

Q fs am File Edit Wiew Docurnent Form fMarkup Measure Window

= -
R
Sawve Frint E-mail Studio

éil--ﬁ‘:‘m*‘E_jll '?r'-:
“m

(1) Click on the
Set icon

(2) Click on the arrow
and select new Set

Figure 18 - Creating a Set File
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3. Then click Add and then Projectwise and OK as shown below:

Set : New Set.bex

x|

File Mame

(1) Click Add

Tupe L ocation Status

[y Computer [EIAE

Add Dpen Files
Optionz

z I

Sort By: | Page Label Only

Click Projectwise

and then Click OK

Sort Tupe: | Al

phanumeric Ascending w |

_

= (s

Figure 19 - Adding Files to the Set File

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except
the standard subsets. Then click Open: After you click Open it may take a minute for

Bluebeam to load all the files into the set, please be patient.

? Open Document:

Select

Folder

‘ |=7 100_Contract_Plans (PDF}

LY

Document

|_FP

T_CON_FPL_0135-0270_CTDOT_HIGHWAY_STD, pdf
B CT_con_FRL_0135-0270_CTDOT_TRAFFIC_STD.pdf

Label (User Defined) Description Main Category  Sub Gafégory | Sub Category Des m

(1) Browse out to your
project's 100 Contract
Plan folder

Plans_04 - Final P

Standard Details
Flans_04 - Final P

CTDOT_TRAFFIC_STD _ .

(2) Select all the files

<

Address:
Deseription:
File Mame:

Application:

[¥] Open documertt as read-only

' N except the standard
|pw:\\[tdnt.prn]ettwlsennllne.(nm(TDOT\DD(uments\Dl.EI-Pm]etts-A(twe\ﬂl35-EIZ7EI\1DD_Cuntra[t_P\ans (PDF)\[ oL SU bsets and Click OK Zl

| " "REVISIONS" "HIWY Details & Misc™ "HIGHWAY PLANS & SUPERELEVATION DIAGRAMS" "KSC STA, 5+00 TO 125+00" XNTA. 125450 1U itotDU ADL 21H, gabUl 10 3au+U0 Laomru rinal de:
N

| "CT_CON_FPL_0135-0270_01.,01 - General,pdf" "CT_CON_FPL_0135-0270_01,02 - Revisions. pdf” ”CLCON,FPL,mas—Dzm,h{oz - HWY Detal & Misc.pof” "CT_CON_FPL_0135-0270_01,04 - Plans & ‘
N

N |

|Azmhat FOF

~ =~
([_open_[J open from bisk Cancel
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Figure 20 - Adding Files to the Set File

27 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

5. Next Click on Relative Paths and make sure the options are selected as shown below:

Set: New Setbex (=3

File: Name

01-General_CT_DCD_0171-0346 pdf
02-Revisions_AD1_CT_ADF_0171-0346 pdf
02-Revisions_CT_FDP_0171-0346 pdf
03-Highways_AD1_CT_ADF_0171-0346 pdf
03-Highways_CT_DCD_0171-0346 pdf
04-Structures _AD1_CT_ADP_0171-0346 pdf
04-Structures_CT_FDP_0171-0346 pdf

1| 1 | 3

( Use Relative Paths )
[] Show Paths N

Optons o Select

Sort By ff | Page Label Oniy -
Sort Type '\ | Alphanumeric Ascending ']

Advanced...
Cpen... H Save ][Save s ]

Figure 21 - Set File Options

6. Next click on Advanced and select and unselect the options as shown below:

04 - STRUCTURAL SUBSET | | BN |
INDEX OF DRAWINGS i (R
. Advanced Options
M Set:New Setbex |_§3 | ( Revision Filter: [Wildcard v] ’
H File Name Revision Field: | page Label
: D4-Structures_AD1_CT_ADP_0171-0346_(1) pdf Wildcard Fiter: 73
H 04-Structures_CT_FDP_0171-0346 pdf Previous Revisions: [cDefault - Cross Out> vl
i Revision Action: [ <Defactt ; Highiht> -
: [] Copy markups to newly added revisions
I (2) Select
i Wildcard, e _
H a1 _ [ Stamp previous revisions "Superseded
1 e (1) Click  —__unselect these ..
H - Represents zero or more characters
i Use Ad van ced [] pt 1ons an d Represents a series of characters that form a number
i Represents a serfies of alphabetic letters
] Shows + wure - Separator for specifying multiple fiters
M Optiors cl 1C k OK Escape characterto treat above characters as literal
1 Sort By: her characters are literal
Sort Type: | AlohanFacic fs any characters followed by "A’ and then a number)
1 [omn ][ sne ] [smvose. ] ==y

Figure 22 - Configuring the Set File
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7. Next click Save, this may take a while depending on how big the project is, please be

patient. When the box pops up choose Projectwise and click OK:

Mew Sel.Dbex

File Mame

P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Pz ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTS01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdat. projectwizeoniine. com:CTDOTA01.0 - Projects
P ctdot. projectwiseoniine, com CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdot. projectwigeoniine, com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F/:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeoniine. com: CTDOTA.0 - Projects -
F:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects -
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects -

(1) Click
— Save

Optiong

- Activeh0135-02705100_Contract_Plans (PDFISCT_CON_FPL_0135-0270_01.01

- Activeh0135-02708100_Contract_Plans (PDFICT_CON_FPL_0135-0270_02.01

- Aclive’(135-02705100_Contract_Plans (PDFINCT_COM_FPL_0135-0270_03.01
- Active(1 35027051 00_Contact_Plans [PDFINCT_CON_FPL_0135-0270_04.01

- Activel0135-027085 00_Contract_Plans (POFMCT_CON_FPL_0135-0270_05.01

- General pdf. 67E10.63
- Achived0135-027045100_Contract_Plans (PDFMCT_COMN_FPL_0135-0270_01.02 -
- Active’h0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_01.03 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_01.04 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_01.05 -
- Achived0135-027045100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_071.06 -
- Active’h0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_01.07 -
- Structures. pdf. 67E510,80
- Active’h0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.02 -
- Actived0135-02708100_Contract_Plans (PDFRCT_CON_FPL_0135-0270_02.03 -
- Active’h0135-02708100_Contract_Plans (PDFRCT_CON_FPL_0135-0270_02.04 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.05 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.06 -
- Traffic. pdf. 6761068

- Landzcape.pdi. 6761081
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_04.02 -
- General pdf B7E10.71
- Activedh0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_05.02 -
- Activeth0135-02708100_Comtract Plans (POEACT COR _FPL_013R-0270 0 07 -

Revisions.pdf. 67610,28

HwY Detail & Mizc.pdf 67610,32
Planz & Super Dia.pdf. E7610,29
Crozs-Sections.pdf. 67E10,25
Cross-Sections. pdf 67610,25
Cross-Sections.pdf 67610,27

Structures. pdf B7E10,64
Structures. pdf 57510,65
Structures.pdf. 67610,86
Structures. pdf B7E10,87
Structures. pdf B7E10,57

Invasive Removal pdf. 67610,49

Revizions.pdl. 67610.75
Ciwil nlf £7R10.72

Type Location Status
Projectwize Wi ctdot. projectwizeonline. com: CTDOT Logged In ]
gy s g L

(2) Choose Projectwise
and click OK

e =1

Sort By: | Page Label Only

yau

Sort Type: |.&Iphanumeric As%ding v|

H

Open... Save

ave fs..
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8. Select the Advanced Wiza

rd, and then on the Select target folder browse out to your

project’s 100_Contract_Plans folder. Then click next until you get to the attributes

page. Attribute the Set File as shown below:

Advanced Document Creation Wizard

Define Document Altributes

il

*fou should define environment specific document attibutes.

Discipline

cT
Main Category
COMN

Sub Category
Set File

-

Project Number(s)
01710346

00-Set File
Description

/

Main Category Description

All Contract Plans & Specs ‘
Sub Category Description

Blugbeam Set File

(1) Select these
attributes

(2) Type these
attributes

m

Up to Addendum Mo. 1

CT Code (Auto Fill In}

00-Set File_CT_Set File_0171-0346

CTDOT Asset Tags

Sign Structures

Bridge Mo(s)
[

Signal Intersections

(3) Click Next until
the document uploads

Building No(s)

LI

Ve

< Back Next > Cancel |

N—

Figure 24 - Attributing the Set File

9. Click OK after the set file has been saved into Projectwise:

File Mame

Pw:ctdot. projectwiseonling. com: CTDOTH01.0 -
P ctdot. projectwiseonling. com: CTDOTSO1.0 -
P ctdot. projectwizeonline. com: CTDOTS01 .0 -
P ctdot. projectwizeonline. com: CTDOTS01 .0 -
P :ctdot. projectwizeonline. com: CTDOTO01.0 -
P :ctdot. projectiwizeaniing. com: CTDOTAIM.0 -
P :ctdot. projectwizeonling. com: CTDOTS01.0 -
P sctdot. projectwiseonline. com: CTDOTH01.0 -
Pcctdot. projectwiseonling. com: CTDOTH01.0 -
Pcctdot. projectwiseonling. com: CTDOTH01.0 -
P sctdot. projectwiseonling. com: CTDOTH01.0 -

Praojects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects - Actives0001-0001%100_Contract_Plans (PDFISCT_COM_FPL_0001-0001_09-Electrical pdf. 823766
Projects - Actives0001-0001%100_Contract_Plans (PDFINCT_COM_FPL_0001-0001_10-Environmental.pdf.82...
Projects - Actives0007-0001%100_Contract_Plans (PDFISCT_COM_FPL_0001-0001_11-Traffic. pdf. B2376.8

Actives0001-0001%100_Contract_Plans [POFSCT_CON_FPL_D00-0001_0N-General pdf. 82376.11
Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_02-Revisions.pdf. 82376,13
Activeh0001-00014100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_03-Supporting Docs. pdf.
Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_04-Civil pdf 823761
Activehd001-00014100_Contract_Plans (PDFNCT_COM_FPL_0001-0001_05-Architectural. pdf.823...
Activet0001-00014100_Contract_Plans (PDFNCT_COM_FPL_0001-0001_0E-Structural pdf. 82376,3
Activet0001-0001%100_Contract_Plans (PDFNWCT_COM_FPL_0001-0001_07-Plumbing. pdf. 82376 4
Activet0001-0001%4100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_08-Mechanical pdf. 8237...
] _|
) _|
I |

Add

Options

SortBy: | Page Label Orly

“|

Sart Type: | Alphanumeric Ascending

Click OK

v

Cancel
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10. Now the set file has been created for use of the Set File see Appendix C:

All the files will be
shown here in the
correct order

Figure 26 - Set File
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1.

1.12.3

1.12.3

Updating a Set File

The following will show how to update a set file.

.1 Adding a File to the Set File

Double click on the set file from Projectwise and open as shown below: This may take a

while depending on how big the project is, please be patient.

% o130-0178
% 0131-0191
% 0131-0194 & 0131-0195
% 0131-m97
% 0131-0198
1% n131-0202
%% 0133-0094

<

Document Praperties

Real (Docume ¥

Narne

&
@ @4 ~ search|i v | P> i Interface CTDOT_Doc_Code w | View| Document w | : Spatial View: Default View ~ | Backgr
Address| | pw:ctdet.projectwiseanline.com:CTDOT\Documents\01.0 - Projects - Active\0135-02701100_Contract_Plans (F ¥ | [B» Go
-3 B

- [% 0098-0093 ~ List [ @ Geospatial
: t: gg:::g:g; Description Main Category | Sub Categary Sth Category Description Application
[ 00980103 | 00-Flan Set Updated ko FDP Flans con = Plans_08 - Consalidated 43
w26 i02-07e con FRL Plaris_04 - Final Plans (adv) Acrobat PDF 4fs
w0 (% 01020517 # Blo1.02 - revisions REVISIONS con FRL Plaris_04 - Final Plans (adv) Acrobat PDF £l
& [ n10z-0325 # [B) 01.03 - HY Detail e Y Detals & Misc con FRL Plaris_04 - Final Plans (adv) Acrobat PDF afz7
@ [*F 01020328 # Bl 01.03 - Hwiv Detail_ant Pages from CT_CON_FPL_0135-0270_01,03 - Hw..,  CON ADP Flans_05 - Addenda Acrobat PDF 413
@ [ 0104-0164 # [B) 01.04 - Plans & Super Dia HIGHWAY PLANS & SUPERELEVATION DIAGRAMS ~ CON FRL Plaris_04 - Final Plans (adv) Acrobat PDF 3f
@ [*F 01040167 # [B) 01.05 - Cross-sections ¥5C 5TA. 5+00 TO 125+00 con FRL Plaris_04 - Final Plans (adv) Acrobat PDF 3f
@ [* 0105-0206 /@ 01.06 - Cross-Sections C STA. 125+50 TO 245450 CON FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3f
@ [ 01070158 /@ 01.07 - Cross-5ections KIMGTA, 245+00 TO 350400 Con FRL Plans_04 - Final Plans (Adw) Acrobat PDF 3t
= [ 01080178 # Bloz.o1 - structurss 135-2% Final design Plans_Structures con FPL Flans_04 - Final Plans (adv) Acrobat PDF 3j2
& [ 0103062 & Bl oz.02 - structurss con FRL Plans_04 - Final Plans (adv) Acrobat PDF 3
. l——: oLip-nizz # Bl 0z.03 - structwres e el 1= 24 - Final Plans (Adv) Acrobat PDF 3f
* |4 0110-0123 # Bl oz.04 - structurss . 4 - Final Plans (Adv) Acrobat PDF 4
= L2 01150114 /amzﬂs-ﬁtru:t . Double CI'Ck bt PDF af
w4 01150117 «< Open document with
% 1% o115 0128 # Bl oz.06 - struet on the Set flle bt FDF 3
& % ol 1e-015 # Bloa.o - Traitq [caeat bat FDF 3ju
[ 01160134 # Blos.o1 - Lands and CI |Ck OK hat FDF 3z
& [ 01170153 Z Blosoz-muss) | program bt PDF Az
@ (% 01180163 # [B) 05.01 - Gener| hat FDF 312
& [ n120-0081 # [B) 05.02 - Revisi Maine Applicatian Erc hat FDF £l
e [[* 0120-0088 rd @ 05.03 - Ciwil (¢ Blusheam Revu Set Bluebeam Rev "C:iProgram FilesiBlusbeam Software!Blusbeam RevulRevulRevu.exe”"... Mo bat FDF 3j12
- [*% n124-0162 # [B) 05.04 - strucy hat PDF 3f12
@ [F 0124-0165 # Bl 05.05 - Existir hat FDF 3fz
[ n126-0162 # Bl 05.06 - Envir bt FDF 32
@ [ 01270058 /@ CTDOT_HIGH! bt PDF zn
= [F 01300173 # Bl ctoot_TRa bat PDF 11
®
&
®
&
®
o
®
&

L% 0133-0095
% 0135-0270

\SAsisASASARASARASASASARLS

100_Contract_Plans (PDF)
110_Contract_Specifications (FC
120_Contractor_Submittals (POF
130_s0il_atchasological_Misc_Ri
210_Construction

220_FHWA
230_Conkrack_Administration
240_Contract_Development
241_Contract_Development_Coi
310_Preliminary_Design_Docume
320_Permit_Applications
330_Design_Data
340_Administration
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€ ADMINISTRA|
€ Ere-adnin

€ o3-admin

€ cs-admin

€ EConnDoT_In.
€ EConsultant £
€ Crcodechan
€ CTDOT _Cont|
€ cTooT_Eng |
€ CTDOT Proc)
€ ctdot-servic

Click here For a list of suggested document viewers
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=
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A
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Figure 27 - Opening a Set File
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2. Next click on the Set icon and click Add as shown below:

CT_CON_FPRNI135-0270 01,01 - General pd =

(1) Click on the
Set Icon

TR = =
m.o.o1

ON_CNS_0 0270_00-P

File Name -
Paufctdo. projectuiseonline.com: CTDOTAD 0 - Projects - Active\I1 3502700 00_Contiact_Ple
Pafctdo, proiectwiiseoniin com: CTDOTAD1.0 - Prajects - Active\01 35-0270V 00_Contiact_Ple
Ft-ctdol. projectwiseoniine com: CTDOTND1.0 - Projects - Active\01 35-027081 00_Conbiact_Ple
Fawi-idot. projectwiseonling com: CTDOTA01.0 - Frojects - Activej

Phufctdot. projectuiseoniin. com: CTDOTA01.0 - Prajects - ActivefllEh1S

Pawsctdot, projectwiiseoniing com: CTDOTNO1.0 - Prajects - Activel

F4-ctdo. pojectwiseonlin. com: CTDOTA01.0 - Frajects - Active}

Fawi-idot. projectwiseonling com: CTDOTA01.0 - Frajects - Activel
Phuctdo. projectwiseonlin. com: CTDOTA01.0 - Prajects - Activel

o1.01.02

frty-Compeer

Fwt:ctdat. projectwissoniing, com: CTDOTY1.0 - Projects 3
Yosldol. projectwiseonling. com: CTDOTYO1. - Pigiset®™ Acive

D (2) Click Add

Sy then Projectwise
SonType then OK
01.01.03

Figure 28 - Modifying a Set File

3. Next browse out to your project and select the files to add to the set and click Open.

This may take a minute to add the additional file to the set so please be patient. After it

finishes click OK.

Q Open Document

Select |
Folder
‘ [ 100_onkract_Plans (PDF)
#la
Document
Name Description Main Catege
Vd-
7 B cT_con_FeL X (1) Browse out to
# BT _con_FeL_n135-0270_01,02 - Revisions.pdf 01,02 - Revisions REVISIONS con A
# B CT_CoN_FPL_0135-0270_D1.03 - HWY Detal & Misc.pdf 01,03 - HWY Detall & Misc HiwY Details & Misc con your p rojeCt
# Bl CT_Con_FpL_n135-0270_01.04 - Plans & Super Dia.pdf 01,04 - Plans & Super Dia HIGHWAY PLANS & SUPEREL..,  CON
# B CT_con_FPL_0135-0270_D1.05 - Cross-Sections pdf 01.05 - Cross-Sections H5C STA, 5+00TO 125400 con e Fians_u+ - rinai
/a CT_CON_FPL_0135-0270_01.06 - Cross-Sections,pdf 01.06 - Cross-Sections ®SC STA, 125480 TO 245450 CON FPL Plans_04 - Final
- Crass-Sections.pdf 01.07 - Crass-Sections HSC STA, 245400 TO 350400 CON FPL Plans_D4 - Final
# Bl cT_con_FRL_p135-0270_02.01 - Structures. pdf 02,01 - Structures 135-270 Final design Plans_St... CON FRL Plans_04 - Final
& B cr_con_FeL_0135-0270_02.02 - Structures.pf 02.02 - Structures 5125 FDP_Structures con FRL Plans_D4 - Final
# BICT_con_FRL_D135-0270_02.03 - Structures. pdf 02.03 - Structures 126 FDP_Structures Con FRL Plans_04 - Final
/B cT_con_FeL_0135-0270_02,04 - Structures.pdf 02,04 - Structures con FRL Plans_D4 - Final
# B)CT_con_FRL_D135-0270_02.05 - Structures. pdf 02.05 - Structures Con FRL Plans_04 - Final
/B cT_con_FRL_0135-0270_D2.06 - Structures.pef 02.06 - Structures con FRL Plans_D4 - Final
# B CT_comn_FPL_D135-0270_03.01 - Traffic pdf 03.01 - Traffic Con FRL Plans_04 - Final
/B cT_con_FL_0135-0270_04.01 - Landscape.pdf 04.01 - Landscape con FRL Plans_D4 - Final
# B CT_CON_FPL_0135-0270_04.02 - Invasive Remeval paf 04.02 - Invasive Remaval con FPL Plans_D4 - Final
# Bl cT_con_FRL_n135-0270_05.01 - General.pdf 05.01 - General con FRL Plans 04 - Final
# B CT_CON_FPL_0135-0270_05,02 - Revisions df 05.02 - Revisions Inde of Revisio o« -
# Bl cT_con_FeL_0135-0270_05.03 - Civil,pdf 05.03 - Civil cc (2) Select the flle
# B cT_con_FRL_0135-0270_05.04 - Structural pof 05.04 - Structural c
# Bl cT_con_FPL_0135-0270_05.05 - Existing Plans,pdf 05.05 - Existing Plans [ tO be ad ded tO
# Bl cT_con_FrL_0135-0270_05.06 - Envirenmental.pdf 05,06 - Envirenmental c -
# Bl CT_con_FeL_p135-0270_CTDOT_HIGHWAY_STD.pef CTDOT_HIGHWAY_STD Standard Detals [ the Set a nd CI ICk
# B CT_con_FRL_0135-0270_ZTDOT_TRAFFIC_STD.pdf CTDOT_TRAFFIC_STD CTOOT_TRAFFIZ_STD o) pen
< | > |
Address: ‘pw‘\\Etdnt.pm]ettwlseunllne‘(um‘CTDOT\Dutuments\Dl‘IJ - Projects - Activel0135-02701100_Contract_Plans (PDF)\CT7CON7ADP7D¥ 0270_01,03 - HWY Detail_a01pdf ~ ‘
\
Description: ‘ \ ‘
\
File Name: | C7_CON_ADP_D135-0270_01.03 - WY Detall_ADLpef \ |
\
Application: [crabat FDF \ v
[¥] Open document as read-only

t Open Epenrmmmsk Cancel
" S—

Figure 29 - Adding Files to the Set File
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4. Now the file will be added to the set, scroll down and you will see it.

- = > ° *3 0
E ON_ADP D D270 01.0 D 0
.01_.52.01 —
5T CON ADP 01350270 01 3 - WY Derail .
Addendum No. 1
i plan sheet .03 - HIG:‘L“J&"OE
071.03.01.41 B
CT_COM_FPL_0125-0270_071.02 - H¥Y Detail & ... Ti-b SURNEY TIE ROXER
LIS [
== 8 "':
Original Plan
sheets
8- o comecnur §
+ X 34 0%

Figure 30 - Set File
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1.12.3.2

Deleting a File from the Set

1. Double click on the set file from Projectwise and open as shown below: This may take a

while depending on how big the project is, please be patient.

130_5oi_Archaeological_Misc_Ri
210_Construction

220 FHWA
230_Conkract_Administration
240_Contract_Development
241_Contract_Development_Cai
310_Preliminary_Design_Docume
320_Permit_Applications
330_Design_Data
340_Administration

|SARASASARASASASASARARARAS

Issued 01-2016

ConnDOT_In
€= cansultant £
€ crcadechan
€F cTooT_Cont|
€ cTooT_Eng |
€ cTooT FProc)

€ ctdot-servic

Qpen document as read-only
Click here For & list of suaqested document viswers

Browse

() =n

€ pave.srumba...

€ Extraction
=00

Dave Brumbaugh BENTLEV
Service Account Ext,..

A
1<
1=
1=1<]
1=<1<

Figure 31 - Opening a Set File
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&
N & RS @ : #4 - |searchil v | > : Interface| CTDOT_Doc_Code v | : View| Document | : Spatial View: Default View v | : Backgr
Address| | pw:\ctdot.projectwiseonline.com:CTDOT\Documents\0L.0 - Projects - Active\0135-0270\100_Contract_Plans ( ¥ | B> Go
2B
n-: 0038-0033 List | @ Geospatial
00360101
e Description Main Category | Sub Category | Sub Category Description Application
+ :,g 0095-0103 | D0-Fian Set Updated ko FDP Plans con ChS Plans_0& - Consolidated 43
(%% 0102-0278 con FrL Plans_04 - Final Plans (Adv) Acrobat FDF 45
e [ 01020317 # Bl o1.02 - revisians REVISIONS con FPL Plans_04 - Final Plans (Adv) Acrobat PDF an
(%% n102-0325 # [B) 01.03 - HY Detail e Hw¥ Detals & Misc con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3427
& % n10z-0328 # [B) 01.03 - Huiv Detail_ao1 Pages from CT_CON_FPL_0135-0270_01,03-HW... CON ADP Plans_05 - Addenda Acrobat PDF 443
& L6 0104-0164 # [B) 01.04 - Plans & Super Dia HIGHWAY PLANS & SUPERELEVATION DIAGRAMS  CON FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3
@ % 01040187 # [B) 01.05 - Crass-Sectians X5C 5TA. 5+00 TO 125400 con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3
L% n105-0206 # B 01.08 - Cross-sections con FRL Plans_04 - Final Plans (dv) Acrobat PDF 3
= %% nwo7-0158 # B 01.07 - Cross-sections XSMSTA, 245+00 TO 350400 CON FRL Plans_04 - Final Plans (Adw) Acrobat PDF 3t
L-: 0108-0178 # Bl oz.01 - Structures 1:35-2% Final design Plans_Structures CON FRL Plaris_04 - Final Plans (Adw) Acrobat PDF 3z
i = 0109-0162 & B 0z.02 - Structures con FRL Plans_04 - Final Plans (dv) Acrobat PDF 3
e 0110-0127 # Bl 02.03 - Struchures el L ~1-= 4 - Final Plans {Adv) Acrobat PDF 3
iy A gﬁgg:fi # Bl0z.04 - Structures D bl lick 4 - Final Plans (Adv) Acrobisk PDF 4
e # B 02.05 - Strucy ) ouple clic bt FDF 4
% 1150117 S Blozos . coafl Open document with | o vor o
® % 01160128 - = i =
7 arentas # Bloant - Tesffd [“zojoqt on the set file bat PDF 3jt
- .
% % ol60134 78 04,01 -Lands and click OK bat FDF 3z
m [ 01170153 A Bloanz-twas | -Program bat FDF 3i2
e [ 01160163 # Bl os.01 - Gener| bat FDF iz
(% 0120-0081 # Bl 05.02 - Revisi Name Application Enz bat FDF an
& [*F 0120-0088 A Blos.03- il (% Blusheam Revu Set “C:iProgram FilesiBlusbeam Software\Blusbeam RevulRevuiRevu exe” ", Mo bk PDF 3z
% n124-0162 # [B) 05.04 - Strucy bk PDF 3z
% n124-0165 # [B) 05.05 - Existir} bt FOF 3z
2% n1ze-n162 # [B) 05,06 - Erwir bt FDF 32
@ [** 0127-0088 # Bl cTooT_HiGH bat FDF 2j1
128 man-n173 # Bl ctooT_TraF hat POF 11
@ % 0130-0178
@ [ 0131-0191 <
& [7F 0131-0194 8 0131-0195
= 510157 Dacument Properties|
% g
[ 0131-0198 Real (Documer v
@ | 0131-0202 e
% 0133-0094
@ % 0133-0095
= [ 01350270 €F ADMINISTRA|
100_Contract_Plans (PDF) € Eop-advin
110_Contract_Specifications (FC € ooadnin < >
120_Contractor_Submittals (PDF € CLS-admin
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2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

et e R ey e Note: You can make
the width of the file —+O
General pdl. 6FE10.63

P ctdot. projectwizeoniine.com CTDOTY01.0 . 2F0_01.071 - L pdt. |

P ctdot. projectwizeoniine. com CTDOTOT, EI n a m e col u m n WI d e r 270_01.02 - Revisions.pdf B7E10.28

P ctdot projectwizeoniine. com CTDOT01 270_01.03 - Hwh' Detai & kisc pdf 67610.32

P ctdot. projectwizeoniine. corm: CTDOTO1. D 270_01.04 - Plans & Super Dia.pdf. 67610,29

P ctdot. projectwizeoniine. com: CTDOTY01.0 by d ra g g I n g th e co I u m n 270_01.05 - Cross-Sections. pdf. 67610,25

F’W ctdot. projectwiseonline. com CTDOTAO0T.0 h e re 270_01.06 - Cross-Sections. pdf. 67610.26
tdot. projectwizeoniine. com CTOOTY01.0 270_01.07 - Cross-Sections. pdf. 67/610,27

T - n T e s e e T
P ctdot. projectwizeoniine. corm: CTDOTY01.0 - Projects -Actlva\D‘I 35-0270M1 UU Contract_JMans [PDFNCT _COM_FPL_0M35-0270_02.04 - Structures. pdf. 67610,86
P ctdot. projectwizeoniine. com CTDOTYO1.0 - Projects - | g .05 - Structures. pdf. 67610,87
P ctdot. projectwizeoniine.com CTDOTS01.0 - Projects - - Structures. pdl.67610,57
P ctdot. projectwizeonine. com CTDOTSOT.0 - Projects - | | | | .07 - Traffic.pdf. EYE10,62
P ctdot. projectwizeoniine. com CTDOTYO1.0 - Projects - Activet0135-02704100 2 - Landscape pdf. 67610,81
P ctdot. projectwizeoniine. corm: CTDOTYO1.0 - Projects - Activet0135-027041 - Invasive Removal pdf 67610,49
P ctdot. projectwizeoniine. com CTDOTAO.0 - Projects - Actlva\m 35-0270° - General pdf. 67E10.71
P ctdot. projectwizeonine. com CTDOTYO1.0 - Projects - - Revisions.pdf 67610.75
P ctdot. projectwizeoniine. com CTOOTY01.0 - Projects - Acti | | | | _ | FPL_I | | - Civil pdf. 6FE10,72
P ctdot. projectwizeoniine. com CTDOTY01.0 - Projects - Acti | | | _ | FPL_I 2 | | - Stuctural pdf. B7E10,73
Prad:ctdat. projectwizeonline. com CTDOTY01.0 - Projects - -02705100_Contract_Plans [PDFISCT_COM_FPL_0135-0270_05.05 - Exigting Plans. pdf.E7E10,76
P ctdot. projectwizeoniine. com: CTDOTAO.0 - Projects - Acti 35-02704100_Contract_Plans (FOFACT _COM_FPL_0135-0270_085.06 - Environmental pdf 67610,77

Select file to delete

and select delete, then
_ click OK

Sort By |Page Label Only V|

Sort Type: |A\phanumeric Azcending e |

Figure 32 - Deleting a File from the Set File
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Section 2 Digital Signatures for Contract
and Other Engineering Documents

The follow contract documents must be digitally signed when submitted to the Department in
accordance with the following section:

e Contract Plans — FDP, Addendum, Change Orders

e Engineering Reports

o Hydraulic Report
Scour Report
Floodway Report
Final Drainage Reports
Bridge Inspection Reports
Task 110
Task 220
o Underground Storage Tank System Closure Reports

e  Working Drawings for Permanent and Temporary Structures — Plans and Calculations

O O O O O O

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures.
The Engineer of Record or document signer will always digitally sign using a visible certifying
signature. If multiple signatures are required per document, the second signer or sub-engineers
shall always digitally sign using a visible signing signature after the primary signer or engineer
has applied his certifying signature. Certifying signatures allow controlled changes, to the now
certified document. These controlled changes include; allowing PDF digital comments, and the
application of additional signatures. Signing signatures should always be accompanied by a note
listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the
first sheet of the document, regardless of the number of pages the document contains. This
digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following
purposes:
e It shall be attached to the digital signature and displayed when the digital signature is
applied.
e It shall be placed as a watermark on all contract plan sheets a particular engineer of
record is responsible for (digitally signing for).
e It shall be placed on the first sheet by the preparer and checker of an engineering
report.
e The watermark shall be placed on all contract plan sheets and all plan sheets contained
in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the
specifications of Adobe’s Certified Document Services (CDS). The necessary hardware and
software needed to apply the required digital signatures may be purchased from the vendor list
provided at the following website: http://www.adobe.com/security/partners cds.html,
additional information on Adobe’s CDS is also available at this website.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
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2.1 Graphic Image of Signhature

2.1.1 Contract Plans
The following figures display an example of both a state designer and a consultant designer’s
digital signatures, and their accompanying graphic image(s) of their signature(s). See section 2.2.
for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state

employee’s graphic image must contain only his signature. See Below.

- State Design
Digital Signature

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

= “E;_f 15t age of Subset ) ﬂunagﬁgg&ss
E oo’

L. Consultant
““% Digital Signature

ustns-mnu

IlAnA 3

Scanned Signature "Graphic Appearance

Figure 33 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages
be watermarked with a copy of the engineer of records graphic signature before they are
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are
always placed in the border of contract plans and working drawings for permanent structures.
This is to prove validation of a digital document if printed.

Watermark of State Design Graphic
Signature

Vgt = 1|_0--'\J SCA

T W PROIECT T
7| OFFICE OF ENGINEERI
APPROVED BY: ').QTF N

Watermark of Consultant Designers
Graphic Signature

.T.S,

B

awiling,

“n!wwé" Consutrt ca. A
Addre:

=

Figure 34 — Watermarks
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2.1.2 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic,
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital
signature of the Approved Hydraulic Engineer. The digital signature must include the graphic
image of the signer’s PE stamp and signature as shown below, section 2.2. for instructions on
how to create a graphic image. These reports shall be digitally signed in accordance with section
2.6.7

May, 2014
Revised November. 2014

Prepared for:

Siate of Connecticut

Digital Signature oc.oiment o ronssortation

J FINAL HYDRAULIC ANALYSIS REPORT

pproved By: Bl'idge NO. 00]45
W Project No. 170-2811 (P.E.)
ﬁ,*g/{i':;;%"‘»*’ff‘»z;_ David M. Cicia State Project No. 83-261

&%) M J7E 2014.11.03 F.A.P. No., 0951(351)
"g’&ﬁ?ﬁf 09:33:39-05'00' I-25 over Wepawaug River
Milford, CT

¢ Watermarks of
Prepared B_\«D:llc: 11/4:2014

Cameron Hendry P re pa re r a n d
Checked By: - Date: 11/4/2014
o David Cicia ” Chec ker

Figure 35 - Engineering Reports
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Bridge Inspection Reports

The following shows how Bridge Inspection reports are to be digitally signed in the bottom right
hand corner of the report. The digital signature must include the graphic image of the signer’s
PE stamp and signature as shown below, section 2.2. for instructions on how to create a graphic
image. These reports shall be digitally signed in accordance with section 2.6.7

Inspection Type: Routine and Fracture Critical

BRIDGE NO.08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015

Inspected by:  TranSystems

Digital

SIQnature Mathew J.

Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 36 - Bridge Inspection Reports
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Environmental Compliance Reports

The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure
Reports must include a graphic image of the Professional engineer’s signature or a graphic
image of the signer’s signature where applicable, see section 2.2. for instructions on how to
create a graphic image. These reports shall be digitally signed in accordance with section 2.6.7

2.1.3 Working Drawings

Working Drawings for Permanent and Temporary Structures

The following shows the digital signature and Professional Engineering watermark requirements
for the engineer who prepares the working drawing submittal. These types of submittals shall
be digitally signed in accordance with section 2.6.6 Note: Working Drawing for Temporary
Structures only require that the first sheet in the submittal be digitally signed, watermarks are
not necessary. See section 2.2. for instructions on how to create a graphic image.

Working Drawing Plans

The first plan sheet in the submittal shall have a digital signature and a watermark placed on it
as shown below. All others sheets will only have the watermark. A place in the border of the
plan sheets shall have a spot for this watermark.

BEAM END PAINTING AND BEARING REPLACEMENT IN DISTRICT 2.

CONNECTICUT DEPARTMENT OF TRANSPORTATION |
STATE PROJECT NO. 172-405

BRIDGE #3415 & #3416 - WORK PLAN

DRAWING INDEX )

13002-01-01

COVER SHEET

130020102

GENERAL NOTES

13002.01-03
130020110

JACKING PROCEBURE
PLATFORM PLAN

13002-01-11

PLATFORM PLAN

~| Digital Signature

130020112
130020113

JACKING PLAN
JACKING PLAN

130020120

PLATFORM SECTION

13002-01-21

PLATFORM SECTION

A William Pratt
4. 2014.03.12
13:49:10-04'00'

130020122

PLATFORM SECTION

130020123
130020124

PLATFORM WALKWAY
STAIR CASE

13002-01-30
130020031
13002 0140

JACKING DETAIL
JACKING DETAIL

CONTAINMENT SECTION

13002-01-41

CONTAINMENT SECTION

Watermark

~

130020156

CONTAINMENT DETAIL

[13002.01.60
130020161

CONTAINMENT NOTES
CONTAINMENT NOTES

BEAM END PAINTING AND BEARING REFLACE,

N mISTRIC

T2, CONNECTICUT

MENT

oG T

Issued 01-2016
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BRIDGE #3415 & #3416
“COVER SHEET

172-405
" M)

Figure 37 - Working Drawing for Permanent Structures
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Working Drawing Calculations
The first sheet of the calculations shall have a digital signature as shown below:

ABHE
SvosoDA
INC.

W

BRIDGE BEAM END AND BEARING REPAIR
IN DISTRICT 2
CONNECTICUT DEPARTMENT OF
TRANSPORTATION

PROJECT NO.172-405, ASI JOB NO.13002
(BRIDGE #3415 & #3416)
Calculations

William Pratt

Digital =% , .
¥ ix 14.03.1
Sighature SR 50 k00

Abhe & Svoboda, Inc.
17066 Revere Way, Prior Lake, MN 5537

June 24, 2013

Ane: & Sucbada, Inc. s an Equal Opparunity Employer

Figure 38 - Working Drawing for Permanent Structures

2.1.4 Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic
image of the signer’s signature attached to their digital signature. See section 2.2. for
instructions on how to create a graphic image.
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2.2 Creating Graphic Image of Signature:

2.2.1 In House CTDOT or Non-Professional
Engineering Signature:

The graphic signature will be used by CTDOT employees and signers that are not signing as a
Professional Engineer.

CTDOT graphic signatures shall be created as follows:

Signer must sign a blank piece of paper.

Scan this signature.

Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
Save the images, in PDF to an area on your PC.

12 30—

Figure 39 (Example of CTDOT Graphic Image of Signature — Used with Digital Signature and as a Watermark)

PwnNPE

2.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall
accompany their digital signatures and a different one that shall be placed as a watermark on all
the plan sheets the engineer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their
signature; Architect’s shall follow this section when they are preparing their digital signature.
Graphic Appearance Attached to Digital Signature

The graphic signature that accompanies the digital signature only needs to include the
designer’s signature and P.E. Stamp. , and shall be created as follows:

Stamp and Sign a blank piece of paper.

Scan this signature.

Crop the image to approximately 250 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the signature set-up procedure.

PwnNPE

-----

Figure 40 ((Example of Consultant Engineer Graphic image of Signature — Applied to 1* page only with digital signature)

Graphic Appearance used as a Watermark
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In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a
watermark shall also include the designer’s company name and address, and shall be created as
follows:

On blank paper — Print company name and address.

Place P.E. stamp next to company name and address.

Sign P.E. Stamp.

Scan the image created in steps 1 thru 3 above.

Crop the image to approximately 500 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the watermarking procedure.

ounkwnE

Figure 41 (Example of Consultant Engineer Graphic image of Signature — applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature
appearance preferences must be set as follows:

2.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be
defined as follows:
Bluebeam Digital Appearance
1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the
Document tab and select Signatures>Digital ID’s:

Document Form Marup Measurs Window Help

m@ D¢ % Rhixd

3 Process Flatten

E-m= Studio Security

J’_’_.. Sign Document
NE 9 a1 5 | % Add Signature Field

| | : - Certify Document. ..

Documentl*® = Validate Signatures

Digital IDs...

Trusted Identities...

Figure 42 - Digital Appearance

2. Nextclick on your ID and click Manage Appearances:
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(1) Select ID

Location

d:\Documents and Settings\oalkinsmihAapp
Wwindows Certificate Stare [j

|dentity

— ame:
OrganizationayL nit:
Organization M &me:

E-mail &ddres:

oy S

Mathew Calking lzzued By:

Starts:
AEC Applicati Expires:
rhathew cafins@ct, gov

(3) Double Click

Dijafital Signatures and Drata Encryption

- [Export...(‘IFManageAppearances... l R
(2) Click Manage

Appearance

Figure 43 - Manage Appearances

3. Next follow the figure below:

) Mone

Signature Appearance
(Trtle: Mathew Calkins| ) 44— Type in Name
Graphic

@ File

D \Usershcalkinem)\Desktopmic pe jpg

D e—

Posttion: @) Left

) Right ) Background

oy

af [¥] Name

("] Distinguished Name
v} [] Location

[¥] Reason

["] Contact Info

[¥] Date

M

— W00

V4

4

Font Size: |9

Preview

-
[ Labels
Auto % [ Logo

<Name>
<Reason>
<Date>

Co D)

Browse to graphic
appearance

Make sure these
settings are set
as shown

_~ Click OK

Figure 44 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.
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2.4 Watermarking Plans with Graphic Image of
Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a
copy of their graphic signature as a watermark on each sheet of each discipline subset, or
working drawing submittal(Plans and Calculations) that they are responsible for. For
Engineering Reports the preparer and checker of the report shall place a copy of their graphic
signature as a watermark only on the cover of the report.

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant
Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The
following shows an example of a CTDOT signature, but the procedure is the same for a
consultant when they are placing their PE stamp in the border or on the first sheet of an
engineering report.

Watermarking Workflow:

Option 1
1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup

tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not
in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

|\ =

Place stamp in this
area in the border ——

SLONATURE! PROJECT  TITLE:
BLOCE

F CONNECTICUT @ OFFICE OF DNGINEERING
)F TRANSPORTATION =t

L = L=
145 Duck Pan.dgn Méf‘

Figure 45 - Placing Watermark
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3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an
engineering report you do not need to apply to all pages.

Cut

Copy

Open Pop-Up Note
Change Colors

Crder

Alignment

Edit Action
Flatten

- Comments
Lock Ctrl45hift+L .

Reply

Set Status

Chede

Add to Tool Chest
Set as Default
Apply to All Pages

Properties

Figure 46 - Placing Watermark on All Pages

If more than one group has to watermark this subset, browse to the pages the other group is
responsible for and delete the watermark. Then they can come in a place their watermark on
these sheets.
Flatten Markups

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF

document. Go to Document>Flatten Markups. Use the default settings and click OK.

Option 2

1. Go tothe Document tab and Pages>Apply Stamp.

Document Form Markup Measure Window Help

=

Insert Blank Page... Ctrl+5hift-+M

Documentl™® ; - Ctrl+5hift+

Crop Pages... Ctrl+5hift+C

Number Pages...

Figure 47 - Applying Stamps
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2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

Apply Stamp
Stamp Selection
HAVE_Admin'Bluebeam Stamps*Traffic

e

Vaiy

X
ect stamp
(oo

3|

@ﬂuck Harlow brx

Name:

Author:
Size: 3.77inx058in

Date: 10/18/2011 7:23 AM

Blend Mode: |Norrna| {nong)

Opacity: (100

~
-

%

Pag;
Pages |All Pages (1-36) v Of%)

Pages Range (1-36)

Edi Stamp | [ Add Fies |

k Choose page
4 » File [1of 1] State Dﬁgﬁm@u&lsgﬁtion

Choose scale and
4+ position

43 (14

1 (100

: [17.9610 Inches

Inches

oo D00
000

[ Lock

Figure 48 -

Flatten Markups

Applying Stamps

3. After the watermarks have been placed on the subset, the watermarks must be
“flattened” to the PDF document. Go to Document>Flatten Markups. Use the default

settings and click OK.

2.5 Digital Signature Fields

Contract Plans

Digital signature fields are form fields created using Bluebeam, and are used to house the digital

signatures. Digital Signature form fields shall

be placed within the form field place holders. The

form field place holders are cells that are placed in the MicroStation file on the title sheet and

the subset cover sheets and on any Addendu

m or Change Order Subset. The figure below

shows a CTDOT designed project with the form field place holders (circled) on the title sheet and

the discipline subset cover sheet.

rgg’é CONNECTICUT DEPARTMENT OF TRANSPORTATION ‘-’5“;
. s L.

EDIT FOR
PROJECT

TITLE

romnie iy ot
EDIT FOR
TOWNS AND/OR
CITIES

- SUBSET NAME

#4
INDEX OF DRAWINGS

‘, =

=
|

Figure 49 - Digital Signature Fields
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The figure below shows a consultant designed project’s title sheet and discipline subset cover
sheet with their form field place holders.

@ CONNECTICUT DEPARTMENT OF TRANSPORTATION (@)
EDIT FOR =

PROJECT
TITLE ## - SUBSET NAME
INDEX OF DRAWINGS

Townis)city of
EDIT FOR
TOWNS AND/OR
CITIES

/oo0o-000 [-5 e

Figure 50 - Consultant Watermarks

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT Digital Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each
discipline subset for each required digital signature.

Note: All signature form fields need to be created for both certifying and signing signatures
before any digital signatures is applied to the document.

Contractor Submittals
Contractor submittals will not be required to have a digital signature place holder.

Engineering Reports
Engineering reports will not be required to have a digital signature place holder.

2.5.1 Bluebeam - Creating Digital Signature Form
Fields

The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed
01-General title sheet, only one digital signature form field needs to be placed.

Com Markup Measure Window Help

Go to the Document tab and select Signatures>Add Signature Field.
View Document

o -

Print E-ma Studio

SNk iy

| | |
4 - |?-| 4 Documentl® =

s Digital IDs...

Trusted Identities

Figure 51 - Adding Signature Fields
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2. Next place three signature fields in the appropriate location and hit save as shown
below:

THE DESIGN APPEARS TO COMNFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAM THAT ALL ASPECTS OF THE DESIGN HAVE
BEEM PERSONALLY CHECKED BY THE UNDERSIGNED.

SUBMITTED BY TRANSPORTATION PRIMCIPAL ENGINEER P.E.
(>

WPPROVAL RECOMMENDED BY MANAGER OF STATE DESIGN - SCOTT A, HILL P.E.
[

APPROVED TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 52 - Placing Signature Fields

2.6 Applying Digital Signatures
This section describes how to apply digital signatures for contract plans, engineering reports,
working drawing plans, and working drawing calculations.

Contract Plans
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic
Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded
into projectwise because the Principal Engineer will be looking in projectwise to digitally sign
documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of
record, using a single visible certifying signature, applied to the signature form field located on
the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of
Record who is responsible for the most sheets in the subsets. This engineer will apply a visible
certifying signature in the top most form field. The next Engineer of Record shall apply their
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when
applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital form fields, previously created. See Section 2.5
Engineering Reports

Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying. See
section 2.7. for instructions on how to apply a certifying signature to an engineering report.

Issued 01-2016 50 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

2.6.1 Applying Digital Signatures to 01_General
Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General_A#
subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead
discipline’s Principal Engineer, using a certifying signature. The Principal Engineer should make
sure that all three digital signature form fields (blue boxes in the signature block) are placed
before signing, as these forms cannot be added after the document is digitally certified. After
processing has approved the 01_general subset for Advertising, the Manager, and the
Transportation Engineering Administrator shall digitally sign the same sheet directly below the
principal’s signature, using a signing signature while the plans are in the Manager and Engineer
Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager
and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by
the Manager and Engineering Administrator of the 01_General subset. When both signatures
are applied to the plans, the lead designer shall then notify processing that the 01-General
subset has been signed.

See Section 2.7 Applying Digital Signature Workflows

Note: When digitally signing the 01_General subset all signers shall leave the reason code
blank.

The following image shows a typical project title sheet from the 01_General subset that is
digitally signed:

RAFFIC CT_CON_DCD_0092-0655_01_General &

CONNECTICUT DEPARTMENT OF TRANSPORTATION

Plans For

UPGRADE
OF
SIDEWALK RAMPS

Town(s)/City of

NEW HAVEN

0092-0655 |-

Figure 53 - Title Sheet Digital Signatures
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THE DESIGN APPEARS TO CONFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEN PERSONALLY CHECKED BY THE UNDERSIGNED.

Visible Signing Signature

ik /”/%z? 20920608 1156180400 Vieible Certifying Signature
SUBMITTED BY: TRANSPORTATION PRINCIPAL ENGINEER - LEQ L. FOUNTAINE P.E.
\\) At &(Q;QLA_ Equn;%ibi%ggmss-owoa Visible Signing Signature
APPROVAL RECOMMENDED BY: MANAGER OF - JAMES A. FALLON P.E.
’? ! James H. Norman

2012.04.04 09:58:05-04'00"

APPROVED BY: TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 54 Example: CTDOT 01_General.pdf, Project Title Sheet Digital Signatures

CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant,
using a certifying signature.

See Section 2.7 Applying Digital Signature Workflows

When more than one consultant works on a CTDOT digital project the project manager (prime
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.
By applying this signature the prime consultant is accepting responsibility for the entire set of
digital contract plans. However the individual subsets shall be signed by the corresponding
firms.

Note: When applying certifying or signing signatures leave the reason code blank.
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2.6.2 Applying a Digital Signatures to 02_Revisions

Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet
is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed
by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 2.7 Applying
Digital Signature Workflows with the following EXCEPTION; the option “No Changes
Allowed” must be selected to eliminate unauthorized changes after certifying the

document. See the figure below:

Drigital 10

| Matt Calkins

Pazsword:

vH Miem... ][ Mew... ]

Signature Type
() Digital Signature

(%) Document Certification

Mo changes allowed

I ('-"etmltted changes after cerhifying: D
| DA

b

Optionz

Reazon: |

Location: |

Contact Info: |

Appearance

| Standard Text

v || Edt. || New. |

#eteer f 95 < ocation>

<Name>

<Date>

l ak. ” Cancel ]

Figure 55 Certifying Dialog Box for 02_Revisions.pdf
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2.6.3 All Other Discipline Subsets - Single
Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the
responsible design engineer. As shown below.

See section 2.7 Applying Digital Signature Workflows

: i, .
O O NSULTANT COMPANY NAME \ _..ng’/ William Pratt

2009.01.27
oites /ES 10:46:19
| o‘?,;m"”eﬁx* -05'00'

s,
'°\

¥a

"
\§=t€5€!
ei{n' L(\
ltlll\\i\

Figure 56 CTDOT Certified Plan Subset

2.6.4 Standard Drawing Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need

to be digitally signed with a visible certifying signature, by the responsible design engineer that
submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the
index sheets, not the Highway Principal Engineer.

See section 2.7 Applying Digital Signature Workflows

2.6.5 All Other Discipline Subsets — Multi-
Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same for
CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are
responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall
digitally sign the subset using a certifying signature, and leave the reason code blank. See
Section 2.7 Applying Digital Signature Workflows
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Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset
using a signing signature, and complete the reason code with a note stating which pages,
contained in this subset, that they are responsible for. See table 2-1 below:

See Section 2.7 Applying Digital Signature Workflows
Table 2-1 Reason Codes for Prime and Sub Consultants

Designer Certify or Responsible Reason Code
Sign Sheet
Numbers

Lead Designer Certify
Sub-Designer 1 Sign 03.78 Thru | am Signing for Sheet Nos. 03.78 thru

03.88 03.88
Sub-Designer 2 — Sign 03.88 Thru | am Signing for Sheet Nos. 03.88 thru
etc. 03.98 03.98

2.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 2.7 Visible
Digital Signature using a Certifying signature, of this manual.

2.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See
section 2.7 for instructions on how to apply a certifying signature to an engineering report. If a
report needs to be digitally signed by more than one person, the first person must apply a
certifying signature as shown in section 2.7 and any subsequent signature will be a signing
signature as shown in section 2.7.
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2.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The

figures contained in this section show a CTDOT signature where the document is located in
Projectwise, but the workflows are the same.

Certifying Signature:

1. Leftclick on the signature field and then update the settings as shown below. Examples
below are for a CTDOT designed project’s title sheet and the first sheet of an

Engineering Report:

Discipline Subsets

Sign

( Mathew J. Calkins, P.E.

Fassward:

Signature Type
(") Digital Signature

G- Document Certification __)

Pemitted changes after cerifying:

=
\
—

 Select your ID
and then select

/

( Markups, fill in forms, and digital signatures

as shown.

>

Then Click OK

Options
Reason: -
Location:
Contact Info:
Appearance
Standard Texd v][ Edit. .. ][ Mew... ]
Mathew J.
i Calkins, P.E.
Ll [aké '
Fafar 2 9016.03.10
10:42:14-05%"

([OK ’

Cancel ]

Figure 57 - Certifying Discipline Subsets
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Engineering Reports or Documents that Require (1) Digital Signature

FINAL HYDRAULIC REPORT
FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER

(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC

March 8, 2010 -
Prepared By: Plitar f 5 Date: 1/21/14 CI k h
Mathew Calkins ic on the
Checked By: 1 b Date: 1/21/{ . )
) ill signature field
an -
to certify

Figure 58 - Certifying Engineering Reports

2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list

below:
Save To El
Type ocation atus
[l ProjectWise VBi ctdot projectwiseonline com CTDOT Logged In ™

Figure 59 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for projectwise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File x|

The file 'TT_DOC_PUB__Intro to Bluebeam pdf” already exists
A in ProjectWise.

Do you wart to overwrite. Select "No’to save as a new

filename.
( Yes U Na ][ Cancel ]

Figure 60 - Certifying Signature

4. If using Projectwise check the document back into Projectwise.
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Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be
applied by the sub-consultants as follows:

1. Leftclick on the signature field and then update the settings as shown below:

Sign X
=) Select your ID, a reason
Click on the Maten Cabors v =TT if necessary and select
i as shown
/ signature
Sonature Type
THE OCSIGN APPCARS TO CONFORM TO APPLICAIRE, ITERIA. APPROVAL IS /
e e e Perminad changes aher centyiog
[/
' Mas) Calkins
w‘z 20)¥.10.18 10:40:43-04'00"
;.IHU A7 TNATTONATION PR DR -

Mathew Calkin

3
Mé:’zmuo.ww:

40:46-04'00'

Figure 61 - Signing Signature Bluebeam

2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list
below:

Save To

atus
Logged In

ProjectWise V& ddcnt projectwiseonline. com:CTDOT

Figure 62 - Open from Projectwise

3. Then select yes to overwrite existing file as shown below for Projectwise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

The file CT_DOC_PUEB__Intro to Bluebeam pdf’ already exists
A in ProjectWise.

Do you want to overwrite. Select "Mo'to save as a new
filename.

Yes Mo ] [ Cancel ]

Figure 63 - Overwriting a File
4. If using Projectwise check the document back into Projectwise.
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Section 3 Projectwise and Submitting
Documents to CTDOT

This section details Projectwise and the procedures for submitting and checking documents that
are submitted to CTDOT.

3.1 Discipline Subset PDF Checker

The Discipline Subset PDF Checker software was developed to check that Contract Plan
Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the
old requirements of attaching the discipline subset checklist to each subset and stamping each
subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick
Client. See section 3.1.2 for the typical workflows for using the PDF Checker. This section
provides details for Projectwise Thin Client users.

The following details what is checked with this software:

(1) CAD Requirements have been completed correctly:
a. Page Size (see section 1.4.1)
b. Searchable Text (see section 1.4.1)
c. Levels (see section 1.4.1)

(2) PDF post processing steps have been completed correctly:
a. Page labels (see Section 1.6.2)
b. Sheet numbers (see Section 1.6.2)
c. Watermarks and flatten comments(see Section 2.4)
d. Any digital signature fields (see Section 2.5)
e. Digital Signature (see Section 2.6)

(3) The subset was uploaded and attributed correctly in Projectwise.

After the PDF checker is run, an Excel report is created detailing what is incorrect on each
subset. Things that are incorrect will show up red and include a note on what is incorrect. Also
an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document
is run through the checker:

o List |. Geospatiall P —
Label (User DE‘fH’I;d] Description Document Date (m... Application State r Format_Compliance aJtto
/Bl o1- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRAMSF. § PASS
/B 02- Revisions Revision Sheet Acrobat PDF DOCUMENT TRAMSF..§ PASS
/B 03- Supporting Docume...  Supperting Decuments Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
7 Bl oa- civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF. § PASS
/ 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS

B) 08- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS

- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS

- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS

=4 09- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§ PASS
_/ - Electrical Electrical Plan &' S DOCUMENT TRANSF. § PASS
/ll-EnvironmantaI Environmental | Format COmpliance :_—M.‘ FAIL
_/ CTDOT Highway_STD Highway Stand: F DOCUMENT TRAMSF. § PASS
_/ CTDOT Traffic_STD Traffic Standard Att ri bute F DOCUMENT TRANSF.. \ PASS

Figure 64 - Format Compliance Attribute

The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which
includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.

Issued 01-2016 59 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

3.1.1 Installing the PDF Checker

This is step is for consultants only, DOT staff already have the checker installed.
1. Download the PDF checker executable from this link: Discipline Subset PDF Checker
2. Close Projectwise if it is open.
3. Runthe executable.

3.1.2 Typical Workflow for using the PDF Checker

CTDOT Designed Projects
The following details the typical workflow for a CTDOT designed project.

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into
Projectwise in accordance with this manual.

2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the
unsigned subsets, any errors can be found before the Principal digitally signs. Note: An
error will be returned that a signature was not found and the Projectwise attribute will
show FAIL.

3. Ifthere are any other errors, other than the signature error, they shall be fixed. If the
only error in the report is the signature error, then the plans can be digitally signed by
the principal.

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check
the digital signature was applied correctly. If there are no errors then the check is
complete. If there are any errors they shall be fixed and the PDF Checker rerun.

5. The project lead should check in Projectwise that all subsets have PASS in the Format
Compliance attribute column.

6. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.

Consultant Designed Projects
The following details the typical workflow for a Consultant designed project:

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in
accordance with this manual.

2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does
not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead
consultant on the project to run the PDF Checker on those discipline subsets. Any error
shall be fixed and the checker rerun until the report does not have any red errors.

3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all
subsets have PASS in the Format Compliance attribute column.

4. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.
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3.1.3 Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The
following shows how to check multiple discipline subsets, but the procedure is the same for
checking one subset.
1. Loginto Projectwise.
2. Browse out to your project and open the 100_Contract_Plans folder.
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF
Check. Hold control or shift to select multiple subsets.

- b EVie‘w[Dacument v] EInterface[C{Do‘[ﬁDogCode

MNDocuments\01.0 - Projects - Active’0077-0234'100_Contract_Plans I + > Go

List |. Geospatlall
Label (User Definea) Description Document Date (mm/dd/yyyy) Application

e a 01-General

MNew 3 Acrobat PDF|

/. 02-Revisions Acrobat PDF|
Wd 03-supporin| Open Acrobat PDF
PP
P4 - |04-Demoalitiol Open as Read-Only Acrobat PDF|
/‘ 05-Civil Open With... Acrobat PDF|
7 . 06-Mechanici Markup Acrobat PDF
rd ‘ 07-Electrical View 9/14,.'015 12:00:00 AM  Acrobat PDF
Check Qut
CheckIn
Free
Copy Out
Export...
o Select all subsets,
Stort Studio Sesson. right click and select
Export Dependency Mapi(s)...
DMSconform>PDF Check

Import Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy
Purge Workspace

Cut

Copy
Paste...

Copy To...

Move To...

Rename...

Delete

DMScenform

Moﬂy...

Modify Spatial Attributes...
Add Comment

-

PDF Check |)

Set 3
Send To 3
[P Copy List To >

Figure 65 - Selecting the Subsets and Running the Checker

4. Click OK on the dialog box shown below:
ContrelCAD Check Drawing & Attributes @

01 -General_CT_FDP_0032-0130.pdf
03-Highways_CT_FDP_0032-0130.pdf

04 Structures_CT_FDP_0032-0130.pdf
05-Traffic_CT_FDP_0032-0130.pdf
06-Tlumination_CT_FDP_0032-0130. pdf
07-Environmental_CT_FDP_0032-0130.pdf

TOTAL 6 PDFS

Co ) o ]

Figure 66 - PDF Checker
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5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The
PDF Checker may take a few minutes to process depending on the size of the files it is
checking.

ControlCAD EX

Report complete. Open in Excel?

Figure 67 - PDF Checker Report

6. Inthe report, errors will show up in red and if you hover over a red piece of text it will
show the details of what is incorrect. If any false errors show up in the report, please
notify DOT.AECApplications@ct.gov with the project and document(s) you are having
issues with. Example of false errors could be the page labels were applied to the subset
but the report details they were not.

611 - £ | incorrect

A | B c
CTDOT CONTRACT PLAN QA REPORT

0 E F G H J K L M N o P Q R s

1
2 01.0 - Projects - Active/0032-0130/100_Contract_Plans (PDF) T 1] I I T | | | T | | I ]
3 I “ormat Checks ProjectWise Attribute C|
4_Tabel [Document ame Wodiied Type Description NoPages Sheet S\xeflgﬂ:\ue Searchable Layers _Flattened lPige Labels [Engineers Stamp |Drscipi Cat [Sub Cat [ AssetLabel [Bridge No|Signal in|
5 07 General CT_FDP_0032.0130 pol 7172015 10.3 [pol_JGeneral Plans FOP____ 14 C CoN P |none_ ank___[bank__|
7 [03Fhghways CT_FOP 0032-0130 pdl 73072015 116 5 [pof Jrighway Pians FOP 7 c con none ) ani
8 04 Structures CT_FDP_0032-0130 pal 19.21 PM_[pal JStructural Plans FOP 134 C coN__|Fi [none lank__[blank |
9 105-Traffic_CT_FDP_0032-0130.pdf 5047 pdf |Traffic Plans FDP 1 C CON FDP [none lan blani
A CT_FDP_0032-0130 pdf /12/2015 12:17 4. M [pdf lllumination Plans FDP [Sheet Size must be 34°x22° C CON FDP [none lani blank |
CT_FDP_0032-0130.pdf |4/28/2015 12.4152 PM |pdf Plans FOP Olp1 i 36"x24", p2 I 36"x24", p3 i 36"X24", p4 s C CON P__|none ani [bian
367x24", p5 15 36™24" |
|

Report created by calkinsm] N
| ControlCAD version 3784 |
T .

| I I | | | I

PDF Format Checks

No.Pages Sheet Size Signature Searchable Layers Flattened Page Labels |En

4 Incorrect  |OK OK Not Found |OK 01.01-01.04 |Inco

57 Incorrect  JOK Incomplete |Not Found |Comments]03.01-03.57 [Inco
> 14 Incorrect  |OK oK OK Comments ]04.01-04.14 [OK

11 Incorrect  |OK OK Not Found |Comments ]05.01-05.11 |incol
P 8 Incorrect Sheet Size must be 34"x22" Incol
FDP [5 Incorrect 0l p1 is 36"x24", p2 is 36"x24", p3 is 36"x24", p4is p_|OK

36"x24", p5 is 36"x24"

—J

Figure 68 - PDF Checker Report

The Format Compliance attribute will also be set when the checker is run. It will return a PASS
or FAIL value as shown below:

a Lst | @ Geospatial|  pr—
Label (User Defined) Description Document Date (m... Application State Format_Compliance Ot to
,/m 01- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 02- Revisions Revisicn Sheet Acrobat PDF DOCUMENT TRANSF..§4 PASS
#[B) 03- Supporting Docume... Supporting Documents Plan Sheets Acrabat PDF DOCUMENT TRANSF.{ PASS
/a 04- Civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/E 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRANSF.§ PASS
/m 06- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 07- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRANSF..§4 PASS
/a 08- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 09- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/Q 10- Electrical Electrical Plan 5™~ tT TR DOCUMENT TRANSF..4 PASS
# B 11- Environmental Envirenmental | Format com pllance _—W FALL
# B CTDOT Highway STD  Highway Stand: : DOCUMENT TRANSF.| PASS
/a CTDOT Traffic_STD Traffic Standard Attri bute F DOCUMENT TRANSF..{ PASS

Figure 69 - Format Compliance Attribute

7. If there are no errors in the report and all document have PASS in the Format
Compliance attribute, this process is complete. If there are errors, the errors shall be
fixed and the checker rerun.
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3.2 Projectwise

CTDOT is currently using Bentley’s ProjectWise as a data management software for digital
projects. Projectwise allows the CTDOT, and authorized business partners to access its data
anywhere internet access is available. Projectwise shall be used by all consultant engineers
delivering digital contract documents. The following link is an introduction to CTDOT’s
Projectwise Site: Projectwise Presentation - April 2015

3.2.1 ProjectWise

Consultant engineers may use either Projectwise thin client or Projectwise Explorer Client (thick
client).

Thin client is a web based version of Projectwise, which does not require any software
installations. All that is required to login to the appropriate webpage is a user name and
password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet
access is available. To use Thin Client a few internet settings must be set the first time a user
logs in, see this document for setting up Thin Client for the first time: Thin Client First Time Set

Up

Thin Client Web Address: https://ctdot.projectwiseonline.com

The thick client conversely requires the installation of the Projectwise client software. In
addition to performing all the functions of thin client; thick client has the addition functionality:

- Deltafile transfer — Improves speed of downloads
- Managed workspaces — Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Users can get Projectwise thick client for free if they have an active license of Microstation.
Download Projectwise Explorer Client from Bentley using your select ID. Once Projectwise is

installed on your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client

Users can get to our Projectwise Datasource using the following various applications. The table
below lists the server URL for each application:

Applications URL
Projectwise ctdot-ws.projectwiseonline.com/pwmobileaccess
WorkSite https://Ctdot-ws.projectwiseonline.com/ws

The following workflow shows how to log in and change your password: Projectwise Log in

If you do not have a Projectwise User name and password fill out the following form:
ProjectWise New User Form

Consultant firms are usually given (2) user names that can be used by the whole firm. More
than one person can use the user name at a time. It is the firm’s responsibility to manage the
user name and password in cases where employees leave and work at another firm. This way
the employee that leaves cannot use their old company’s user name and password.
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3.2.2 Projectwise Folders for Contract Documents

This section gives directions on which folder contract documents will be submitted in
Projectwise.

If two or more projects are being combined into (1) project, all contract documents for these
projects will be submitted into the lowest numbered project in Projectwise.

100_Contract Plans (PDF) — This folder contains only final Contract Plan Discipline Subsets. This
includes all Final plans, Addendum plans, Design Initiated Change Order, As-Builts, and FIO
Plans. There shall not be any working documents uploaded into these folders.

110_Contract Documents (PDF) — This folder contains final signed Contract and other related
documents such as: SOM (Source of Materials), Insurance documents, DBE, Bonds, etc. This
folder also contains any revisions to the contract such as Change Order specifications.

120_Contractor Submittals (PDF) — This folder contains all working and shop drawings
submittals. There shall not be any working documents uploaded into these folders.

130_Engineering Reports and FIO Documents — This folder contains all the final engineering
reports and any FIO documents that are to be made available for the Contractor. There shall
not be any working documents uploaded into these folders.
e Hydraulic
O Hydraulic Report and Hydraulic Report Data
o Scour Report and Scour Report Data
o Floodway Report and Floodway Report Data
o Final Drainage Reports and Final Drainage Report Data
e Environmental Compliance
o Task 110
o Task 220
o Underground Storage Tank System Closure Reports
o Executed Agreements
= Sidewalk Maintenance Agreement
= Lighting Agreement
Proprietary Item Approval
o Standalone Transportation Management Plan Document, taken from the final
design report
e Bridge
O Rehabilitation Study Report
o Load Rating

o

140_Administration — This folder is for final correspondence such as agreements, letters,
memos, etc. and the design phase schedule.

e Design Phase Microsoft Project Schedule
e Sidewalk Maintenance Agreement
e Lighting Agreement

150_GIS — This folder contains the project polygon and parcel polygon files and their associated
kml files.

210_Construction Folders
e Construction Survey — This folder is still in development.
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e Office_Of_Construction — This folder is still in development.
220_FHWA - This folder is used for FHWA documents.
230_Contract Administration — This folder is used by CTDOT Contracts.

240_Contract Development — Designer shall submit the following supplemental contract
documents into this folder:

e All contract specifications and Notice to Contractors (NTC), in word format, both final
and addendum specifications
Proposal Estimate
Federal Estimate
Calendar Day Estimate
Final Design Report

e (Categorical Exclusion

e Design Approval Letter

e Environmental Permits

e DBE/SBE Approval with percentage

e Commitment list

e Agreements

e Proprietary Item Approval

e Standalone Transportation Management Plan Document, taken from the final design

report

310_Review_Documents — The designer shall submit all non-final design documents into this
folder. This includes plans, specifications, reports, estimates, Property Maps (pdf), etc.

320_Permit_Development — This folder is still in development.

330_Design_Data — Under this folder is a sub-folder for each discipline that is used for all their
design documents.

500_Pre_Design Folders
e 01_Planning — This folder is still in development.
e 02_Concepts — This folder is still in development.
e 03_Central_Surveys — This folder is still in development.
e 04_District_Surveys — This folder is still in development.
e 05_Property_Maps - CTDOT or Consultant Surveyors shall upload the following files into

this folder:
o Polygon ROW Parcel Microstation File (.dgn) for each affected parcel on a
project.

o Property Map (.dgn)
o Final Property Map (pdf)
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3.2.3 Uploading Documents - ProjectWise (Thin
Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in

Projectwise.
1. Once logged into Projectwise browse out to project and folder you need to upload into.
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.

2. Next select Document>Upload as shown below:

Advanced search options

@View Tools Help

o MNew..

No cont(‘ )

= ctdot. projectwiseonline.com:CTDOT

@:

= Documents

B 01.0 - Projects - Active

| +] a8 0001-0100

(1]

g 0001-0999
100_Contract_Plans (PDF)
110_Contract_Specifications_&_Permits (PDF)
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports

121 Engineerina Reports Confidential

Figure 70 - Uploading Document into Projectwise (Thin Client)

3. Next browse out to the document you want to upload.

No content available to display.

y /2 Choose File to Upload ==

Upload file OO0 o [ e oot |
(L) M Desktop + [ ¢ ][ Seorch Desktap )
e - Mew folder =~ A @

Name =
450 Favorites

~

Cancel
@ Creative Cloud Files % Pages from 03-Highways. CT_FDP_0043-0128.pdf )
P Desktop 3 I ETED T
i Downloads | Digital Project Develgpment.pdf
e - /% 76193 30 Model.dgn
Browse out to the & Projectwise Bridge Pildf.docx
&) Paper Plan Order Form CT Misc_.pdf
file to upload and [#) 2015-2-EC pef
. reportlog
click Open ] agreementsis
B Videos ) 2015-06-19_PW_Impor] Rail - Copyads
[T FEAE TR S
- 4 [ »
4

rojectWise Properties File name: Pages from 03-Highways_CT_FDP_0043- ~ |AlLils b

Figure 71 - Uploading a File to Projectwise
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4. After the file uploads, right click on the file and select Properties:

Folder Document View Tools Help

~

@ (3@ B =

H Label (User Defined) Description

il Pages fron
B View

Right Click on the

K-j' Download...
, file and select
¢ Export..
Properties
More...
Change State »

$ Copy Link(s) ]
_n Delete
v

ProjectWise Properties
No content available to display.

Figure 72 - Select Properties

5. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign

attributes, the interface was not selected as detailed in step 1 or this section.
ProjectWise Properties

¢
General Document References Audit Tra*! A
— Select these
Discipline P
cT = attrlbutes
Main Category Main Category Des |

con [=]

Sub Category Sub Category Description

-
0P {

Project Number{s)

D001-0933 | ( -
abel (User Defined) Document Date {(mm/dd/yyyy) *1'-—- Type in these
04 - Bridge [=] .
Descri?:tion ' { attrl butes
Eridge Plans | x *
-4
ESSOT fset Sage Select these
Bridge No(s) Building No(s) ) i
ooots B | asset attributes
Signal Intersections Route_No : .
[ = \ if necessary
Sign Structures

= ( v

Click Save J-—*

Figure 73 - Thin Client Attributes
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3.2.4 Uploading Documents - Projectwise (Thick
Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not
shown go to View>Toolbars and select interface.
2. Dragand Drop files into the correct folder in the Project.

G- B D E hiEE @
Address pw:\\ctdot. projectwiseonline, com: CTDOT\Documents\01 - CTDOT Projects\0310_00621100_Contrget_Plans (PDF)Y
= | ¥ ConnDOT (mjc-admin) ~ List | @ Geospatial

=" Documents

5 [ 01- CTDOT Projects Label {User Defined)

(%% 0015_0335 ,/’EDI.DI-GEnera\

L_?c 0017 0183 /" /- 01.02-Revisions

% 0034_0334 # "2 01.03-5tation_Plans

[* 0040_0136 A" 01,04Environmental .

(1% 0036_0309 ZTorosamirak Force (1) MaKe sure the interface
[* 0063_0543 & 0093_0180 # T coT_tighway SO j§ "CTDOT Doc Code"

1% 0o63_08672 # ") CTDOT Traffic_STD - -

L% 0079_0230

[ 0082_0299

% 0084_0106

[/ 0083_0178 & 0093_0166

[ 0092_0531-0622-0627

[** 0092_n532

| 0092_0813

| oo92_os34

|/ 0092_0833

[ 0107 o158 | (2) Select Project folder and

@[ 0108_0178

B 010 then 100_Contract Plans

L™= 0110_0129 e

(" 0138_0221 folder

% 0138_0232

[ 01500125

[ 0152_0148

[ 0158 _0207

[ 0166_009%

%% 0170_2298

|/ 0300_0138

|/ 0301_0059

[%* 0301_0106 (3) Drag and drop discipline
]

| 0301_0125 SUbSEtS

|/ 0301_0140

{1 0310_o038

|/ 0310_0056

% 0310_0057

[ 0310_0058

1% 0310_0058

" 0310 0060

= 0310 006

| 100_Contract_Plans (PDF)
K-

e

110_Contract_Spedifications (PDF)
120_Contractor_Submittals {PDF)
130_Soil_Archaeological_Misc_Reports (PDF)
210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Preliminary_Design_Documents{PDF)
320_Permit_Applications £
330_Design_Data

=3}

HHHHHHTEHTE

=

Figure 74 - Uploading Into Projectwise (Thick Client)
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3. Select the “Advanced Wizard”

4. Click “Next” until you reach the figure below:

5. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign
attributes, the interface was not selected as detailed in step 1 or this section.

Advanced Document Creation Wizard x|
Define Document Attributes »
“rou should define environment specific document attributes. £ Al
Pl

Discipline

= - | ¢——————— Select these

Main Category Main Categary Description attributes
ICDN j ICDnlract Plans & Specs
Sub Category Sub Category Description

|F'Ians_02 - Final Design Plans

Project Mumber{s)
| 0004-0116_0004-0118

L;b;l (UTer Defined) Type in these
Description attrlbutes

Title Sheet and Detailed Estimate Sheets

CT Code (Auto Fill In;
|CT_CON_FDP_0004-0116_0004-0118_01-General

CTDOT Asset Tags
Bridges Sign Structures

| 01456; 01654 J [20010:20156 J

&+ Select the correct
asset tags

Signal Intersections

I [

Click Next

e
< Back ‘l Mext D ancel |
T —

Figure 75 - Attributing (Thick Client)

6. Onthe Document Properties page nothing needs to be edited.

7. Onthe create document page click next and the document will be uploaded into
Projectwise.

8. Once the document is uploaded the user may need to click F5 (refresh) to see the file
name update.
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3.2.5 Combining and Uploading Contract
Specifications and CSI Special Provisions

For projects that are led by a consultant designer, FDP and Addendum Contract specifications
and CSI Special Provisions shall be placed in (1) zipped folder. For projects that are led by a
CTDOT design unit, FDP and Addendum Contract specifications and CSI Special Provisions shall
be placed in individual zipped folders per discipline.

Addendum specifications shall be placed in (1) zipped folder and submitted into the 240
Contract Development Folder. Each page of the specification section shall be marked in the
bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum
number. Also a line shall be placed on the right side indicating where language was changed in
the specification.

Design Initiated Change Orders specifications shall be placed in (1) PDF document and uploaded
into the 110_Contract Documents folder. Each page of the specification shall have a “C#” and

the date in the bottom right corner of the footer. An example would be, “C1 - 01/01/13”. Also a
line shall be placed on the right side indicating where language was changed in the specification.

The following shows an example of a consultant designed project, but the process shall also be
followed for a CTDOT designed project.

See the figures below for how to zip a folder:
1. Place all specifications (word documents) in one folder.
2. Right click on the folder and select “Compress to” option shown below:

Open
Browse With Paint Shop Pro 7
Command Prompt Here
Explore
Search...

& Snaglt

1 Combine supported files in Acrobat...
ClipPath

Scan for Viruses. .,

1 _ompre = = Sphe
1C0 Compress to "310-056-57_FDP_SPecs.zip"
—————

Send To

Cut
Copy

Create Shorteut
Delete
Rename

[~ Properties

310-056-57_F
DP_SPecs

Figure 76 - Compress Spec. Folder

Specifications shall be submitted in a zipped folder for every submittal into Projectwise.
Submittals include FDP, revised FDP specifications, Addendum specifications, and revised
addendum specifications. Revised FDP and addendum submissions shall only include the revised
specifications.
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Submitting Contract Specifications
Once logged into Projectwise the final contract specifications shall be submitted as follows:
1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Dragand Drop the zipped specifications folder into the 240_Contract Development
Folder or the pdf of the change order specs into the 110 _Contract Specifications folder.
6. Use the advanced wizard and then assign the applicable attributes from the tables in
Appendix E: If you cannot assign attributes, the interface was not selected as detailed in
step 1 or this section.
3. Click next until the document is uploaded. The document name and file name will be
automatically updated to match the CTCode when Projectwise is refreshed.

3.2.6 Uploading Supplemental Contract Documents

Once logged into Projectwise, the Final Design Supplemental Contract Documents shall be
submitted and attributed into the 140 Project Administration or 240_Contract Development
folder as follows:

Document Folder

Proposal Estimate, with signed checklist 240
Federal Estimate 240
Calendar Day Estimate 240
Final Design Report 240
Categorical Exclusion 240
Design Approval Letter 240
DBE/SBE Approval with percentage 240
Commitment list 240
Executed Agreements 140

e Sidewalk Maintenance Agreement

o Lighting Agreement
Proprietary Item Approval 240
Standalone Transportation Management Plan 240
Document, taken from the final design report

1. Make sure the Interface “CTDOT_Doc_Code” is selected.

2. Dragand Drop the document into the 140_Project_Administration or 240_Contract
Development Folder.

7. Use the advanced wizard and then assign the applicable attributes from the tables in
Appendix E: If you cannot assign attributes, the interface was not selected as detailed in
step 1 or this section. All agreements must have the applicable asset tags filled out.

3. Click next until the document is uploaded. The document name and file name will be
automatically updated to match the CTCode when Projectwise is refreshed.

Revised Document

For documents uploaded into the 240_Contract Development folder, if a document needs to be
revised, a new revised document shall be uploaded into projectwise with the addition of
“Revised” being included in the Label.

For documents uploaded into the 140_Project Administration folder, if a document needs to be
revised, the old document shall be deleted and a new document shall be uploaded. Do not
include revised in the label. Contact AEC Applications to delete the file:
DOT.AECApplications@ct.gov.
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3.2.7 CTDOT Contracts Finalizing of Contract
Specifications

CTDOT Contracts shall finalize the specifications working in the 110_Contracts_Specifications
Folder following this workflow CTDOT Contracts Workflow.

3.2.8 Notification of Submittals

When Contract Plans, Specifications, and supplemental contract documents are submitted into
Projectwise the applicable personnel must be notified as follows as applicable:

1.

For consultant designed projects, the consultant will notify their Liaison Engineer, who
will then notify, by memorandum, processing that contract plans or specifications have
been submitted for review.

For state design projects, the project manager will notify, by memorandum, processing
that contract plans and specifications have been submitted.

3.2.9 Contract Plans Workflow (FDP - Advertise)

Table 3-3 below shows how final digital design plans (FDP) flow from delivery through
processing to their final state in advertising.
Processing personnel shall use the following workflow: Projectwise for Processing

Final Design Submission (Subsets)

Step Group Responsibilities of Group
1 Designer | -Submits FDP subsets into the 100_Contract Plans folder 2 weeks prior to FDP.
2 Project -Changes FDP subsets to the LEAD DESIGNER State. This will lock the documents so the project lead can review the
Lead subsets prior to FDP.
Processing . . .
(CTDOT) - Change FDP subsets to the Processing State and digitally mark up with comments and save FDP plans. Keep FDP

Plans in the Processing State. If there are no comments proceed to step 7.

2
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.
- Change subsets to reflect comments made by Processing

3 Designer
- Submits DCD subsets

) - Change DCD subsets to Processing state
Processing
(CTDOT) | - perform a document compare on the FDP and DCD plans using Bluebeam.

& - Digitally markup DCD subsets with comments and save. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.
- Change subsets to reflect comments made by Processing on DCD Plans

5 Designer

- Submits DCD2 subsets
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- Changes DCD2 subsets to Processing state
Processing

(CTDOT) | - Perform a document compare on the DCD and DCD2 plans using Bluebeam.

- Digitally markup DCD2 subsets with comments. [f there are no comments proceed to step 7.

- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.

- Change the Sub Category Attribute of the approved subset from FDP or DCD(1,2..etc.) plans to FPL plans. STD and
Processing | FIO plans shall not be change to FPL.

(CTDOT)
- Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a “.pdf” on the
end.

-If is a CTDOT Design project, change all discipline subsets to the Manager and Engineering Admin. Sign State. Notify
Designer they have to have Manager and Engineering Admin sign the title sheet. When the Designer notifies processing
these signatures have been applied to the title sheet, change all discipline subsets to the Advertise state.

-If is a Consultant Designed Project, change discipline subsets to Advertise State.

-Delete all previous versions of plans, FDP, DCD, DCD2, etc.

-Keep Comment reports in the 240_Contract_Development folder for records if necessary

-Formally notify Contracts when all subset have been approved for Advertising

Table 3-1 Workflow for CTDOT Processing Unit (Contract Drawings)

3.2.10 ProjectWise Project folder Security

Through the use of Workflows and States, Projectwise can provide dynamic securities to a folder
or document. Dynamic security allows a different level of security to each document at various
phases of its life cycle. This allows a document to reside in one location, in Projectwise,
throughout the project life cycle.

3.2.11 100_Contract_Plans (PDF) Folder
(Dynamic Security)

During the design submittal process the Projectwise workflow, “Contract Plans Processing”, shall
be applied to this folder. This workflow allows three different states (securities settings) to be
applied to documents within this folder. Each state provides a unique security. The CTDOT
Contracts Processing Unit shall determine which state a document in this folder shall be in.

The “Contract Plans Processing” workflow contains the following security states:

Document Transfer State — allows either the Consultant or State Designer to upload, read and
alter a document.

Lead Designer State — Allows the project lead to lock the documents so they can review the
project discipline subsets prior to FDP.

Processing State — Allows only the processing unit read, write access, allowing them to review
the documents in a secluded area. All other users shall have read access.

Manager and Engineering Admin. Sign — Allows the Manager and Engineering Administrator to
sign the project Title sheet.

Advertise State - Allows all users file read access, allowing any user to open and read the
document.
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Once the contract is awarded to the low bidder (Contractor), the documents will move into a
new workflow called “Contract Plans Construction” which hands control of the documents to
the CTDOT Office of Construction (all offices).

The “Contract Plans Construction” workflow contains the following security states:

Construction State — allows construction to upload, read and alter a document. All other users
shall only have file read.

Perform As-Built — allows construction to place as-built information on the plans. All other
users shall only have file read.

As-Built Complete - All users will have read only when the documents are put in this state.

3.2.12 Changing the State of a Document

The designer and district construction will be required to change the state of documents for
contractor submittals during the review process. To change the state of a document, follow the
figure below:
1. Right click on the document that you want to change the state of, then select change
state>change, as shown below:

Wise Explorer Vi1 series 4
+ Folder Document Yiew Tools ‘Window Help
2 5; Op 25 - ” @ © 44 - search|[D - D Interface CTDOT Doc_Code | : View| Document
a pw:i\ctdot.projectwiseonline.com:CTDOT\Documents'01.0 - Projects - Active'0085-01414100_Contract_Plans (F ¥ D Go
- B
" oos7-o117 -~ Description

|/ ooss-0325 3
|[* nose-0157
/" ooe0-0151 -

03-H
%8 0063-0601 & 0063-0674 /g Open
% ooes-nez1 043 Open as Read-Only =

L4
et

" 0063-0837 ZBosk openwith...

" 0063-0639 ZBosaf markup Plan

" 0063-0841 2 0063-0671 /a <TDg Vig | 0085-0141_CTDOT_Highway_STD
{78 0063-0643 & 0093-0180 #Bemd FIC_STD

Check Cut

Right Click on e
a document and ot
select "Change State’
then "Change

' Start Studio Session,..

" oos1-0088 Refresh Local Copy
[% oo@1-0091 Purge Local Copy
|78 oogz-0299 Purge ‘Workspace
[ o0a3-0253 o
£ ooss-0141 " Y
[ 100_Cantract_Plans (FOF) Copy
L 110_Contract_Specifications (POF) Drocument Pr Phato Preview | Dependency Service | Access Control | Cor
L 120_Contrackor_Submittals (POF) = Copy Tou..
= 130_Soil_Archaeological_Misc_Reparts (PDF GENERALl  Move To...
L= 210_Construction Rename...
[ 220_PHWA GEMERAL| i
L= 230_Contrack_Administration GENERAL ee.e
[ 240_Contract_Development GEMERAL MOd!Fy"' i .
L= 241 _Contrack_Development_Confidential GEMERAL Madify Spatial Attriutes. .
L 310_Prefiminary_Design_Documents(PDF) GEMERAL Add Cornent
L= 320_Permic_applications GEMERSLE set »
W 399 Posion Dt ASSETSi send To ,
e _Admininstation f
L 341 _Confidential_Administration igggg COD.Y Lt To :
|0 500_Pre_Design .
7% noes-0142 Desian - P4 gatch print
% oogs-0177 Design - Pt
[*% 0088-0178 & 0093-0166 Design- Py "roperties.. et Final Stabus
L% Doss-on25 Design-P1 Change filename to CT_Code
| oogg-0126 Desin- [t
L," 0092-0522 Design - FU Edit attributes For multiple documents
I_'Pﬁ 0092-0531 & 0092-0622 & 0092-0627 an
(%% 0os-0532 Design - DCD (Core Constr DED)
" 0092-0541 Design - ADV [Care Constr ADY)
(%% D09z-0549 Design - Digitally Signed

Figure 77 - Changing the State
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2. Next drag the file(s) from one state to another as shown below:

= Change Workflow State

Change state

Folder

“arkFlow

Documents in States

MName: 100_Contract_Plans {PDF)
Description:  FDP,DCD,FP Addenda, and Construction Order Plans

Name; Contract Plans - Conskruction

Description:  Dynamic Security {Post Award of Conkrack)

= 5, Contract Plans - Construction

BB

&5 PERFORM AS_BUILT
& AS_BUILT COMPLETE

Select a file or all
the files and drag

[« ]

them to the desired

state

Close

Figure 78 - Changing the State

3. Click OK when the comment window opens up and the documents state will change.

Next close the change workflow state window.

4. Notice the “State” column, the state of the documents has been changed.

#+/ | Label (User Defined) Description
01 _Genersl 01_General
# Bloz_revsions Revisions Subset
/ Bloz-Highway 03-Highway
/ Bloa _structures Structusl Subset
# Blos_Trafic 0S-TRAFFIC
/ Blos_tet_Fio ATET_Lity_Plan
7 B cTooT_Highway_sTD CT_CON_STD_0085-0141_CTDOT_Highway_STD

# Bl cTooT_TRAFFIC_STD CTDOT_TRAFFIC_STD

Main Category | Sub Category

ON
con
CON
on
con
CON
on
con

FOP
FOP
FOP
FOP
FOP
FIO
s
S0

Sub Categary Description
Flans_02 - Final Design Flans
Plans_02 - Final Design Plans
Plans_012 - Final Design Plans
Flans_012 - Final Design Flans
Plans_02 - Final Design Plans
Plans_11 - For Info. Orly Divg.
Flans_10 - Standard Drawings
Plans_10 - Standard Drawings

Figure 79 - State has been changed

3.2.13 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract

plans and specifications for DOT Projects. This form is located in each project in Projectwise and
each unit in the Department that needs paper copies of contract plans and specifications is
required to update this form for their paper needs. This form is then used by the Department’s
Engineering Records unit to make the prints and send them out.

Appiication

Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrabat POF
Acrobat PDF
Acrobat PDF
Acrabat POF

State
PERFORM AS_BLILT
PERFORM AS_BLILT
PERFORM AS_BLILT
PERFORM AS_BLILT

PERFORM AS_BUILT
PERFORM AS_BLILT
PERFORM AS_BLILT
PERFORM AS_BUILT

File Size
925 KB
339 KB
1,448 KB
1,559 KB
1,620K8

218K
2,012 K
3,394 KB

Any Addendum or Change Order that is submitted for a project will be printed and sent out
using the information indicated on the form. Addendums will be printed and sent out
automatically. When a Change Order is submitted, the designer must notify Engineering records
that a Change Order has been submitted and that paper copies of the Change Order need to
printed and sent to the applicable units indicated on the Paper Plan Order Form.
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This following shows the procedure for how the Paper Plan Order Form is filled out and the
prints are made.

Contact Information for Engineering Records:

Print Shop: 860-594-3086 Plan and Specification Printing

Step

Project

Stage/Submittals

Group

Action

FDP

Processing

After the contract plans and specifications have
been submitted for FDP an email is sent to each
unit in the Department that requires paper copies
of contract plans and specifications.

FDP

Units

Open the Paper Plan Order Form from Projectwise
and fill out the form for their unit’s needs. Save
the form and check the form back into
Projectwise.

DCD

Processing

At DCD, lock the form by placing it in the
Processing state.

Advertise

Contracts

Notify Engineering Records that the project is
going to be advertised and they can print the
required paper copies indicated on the Paper Plan
Order Form.

Advertise

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form.

All Addendums

Contracts

Notify Engineering Records that an Addendum is
going to be advertised and they can print the
required paper copies indicated on the Paper Plan
Order Form for this Addendum. Make sure to tell
Engineering Records which subsets are included in
the Addendum.

All Addendums

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form for the Addendum. Make
sure to print all the subset that were affected by
the Addendum including the 02-Revisions subset.

All Change
Orders

Lead Designer

Notify Engineering Records that a Change Order
has been submitted and they can print the
required paper copies indicated on the Paper Plan
Order Form. Make sure to tell Engineering
Records which subsets are included in the Change
Order. If a unit is not listed on the Paper Plan
Order Form, give Engineer Records those units’
contact information so those units’ can receive a
copy of the Change Order.

All Change
Orders

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form for the Change Order and
for any other units’ requested by the Lead
Designer. Make sure to print all the subsets that
were affected by the Change Order including the
02-Revisions subset.
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Section 4 Contract Plan and Specification
Revisions (Addenda and Design Initiated
Change Order)

4.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed
PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall
be digitally signed in a digital signature place holder, that is placed in Microstation as described
in Section 2.0 of this manual, DO NOT ADD an index of drawings sheet. Once digitally signed,
the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section
3.0 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they
must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise
(See Section 3.0): The addenda subset shall have the same Projectwise label as the original final
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda
number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See
example below:

PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

Addenda Discipline Subset: 04-Traffic_A01
2nd Addenda 04-Traffic_A02
6th Addenda 04-Traffic_A06

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by
addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on
the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum
number. This stamp is placed over digital signatures therefore; removal of the signatures is not
required prior to placing the addenda stamp. For this process see Section 4.4.

WARNING — When placing the stamps, removing the digital signature is not allowed.
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the
project manager for all addenda, and submitted as described in_Section 4.3.1. A new subset

must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants)
shall be placed on all added or revised sheets. See Section 2.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent
to all applicable units following section 3.2.13.
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4.1.1 Revised Plans - Addenda

Microstation Processes

A note shall be placed, directly above the bottom right hand corner of the title block, on the
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number. This
note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed within this clouded area. A like numbered triangle shall be placed in the revision block of
the changed sheet, accompanied by a description of the revision itself. The revision number is
specific to a particular sheet, and increases in consecutive order per revision and per addenda. If
a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is
changed again under addenda 7 the revision number becomes 2.

Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a
clear manner, do not void out the existing sheet and create a new sheet. In these instances,
the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate
Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General
Plan sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

Original: 02.25
Addenda 1: 02.25.A1
Previous Addenda Sheet;

Original: 02.25.A2
Addenda 4: 02.25.A4

If a sheet requires further revisions by a subsequent addendum, the addendum shall be
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam
after addendum approval, see Section 4.4.

4.1.2 New Sheets - Addenda

Microstation Processes
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline
subset, the new sheet shall be placed last, and numbered sequentially from the last
sheet of the discipline subset. The total number of sheets noted on the project plans
and discipline subsets stays the same. A note shall be placed on the new sheet stating,
"NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.
This note shall be located directly above the right hand corner of the title block. This
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note is a level in Microstation that needs to be turned on and edited. The revision block
on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the
discipline subset, the new sheet number shall be the number of the previous sheet
followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be
02.57-2.A1. The total number of sheets noted on the project plans stays the same. A
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM
NO."Y", where "Y" equals the addendum number. This note shall be located directly
above the right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet
number the drawing number of the new sheet shall be the drawing number of the
previous sheet plus a decimal and the sheet count. For example, if the new drawing
must be placed in the project plans right after drawing number S-5, the drawing number
shall be S-5-1.

Bluebeam Processes
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31
Addenda 3: 04.32.A3
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4.1.3 Adding New Subset - Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed,
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in
Microstation that needs to be turned on and edited. The label attribute on the new subset shall
contain an “_A##". The first sheet of a new subset to the contract will be a subset cover sheet
and contain an index of drawings.

4.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted,;
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED

BY ADDENDUM NO.”Y"; where "Y" equals the addendum number. See Section 4.4

4.1.5 Addenda Plans Workflow

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings below shows how
addenda subsets are delivered and processed for advertisement.

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings

Addendum Plans

Step Group Responsibilities of Group
1 Designer | -Submits ADP subsets into the 100_Contract Plans folder.
Processing . . . n
(CTDOT) - Changes document to the Processing State and digitally mark up with comments and save. Keep ADP Plans in the
Processing State. If there are no comments proceed to step 7.
2
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.
- Change subsets to reflect comments made by Processing
3 Designer
- Submits ACD Subsets
Processing | - Changes ACD subsets to Processing state
(ereens) - Perform a document compare on the ADP and ACD plans using Bluebeam.
& - Digitally markup ACD subsets with comments. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.
- Change subsets to reflect comments made by Processing on ACD Plans
5 Designer
- Submits ACD2 Subsets.
- Change ACD2 Subsets to Processing state
Processing
(CTDOT) | - Perform a document compare on the ACD and ACD2 plans using Bluebeam.
g - Digitally markup ACD2 subsets with comments. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.
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Processing

- Change the Sub Category Attribute of the approved subset from ACD(1,2..etc.) plans to ADP plans

(CTDOT) - Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a “.pdf” on the

end.

- Change discipline subsets to the Advertise State.

-Delete all previous versions of plans, ADP, ACD, ACD2, etc.

-Keep Comment reports in 240_Contract_Development folder for records if necessary
- Formally notify Contracts when all subset have been approved for Advertising

- Notify the designer that the plans are going to be advertised and they can put the addenda stamps on the affected
sheets.

4.1.6 Addenda Specifications

Contract Specifications that are revised or added due to addenda shall be submitted digitally in
accordance with section 3.2.5.

4.1.7 Addenda Report

Addenda report shall contain all the changes to the plans and specifications and any contractor
guestions and answers. This report shall be submitted in Word format into the
240 _Contract_Development in Projectwise with the following attributes:

Discipline = CT

Main Category = DOC

Sub Category = RPT

Label = “Addn. No. # Report”, where # is the addendum number. If a report is revised the label
shall include “Rev.” at the end. If the report is revised a second time the label shall include “Rev.
2” at the end, etc.

Description = Give a brief description of the submission.

4.1.8 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance
with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow section 1.8 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.
4.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the
original contract by:

e Arevision to an existing plan sheet(s) or specification(s)

e The addition of a new plan sheet(s) or specification(s)

e The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.
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Contract plans changed or added due to DCOQO’s shall be submitted in a digitally signed PDF
discipline subset(s) containing only the added or changed sheets. The sheets being revised or
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset
shall be digitally signed in a digital signature place holder, that is placed in Microstation as
described in Section 2.0 of this manual, DO NOT ADD a cover sheet. Once digitally signed the
DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 3.2 of
this manual.

DCO sheets from different subsets cannot be combined and submitted as one subset.
The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See
Section 3.0): The DCO subset shall have the same Label Attribute as the original final plan subset

with the addition of (_C###) added to the end, where the ### equals the DCO number. The sub-
category attribute shall be DCO (Design Initiated Change Order) See Examples below:

PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

DCO Discipline Subset: 04-Traffic_C001
6th DCO 04-Traffic_C006
Original Addenda Subset: 04-Traffic_A03
DCO Discipline Subset: 04-Traffic_C001
3" DCo 04-Traffic_C003

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being
revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on
the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet
with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITATED CHANGE
ORDER NO."Y" —-mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This
stamp is placed over digital signatures therefore; removal of the signatures is not required prior
to placing stamp. For this process see Section 4.4

WARNING — When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the
project manager for all DCO, and submitted as described in Section 4.3.2.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants)
shall be placed on all DCO sheets. See Section 2.2

Paper copies for all change orders will be requested and sent to all applicable units’ following
section 3.2.13.
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4.2.1 Revised Sheets - DCO

Microstation Processes

A note shall be placed, directly above the right hand corner of the title block, on the
replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y”
equals the Design Initiated Change Order number. This note is a level in Microstation that needs
to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed within this clouded area. A like numbered triangle shall be placed in the revision block of
the changed sheet, accompanied by a description of the revision itself. The revision number is
specific to a particular sheet, and increases in consecutive order per revision and per change to
the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1
revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Details shown on the original PDF, but no longer required, shall not be deleted on the revised
PDF, but shall be crossed out. Any details to be deleted shall be crossed out with an “X” on the
revised sheet. Engineering judgment must be used to produce clear and concise information
for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the
existing sheet should be voided in accordance with Section 4.2.4 and a new DCO sheet created
in accordance with Section 4.2.2

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:

Original Final Plan Sheet;
Original: 02.25
DCO 1: 02.25.C1
Previous Addenda Sheet;
Original: 02.25.A2
DCO 4: 02.25.C4
Previous DCO Sheet;
Original: 02.25.C2
DCO 4: 02.25.C4
Drawing numbers shall not be modified on revised sheets.
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp

(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section
2 of this document.
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4.2.2 New Sheets — DCO

Microstation Processes
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline
subset, the new sheet shall be numbered sequentially from the last sheet of the
discipline subset. The total number of sheets noted on the project plans and discipline
subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy” where “mm/dd/yy”
equals the month, day and year the change order request was submitted. This note
shall be located directly above the title block. This note is a level in Microstation that
needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a
discipline subset, the new sheet number shall be the number of the sheet it most closely
relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet
shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE
ORDER NO. Y — mm/dd/yy” where “mm/dd/yy” equals the month, day and year the
change order request was submitted. This note shall be located directly above the
bottom right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number
of the new sheet shall be the drawing number of the sheet it most closely relates to
followed by (-#). For example, if the new drawing must be placed in the project plans
right after drawing number HWY-10, the drawing number shall be HWY-10-1.

Bluebeam Processes
Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
Original: 04.31
DCO 3: 04.31-1.C3

Previous Addenda — Added Sheet;
Original: 03.24.A1
DCO 4: 03.24-1.C4

Previous DCO — Revised Sheet;
Original: 02.45.C1
DCO 2: 02.45.C2

Previous Addenda - Added Sheet;
Original: 05.14-1A1
DCO 2: 05.14-2.C2

Previous DCO — Added Sheet;
Original: 02.45-1.C1
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DCO 2: 02.45-2.C2
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus C#., where # equals the Design Initiated Change Order Request
number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4

4.2.3 New Subset - DCO

The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline
subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly
above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y” equals the Design
Initiated Change Order number. This note is a level in Microstation that needs to be turned on
and edited. The label attribute shall contain “_C##”. The first sheet of a new subset to the
contract will be a subset cover sheet and contain an index of drawings.

4.2.4 Voided Sheets

Sheets submitted within final design plan subsets, addenda subsets, or design initiated change
order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO
stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a
red X and adds the following note; "VOIDED BY DESIGN INTIATED CHANGE ORDER NO. Y —
mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 4.4

4.2.5 DCO Specifications

Specifications shall be created in accordance with the Departments policies and procedures for
Contract Development. The Engineer shall also combine all specifications into (1) PDF document
and upload that into the 110_Contract Specifications (PDF) folder in Projectwise following
section 3.2.5.

4.2.6 DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the
following.

The DCO for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow section 1.8 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

4.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded
from these links:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE Subset
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Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions
Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP)
and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions
subset starts out as an un-signed blank place holder in the project. The figure below is an
example of a blank 02-Revisions subset:

DESCRIPTION BY ’R_:: SHEET No. | DATE

HEE IREV] DATE |23
HEE DESCRIPTION 8 [yo | SHEET Mo | 205, |T

IREV. DATE
i |22 | B Ho.

No.| SHEET No.

REV
DEL]

=
g DESCRIFTION BY

REV
DEL

T REHABILITATION OF - TOLLAND 142-148
STATE OF CONNECTICUT @ OFFICE OF ENGINEERING T
"& . = e evr
DEPARTMENT OF TATION ROUTE 74 OVER 1-84 REVISIONS SHEET —
02.01

Figure 80 - Blank 02-Revisions Subsets
ADDENDA:

When the project requires an Addendum, the Project Manager must record these changes on a
NEW 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets
shall contain all previous Addendum information. For example, Addendum 4 shall include all
changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when
multiple addendums are being submitted to processing for the same project. An example of this
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two
addendum revision sheets must be submitted.

DESIGN INITIATED CHANGE ORDER:

When a project requires a Design Initiated Change Order (DCO), the following process shall be
followed:

For each DCO, the Project Manager shall AMMEND the 02-Revisions subset. The 02-Revision
subset shall always contain all previous Addendum information and the new DCO information.
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum
information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to
Addendum #3:
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' STARTFORD/MILFORD 138-221

REV-1

Figure 81 - Index of Revisions Sheet

Detail A from figure 1 shows the information typed in for a change to the contract plans. The
project designer inputs the Addendum or DCO number, the sheet number, the date, a

description of the change, the person who made the change, and checks the appropriate box
for: new sheet added, revised sheet or deleted sheet.

Detail B from figure 1 shows th
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Figure 82 - Detail A
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4.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project
Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their
local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:

s
PROJECT 1

/ BPCT VT 1T 7 7 =
S Clear Signature [% b
i Validate Signaturs
4

L View Signed Yersion

Compare Signed Ysrsion to Current Yarsion

Show Signature Eroperties. ..

Legal Notice. ..

RB-01.dgn
in €

Figure 84 Clearing the Digital Signature

3. Enter the information into form fields as described in section 4.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the
title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow section
4.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 2.6.2
7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A##

9. Make the document description 02-Revisions_A##.

4.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to
export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:
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s
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Figure 85 Clearing the Digital Signature

3. Enter the information into form fields as described in section 4.3.4.

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y -
mm/dd/yy”

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy”

6. Resign the 02-Revision subset in accordance with Section 2.6.2

7. Instep 7 “Check In” the document into Projectwise

4.3.3 Adding a New Revisions Sheet to the
02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 1.4 step 16.
2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block
information and update the sheet accordingly.

4.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the
Addendum or Design Initiated Change Order. The second column is the revised or new sheet
number. The third column is the date, followed by a brief description that is similar to the
description on the actual sheet being revised. Finally click in the appropriate check box per row
to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is
not required to input changes numerically by Sheet No. If another changed sheet is added to an
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of
Revisions Subset”.
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REV. DATE |2 |> |4 R
No.| SHEET No. | gons @@ @ DESCRIPTION BY [\
Addenda a1\ 02.06.00341 01/01/11 ¥ REMOVED DETAIL MIC
\‘ A1l ||03.05.00141 01/01/11 v J|DELETED sHEET MIC
A2 foa.05.00342 oy20/11 | | v | AlBEARING DETAILS MIC
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| c2 Jo3.04.055-1c2 03/02/11 e ALL 101 DETAILS MIC
< -
Design Initiated \ Deleted Sheet
Change Order \ Revised Sheet
New sheet

Figure 86 Modifying the “Index of Revisions Subset”

4.4 Placing Stamps on Affected Sheets - Revised, or
Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or
in Markup>Stamps as shown below:

Markup Measure Window Help

William Pratt.pdf
— JND A |HIBIL
01-Addendum_and_Change_Order.pdf [
v

END STATE PROJ. NO|

BEGIN STATE PROJ. NO.092-612 STA. 75400 {sB),
FAP NO. 0911(123)

STA. 67+00 (SB), STA. 63+00 (NB)
L ND OVERLAY

,,,,,

The Addendum and
* Change Order Stamp ~
= can be found -
in both places —

sy

Figure 87 - Addendum and Change Order Stamp
If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User

Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see
Appendix A — Bluebeam Stamps

WARNING — When placing the stamps, removing the digital signature is not allowed.
Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and
as built notes. These notes should be used in conjunction with the cross-out stamp.

The following shows how to apply the stamp to the sheet that needs to be crossed out for an

Addendum or Change Order.
1. Select the stamp from the Tool chest or Markup>Stamps and place it:
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Markup | Measure  Window  Help

RN -

Lires .
William Pratt.pdf

LY / m— 7.@ Aa \E E|1\
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; v %/

| &
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~ Recert Tools

BEGIN STATE PROJ. NO.092-612 STA. 75400 (SB), STA. 734
FAP NO. 0911(123)

STA.

i

y END STATE PROJ. NO.
e Si FAP_NO. 0!
| SB), STA. 63+00 (NB)
AND QVERLAY

can be found
= jn both places

e Lbo
T ES = L

Figure 88 - Addendum and Change Order Stamp

2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1
below in all caps as shown below:

- A SRR gy SRR - AR SR TR s
Add. or CO Note ==
Enter Mote: - ﬁ
= -
A L

| oK || Cancel |

T TILDo® THICTLAT Lorar LIME,

ASTIY ESIGSE WO, 0T 1. SUVEY BY DISTRICT L SUMVEFS
FeLm iy 2 Al FOOT GAID RASED: DR HAD R0

Figure 89 - Enter Note for Addendum and Change Order Stamp

Table 4-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts

Addendum Notes Description of Use

THIS SHEET REPLACED BY ADDENDUM NO. Y | The revised sheet is considered to replace, in
total, the original sheet.

VOIDED BY ADDENDUM NO. Y Sheet is voided by Addendum.
Design Initiated Change Order Notes Description of Use
THIS SHEET REPLACED BY DESIGN INITIATED | Used for revisions to existing sheets. Changes
CHANGE ORDER NO. Y - mm/dd/yy must be noted only on the revised sheet.
VOIDED BY DESIGN INITIATED CHANGE Use this for voiding of existing sheets.
ORDER NO. Y - mm/dd/yy
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3. The following shows a completed stamp.

GENERAL NOTES LIST OF DRAWINGS

TROT Plan_Stamp.pdf

Text input through
dialog box

REPLACED BY ADDENDUM NO. 1

-& @ REPLACEMENT OF BRIDGE 93-166
OFFICE OF ENGINEERING NEWINGTON 931t
TET OF TRANSPORTA . o NO, 04324 (ROUTE 175 OVER e Sm2

DEFARTMENT OF TRANSPORTATION —
M= ABANDONED RATL ROAD) GENERAL PLAN -1 0102

Figure 90 Typical Sheet Replaced by Addendum 1

AN WIONJOLC LA

'ANS 10 & 11.

AND DISPOSE EXISTING B!
iCK, DECK JOINTS AND STEEL

[E AND ERECT NEW STEEL ROADWAY
INTS, CONCRETE SIDEWALK, BARRIER CU
'ANS 10 & 11.

AND DISPOSE EXISTING ELASTOMERIC BEARINGS 10 LOCATIONS
PORTLAND VIADUCT.

TE AND INSTALL ELASTOMERIC BEARINGS AT 10 LOCATION:
PORTLAND VIADUCT.

“ONCRETE BASE PEDESTALS AT 4 LOCATIONS IN THE PORTLAND

HE EXISTING BRIDGE DRAINAGE SYSTEM (SCUPPERS AND DOWNSPOUTS)
IRIDGE SPANS INCLUDING CLEANING OF DRAINAGE TROUGHS AT
10 AND 11..

NI WAJIVLRL I C DARRICR ANLY DLUVCYMLN LY

INOUS WEARING SURFACE, CONCRETE FILLED
Y STRINGERS IN ARCH SPANS 10 & 11.

NGERS, CONCRETE FILLED GRID DECK,
D INCIDENTALS IN

TIMATED QUANTITIES OF
SED ON LIMITED INVES-
0 WAY WARRANTED TO
(CTUAL QUANTITIEp—6R
ORK wHicH wiJTHES SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER

NO. Y - dd
- mm/dd/yy

=

82-299

TY REPAIRS TO THE | MiDDLETOWN PORTLAND [wmw |
IRIGONI BRIDGE s STR-2
NOTES AND s

TABLE OF QUANTITIES | 03.02

Figure 91 Typical Sheet Replaced by DCO
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Section 5 As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross
Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or
State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-
Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual,
amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed
over the top of the digital signature and its security, therefore, the original content of
the PDF plans can never be altered. Because as-built comments are digital and placed
over the top of the plans they are easily recognizable, searchable, and may be turned off
if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original,
addenda, or construction order plans, located in ProjectWise within the project’s
100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed
on the digitally signed contract plans), these sheets shall be combined by subset number
and uploaded into the 100_Contract Plans folder in Projectwise.

CAD drawings may be updated, at the discretion of each design office, to reflect any
addenda, change orders, and as-built revisions for use in the future; however the
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set
for permanent records.

5.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following
sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on
their record set (paper copies) during construction. Once construction is completed these
revisions shall then be applied as comments to the digital PDF per the workflow in section 5.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built
revisions on their record set (paper copies), and shall apply them as comment to the final set of
digital PDF plans on an intermittent bases, during construction. By using this method as-built
information becomes available to all parties that have access to ProjectWise during the
construction process, improving communication and transparency.
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5.1.1 Post Construction As-Built

As-Built Workflow

Step Personnel Task
1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that
As-Builts can be applied to the Contract Plans.

2 Contracting Engineer | Change the state of the Contract Plans to “Perform As Built”,
or District Staff see Section 3.2.12

3 Contracting Engineer | Apply As-Built revisions to the Contract Plans in accordance
or District Staff with Section 5.3

4 Contracting Engineer | Change the state of the Contract Plans to “As Built Complete”,
or District Staff see Section 3.2.12

5 Contracting Engineer | Notify all applicable personnel list in the Section 5.4.2 that the

or District Staff

As-Builts have been completed for this project.

5.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be
available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

3

-

"ﬂ\l‘

(G

it

Mew Open Save Print E-mail Studio

W T ESE- Sy

| 5 -
Recent Tools

CTDOT Review Tools
CTI op/Waorking Drawing Review Tools
CTDOT As Buitt Tools

Subject G "
= |Construction Started Construction Started and
and Complsted Date Completed Date
= | As-Built Stamps This sheet not comected
= | Az-Built Stamps This sheet comected
= | As-Built Stamps Typical Section comected
— | Az-Built Stamps These quantities not comected
Text Box
Callout Use to Add a Callout
Line Use to Cross Out
Amow

AN 2515

O - of 1N
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Figure 92 - As-Built Commenting
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5.3 Applying As-Built Comments to Contract Plans

5.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built
revisions. By completing these steps as-built revisions will be standardized across the all
CTDOT users. These steps only need to be completed the first time using Bluebeam or when
the user logs into a new computer.

. Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
. Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
. The user must have a ProjectWise login/password. Contact Julie Annino if you do

not have a Projectwise Username and Password.

5.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as
shown below:

i RS 0t Z=| @ #h - searan|@ | P> : Interface cTDOT_Dac_code | : view Document v | ; spatial View 1
Address puictdat.projectwiseonline.com:CTDOT\Documents\01.0 - Projects - Active\0085-01411100_Contract_Plans [F % | = Go
& - B
% no63-0637 # | | Label {User Defined) Drescription Main Category S
L—: 0063-0639 # B o1_ceneral 01_General con Fl
L_'“ 0063-0641 & 0063-0671 _/' 0Z_Revisions Rewisions Subset COon Fl
" 0630843 & 0093-0180 /Bl u3-Highway 03-Highway con Fl
"% 0063-0644
[ gs3-0670 /Bl 0a_structures Structual Subset CON Fl
“ # B) os_Ttraffic 05-TRAFFIC con Fl
Lo DDA3-0672 =
; E ity _Plan
% oes0e73 # B os_ateT_FIO ATAT _Utiity_P con Fl
% oosz-0879 # B) cTooT Highway_STD CT_CON_STD_O085-0141_CTDOT_Highway_STD con 5
[ nogs-079 # [B) CTDOT_TRAFFIC_STD CTDOT_TRAFFIC_STD Con 5

" n070-0115
" 0070-0116
* 00730173
" 00730174
" 0076-0216
{* no79-0235
[** noa1-0088

"% nos1-009t Contract Plans
o / are located in the
- L-x f;ussl-ﬂoﬂljclontractjlans (PDF) 1 OO_COntract Pla nS

{Z 1ZD:COntract;r_Submitta\s (PDF) fo I d e r Of th e P roj eCt

L 130_50il_Archaeological_Misc_Reports (FDF
L= 210_Construction

L 220_FHwA ¢
L 230_Contract_Administration -
{ 240_Contract_Development Project Properties | Folder Properties | Dependency Service | Access Control
L= 241 _Contrack_Development_Confidential
L_— 310_Preliminary_Design_DocumentsiPDF) BENERAL - Project Numbei(s)
L 320_Permit_applications
[ 330_Design_Data GEMNERAL - Pragram Murnber
[ 340_Admininstation GEMERAL - Praject Title
{341 _Corfidential_administration GEMERAL - CTDOT Impravement Type
' 500_Pre_Design GEMERAL - General Description
@4 saved Searches GEMERAL - Federal Proj Oversight
{2 noas-0142 GENERAL - Project Curtent Phase

Figure 93 - Location of the Contract Plans in Projectwise
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1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you

are working on.
2. Toopen a document with Bluebeam right click on the document, and select “Open

With” as shown below:

# | Label (User Defined) Description

,/ n 01_General [l Er 3

_/ 02 _Revision

/ 03-Highwway

/a 04 _Skruckur

-/ a 05 _Traffic Cpen With...

Z Blos_atar PR ——n

./ CTDOT _High View E-0141_CTDOT Mighway STD

# Bl cToot_TRe 51D i i
Check Out Right click on the
. plan subset to open

opy Ol
L1] H "
— and select "Open With
Start Studio Session..,
= Refresh Local Copy
Purge Local Copy
(PCF Purge Workspace

Cut

£ Copy

Document Properti to Previews | Dependency Service || Access Control | Compon

::I) = Copy Ta... [
GEMERAL -Proj  Move Tao..,
GENERAL - Proi  Rename...

Figure 94 - Open With Bluebeam

3. Select the Bluebeam icon and check “Always use this program” and select OK. The
document will now be checked out of Projectwise and open with Bluebeam:

« Open document with x|

Select I
Program
MName | Description | Application
lIl:“JF’DF Document PDF Document "C:\Program Files\Bluebeam Software'Blusbeam Revu'Revu'Revu,exe”™ ™01
B sdobe Reader 9.3 Adobe Reader 9.3 C:\PROGRA1\adobe\READER ~2. 0'reader\acrord32. exe "%1"
F.. Adobe Acrobat Document Acrobat "C:\Program Files\Adobe\Acrobat 10.0\Acrobat\Acrobat.exe” " 1”

Select

1| — Check | _;l
I al use this program Select Browse |

[~ Open document as read-only
Click here for a list of suggested document viewers

Figure 95 - Open with Bluebeam

Note: Since we checked “Always use this program”, the next time you open a pdf in
ProjectWise all you need to do is double click on the file.
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then
select “Check In” when a projectwise dialog box pops up. If the document is not
checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

5.3.3 Applying Digital As-Built Stamps

5.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet,
located in the 01_General subset, as stated below:

1. Select the "ConstructionStartedandCompletedDates”: stamp from the “CTDOT As Built
Tools” tool box and place it at a conspicuous location on the title sheet:

)

Print E-mai Studic Create ‘Combine Batch

%iNE g

e
Recent Tools
CTDOT Review Tools
CTDOT Shop/Working Drawing Review Tools
CTDOT As Buitt Tools
Subject Ci
~—_ |Construction Started | Construction Started and ——— =1
and Completed Date Completed Date
e O T e R STATE
Comected N
=== |This Sheet Comected | This sheet comected
— gﬁ:ﬂ;ﬁdion Typical Section comected
""" gﬁzaﬁe!;amﬂies B These guantities not comected
A Text Box
a
E Callout Use to Add a Callout
{ Line Use to CI'OSE OLI't [CONSTRUCTION STARTED DATE 01,01 /2011
[ CONSTRUCTION END DATE 02/02/2012
/ Amow _:
-
Figure 96 - Construction Started and Completed Date Stamp
2. Enter Start and end and click OK as shown below:
Construction Started and End Dates
JavaScript Window
Type Construction Started and End Dates
Inspector:
nstruction Started Date mm/ddAryyy: 12/12/2014
Construction End Date mm./dd Ay 12/13/2015
Lok [

'Enter Start and End Date
and then click OK

Figure 97 - Entering the Dates for the Stamp
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Below is an example of the placed stamp:

IENT OF TRANSPORTATION

Yans For

EHABILITATION
'E 2, 207 & 430

n(s)/City of

\, MANSFIELD

RLBOROUGH
AINTEMANCE
SPONSIBILITY LENGTH

STATE 00D FEET

Issued 01-2016

INSPECTOR

CONSTRUCTION STARTED DATE 12/12/2015
CONSTRUCTION END DATE

Figure 98 - Placed Stamp
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5.3.3.2 This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail
Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select
that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to
every sheet included in plan set, including the as-built revised sheets, and then go back and
remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that
stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner
of the first sheet in the plan set:

| TH@ A @

CT_CON_FDP_0009-0094_03-Highway™

SUBSET 03 - HIGHWAY
INDEX OF DRAWINGS

Figure 99 - Placing the "This Sheet Not Corrected Stamp"
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2. Right click on the stamp that was placed and select “Apply to All Pages”:

Cut

Copy

Paste Ctri+v

Delete Del

Open Pop-Up Note

Tz

Change Colors

Layer

Right click Order

Alignment

Edit Action

''''' - Lock Ctrl+5hift+L

Reply

Set Status

Check

Add to Tool Chest

Sel as Default

Apply to All Pages

Properties

Figure 100 - Placing the Stamp on All Pages

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the
pdf set.

NOTE: You must go back and replace this note on the sheets that contain as-built revisions
with the appropriate stamp.
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This Sheet Corrected

5.3.3.3

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that
stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every
sheet included in plan set, including sheets that do not contain as-built revisions, and then go
back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp
from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the
first sheet in the plan set:

2. NOTE: You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED"” stamp.

5.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built
tool box shown below and apply it to the document that is being as-built.

Recent Tools

CTDOT Review Tools
CTDOT Shop/Working Drawing Review ...
CTDOT As Built Tools

Construction Started
and Completed Date

This sheet Not

" |Comected
| This Sheet Comected

| Typical Section

Comected

| These Quantities Mot

Comected

Text Box

o

Construction Started
and Completed Date

This sheet not
comected

This sheet comected

Typical Section
comected

These quarntities not
comected

Line Tool

Use to Add a Callout

x

Line

Use to Cross Out

N\ B >

Amow
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Figure 101 - As-Built Tools
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In the following example, the Line tool was used to cross out the existing text and the Text Box
tool was used to add text:

BITU MINBU
CONCRET
- PARIK-LCURBIN

\ Line Tool
\ \L I P\ Text Tool h /L’

N

Figure 102 - As-Built Note Example

Additional tools are available by selecting Markup:

WP (@ Fie Edt  View Document  Makup  Measw=  Window  Help

"hkeE-Sma4 - KA\

New  Open Save Print Emsi  Studo Text Pen Lnes  Shapes  Image  Hypeink  Atchment  Stmp
ERmEEo@- -y i I SiNE (/| TND A W

LI 9

Figure 103 - Other Markup Tools

These tools include:

ARFE '/

A B C DE F G H I J KL M NO P Q R

List of Commenting Tools:

Text — commonly used tool for as-builts

Typewriter — Do Not Use for As-Builts — cannot edit text
Note - Do Not Use for As-Builts — will not print

Flag

Pen

Highlight

Eraser - Do Not Use for As-Builts — cannot edit graphics

I 0om Mmoo O0 ® >

Line— commonly used tool for as-builts

Arrow— commonly used tool for as-builts

—

Arc
Polyline

Callout— commonly used tool for as-builts

2 =

Dimension
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N. Box

0] Circle

P. Polygon

Q Cloud — Do Not Use for As-Builts - this may be confused with change orders or
addendums

R. Picture — Pictures can be inserted into a document or attached. It is

reccommended that pictures be attached as not to obstruct any part of the pdf.

Do not add a note to a comment by double clicking on the comment. For example, if a line
was placed the user could double click on the line and add notes to it:

N

Line

/ Fonald Tellier Supe... 10/11/20

Y A s R

Figure 104 - Incorect Way to Add Text
If notes are added this way they do not print.

5.3.4.1 Digital As-Built Stamps and Notes Using
ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this
folder:

C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current
user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous
sentence, if version 10 is used replace with 10.

Stamp Files

As-Built stamps.pdf

Construction started and completed dates.pdf

These stamps are to be placed following Section 5.3 above.

As-Built notes shall be placed on the plans in accordance with Section 5.3 using the Adobe
commenting tools in the following format:
1. Text Font shall be Cambria 16, and the color Red.

2. All line work shall be line width 2 and the color Red.
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the following:

5.3.5 Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to
Projectwise for future use. This information shall be uploaded to Projectwise in accordance with

e Combine the additional As-Built information into (1) PDF for each discipline subset.
For example if the 03-Highway and the 04-Structures set had additional As-Built
information, 2 separate PDFs would need to be uploaded to Projectwise.

e After the additional As-Built information is combined into their respective files they
will need to be uploaded and attributed into Projectwise in accordance with the
following:

Log into Projectwise Explorer.

Make sure the Interface “CTDOT_Doc_Code” is selected.

Drag and drop the PDF into the 100 Contract Plans folder in Projectwise.

Select the advanced wizard.

Click next until you get to the attributes page shown below and assign the

following attributes:

oo oo

Discipline = CT

Main Category = CON

Sub-Category = ASB

Label = Subset No. and name, for example for the 03-Highway set
type 03-Highways.

Description = Additional As-Built information for....

Advanced Document Creation Wizard | gz |

Define Document Altributes
*You should define environment specific document attributes.

cT
Main Category ain Category Description
CON

Sub Category Eub Category Description
ASB

Project Number(s)
0058-0329

Discipline : / Fill these in -

- All Cortract Plans & Specs

As-Built Plans

03-Highways _CT_ASE_0058-0329

Bridge No(s) Sign Structures

Then Click Next

Label (User Defined)
03-Highways -
Description

Additional As-Buitt Information for Loop Detectors

Document Date (mm/dd/yyyy)

m

to Fill I

CTDOT Asset Tags

| []

lilding Mo(s)
L \ 3

[ <Back {J[ net> ]'[ Cancel
~—
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f.

Figure 105 - Additional As-Built Information

Then click next until the document uploads.
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5.4 Notifications

Issued 01-2016

5.4.1 Notifying Department Personnel

After the as-built information has been completed, the person responsible for the as-built
revisions shall notify the appropriate Department personnel (via e-mail):

Lead Designer

Chief Inspector

Central Surveys

ROW

Central Construction

Bridge Maintenance (if a structure is on the project)

Mathew Calkins and Julie Annino — AEC Applications Email Mathew Calkins
and Julie Annino
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Section 6 Contractor Submittals - Under
Development

This section details how various contractor submittals shall be formatted, submitted, and
reviewed by CTDOT for projects that are not using a Document Control Software such as
SharePoint or Primavera Contract Manager.

The contractor submittals that are detailed in this section are as follows:
e  Working Drawings for Permanent Structures
e  Working Drawings for Temporary Structures
e Shop Drawings

e Product Data
e RFls
e RFCs

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow
the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location.
Projectwise also allows the Contractor to access the Department’s comments quickly after the
submittals are reviewed.

Important Requirement for the Designer

By the FDP date the designer is required to fill out columns A through G in the spreadsheet
labeled “CNS Item List” located in the 240 _Contract_Development Folder under the project in
Projectwise for each item in the contract that requires a shop drawing, working drawing, or
product data submittal.

The spreadsheet shall be filled out in accordance with the following:

e Label (User Defined) — Item number or CSI number or Product Data Title. For multiple
structures, sites, or expected multiple submittals for an item, add an “_01", “_02”, etc,
after the item number for each structure/site/multiple submittal.

e Description — Item Description

e Sub Category — Shop Drawings, Working Drawings, or Product Data.

Bridge No(s) — Type in the bridge number(s) the submittal is associated with.

Building No(s) — Type in the building number(s) the submittal is associated with.

Sign Structures - Type in the sign structure number(s) the submittal is associated with.
Signals Intersections - Type in the signal intersection number(s) the submittal is
associated with.

The first three rows in the spreadsheet are filled out as an example and should be edited when
the designer fills out this spreadsheet. Once the designer fills out this spreadsheet they shall
notify DOT.AECApplications@ct.gov. AEC applications will then create place holder documents
in Projectwise that the Contractor will edit for each Contractor Submittal. If this spreadsheet is
not updated, the place holder documents will not be created, and the Contractor will not be
able to submit their Contractor Submittals. In the event a place holder was missed or a new
item has been added, AEC Applications or the designer will be able a new placeholder using the
templates in the 120_Contractor Submittals folder. When creating new documents make sure
to correctly attribute the place holder document.

These placeholder documents also allow for tracking of the project’s submittals. When these
documents are created they are placed in an OPEN state. Once they are completed they are
placed in a CLOSED state, which allows the engineer to easily see what items are OPEN or
CLOSED.
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Contractor Requirements
The Contractor requirements for this procedure are as follows:

e Purchase a license of Blubeam REVU or Extreme. This can be purchased from
www.bluebeam.com or various resellers.

e All submittals that require a PE Stamp are required to be digitally signed using an ADOBE
CDS Signature, see section 2 of this manual for more information.

o Upload all submittals into CTDOT’s Projectwise Site. Fill out the following form to have a
CTDOT Projectwise username and password set up for your company: CTDOT
Projectwise New User Form

e The Contractor’s instructions for this procedure can be found here: Contractor Submittal
Instructions
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6.1 Workflows

Software Setup — Contractor, SHOP DRAWING SUBMITTAL WORKFLOW

Designer, Construction

Request access to CTDOT's

Projectwise Site Submittal Preparation and Submission - Contractor
,P“mhase Bluebeam and have it »| Prepare drawings in the correct format for the submittal. |_1
installed on your computer |

h
Add drawings to the submittal located in Projectwise.

h 4
Send an email notification to applicable personnel stating a
shop drawing subrmittal is ready for their review.

Designer’'s Review - Designer
r
Change the state of the submittal to REVIEWING.

Note: For the initial submittal the state will be changed from OPEN to REVIEWING. For revise
and resubmit submittals the state will be changed from REVISE AND RESUBMIT to REVIEWING.

¥

Markup the plans as necessary
stamp each drawing appropriately.

v

If all drawings are stamped: If any drawings are stamped:
No Exceptions Noted or Exception Revise and Resubmit
as Noted +
3 Change the state of the submittal to REVISE
Change the state of the and RESUBMIT
submittal to CLOSED
A
¢ Create a New Version of the submittal
Send an email notification to the Contractor
stating the shop drawing submittal has been y
reviewed. Send an email notification to the Contractor

stating the shop drawing submittal has been
reviewed and include the status of each
drawing.

Print Paper Copies for Construction - Contractor

Print the required paper copies of the submittal and mail to
“lthe required people,
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Software Setup — Contractor, WORKING DRAWING FOR PERMANENT AND
Designer, Construction

Regquest access to CTDOT's Projectwise
Site Submittal Preparation and Submission - Contractor

Purchase Bluebeam and have it ol Prepare drawings and/or documents in the correct format for the
installed on your computer submittal.

Add drawings and/for documents to the submittal located In
Projectwise.

Send an email notification to applicable persennel stating a
Working drawing submittal is ready for their review,

Send an email notification
to the designer stating a
working drawing submittal
requires a designer’s
review,

Change the state of the submittal to REVIEWING.

Mote: For the initial submittal the state will be changed from OPEM to
REVIEWING. For revise and resubmit submittals the state will be
changed from REVISE AND RESUBMIT to REVIEWING.

Markup the plans as necessary
stamp each drawing appropriately,

Update the submittal cover sheet in -
the designer area. Change the state of the submittal to REVIEWING.

Mote: For the initial submittal the state will be
changed from OPEN to REVIEWING. For revise and
resubmit submittals the state will be changed from

If all the drawings/documents If any of the drawings/ REVISE AND RESUBMIT to REVIEWING.
are APPROVED documents are NOT APPROVED

Change the state of the Change the state of the Markup the drawings/documents as necessary
submittal to CLOSED submittal to REVISE and stamp each drawing/document appropriately.

RESUBMIT

SEI'Id an El‘l'lall noﬁfication to Up‘dm m Submlnal cover sheﬂ |rl m dﬁﬂgn!r
the Contractor stating the Create @ New Version of the iz
working drawing submittal has submittal.
been reviewed and is approved. Send an email notification to the Construction
stating their working drawing submittal review has
been completed and our comments are detailed
on the submittal cover sheet.
Send an email notification to the Contractor stating
the shop drawing submittal has been reviewed and
include the status of each drawing.

Print Paper Copies for Construction - Contractor

Print the required paper copies of the submittal and mail to
the required people.
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PRODUCT DATA SUBMITTAL WORKFLOW

Software Setup — Contractor,

Designer, Construction
Request access to CTDOT's
Projectwise Site Submittal Preparation and Submission - Contractor
Purchase Bluebeam and have it .| Prepare the documents in the correct format for the |
installed on your computer | submittal. B

For the first submission, add the documents to the submittal
located in Projectwise.

Send an email notification to applicable personnel stating a
Product Data submittal is ready for their review.

Designer's Review - Designer

L
Change the state of the submittal to REVIEWING.

Mote: For the initial submittal the state will be changed from OPEN to REVIEWING. For revise
and resubmit submittals the state will be changed from REVISE AND RESUBMIT to REVIEWING.

¥

Markup the submittal as necessary
stamp each document appropriately,

|
¥ v

If the document is stamped: If the document is stamped:
No Exceptions Noted or Exception Revise and Resubmit
as Noted 3
" Change the state of the submittal to REVISE
Change the state of the and RESUBMIT
submittal te CLOSED ¥

Create a New Version of the submittal.
. v
Send an email notification to the Contractor Send an email notification to the Contractor

statling the prcfduct data submittal has been stating the product data submittal has been
reviewed and include the status of each reviewed and include the status of each

drawing, drawing.

Print Paper Copies for Construction - Contractor

. |Print the required paper copies of the submittal and mail to
" |the required people.

Issued 01-2016 110 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

Request access to CTDOT's
Projectwise Site

Browse out to the 120_Contractor Submittals Folder of the
Purchase Bluebeam and have it . .

project you are working on and open the RFI or RFC
installed on your computer R

Once the template is opened, save it to your local computer.

Fill out the required information on the RFl or RFC form and
add documents to the form as necessary.

Upload the RFI or RFC into Projectwise and apply the correct
attributes.

Send an email notification to District Construction stating an
RFI or RFC has been submitted.

Send an email notification to
the designer stating an RFl ar
RFC has been submitted and
requires their review

Change the state of the
submittal to REVIEWING.

Answer/or add information
the RFl or RFC and attach any
documents as necessary

Change the state of the
submittal to CLOSED

Send an email notification to the
Contractor stating the RFI or RFC has been
answered.

Change the state of the
submittal to REVIEWING.

Answer the RFl or RFC and
attach any documents as
necessary

Send an email notification to
District Construction stating
the RFI or RFC has been
answered.
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6.2 Contractor Submittal Review Process
(CTDOT/Consultant)

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows. Before
starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile
contains all the markup tools as well as the submittal stamp that needs to be applied to all
contractor submittals.

CTDOT Newington Employees — The profile is located on the X:// Drive in the V8
Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT
Bluebeam User.

CTDOT District Construction Employees — Save this file to your desktop and then double click on
it Bluebeam Profile

Outside Consultants/Designers — A custom stamp must be created that includes your
company’s information. See Appendix D of this manual to download and edit the stamp for
your firm.

In each submittal there will be a submittal cover sheet that tracks all the information for the
submittal. The CTDOT/Consultant shall record all their responses or comments for the
submittals on this cover sheet. The form shall be updated throughout the review process for all
submissions associated to a Contractor Submittal.
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6.2.1 Initial Contractor Submittal Review
CTDOT or Consultant Review

The following shows how to review an initial contractor submittal. The figures show a shop
drawing submittal but the procedures are the same for a Shop Drawing, Working Drawing, or
Product Data submittals.

1.
2.

Log into Projectwise.

project.

click on the submittal, select Change State, and then Next.

cwiseonline.com: CTDOT\Documents'01.0 - Projects - Active'0142-01481120_Contractor_Subr « DP Go

-

tio

:nt
:nt
Jo

str

Browse out to your project and open the 120_Contractor Submittal folder of that

Then change the state of the submittal to be reviewed to REVIEWING. To do this right

List |. Geospatial

Description

Document_...

=

Application

State
01-OPEN

/ [B 05034204
7 B 05221784
# B 0602030
[ 0802030

/B us013234

emporary
Keeper Blg
Wingwall
Wingwall
Bearing P

then select

Next

<

Change state to

Open

Open as Read-Only
Open With...
Markup

View

Check Qut
CheckIn

Free

Copy Out

Right click and

tudio Session...

Dependency Map(s)...
: Dependency Map(s)...

= Server Copy

1 Lecal Copy
Purge Local Copy
Purge Workspace

Cut

Copy
Paste...

Copy To...

Move Tou.

Rename...

Delete

Madify...

Maodify Spatial Attributes...
Add Comment

Set
Send To
Copy List Te

T CLOSED
02-REVIEWING
02-REVIEWING
03-CLOSED
03-CLOSED
03-CLOSED

Col
Col
Col
Col
Col
Col

( Change State

Mext

| Document Froperties I Project Properti

’Real (Docum V]lllﬂ_Contrac -

MName

(S

Description

Enter filter here Enter filter h

K

[

Batch Print
Properties...

Change filename te CT_Code

Edit attributes for multiple documents

Previous

Change...

Set Final Status

Remove Final Status

If\

[ = 7 1

t||'—|._

=

=~

Figure 106 - Changing the State of the Submittal
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4. Then double click on the contractor submittal file to open:

e o B

= U_J Projectise Explorer Datasources
= | CTDOT (mic-admin)

= Docurments
" Q0040116 & 0004-0118
L 100_tContrack_Plans {PDF)

l‘ {7 120_Contrackor_Submittals (PDF) ’

[ v g )
| 210_Conskruction

Browse to your =
project

iment_Confidential
ks
L 2EU_FENHIL_HpPILaUuns
L= 330_Design_Data
L= 340_Administration
L= 341 _Administration_Confidential
' 500_Pre_Design
% saved Searches
{1 oooe-01z2
[ 0007-0182 & 0170-3155
{1 o009-0094
[*% o011-0151
[*% o012-0095
[/ op12-0098
[ o014-0177
[/ op14-0183

List | i@ Geozpatial

[B) n153468-Bearings

Figure 107 - Opening a file from Projectwise
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5. When the submittal opens, you should see the submittal cover sheet followed by the
shop drawings, working drawings, calculation and supporting documents, or Product
Data Documents as shown below: The following shows a shop drawing submittal but
the procedure is the same for a Working Drawing or Product Data submittal.

CT_CON_SDR_0D04-0133_0153468-Bearings.pdf*

PDF Package

@T_E R,

hadified

Submittal form

01_Shop Drawing Submittal Form.pdf 1.23MB 91372013 10:08 Aw

SN32013 11:47 A

&— Shop drawings

E-1 pdt 91312013 11:47 A

GN-1.pdf 91312013 11:47 A

Figure 108 - Example of a Submittal

6. To review the drawings/document double click on one of the files to open it. A new tab
will open as shown below. Markup the drawings/document with comments using the
markup tools located in the tool chest shown below.

| &
LocATiaN The file will open To review use the < cioor
. H i ~ CTDoT
ABUTIPIER SPAN 54 jin a new tab and you CTDOT ShoplWorklng el
2 PIER 2 3 B-T1ES . . .
= mER 2 B = can start your review drawing Review tools | ot S
1 PIER 2 3 B - . e eview Stampl
i WA Wi W | e, ., . .  m=] located in the tool chest ittt
Az A2
SOLE PL | SOLE PL. . . | Highlight
L2 w2 Z _1,,.'_77..._
TR e ////’ [ P TeutBox Use to Add test
% Pl B WLGANZED TO
[ |, Sl THE SOLE FLATE e Callout Use lo Add 2 Callou
T i Use to Cloud
L | ! \ - oo
5 23[0 X | ( / ‘ \ . Use o Cross Olut
3 Bal] ! ' 3 - 5 : -
P I— T g - : :
i ! 1 ilg ¥
g |l ! o HE COVER PLATE
H 1 } 1 / | e PL 3B K B X 4
o [ | Zg ASTH A36 (UNPAINTED)
S I D a ez B el HOLES - 501 Lo
— L 11GA (1196" NOM) INTERMAL SHIM/ - 2
1907 NOUY WTERIL Set/ 1L vewn 88 (1) TOTAL REGURED
PN vEw s B
& SEE_SHEET GH1 OF 1 FOR GENERAL NOTES
St T W L LAMINATED PAD STATE OF CONNECTICUT
ANT ON TOP— BEVELED SOLE PLATE 50 DUROMETER NEOPRENE GRADE 3 HAVING A SHEAR DEFARTMENT OF TRANSPORTATION
\CE OF SOLE ™ ©CLx B" x A" MODULUS OF .005 KSI :WSZA BRIDGE NO. 01702
ELD WELDING ; VULCANIZED TO SOLE FLATE ROUTE 2 WESTBOUND OVER
=8 ) REQURED GURRY R
S T IFp — DISTRICT 1 = SITE &
| @ oo 1" % W x LT MNATED PAD 5 ! [0V OF GLASTONBURY
B r - — | A— 50 DUROMETER NEOPRENE CRADE 3 HAVING A SHEAR | s Coumry e v
MODULUS OF 005 KSI ANZA 1
L LY ~ NO SOLE PLATE
- 1) REQURED

= e o1
ELEVATION VIEW
IANSION ELASTOMERIC BEARING ASSEMALY

Figure 109 — Shop/Working Drawing Review Tools
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Submittal Review Stamp
7. For CTDOT Engineers and District Construction the submittal review stamp is located in

the tool chest in Bluebeam and should be placed on an open area of the drawing. For
Consultants Appendix D must be followed before their stamp is located in the tool
chest.

8. To place the stamp, left click on the stamp in the tool chest and then place it.

CT NO. 106-121
TA. 17+50
UCTION

PAVEMENT Left click on
PAVEMENT MARKINGS

Normal Text

Speling Emor
stamp and place
Highlight tool
w
g \z Preliminary Stamp
o
-:'E SUBMITTAL REVIEW o Note
b DESIGNER'S REVIEW
Cloud
Length Measurement
Area Measurement
The plans have been
Stamp checked that the folo...

Comment

= [Submittsl Review 216 Stamps
—_— —b‘
_ . January Supplements 10}
Submittzl Review the 216 Stamps

Highlight

Highlight

Figure 110 - Placing Submittal Stamp

9. Next select the appropriate option from the java script window.

Submittal Review (5m)

JavaScrpt Window

ion

@ No Exceptions Noted () Exceptions as Noted () Revise and Resubmit ) Rejected ) No Action Required

Reviewer's Information

Date: 2/4/2015

D

Figure 111 - Submittal Review Stamp
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10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging

a corner as shown below:

- - e o v
015 arings.pdf* D-1* &
BEARING LOCATION BEARING TOTAL BEARING DIMENSIONS
mark | 9T TYPE LoaDS
ABUTIPIER SPAN BEAM(S) KIPS) L w T A
EBA1-D 2 PIER 2 3 B-11E & B-11W EXP 75 B Ex 1.735" 9"
~ EBA2D a4 PIER 2 3 B2 EXP 75 8" E3 1.735" 9
EBA3-D 1 PER2 3 B-12 EXP 75 8" 9 1.735" 9
TEST-D | NiA NiA Tnia EXP 75 B o 1.735° NiA
A2 A2
SOLE PL. [ SOLE PL. SUBMITTAL RELIIEW
e w2 DESIGNER'S REVIEW
LAM. PAD | LAM. PAD L . . ) e 3 // LAMINATED PAD TO
. h : OLE PLA BE WULCANIZED TO
BEARING THE SOLE PLATE
r——=—""—-7"
w72 i |
ald e I I |
ST o
oy (B 23]l |
3 T |2 g4 I
“ = o, | |
ElFvall I . &
ey - 5
W |E I : 3l
5 alg | oy 23
o ) o
sE=E | | Ji | | EE
a = |
- L___*___J

we s 10 Fesize the stamp,
" first click on the middle

Figure 112 - Submittal Review Stamp

The stamp is now resized as shown below
oce Ay

OCR

ELAN WIEW
e e Of the stamp so the
S 2 o e TN -
e FATACE OF SOl ! yellow circles appear,
® | tooms| o )° then click on a corner and
g R = drag it to the size
| EEEEEEECEL g
“eomn . that fits.
ELEVATION VIEW

Issued 01-2016

0004-0133_0153468 gs.pdf* D-1% =
BEARING LOCATION BEARING T
arTy. L
MARK ABUTIPIER SPAN BEAM(S) TYPE (
EBAT-D 2 PIER 2 3 B-11E & B-11W EXP.
EBAZD 4 PIER 2 3 B-12 EXP.
EBA3D 1 FIER 2 3 B-12 EXP
TEST-D 1 MIA MiA | MA EXP.
AfZ AS2
SOLE PL SOLE PL. { SUBMITTAL REVIEW
CESIGHNER'S REVIEW
L/z Lz =
LAM. FAD | LAM. FAD ul=1
§ BEARING
A
Sl e

The stampis ' |
now resized

Figure 113 - Resized Stamp
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11. After the review is completed, close the file and click yes to save.

BEARING | BEARING Eg;g; BEARING DIMENSIONS STEEL SOLE PLA"
MARK " | aBuTPIER SPAN\ TYPE (KIPS) L w T A B Th
EBA1-D 2 PIER 2 3\ EXP 75 8" EQ 1.735" ER 11304 3.09"
__EBAZ-D 4 PIER 2 3 N B12 W 10" 3.09"
EBA3-D 1 PIER2 3 B-12 10 391"
TESTD 1 NiA NiA NiA Close the file NiA NiA
a2 A2 \ .
auE P B0t L and click yes to save .
DESIGHNER'S REVEEW 2 _—
L2 =) - '1
LAM. PAD LAMINAIEY FAY 10
Gk BE VULCANIZED 70 —
THE SOLE PLATE . { )
~ : Wl &
[ E—

FE l .
M I " |:
aly S8 x|l

47z 61 "

El-mll =~
3 Bsf] - . B
o I | >

" o | | Save changes to following PDF files? 3 E =

g =1 | I =
ala SIE | | | File Path g g COVE|
NE Z | [ D-1.pck b FL 38"

3 | | 2|5 ASTH A36

O = L E e 10 BE FIELD

”””” V168 ( £ EXISTING HOLES
l e (14) TOTA
ELAN VIEW
AHEAD —
STATION . STATE €
[ — BEVELED SOLE PLAT DEPARTMED
SURFACE OF SOLE THOCLx B xA BRID!
PLATE FOR FIELD WELOING . ~ ROUTE 2
= E ; Q Yes m No ] [ Cancel ] — UIST%:
® *‘ BEARING - ]
&t T -
( — —t=] 50 DUROMETER NEOPRENE GRADE 3 HAVING A SHEAR B
MODULUS OF 085 KSI +15% A | X | [
- PAD ONLY — NO SOLE PLATE 141 ; L 2 PROJ. MO 171
_ 3 (1) REGUIRED ol o
“Ssee oETAL 1 | e LAMINATED
ELEVATION MIEW L
]
EXPANSION ELASTOMERIC BEARING ASSEMALY gﬂ

Figure 114 - Saving the Shop Drawing

12. Repeat the review process for the each drawing/document in the submittal.
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13. After all or each one of the drawings/documents in the contractor submittal has been
review, update the submittal cover sheet. To update this sheet, double click to open
and then fill in the appropriate information.

SHOP DRAWING OR PRODCUT DATA SUBMITTAL COVER SHEET

Connecticut Department of Transportation - Shop Drawing Submittal Cover Sheet

PROJECT MO.r 142-158 ITEM MO I52I000A ITEM HAME: Branng Replacrment with Elssiomens Braring Pads for Bndgpe Mo,
FIRST SUBMISSION
g DATE: A3amn FROM; M-;lqr-d— DATE:
S Tor l-‘l_r'l:-l'lhﬂl i:c.-ls:. Abraba To: —
e (243 _I::'f‘:“l?‘“-‘“ 1j 4 ] o
= li‘;’::ﬂ T a1
§ 2"57.‘“ ]
g Motes: Total Sheet Cnu;ll: - Moles:
ot e s Tt abeops 0 st o o it B st P ot yomat rovers s appron sl Plisess cnpadins
Engineer's Response -‘\
Reviewesd By? Lok Codons Dater Vietoi: Reviewed By:
BE]
Shast i i 1. Sheet i
Mumbar _E )3 X Responie Mumiser H
HH{H :
L Fa ﬂiﬂ [ C
T [# Dll:l e £
\ 0 r—||'—1 / |C
o|ofo \ C
(| DlD \ - . - - - C
Fill in this information [
1 I:Il:l = E
for the submittal _
O l_lll_l 1 E
i | I_Ill_l " =

Figure 115 - Shop Drawing Submittal Form
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WORKING DRAWING SUBMITTAL COVER SHEET

The working drawing submittal cover sheet will need to be filled out by the engineer(s) and
district construction as necessary. Below is an example of a submittal that district construction
forwarded to engineering for review. Notice the two design groups recorded their comments in
the space provided and district construction gave the final approval at the bottom of the form.

Connecticut Department of Transportation - Working Drawing Submittal Cover Sheet

PROJECT MO

ITEM NO.:

ITEM NAME:

FIRST SUBMISSION

Fillad gut by Contractar

DATE:

Total Document Count:

Total Sheet Count:

FROM;

L A i e

TR

, Bridge

Dacumants Included in Submittal:

Designer's

[ e approve ds submemal. Please follow the engineers commenis.

Enginefys Respons
B - C
I Il Comments |
Pridge Feisn A [
Comiments:
feve il the ubsaial acceprabis and Bave ganeped e saboind
- . - gy |
F
) e Il e Soils Unit's :
E Einls Lyt AEE hceopiablc
E Comments: ' o e ts
E fo find e sidberet 1) mceplible il hive dmrgead he sibrotlal m m n
E
F
10 ann M| Date asclition L
Commuents:
' Construction’s Response
Raviewed Reviewed E
IUII\:!:E‘{"‘:I; Date Basclution 1
fim: Bemc [ISmLS Agproved
Comments:

Fillad aut by Constr@etion

Issued 01-2016

P Final

approval by
District

Figure 116 - Working Drawing Submittal Form
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14. After filling in the fields, save the file and close Bluebeam. Then check the document
back into Projectwise by clicking on Check In in the Check In dialog box as shown below:

x

General I

— Documents

rame | File Mame
v B CT_COM.. CT_CON_SDR_9576-5432_0156478-Bearing_(1).pdf

« I i

Folder: 01.0 - Projects - Ackive)Shop Drawing Teskh120_Contrackor_Submitkals (PDF)

[T Create new wersion during Ch

. Click Check In

Mersion:

| Check In ' Update Server Copy | Free | Cancel

Figure 117 - Check In Dialog

15. If there are no drawings/documents that need to be revised and resubmitted, proceed
to step 19. If any of the drawings need to be revised and resubmitted, proceed to step
16.
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Drawing Stamped Revise and Resubmit

16. If any of the drawings/documents need to be revised and resubmitted, the engineer or

District Construction (depending on who is reviewing the submittal) will change the
state of the document to REVISE and RESUBMIT and then create a new version of the

submittal to keep as a record of that submittal, as shown below.

To create a new version right click on the submission in Projectwise and select

New>Version:

[/™ 15 _DEV_553

[[™ JSRO000_Test

=-{/™ shop Drawing Test

' 100_Contract_Plans (PDF)
110_Contract_Specifications (PDF)

& B 0156478-Bearing
[[B) n156475-Bearing
B o156475-Bearing

Bearing Shop drawings For Bridge 01564 and 01457
Bearing Shop drawings For Eridge 01564 and 01457
Bearing Shop drawings For Eridge 01564 and 01457

120_Contractor_Submittals (PDF)
130_Engineering_Reparts
210_Construction

220_FHWA
230_Contract_aAdministr ation
240_Contrack_Development

241 _Contract_Dewelopment_Confidergfal
310_Review Documents

|
I ARASANARASASASANAS

Open

Open as Read-Only
Open With...
Markup

igw

Check Cut

* Right click on the submission

. and select New>Version

[+ Saved Searches

[7™ test securities

|___Pi test securities2

[ BMap

01.1 - Projects - Legacy

01.2 - Projects - Research

01.3 - Projects - Research - Legacy
01.4 - Projects - Local

02.0 - Assek - Bridges

#H-{7 02,1 - &sset - Signal Intersections
#L 02,2 - #sset - Sign Struckures
HL 03,0 - Imagery

B
ATASARAGAR =R

Figure 118 - Creating a New Version

DA SCUAID DESSI0N, .,

Refresh Local Copy
Purge Local Copy
Purge Workspace

Cuk
Copy
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17. Next type in the version as shown below. The example below is for a second
submission:

Mew Document Version

Wersion | Comments|

Folder

Marne: 120_Contractor_Submittals (FOF) Ty pe i n 1 St S' u b m i SS‘ i 0 n
D escriptiorn: Contractar Submittals Working Drawings, Shop Drawings, etc. h e re to tag th e 1 St
Documert submission

Mame: CT_CON_SDR_9576-5432_0154678-Paint Platform. pdf
D escriptian: Faint Platfarm for Bridge 00001

@rsioni | 13t Submizsion | )

Sequence: 1}

T _ Type in 2nd submission
("’ [2nd Subrision O“E here to tag the 2nd

submission and
then click OK

G 0K -]') Cancel ]

Figure 119 - Creating a New Version

18. After you create the version you will see it underneath the new version. The Contractor
will only be able to see the current version, so they can’t update the wrong file. CTDOT
and Consultants will be able to view all versions for document comparison.

jectwiseonline.com:CTDOT\Documents\01.0 - Projects - Active\0142-0148\120_Contractor_Subr + [ Go

List | @ Geospetic

»

p—
Label Description Document.... Application State File Updated ~Bridge No Crestedf Version
/ Boszoma Bearing Replacement 4/24/2012 .. AcrobatPDF  02-REVIEWING 13/2015 7:06:47 PV 00840 1/9/2015 8:42:58 Pl
/ Blosot201 Class 'F* Concrete Stay-TIn-Place .. 3/26/2012.. AcrobstPDF  03-CLOSED /201515214 PM 00840 1/13/2015 1:34:54 P
/ Blos034204 Temporary Deck Suppnrl 3/26/2012 ... Acrobat PDF 02-REVIEWING ﬁlﬂli 1:07:58 PM 00840 1/12/2015 1:06:49 PI
L2 Bnszzas KesparBlock Dy 4/24/2012 .. AcrobstPDF  02-REVIEWING £12/201512:57:40 PM 00840 1/12/201512:200
/ Bl 0602020 Wingwall Rebar Drawings 4/26/2012 ... Acrobat PDF 03-CLOSED 1/201512:45:00 PM 00840 1/12/2015 12
( [1B 0602030 Wingwall Rebar Drawings 4/24/2012 .. AcrobatPDF  03-CLOSED

" ?JZUIS 12:41:09 PM 00840 1/12/201.
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Figure 120 - Version Column
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19. Only for submittals where all drawings/documents do not need to be revised and
resubmitted: Once all the drawings/documents are acceptable, the state of the

submittal must be changed to CLOSED. To change the state follow the figure below:

Shop Drawings and Product Data - Shall have the state changed by the Engineer.
Working Drawing - Shall have the state changed by District Construction.

Right Click on
the submittal
and select

# B 0z05105-5truckural Steel
/# Bl n605205-Defarmed Steel Ba
70

Template{Ttem:#d

Change State>Next

lan_2011a

b

Decument Properties |

Wiew:  [<Default

-
L=)
POF

Hew

Structural Steel Shop drawings for Bridge 01564 and 01457
Deformed Steel Bars Shop drawings For Bridges 01564 and 01457

02-CLOSED
02-CLOSED
01-0OPEN

Open
Open as Read-Only
Open With. ..
Markup

View

Check Out
Check In
Free
Copy Out

Export...
Lrrport
tart Studio Session...

it Dependency Vap(s)h..
port Dependency Map(s). .

ite: Server Copy.
Relfresh Local Copy
Pulge Local Copy
Purlie Workspace

ieview | Dependency Viewer | Access Contiol | Companents

\ Property value
CT_COMN_SDR_9676-5432_Tampl

120_Coniractor_Submittals (PDF)
CTDOT _Design_Envir
CT_CON_SDR_9576-5432_Tempk
120_Conitractor_Submittals

Add Commient:

MIC-Admin
MIC-Admin
MIC-Admin
Checked In
1st Submission

Set
Send To
Copy List

Batch Print

Change...

Froperties...

Set Final Status

Edit attributes For multiple documents

Remove Final Status

Figure 121 — Changing the State of a Document

Change Document To State

Comments |

Erter Commert:

Click OK you

do not need to

enter a comment

o —
(o] Joenen |

Figure 122 - Changing the State

20. Next the Designer shall send an email notification to District Construction stating their

review has been completed. Then District Construction will send an email notification

to the Contractor.
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6.2.2 Subsequent Contractor Submittal Reviews

CTDOT or Consultant Review
After notifying the Contractor through email that all the drawings/documents have been
reviewed they will revise and resubmit any drawings/documents that were stamped as such.
After the Contractor sends an email notification that the revised drawings/documents have
been uploaded, the drawings/documents can be reviewed in accordance with the following:
1. Loginto Projectwise
2. Browse out to the project’s 120_Contractor Submittal folder.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right
click on the submittal, select Change State, and then select previous. The state will go
from REVISE AND RESUBMIT to REVIEWING.

& B 02044024 Handling Water (Site No. 2)
andlin ater (Site No.
/ B 02044034 Handling Water (Site No. 3)
e * . =S
Concrete Fish Ladder
dpen _oncrete Fisl
,/ 060 Open as fjead-Only ed Steel Bars - Galvanized
1l L:,_]E 050, Open Wikh... ed Steel Bars - Galvanized
# B os0 Markup Anchor Bolts .
_/m 060, i Hales and Grouting Dowels
_/'a 065 =T " Corrugated Steel Pipe Arch, Aluminizec
_/E 085 Check Oy ' Corrugated Steel Pipe Arch, Aluminizec
. /E 071 CheckIn ary Earth Retaining System
ttial /Bloot e Fence (' High)
Free
_/a Cla " Concrete
_/'a Flo POt ontingency Plan
-/E Pip Export... - =
jRFC Jmport Right click and
&) RFL
Start Studify Session...
/ Bisen then select
./E Te Export Depgndency Map(s)...
-/ETE Import Degendency Map(s)... Change State
] Update Serfer Copy and prev'ous -
< Refresh Logal Copy
| Document Purge Localj Copy iew | Dependency Viewer | Access Control
Real (Do Purge Worlpace - | @
Name Cut Docur
Enterfite{  Copy | 9 0| % | X |
€ap  FPaste. E N N N
€ R Copy Tow B F M F M
€ Wy B M M I ¥
€ X B~ M I ¥
ename... B O m ra ra
Delete T T
Modify... B -~
E Co Modify Spatl Attributes... B v [V [ [v
g Co Add Commeht By [¥] [~] [ [
€cr B M F M ¥
B P "2 F FFEFE
E Da Send To ] B [ [ [ [~
€M copylistT (5] N/ 2/ 2 a1
€ N B~ M F &
EJ . Change State + Mext =
g Jm Batch Print EI=ion ’
€ R Change... b
€ Properties... F
Set Final Status =
g Key Change filename te CT_Code Ry e EinalSto i r
. Ma o ~ ¥
g WU Edit attributes for multiple documents [ B 2 2 2 o
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4. Then double click on the submittal file to open. Note: The initial submittal will be

updated to include any revise and resubmitted drawings/documents, a second file will
not be submitted:

e B

= | Project\wise Explorer Datasources
=1 L CTDOT {rjc-adrin)

= Documents

= 01,0 - Projects - Ackive

+ % 004N F 8 0004-0118

[ " 0004-0133

=
g

Browse to your

iment
iment_Confidential
ks

project

e

-

T S

L 100_Contract_Plans (PDF)
o T

= O abion =l
| 120_Contrackor_Submittals (PDF)
0 ey repar

210_Conskruckion

SEU_FETHL_SpHilLdLidig
330_Design_Data
340_Administration

341 _Administration_Con
S00_Pre_Design

Saved Searches

™ ooos-0122
[/ o007-0182 & 0170-3155
[ 0o09-0094
[ 0011-0151
[*% o012-0095
[*% 0012-0096
[*% 0014-0177
[*% 0014-0183

5 List | i@ Geospatial

\

fidential

Figure 124 - Opening a file from Projectwise

[B) n153466-Bearings

Crescription
Bridge Mo 01534 and 01567Bearing shop drawings

Double click
on the file to
open

5. When the file opens double click on the submittal cover sheet. Also if you open the
submittal cover sheet the Contractor will have updated the submission information, as

shown

below:

6. Open up the revised drawings/documents, review, apply comments if necessary, apply
stamp and save the file.
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7. After the file is reviewed record the resolution for the drawing/document under the
applicable submission as shown below:

o portment of Transpartation - Shop Drawing Submitta Cover Sheet
PROJECT NO.; 170325 ITEM NO.; D125 ITEM NAME: Boadpe Beamps SITE NO.: BRIDGE NO(=), SIGN sur_neh'r "
RETAINING WALL NO[s) if applis
= FIRST SUBMISSION SECOND SUBMISSION
3 FROM: e v oate:
% Notes: Total ’h!el’(“colllli‘r Notes: T - -
For a second submission
fill in the response here _
————
Reviewed By: Dater Reviewed By: I ]
F] ; 1 ; H
Sk N Shest [
Humber ig i i Resgon: Wb Ei §£|§i l Respanse Nombar % 5
| ] 1 I (] [
, [ (][ ] (] (i
b OC= e i (=] [ ] ) || [
[l [l 1 (] )
O|C 1| 1 (] )
() ) ) () ) () ] [}

Figure 125 - Revised Shop Drawings
WORKING DRAWINGS

Connscticut i

FrosEcT o, e o Tre wane, e, SRIDGE noto) TGN suRORT ¢
i

é FIRST SUBMISSION SECOND SUBMISSION

£ Dare: mon: [T — Fnon;

(S anl————

£ = | reseeeees 0 ] s

I

)} _ —

Dosumenta Inchuded in Submiial:

For a second submission
fill in the comments here\\ G ==
ey | o

Filed out by Somsireciion

Figure 126 - Revised Working Drawings

8. After the information is filled out, click save and close Bluebeam. Then “Check in” the
submittal into Projectwise.

9. If any of the drawings/documents need to be revised and resubmitted, create a new
version as shown in Section 6.2.1 step 16. If all the drawings/documents are acceptable,
proceed to the next step.
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10. Only for submittals where all drawings/documents do not need to be revised and
resubmitted: Once all the drawings/documents are acceptable, the state of the

submittal must be changed to CLOSED. To change the state follow the figure below:

Shop Drawings and Product Data - Shall have the state changed by the Engineer.
Working Drawing - Shall have the state changed by District Construction.

/ Bl 0z05105-5tructural Steel
/ [B) 0805205-Deformed Steel Ba
Template(Itemits

9F)

Right Click on

the submittal

and select

Change State>Next

4

e

Structural Steel Shop drawings for Bridge 01564 and 01457
Deformed Steel Bars Shop drawings For Bridge 01564 and 01457

02-CLOSED
0Z-CLOSED
01-0PEN

Open
Open a5 Read-Only
Open With...
Markup

visw

CheckOut
Check In
Free

Copy Out

Expott...
ot
tart Studio Session...

lan_2011a

Document Propetties l

Wiew: | <Defaulty

&0t Dependency Man(s)i .
ot Dependency ap(s):

izte Server Cony

Reffresh Local Copy
- Pulge Local Copy
- Purfe workspace

review | Dependency Viewer | Access Contiol | Components

| Property valus
CT_COM_SDR_9676-5432_Templ:

120_Contractor_Submittals (FOF)
CTDOT_Design_Envir
CT_CON_SDR_9876-5432_Templ:
120_Contractor_Submittals

MIC-Admin
ey MIC-Adin
2 MIC-Admin
Renami Checked In
Delste Lst Submission
Modify,

Madiy Sogtial Attributes. .
Add Comngnt
Set v
Send To »
Copy List »
Batch Print
Sl Change. ..
Properties...

Set Final Status

Edit attributes For multiple documents

Remove Final Status

Figure 127 - Changing the State of a Document

Camments |

Enter Comment

x|

Click OK you

do not need to

enter a comment

V- —
@ )

Figure 128 - Changing the State of a Document

11. Next the Designer shall send an email notification to District Construction stating their

review has been completed. Then District Construction will send an email notification

to the Contractor.
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Section 7 Digital Review and Commenting

This section details the digital review process using Bluebeam’s collaborative online review tool
called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2)
Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and
6) Respond to comments made in the session. Also, directions for locking the documents after
the review process to create a read-only final record copy to be stored for future use are also
provided.

The following video gives an overview of the Digital Review Process: Digital Review Video.
Specific details are found in this document

Connecticut Department Engineering Directive 2015-4-E, implemented this procedure.

7.1 Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of
the original paper document. Any required markups are placed directly on the document using
a computer with software designed for managing digital reviews. The documents can also be
printed from the review session and the paper copy marked up; however, those markups must
get transferred back to the digital copy.
Advantages of a Digital Review Compared to Conventional Paper Review

1. Higher Transparency — Increased Collaboration.

2. Digital markups are searchable and sortable, by comment, author, etc.

3. Real time collaboration review process improves turnaround time and quality of the
review.
Real time feedback allows easier handling of large amounts of data.
Reduces the time required to compile and resolve comments.
Eliminates document mailing time.
Reduces document printing.
Eliminates shipping cost.
Easily store a permanent digital record on the cloud.
10 Overall reduction in review time.

LWooNO U~

Types of Reviews:
This manual may be used as a guide to perform a digital document review on any digital
document. Below is a list of examples of the types of documents that may be reviewed:
e Preliminary Design Plans
e Structure Type Studies
e Semi-Final Plans
e Final Plans for Review
e Specifications
e Engineering Reports
Review Process:
To help participants of a digital review more easily track the digital review process it has been
split up into six Phases as listed below:
e Phase 1 - Preparation of the Digital Documents
e Phase 2 — Set Up Digital Review
e Phase 3 — Invite Attendees to Review
e Phase 4 — Digital Review
e Phase 5 — Ending the Digital Review
e Phase 6 — Resolve Comments

Issued 01-2016 129 Version 3.11



http://www.ct.gov/dot/lib/dot/documents/aec/Digital_Review_Video.html
http://www.ct.gov/dot/lib/dot/documents/aec/2015-4-E.pdf

Connecticut Department of Transportation — Digital Project Development Manual

Each phase and its required steps will be discussed later in detail.

Digital Comments:

In this review process, all comments must be applied to the documents in the review session.
Reviewers have the ability to print the digital review documents to paper and mark them up,
however, when done, all must be transferred from paper to the digital documents, see Section
7.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email
MaryAnn.Cass@ct.gov. Inthe email include the project number and list documents that need to
be printed, and include the address of where they are to be mailed. In the case of preliminary
contract plan reviews, the original digital documents, with comments, will become the final
record.

All comments associated with a design submission should be applied to the digital documents.
Telephone of email comments must be applied to the correct digital document by the staff
member who received them. Be sure to use engineering judgment to determine the most
appropriate location for the comments in the document. General project comments can be
placed on the first sheet of the document using the note markup tool in Bluebeam. This process
is detailed in Section 7.7.3. If any outside entities (railroads or utilities) will not participate in the
digital review, their comments with your responses should be attached to the final record copy
in accordance with Section 7.7.3. It is not necessary to transpose these comments individually
as all comments can be attached at one time.

FOI Requests
Contract Document Digital Reviews - After a digital review session has been completed and all

the comments have been resolved, a read-only copy of the review documents with the
comments and resolutions will be stored in the 310 _Review Documents folder under the
project.
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7.2 Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and
the software Bluebeam. This software was chosen for the following reasons:

a.

Includes a collaborative live review feature (STUDIO) with real time feedback,
enabling all reviewers to comment on the same document at the same time out
on the cloud.

A license for Bluebeam is more cost effective than competitive software like
Adobe Acrobat. Thus it is much less expensive to purchase and maintain.
Only the Organizer of the review is required to have a licensed copy of
Bluebeam. All other attendees can participate in the digital review using
Bluebeam’s free version, Bluebeam VU.

Bluebeam is integrated with ProjectWise. This simplifies the delivery of the
original review documents as well as saves the final reviewed copies and their
comments.

2. The following table lists the software required to organize and/or participate in a CTDOT
digital review. Note: Itis recommended that the latest version of the software be used.

Role Software

Organizer — Manages review Bluebeam Extreme or Revu Standard and Projectwise Explorer

Author — Produces documents Projectwise Explorer

Reviewer — Reviews documents | Bluebeam Extreme or Revu Standard or Bluebeam VU*

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the
invitation. Note: An IT administrator may have to install this software on the computer.

3. Al CTDOT digital review participants are required to complete the steps provided in
Appendix A prior to organizing or joining a review session. Completing these steps will
standardize the Bluebeam format across all CTDOT digital reviews.
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7.3 Digital Review Workflow
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Figure 129

All CTDOT digital review participants are required to complete the steps provided in Appendix
A prior to organizing or joining a review session. Completing these steps will standardize the
Bluebeam format across all CTDOT digital reviews.

Roles

Organizer — The organizer sets up and coordinates the review session. For in-house projects this
would be the project lead and for consultant jobs this will be the Consultant Liaison.
Author — Group that produces a document(s) for the review.

Reviewer — Group that participates in the review session to review documents.

Step \ Role ‘ Task ‘ Section
Phase 1 — Preparation and Delivery of the Digital Documents
11 Organizer Coordinate the organization and preparation of the review Section 7.4
documents. Request all Authors to upload their review
documents into Projectwise.
1.2 Author Prepare and upload review documents into Projectwise. Section 7.4
Notify the Organizer that this step has been completed.
13 Organizer Check that all review documents have been prepared and Section 7.4
uploaded correctly into Projectwise.
Phase 2 — Set up Digital Review
2.1 Organizer Change the state of the review documents in Projectwise to | Section 7.5
“Review” and then start a Bluebeam review session.
Phase 3 - Invitation to Review
3.1 Organizer Create a Digital Review memo, which includes a link to the Section 7.6

digital review session, and send it to all Reviewers.

Phase 4 - Digital

Review

4.1 Reviewer Join the review session by clicking on the link provided in the | Section 7.7.1 and
review memo. Become familiar with the review session Section 7.7.2
layout.

4.2 Reviewer Set Status to “Reviewing” Section 7.7.3

4.3 Reviewer Review the documents in the Bluebeam review session and Section 7.7.3
place comments on documents as necessary. Documents
can be printed, marked up, and then comments transferred
the PDFs. If the documents cannot be printed out, send a
request to engineering records.

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to Section 7.7.3
“Finished”

4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 7.7.3
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Phase 5— Closing the Digital Review

5.1 Organizer Close the Bluebeam review session and check the Section 7.8
documents back into Projectwise.

Phase 6 — Resolve Comments

6.1 Organizer Notify the Authors that they can review the markups on Section 7.9.1
their review documents in Projectwise. Provide them with a
link to the folder in Projectwise.

6.2 Author Open the specific document(s) from Projectwise. Section 7.9.2
6.3 Author For each comment on your document, type a final Section 7.9.2
resolution.
6.4 Author After all resolutions are applied to comments, Notify the
Organizer that you applied your resolutions.
6.5 Organizer Change the state of the review documents to “Review Section 7.10

Complete” to make all review documents read only after the
resolutions have been applied.

6.6 Organizer Send out a Completion of Review Session Memo to all the Section 7.10
personnel associated with the review session that the all
comments have been resolved on the documents located in
Projectwise.

7.4 Phase 1 - Digital Document Preparation

7.4.1 Organization
Below are the guidelines by which the review documents should be organized:

Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans - Must be in discipline subsets. The review Organizer is responsible for assigning
each Author a subset number in accordance with Section 1.10 or Section 1.11 Note:
CTDOT Standard Subsets cannot be added to a review session because they are
combined in a PDF Package (Portfolio).

2. Specifications — Each discipline shall combine all of their specifications into one (1) PDF
document. Each discipline’s specifications will remain separate throughout the review
session; they will not be combined with the other discipline’s specifications.

3. Other Documents — Shall be individual PDF documents.

4. All Authors must upload their documents into the 310_Review Document folder under
the project in Projectwise.

Other Reviews

1. The only requirement for the organization of other types of reviews is that the
documents must be in PDF format.

7.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:
Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans:
a. Must be in PDF format
b. Plans must be in discipline subsets
c. Plans must be sized 34” x 22”
d. Do not need watermarks, sheet numbers or to be digitally signed.
2. Specifications:
a. Each discipline shall combine all of their specifications for review into one (1)
PDF document.
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b. Sized 8.5” x11”
3. Other Documents:
a. Must be in PDF Format

Other Reviews

1. Documents:
a. Must bein PDF Format

7.4.3 Uploading Digital Documents

Authors shall upload their digital documents into Projectwise in accordance with the following:
For Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Launch Projectwise and log in.

2. Browse out to the project this review is for and open up the 310_Review_Documents
folder and the specific review folder: If the three subfolders are not in the project
contact Mathew.Calkins@ct.gov

B8 ProjectWise Explorer V8i (SELECTseries 4)

Datasource Folder Document Export View Tools Window Help

N W 2 EEE] @ #A - searn B il <
4] - E:> - L’j Address | pwehctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0001-0999'310_Re
EIUJ ProjectWise Explorer Datasources il List |. Geospatial
-l CTDOT (mjc-admin) ‘ ‘ Name
-4 Documents E oo b -
<. =L 010 - Projects - Active > L /L' BOFOREV!W
T L% 0001-0100 /L 60% Review
- (%% 0001-0999 /[ 90% Review
' -4 1UU_Contract_Plans (PDF)
-4 110_Contract_Specifications_8_Permits (PDF)
-4 120_Contractor_Submittals (PDF)
-4 130_Final_Engineering_Reports_and_FIO Documer
-4 131_Engineering_Reports_Confidential
-4 140_Project_Administration
-~ 141 _Project_Administration_Confidential
-4 150_GIS
-4 151_Project Photos
+-4 210_Constructi
(L2 210 Construction Browse out to the
-4 220_FHWA,
-{" 230_Contract_Administration = 1
-4 240_Contract_Development appllcable prOJECt
w241 _Contract_Development_Confidential = gm =
\ /= and specific review
L7 30% Review
folder

{7 60% Review
t..{7 90% Review

1 220_Hermit_Development
- 330_Design_Data

E-{=7 500_Pre_Design

-84 Saved Searches

o[ 0004-0116

F-[ % 0004-0118

{7 0004-0133

j—-L_’* 0006-0122 | Project Properties | Folder Properties | Personal Po

Lo nnnT nen | —— - . Epp——

4|

RO e OO T e OO

Figure 130 - Projectwise Project

Issued 01-2016 134 Version 3.11


mailto:Mathew.Calkins@ct.gov

Connecticut Department of Transportation — Digital Project Development Manual

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

B ProjectWise Explorer V8i (SELECTseries 4
Documen: _Exgort(View ) Tooks Window  Help

T B © L4 s © - [gcmm)ew[:nm.
If the Interface

Address O pweVctdot.projectwiseonline.com:CTDOT\Documents\01.0 - Projects - Active\0001 10_Review Docume > [ GO

dl'opdowrl is not plorer Datasources = | Lst | @ Geospatial| "
mje-admin) stion File Updated File Upda
there, go to View>

ments
0 - Projects - Active (1) Make sure
£ 00010100

Toolbar>and make :ymx CTDOT Doc_Code

= ~ 100_Contract_Plans (PDF)
sure I“terface 1S 110_Contract_Specifications, is selected
checked

120_Contractor_Submittals (
1320_Final_Engineering_Repo
121_Engineering_Reports_Confidential
140_Project_Administration
141_Preject_Administration_Confidential
150_GIS

151_Project Photos

210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Review_Documents

HHUHHYHEHHHHHEE

;_ 30% Review

-7 60% Review

7 90% Review (2) Drag and Drop file
-+ 320_Permit_Development - . -
L 30 Design_Dete into this area in
I 500_Pre Design . .
# Saved Searches Project“"se

-2 0004-0116
75 onnd-n118

Figure 131 - Uploading Documents into Projectwise

4, Select Advanced Wizard

/ Select a Wizard E

Document &em
~|( B ca:

MNo Wizard Advanced
Wizard

J —
[1 Make this wizard the default.

Figure 132 - Advanced Wizard
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5. Click next until the attributes screen appears as shown below. Enter the correct
attributes from Table 2 below, and then click next until the document uploads.

Advanced Document Creation Wizard

Define Document Attributes
“ou should define environment specific documert attributes:

85

Discipline (1 ) Select

- e appropriate
Main Category Main Category Descri

CON v Contract Plans & Specs

Sub Category Sub Category Descrip

PRE w Plans_01 - Preliminary Pjghs (2 ) Type_
Project Number(s] approprlate

0004-0116_0004-0118

Label (User Defined)
30% -01-General v
Description

P1-General Preliminary Dasign Plans

CT Code {Auto Fill In)
CT_CON_PRE_00D4-0116_0004-0118_30% -01-General

\sset Tags

Signal Intersections

(3) Click Next
| L

< >

x

~

w

[ <Back Net> | Y Cancel

Figure 133 - Attributing a Document

The Label attribute must start out with 30%, 60%, 90%, or 100% where applicable. This allows
for the documents to be sorted together in Projectwise. Below are some examples:

Document Attributes
Document Disc. Main Sub Label Description
Category Category
Discioline 30% - 01-General, 30% - 03-Highways, etc.
Subrs)ets CT CON PRE 60% - 01-General, 60% - 03-Highways, etc. 01-General Semi Final Plans...
90% - 01-General, 90% - 03-Highways, etc
I 30% - HWY- Specs, 30% - SB-Specs . -
Specification CcT CON PRE 60% - HWY- Specs, 60% - SB-Specs Highway Semi Final Specs,
PD Statement CT REPORT Reports 30% - PD Statement Preliminary Design Statement
Cost Estimate CT CALCS Estimates 90% - Cost PD Cost Estimate
Bike CcT ANALYSIS Analysis 30% - Bike Assessment i.e. PD Bike Assessment
Assessment
CaIenEciz:r Day CcT CALCS Estimates 90% - Calendar Day i.e. SF Calendar Day Esitmate
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For Other Reviews

1. Launch Projectwise and log in.

2. Browse to the folder where the digital documents are to be stored.

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

=< ProjectWise Explorer V8i (SELECTseries 3)

Datasource Folder Document Tools  Window Help

A % 2| o e @ 84 - |searcn D v‘(Inteﬁa(elUDOT_Duc_Code |  viw| Document -

P BRI

‘Address [ pw:\\ctdot, projectwiseonline com:CTOOT\Documents\01.0 - Projects - Active\0004-0116 &!4-0118\310_F‘rel v [P Go

Select View> Explorer Datasources e
(mjc-admin) Label (User Defined) Description Msin Category | Sub Category
01.0 - Projects - Active

Toolbars>Interface
of the Interface box %57 o (1) Select

is not displayed i comi i CTDOT_Doc_Code

120_Contractor_Submittals (PDF)
130_Sol_Archasological_Misc_Reports FOF) 9§ t h e | n te rface
210_Construction

220_FHWA

230_Contract_administration
240_Contract_Development
241_Contract_Development_Confidential

#

310_Preliminary_Design_Documents(PDF)

320_Permit_Applications

330_Design_Data

340_Administration q

®
(SASACACAGARARASASARARAGARAS

341_Administration_Confidential
[ 500_Pre_Design
4 saved Searches

{*% 0003-0094

{*% 0011-0151

-7 0014-0177 (2) Dl'ag and dl’Op

{* 00140183

w % oot 033 file into this area
= 0017-0183 - - -
2 & omoun in Projectwise

{* no25-0118

PR NN

Figure 134 - Uploading Documents into Projectwise

4., Select Advanced Wizard

/" Select a Wizard El

=
& B

Mo Wizard Advanced
Wizard

Document Creapeh VWizards

[] Malke this wizard the defautt.

Figure 135 - Advanced Wizard
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5. Click Next until the attribute screen appears shown below. Enter the correct attributes
for the review documents and then click next until the document uploads. Make sure a
good label and description are entered.

Advanced Document Creation Wizard

Define Document Altributes
*You should define environment specific document attributes. frvl_

Discipline ( )
o« 1) Select
Main Category Main Category these

CON v | Contract Plars & Specs |

Sub Category Sub Category C

|soR | [ Approved Shop ey (2) Type in
Project Number(s) / these

[0004-0116_0004-0118 ‘ |

Label (User Defined)
tem# 0605252 v

Description

Structural Steel Shop Drawing Review

CT Code (Auto Fill In)
[CT_CON_SDR_0004-0116_0004-0118_ttem 0605252

——

H DOT Asset Tags
(3) CIICk \ Signal Intersections -

| 1\ N -
[ﬁ' ([ _net> ) coce |

Figure 136 - Uploading Documents

|-

6. Notify the Organizer that the documents have been uploaded into Projectwise.
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7.5 Phase 2 - Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: Note: The
example below is for initiating a Semi-Final review but can be followed for other types of

reviews.
1.
2.

Launch Projectwise Explorer from the shortcut on your desktop or the start

menu.

Browse out to the project’s 310_Review_Documents folder. (For other reviews browse

out to the folder in Projectwise where the documents are located. Note: The document

does not need to be in Projectwise to use Bluebeam’s Studio feature.)
B ProjectWise Explorer V8i (SELECTseries 4)
Datasource  Folder Export View Tools Window Help
| @ : @4 v Search [0 - b
4:! - I:|'> - I.!J Address | pw:\\ctdot.projectwiseonline com: CTDOT\Documents\01.0 - Projects - Active’\0001-0999'310_Rer
List |. Geospatial
Name
7 30% Review
/1 60% Review
Z17 90% Review

Document

a | 2

Bp 25 T

-

= UJ ProjectWise Explorer Datasources
Bl CTDOT (mjc-admin) ‘

=] Documents

_ 01.0 - Projects - Active

. 0001-0100

- 0001-0999

100 Contract_Plzans (PDF)

110_Contract_Specifications_&_Permits (PDF)

120_Contractor_Submittals (PDF)

130_Final_Engineering_Reports_and_FIO Docurmer

131_Engineering_Reports_Confidential

140_Project_Administration

141_Project_Administration_Confidential

150_GIS

151 Project Photos

210_Construction

220_FHWA

230_Contract_Administration

240_Contract_Development

241 _Contract_Development_Confidential

310_Review_Documents

-7 30% Review

i
LD 90% Review

o 320_Permit_Development

o-_ 330_Design_Data

i 500_Pre_Design

0-@4 Saved Searches

[ 0004-0116

o[ 0004-0118

H-[* 0004-0133

- L% 0006-0122

LB Ann meon

4

Browse out to the
applicable project
and specific review
folder

YRR

60% Review

1

[ B O WO e

| Project Properties | Folder Properties | Personal Po
S [ r

Figure 137 - Preliminary Design Documents Folder

3. Select all the documents to be included in the Bluebeam review session.

- SearcthQ v‘ = Interface|5ub Category 1 V| View‘Da(ument v
seonline.com: CTDOT\Documents\06.0 - ProjectWise Administration\01 - Administratorsih | [;P Ga
s List | @ Geospatial
Label Description Main_Cat Sub_Cat Cat_Description
,/' a 30% - 01-General 01-General Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
,/ a 30% - 03-Highways 03-Highway Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
7 E 30% - 04-Traffic 04-Traffic Preliminary Design Plans con FRE Flans & Specs_01 - Preliminary
7 a 30% - 05-5tructures 05-5tructures Preliminary Design Plans COoN FRE Flans & Specs_01 - Preliminary
30% - PD Statement Project 120-086 PD Statement DoC MDO Misc Documentation
4 E 60% - 01-General 01-General Semi Final Plans CON FRE Flans & Specs_01 - Preliminary
V4 a 60% - 03-Highways 03-Highway Semi Final Plans CON FRE Flans & Specs_01 - Preliminary
V4 a 60% - 04-Traffic 04-Traffic Semi Final Plans CON FRE Plans & Specs_01 - Preliminary
/ a 60% - 05-5tructures CON PRE Plans & Specs_01 - Preliminary

# Bl 60% - Cost

# Bl 60% - Hw-Specs

0zStructures Semi Final Plans
t Estimate
Highway Semi Fin;

review session

Figure 138 - Select Documents to be Included in Bluebeam Review Session
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4. Change the state of the documents to “Review” as shown below:

IMELIUA IO CUMENTS WD A - FIOJECTVVISE AOMINISTFATIONWL - AOMINISTEAIOS A ¥ | = @u

] List | & Geospatial|

Label Description

30% - 01-General 01-General Preliminary Design Plans
30% - 03-Highways 03-Highway Preliminary Design Plans
30% - 04-Traffic 04-Traffic Preliminary Design Plans
30% - 05-Structures 05-Structures Preliminary Design Plans
30% -PD Statement Project 120-086 PD Statement

05-Structures

Select View »

HHRNRNENNNNNS

Mew 3

Open

(1) Right click on the
documents and select
Copy ot "Change State>Next"

Check Out

rts (PDF) Export...
Start Studio Session...
lential
3(PDF) er Cop
Refresh Local Capy
Purge Local Copy
jetties | Photo Prelew | Dependency Service | Acces:
tion Project)
rts (PDF) GEl ename
GEl Delete
GEl Modify...
GE Madify Linear Attributes. ..
cEn  Modify Spatial Atirbutes...
lential Gy Add Comment
)
ASS|  set »
ASS SendTo v *
ASS Copy List To 3
ASS bt Y
D
Desi
Desi

Des SetFinal Status
Desit  Change filename to CT_Code Remove Final Status
Desi

Desi Edit attributes for multiple documents

Desit  Old Audit Trail Report
Design - Digially Signed

Plasinm - DO AL ITL

Figure 139 - Changing the State to Review

Then click OK next on the box that pops up. The documents will now be in the Review
state.

30% - 05-Siructures 05-Structures Preliminary Design Plans Plans & Specs_D1 - Preliminary Acrobat PDF REVIEW COMPLETE
Project 120-085 PD Statement Misc Documentation Acrobat PDF
01-General Semi Final Plans pecs_01 - Preliminary Acrobat PDF REVIEW

pecs_01 - Preliminary REVIEW

pecs_01 - Preliminary REVIEW

emi Final Plans N Plans & Specs_D1 - Preliminary REVIEW

timate L REVIEW

emi Final Specs, CON N Ot| ce Sta te C OI umn s REVIEW

SNRNNNNNNS

the state is Review

Figure 140 - State of Documents
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5. Next right click on the selected documents and select Start Studio Session:

ey T e R Al e

line.com: CTOOT Documentsi06.0 - ProjectWise Administration\01 - Administrators\h V| ’- Go

2 List | & Geospatial |
Label Description
/ 30% - 01-General 01-General Preliminary Design Plans
/ 30% - 03-Highways 03-Highway Preliminary Design Plans
/ 30%: - 04-Traffic 04-Traffic Preliminary Design Plans
/ 30% - 05-Structures 05-5tructures Preliminary Design Plans
./ 30% - PD Statement Project 120-086 PD Statement
r %,
Z8
§= Select View 3
1|
Vs Mew r b

Right Click on the
documents and select
"Start Studio Session”

“0r)
:_Reports (PDF)

Confidential Refresh Local Copy

aments{POF) Purge Local Copy
Cut
itial Copy
Paste...
£

Figure 141 - Start Studio Session
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6. Using the naming guidelines from the table below, type in the applicable review session
name in the box entitled “Session Name”.

Review Review Name
Preliminary Design (30%) Project #XXXX-XXXX PD Review
Structure Type Study Project #XXXX-XXXX Structure Type Study Review

Semi-Final (60%)

Project #XXXX-XXXX SF Review

Final Plans for Review (90%)

Project #XXXX-XXXX FPFR Review

Other

Include Project number if necessary and give a good description

of the review

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting
the Session Expires date is optional. If set, this date can always be changed after the session is

created.

Start Studio Session

=5

) %
Session Mame:  Project #0123-0123 PD Review

Uocuments

File name

r Y

v

Path

v4]| CT_CON_PRE_30%-04-T... PW:ctdot projectwiseoriin...
CT_COM_PRE__30%-03-H... PW:ctdot projectwiseonlin. ..

Options

Pemission

Save As
Prirt
Markup
Markup et
] Add Documents

Restnct Mtendees by E-mail Address

Session Expires May 22, 2015

= Do

[E~ || 3:00PM |5 ,

(1) Type in the
session name

_. (2) Uncheck

(3) Optional - Set if

/ necessary

— (4) Click OK

Issued 01-2016
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7. Inthe next dialog box click copy invitation as shown below. The invitation will be copied
to the clipboard of the computer and then can be pasted into an email or memo.

Session Invitation

Session Information

Session Mame:  Session

Session ID:  068-578-012

Invitzes

Copy Invitation

B

E-mail Address

Click to copy
invitation to
L__clipboard

= [@

Message (Optional)

Note: A Session is limited to 500 Attendees

Figure 143 - Adding Email Address to Studio Session

Next paste the invitation into a blank Word Document or email. The following is an invitation
that has been pasted into an email. Note how the session URL appears in blue. Then you can

copy the URL from the blank document or email into a formal memo.

3 EH9 T |= Untitled - Message (HTML)

File Message Insert Options Format Text Review Developer Adobe PDF

=) SBH @;‘l @ J@ /?’ EIJ ¥ Follow Up ~ \:
=¥ High Importance

E 5= | Address Check | Attach Attach Signature | Assign Zoom
Book Mames | File Tem= - Poliy- & LowImportance

Clipboard ] Basic Text ] Names Include Tags 2| Zoom

Calibri Body * 11 = A" A7 | F

i}

Paste
- < Format Painter

B I U ¥-A-

= B =

=@

Subject:
You have been invited by M. Calkins AEC Applications (mathew.calkins@ct.gov) to join a Bluebeam Studio Session:

Session
Session 1D: 08528012

Session URGﬁps:/{'studio“ b ..com/ioin.htmI?ID:0687578'013 I - If needed copy URL
Mathew Calkins, P.E. into formal memo.

Transportation Engineer 3

AEC Applications

Connecticut Department of Transportation
2800 Berlin Turnpike

P.O. Box 317546

Newington, CT 06131-7546

860-594-2988

Mathew.calkins@ct.gov

1 i

Click on a photo to see social netwark updates and email messages from this person.

Figure 144 - Session URL
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7.6 Phase 3 - Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:
For Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes
the following:

1. Atable of all documents that are in the review session.

2. Links to relevant documents that are not included in the review session but still need to
be referenced. These documents shall be located in Projectwise and Projectwise links
shall be included. (Not shown in the example below)

3. Alink to this manual (Digital Project Development Manual)

4. Alink to the Review session. To do this, paste the invitation that was copied when you
created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the
Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s
responsibility to compile a complete distribution list so the review invitation gets sent to the
applicable personnel. Below is an example of a memorandum for a preliminary design review:

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modem Roundabout
Route 188 at Route 334 and Holbrook
Road
Town of Seymour

memorandum date: December 11, 2012

10: THOSE LISTED BELOW from: Wiliam W. Britnell List all documents

Transportation Principal Engineer

Bureau of Engineering and Cunslrur.liun/ in the review and

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment our
e e ey o o e et leatn revioes o et v contfone o who authored them
recommendations to the following Preliminary Design Documents included in the digital ga#ffew referenced
below, by Tuesday, January 8, 2013
[ [ |
Document Document Author -
[LGeneral [ ighway Design ) Include a link

Comments and recommendations shall be applied to the documents in M to the Digital Project
d
peument Cj_i ital Project Development ManuD Development Manual

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session

t Invitation to live Review of the Preliminary Design of this prmeaﬁ—
Units that receive paper plans can review the documents on paper, but must transfer their comments to the Include the link

digital pdf documents in the above review session.

to the review session

A Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 at 1:30pm in Room 3130 of
the Department's Administration Building, 2800 Berlin Turnpike, Newington.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594-

3342 should you have any questions or require additional information

DISTRIBUTION:

Thomas ). O'Hala Leo L. Fontaine - Michael F. McDonnell

John DeCastro Gregory M. Dorosh

Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi

Delois L. Barnes Donald Ward - Mary Bajer - Hard Copy to Follow

Mark W. Alexander - Kimberly Lesay Colleen A. Kissane
Leo L. Fontaine - EdgardoD. Block
Lewis 5. Cannon - District 4 (Acting District Engineer) - Hard Copy to Follow

Attachments
Stephen Hall/sh

Figure 145 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to
the end of the review session.

For Other Reviews
Invitations for less formal reviews may not require a memo. It is recommended that an email be
sent which includes the links to this manual and the review session.
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7.7 Phase 4 - Digital Review

7.7.1 Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a
preliminary design review, or for less formal reviews, click on the link in the email. Below is an
example of an email for a preliminary design review (semi-final). Remember the link to the
review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

<

U0 @) From

Subject

4 Date: Today
.4 @ Bourgoin, Bruce R

4 Date: Last Week
DOT Webmaster
1es DPD Manual =
[~4 DOTWebmaster
[~ Savader Asset Advisors LLC

(1) Open the email
from the Review
Organizer

Bentley Technical Support
Molly Watts@bentley.com
Pratt, William S

Richard, Elaine H

Rinaldi, John 5

Robert Brickley

Rinaldi John S

tp, DOT

DIDDDDPE

(2) Open the Review

Memorandum

i

Chhabra, Greg M
Maolly Watts@bentley.com
0 Hanley, Richard C

€1IDBADT@REMTI EV AR

{4 PilePro
=]
b=d
=]

Issued 01-2016

RESHQ3 Conf Room 3130, DOT  Accepted: Smart Board

Project 120-086 Semi Final Review

ConnDOT eAlert: News from the Con|
ConnDOT edlert: Construction News
Bloomberg Public Finance Conferen
RE: AEC Applications Database

ConnDOT eAlert: Construction News
ConnDOT eAlert: Construction News,

Received Size
Mon 10/1/2012 7:36 AM 51 KB
Mon 10/1/2012 1:40 AM 95 KB

File Message

i

=] + ¥ |5

Bluebeam ProjectWise

x —ﬁ] —ﬁk] _$ [5] Meeting

Project 120-086 Semi Final Review - Message

(=8 New e-mail to: N3 S Rules- (¥ Mark Unre:

Before it's too late

RE: proj 25-138: Pilot projectwise Chi
RE: Code Changer

FW: Bluebeam PDF problem

How did we do?

RE: ST Mumber: {ticketno:[300146157¢
FW: 10:30

RE: [GWGA] CT DOT DDE question
RE: [GWGA] CT DOT DDE guestion

RE: Projectwise
JFM

VAC 09/28/2012
sinar: Next Gen Imag
20T DDE question
- Board

Webinar Oct 2: Designing Combined
Using the 84" interactive board in §
RE: ST Mumber: {ticketno:[300146157¢

Bluebeam PDF problem

ST Miimbar firlabnn RANTAST ETATL

) 3 Reply Al - A onehote B Categorize
« Delete | Reply Reply Forward & - Move
& Junk A 2 More (23 test ] Actions - | ¥ Follow Up
Delete Respond Quick Steps Move Tags
From: Bourgoin, Bruce R
To: Calkins, Mathew J
Co
Subject: Project 120-086 Semi Final Review

Please read the attached Digital Review Memorandum for State Project 120-086

Project 120-086
Semi Final Rev...

Bruce R Bourgoin, P.E.
Transportation Supervising Engineer
Division of Design Services

Architecture, Engineering & Construction Applications

Connecticut Department of Transportation

860-594-2760

Bruce.bourgoin@ct.goyv

Figure 146 - Review Memorandum
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2. Click on the link to the Review Session.

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modemn Roundabout,
guutde 188 at Route 334 and Holbrook
oa

Town of Seymour

memorandim date: December 11, 2012

10:THOSE LISTED BELOW from: William W. Britnell
Transportation Principal Engineer
Bureau of Engineering and Construction

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment for your
use in the preliminary desizn review for this project. Please review and apply your comments and
recommendations to the following Preliminary Design Documents included in the digital review referenced
below, by Tuesday, January 8, 2013

[Document [ Document Author |
| o1-General | Highway Design

Comments and recommendstions shall be spplied to the documents in accardance with the following
document.
Digital Project Development Manual

The following is 3 link ta a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session.

( Invitation to live Review of the Preliminary Design of this DrniEM
Units that receive paper plans can review the documents on paper, but must transfer their comments to the Click on the link

digitsl pdf documents in the above review session

the Department's Administration Building, 2800 Berlin Turnpike, Newingten.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594~
3342 should you have any questions or require additional information.

DISTRIBUTION:
Thomas J. O'Hala Leo L. Fontaine - Michael F. McDonnell
John DeCastro Gregary M. Darash
Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi
Delois L Barnes Donald Ward - Mary Baier - Hard Copy to Follow
Mark W. Alexander - Kimberly Lesay Colleen A. Kissane

Leo L. Fontaine - EdgardoD. Block
Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Capy to Follow

Attachments
Stephen Hall/sh

Figure 147 - Link to the Review Session
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3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the

webpage as shown below:

|~§" https://studio.bluebeam... O ~ @ € || (& Bluebeam Studio ‘ ‘

(===

i} 28

s [ Transmittals - All tems .« Installing SharePoint 2013 ... F% Sean Keene's Blog - Peer... [ Documents - All Docume... [[7] Signin to Office 365 2 eB

»

oining Bluebeam Studio Session...

Session: 600-702-866
Unable to determine if a compatible version of Bluebeam Revu or Vu is installed. If the meeting does not open click here to download Bluebeam Revu or Vu.

\ Ignore this text

To join a session click
Allow
N\

Internet Explorer

[ . ) AMllowing web content to open a program can be useful, but it can
\a potertially ham your computer. Do not allow it unless you trust
- the source of the content. What's the risk?

Figure 148 - Accessing the Review Session

Bluebeam will now launch. If this is the first time in a review session, a Studio Account

must be created. To do so click on Create Account and then enter in a State email
address and a password. In the Name box type in the First Initial then Last name and

unit. See below for an example.

Login

If you do not

Studio Server:  studio bluebeam.com

Domain / E-mail:

have an

Password: |

account click e —

pa: ord

Lost Password

create account

Create Account

[ Use Windows Authentication

Figure 149 - Creating a Studio Account

Create Studio Account

&
&

/

E-mail: mathew calkins@ct.gov

Password:
Corfirm:

I Remember password

Select

M. Calkins AEC Applications

q?:

Login with Existing Account

Figure 150 - Studio Session Account
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If this is not the first time in a review session, enter the studio login information as shown
below: If you forgot your password click lost password and an email will be sent to you.

Please review and apply your and recom d to the Semi Final decuments in
the review session referenced below by September 28, 2012, Comments and recommendations
shall be applied fo the documenis in accordance with the following document. This document
contalns instructions for steps that need to be completed before joining the review session above.

LDigital Deslon Review hanual

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the
fallowing link to join the review session.

Invitation io live Review of the Prelimin. sign of this projec

The Semi Final Design M

Department's Ad
E-mail: ¢ ins@ct
Please contact Project B mathew calkins@ct gov
‘assword:
DISTRIBUTION:
Highway Design Remember password Lost Password
Hydraulics

Construction

Create Accourt

Attachments

Malhew Calkins/co
cc: James H. Norman

Enter your studio
session email and
password and click
OK

Figure 151 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam
Profile, See Appendix A
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7.7.2 Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for
commenting, the attendees of the session, and the documents in the session. On the bottom,
there are the list of comments.

Form  Markup Help

BSOSO N i/ QND A~

& CONNECTICUT DEPARTMEReview Session Tab ATION (@)
ROTARY UPGRADE 'rg."unn:nu DAIINNDARNANIT
sty ROUTE 188 ATool Chest for

AND HOLBF
Yo i
seyy Review Tools

Status in the
zreview session
A

Click here to
open comment

List of Comments

0124-0162  [5i]

Record | Notdications  Pending

Figure 152 - Review Session Layout

All comments that are made get saved instantly to the Bluebeam review session; these do not
need to be manually saved. Each user can only delete their own comments and can leave and
rejoin as many times as they want as long as the review session has not been closed. The review
session will be closed by the Organizer in accordance with the date on the review memo.
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7.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital
review. Reviewers may print digital review documents to paper by going to File>Print and mark
them up; however, they must transfer these comments onto the digital review documents in
accordance with this section. If a unit cannot print their own paper copies they should contact
MaryAnn Cass by email MaryAnn.Cass@ct.gov. Inthe email include the project number and list
documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments,
will become the final record.

All comments associated with a design submission should be applied to the digital documents,
including any email or phone call comments. These types of comments must be applied, by the
staff member who received the email or phone call, to the correct digital document, use
engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note
markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text
from any source such as an email or a Word document. This allows larger project wide
comments to be applied to the plans.

v File Edit View Document Form Markup Measure Window Help

k- wil om- 4 PARAR S5 B SN
New Open

-

= Print E-mz Studio Shapes Image Hyperink  Attachment Stamp

‘.-:E';'"g"\/?r‘ﬁq' By o« Q i l}_’/’i ..

- W
¥ R £ @& 151-273 wall OH Cant X-Sections 2* = ifee M

|E Mote N o '

Recents Flag  Shift+F
B 151273 w__.

Figure 153 - Note Markup Tool
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Note about Commenting in a Review Session and Supervisor Approvals

In most cases, the unit that reviews a document has an internal approval process whereby the
supervisor finalizes the comments from staff members. The workflow described in this Chapter
does not specify or dictate an approval process within each unit; rather, it outlines the review
procedures once the review comments have been compiled from each unit. Therefore, it is
important that only the reviewing unit’s final comments be added to the review session. Once
the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review
process is flexible for any procedure a reviewing unit develops. The only restriction is the final
comments must be placed on the digital documents located in the review session before the
reviews session ends:

1. Alower level employee can join the session and comment on the documents in the
review session. Then the supervisor can join the session and filter out their
subordinates comments for their review. If there is an issue with a comment the
supervisor will have to direct the lower level employee to fix that comment. If there are
not any issues with the lower level employee’s comments then nothing has to be fixed.
After this supervisor review, a lower level employee will join the session and fix the
applicable comments. In section 7.1 of this manual there is a list of advantages to using
this digital review process. With this option, all of these advantages are realized.

2. Alower level employee can join the review session and save a copy of the review
documents to their computer. Then they can markup the documents offline and have
their supervisor approve those comments. After the supervisor approves the
comments, those comments can then be imported into the documents in the review
session. In section 7.1 of this manual there are a number of advantages to this digital
review process. With this option, advantages 3 and 4 are eliminated due to the
comments made offline.

3. Alower level employee can join the session and print the documents in that review
session. Then they can markup the prints and have their supervisor approve the
comments. After the approval, a lower level employee can transfer the comments to
the digital documents in the review session. In section 7.1 of this manual there is a list
of advantages to this digital review process. With this option, advantages 3 and 4 are
eliminated due to the comments made offline.

Notes about Outside Entities that will not Participate in a Digital Review

If an outside entity such as a railroad or utility company will not participate in a digital review it
is still important to add their comments to the final record document in Projectwise. It is
encouraged to have these entities participate in the digital review and AEC Applications is
available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to
those comments shall be attached to the final record document in Projectwise:
1. Create a PDF document that includes the non-participating outside entity’s comments
and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in
Projectwise in accordance with section 7.9.1.
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Reviewer
1. First set your review status to Reviewing by clicking on the drop down shown below:

Note: If you leave the session and return your status will stay as Reviewing.

Set Status

18 TEZ AEC Ap... CT_CON_PRE-SF_0120-008,

Figure 154 - Set Status to Reviewing

2. Next select a document to review from the studio session tab. The document will open
up and can be reviewed.

"SUBSET 05" - "STRUCTURES"
INDEX OF DRAWINGS

Select a document =
to comment on

Figure 155 - Selecting a Document to Comment On
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3. Select a commenting tool from the tool chest and mark up the plans. If you do not have

the CTDOT Review Tools show below, follow Appendix A to have them imported in the

Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to
them in Bluebeam.

ing Review Tools

Comment

816 Stamps

January Supplements to
the 816 Stamps

Figure 156 - Bluebeam Commenting Tools

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool
development.
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MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow,
cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have
a note when you type text, but the non-text tools can also have a note attached to them. To
attach a text note to a non-text tool place the comment and then double click on that markup.
Then you can type in your note. The text note box must be closed after the comment is made
by clicking on the X in the top right corner of the note. The example below shows a note being
attached to the cloud tool the correct way:

1.Place Cloud 2. Left click on the 3. Double click

cloud so the on the cloud
yellow circles and type text

show /

Update Road Lis{ E
LITY LENGTH

ROUTE 77 N/A
ROUTE 80 N/A
ROUTE 146 N/A
ROUTE 33 N/A
ROUTE 106 N/A
ROUTE 123 N/A
ROUTE 124 STATE N/A

aNVv1SI

MAINTENANCE
F.A.P. # RESPONSIBILITY PROJECT #
000R(825) STATE 173-440

Figure 157 — Correct Way to Add Text to a Non Text Commenting Tool

General Project wide comments can be placed on the first sheet of the document using the note
markup tool located in the tool chest. Text can be copied and pasted into the note tool as
necessary.
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4. After you have completed your set your status to Finished.

Note: You can still enter the session if your status is set to Finished. You can also change your
status back to Reviewing if necessary. This status is for the Organizer so they know which
Reviewers have completed their reviews.

Set Status

~ Aitendees 7
i‘ M. Calkins AEC Applic... CT_CON_PRE-030_0120-.. / ]

Figure 158 - Set Review Status

5. Create a review comment report of your comments. First filter out the comments so
only your comments are displayed as shown below:

Eoa BE v A <

| Y Filter )E |iji| Columns + 4* ‘ O 6 Vv~ | LB Summary ~
" huor e - (2) Click
[Al]
' The bituminous material specified for use in the ooy

" p Lt S R SUCSOTY Page 03.02
t;l:ttuﬂg?socsqlngze Surface’ item is 0.375"HMA Construction D1 - M. Cakins TE2

Qo Do N (CD orl::z;l:? :,K;elgse; :f;r:;;e Conetniction N1 - M Calkine TE? P=je 03.02 (3) Select your
(1) Select &S name

ial specified for use in the Construction D1 - M. Calkins TE2 Page 03.03

F i Ite r Surface’tem is 0.375"HMA

01 the raised splitter Islands  Construction D1 - M. Calkins TE2 Page 03.03
show a stamped concrete pattem, please indicate
this on the typical sections.
. Are there proposals for utility relocation prior to Construction D1 - M. Calkins TE2 Page 03.05
start of construction?

Figure 159 - Filtering Comments
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6. Now that the comments are filtered by your name create a comment report as shown
below:

sTATH OF W""‘nwur@lulum OF ENGINEERING |ROUTE 15 SAFETY
DEFARTMENT OF o R ERtoor Db

Select Summary

XML Summary and select PDF
PDF Summary S umma ry

FrinL Surminary

Capture Summary

Figure 160 - Creating a Comment Report

Next type in a title for the comment report that includes Project No, What review it is plus the
word “Comments”, and what document this comment report is for. See below for an example:

Project #iHi#-#### Semi Final Review Comments 03-Highways

Make sure all the settings are set as shown below and click OK:

PDF Summary E|
(Page Range \
Pages |All Pages (1-5) w [of 5
Summay Opions _ (1) Make sure all
7S .
Exclude Fitered Markups these settlngs

Exclude Hidden Columns

are selected

POF Cptions
Include Totals Include Page Content

Title:  |Project 0121-0980 Semi Final Review Commerts 03-

Style: | Flow W
Proview: T -
Page Size: |Letter b

(%) Porirat ) Landscape ) 2 C I iC k
Bt

Figure 161 - Comment Report
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7. The comment report will now be created and opened in Bluebeam, leave the comment
report open in Bluebeam. We will be copying this report into the comment report
memo.

8. Next save the following review comment memo to your computer: Review Comment
Memao.

9. Open the memo and fill in the correct information.

10. Then copy all the pages from the comment report as shown below:

@ @ Fe Edt View Document Fom  Makup  Measuwe  Window  Help
vhw T 5

e (2) Select the

: Bl thumbnail view

ks i b Y 7 & LR SV st A

)-0086_03-Highways Review Comment Memo CT_CON_PRE-SF_0120-0086_03-Hig... * *

(1) Click on the
b Pogesetip.. comment report
document

Copy Pages

Copy Page to Snapshot  Ctrl-+AIt+C

(3) Select all
pages and then
right click on them S ale) e
and select Copy Pages b Exvactboges..  ChliShRiX

d Replace Pages... Cirl+Shift+Y

Apply Stamp...

. InsertBlank Page... Ctrl+Shift+N

p  Rotate Page Ctrl+shift+R
B Number Pa

Export Pages

E-mail Pages...

Print Pages...

Repair Page Content

Flatten... Ctrl+Shift-+M

I
[V Fter S| i cobrs - 55 [ X S B - 25 V- [ B sumary -

Author

Markup Summary

Figure 162 - Copying the Comment Report Memo
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11. Then paste the pages into the memo as shown below:
File Edit View Document Form Markup Measure Window Help

- smq

Pint  Ema

(2) Select the
thumbnail view

e I F & 00 SV AR

03-Highways Review Comment Memo*® % (T_CON_PRE-SF_0120-0086_03-Highway...*

ubject: Review Comments
DEPARTMENT OF Project No, 120:086
s FAP Project No. FAP 0125R

==\ (1) Select the comment
=—— report memo document

M Pratimnan Stidine 31 Samiinal (0% - 70%)

(3) Right click below

Page Setup... e

the thumbnail of

L the memo and select
Canv Dana tn Snanchnt Cirlaaltar paste pages

Paste Pages it Ao 8.

Apply Stamp...

Insert Blank Page... Ctrl+Shift+N
Insert Pages... Ctrl+Shift+I
Extract Pages... Ctrl+Shift+X
d Replace Pages... Ctrl+5hift+Y
Rotate Pages... Ctrl+Shift+R

Number Pages...

Export Pages

e maoges. Ve

&= PrintPages... - n
v BB simay -
Repair Page Content PE 5

Figure 163 - Pasting the Comment Report Pages

12. Save the memo and process this memo as your unit requires.
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7.8 Phase 5 - Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per
the date on the review memorandum.

1. Click Finish to close a Bluebeam Review Session as shown below:

EDR*

& X reave W Finisn /B

" Sesson
ect 0120-0086 PD Review - 197-367-177
Status:
v Atendees i
% M. Calkins TE2 AEC Ap.. CT_CON_PRE-PD_(M20-0086_. V4
. .- . B Boun i
Click Finish i |

=
L

"SUBSE

( N_PRE-PD_(120-0086_03-Highways pdf
I N_PRE-PD_(120-0086_04-Traffic. pdf

N_PRE-PD_0120-008
ON_PRE-PD_0120-008

EidrOon

PRE-PD_0N20-008 st Estimate pdf

C_PRE-PD_0120-0036_PD Statemert pdf

DRAWING TI

Figure 164 - Terminating a Session
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2. Make sure all the reviewers in the list below are selected (they will be by default) and

the Save (Overwrite Existing) button is checked and click OK.

Finish Session

Include Markups

FMIS RFI Review - 844-141-744

=5

MName

M. Calkins
B.Bourgoin Supervi...
H. AbdissaTEI AEC ..
mahoneylkm

E-mail i

mathew calkins @ct gov |E |
bruce bourgoin@ct.gov

henok abdissa@ct gov . Ve ry I m po rta “ t -

kevin mahoney@ct.gov

4| 1]

' " Make Sure this is

/ selected

@ Save (Overwrite Exdsting)

) Save In Folder

) Do not save files

Report Cptions
[7] Generate Report

D:\Users'calkinsmj\Documents

[ Close files after finishing

D:M\Usershcalkinsmj\Documerts PMIS RFI F

Figure 165 - Terminating a Session

3. Click OK in the figure below.

Issued 01-2016

Finished...

01 - Administrators . Mathew Calkins“\Digital Review Examples’.124- -
162_Session 14310_Review_Documents\CT_CON_PRE__30% - 04 -
Traffic.pdf. 102693.1...

CT_CON_PRE, s pdf checked outto

PW ctdot projer = DOT06.0 - Project\Wise Administration
\01 -Adminite GG K \Digta Review Bamplest 12
162_Session 1" nts"\CT_CON_PRE__30%-03 -

|Highways.pdf.1 0 K

«

Bluebeam Revu xb4... 100% ER

Figure 166 - Overwriting Existing Documents
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4. Close Bluebeam Revu and check in each document to Projectwise. Note: A check in box
will pop up for each document in the review session.

Check In
“General |
Documents
Name Label (User Defined) Description Main
'{a CT_DOC... PD Statement Project 120-086 PD Statement poC

< |

Folder: 06.0 - ProjectiVise Administration'01 - Administrators\Mathew
Calkins\0123-0145310_Preliminar

[ create new version during Check In . S e I ect C h ec k I n
/

Version: |

&

Check In u Update Server Copy ] [ Free ] [ Cancel
-

Figure 167 - Checking a Document Into Projectwise

5. Notify the Document Authors that the session has been closed so they can resolve the
comments on their documents.
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7.9 Phase 6 - Resolve Comments

This section shows how the comments from the review session will be resolved by the
Document Authors. After the comments have been resolved in the PDF documents located in
Projectwise the Document Author shall notify the Organizer that they have finished applying
their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review
Organizer will notify the Document Authors when the session has been finished. If the
document authors go into the documents located in Projectwise before the session is finished
there will be no comments on the documents.

7.9.1 Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on
the digital PDF review documents using Bluebeam. The following shows the steps for resolving
comments.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

| Y Filter :1— o o> l;'l % o v - |E-' s Summary ~
Subject 4 Author
+ Link doesn't work (1)
* Cloud i work M. Calkins TE 2 AEC Applications 10/2/2012 B:05:33

+ Wrong Date (1)

(1) Right click S—
on a comment e (2) Select
e Reply

Figure 168 - Comment Resolutions
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3. Inthe box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.
Resolution — Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document
Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:

Type in a resolution
in the box

Author

: rattankd
ost. 1t &l 1as the benefit of
ater harg.: #‘u:l_u:lrtn:una y, Iltlhin

e: Text Box o Resolution: Included - This e Townto  Hallsd
correction will be made on I i

deratic
This Pole S

te: Cloud e is con 2c Hallsd

rattankd

Hallsd

rattankd

Figure 169 - Typing in a Resolution
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| | 'V Fiter § mns i [ Summary. -
Subject Author S Do Page

—— §(1) Sort by Author

~ CMarie District Drainage Eng -

~  HendricksonGW (2)
- 4 Coud

» HendricksonGWautilities (1)
Test Box enc es 6:56 AM Page 01.01

- Al dffarances in arade wil and then conminatad at the firt it

Figure 170 — Resolutions

4. Next attach a PDF document that includes any non-participating entities comments with
your responses to the review document. This should be done by adding that PDF
document to the end of the review document as shown below:

Qo File Edit View Document Form Markup

o9 9 R

e Print == ] atures - =
r stamp...
EeswESEfcm-SFeveRin- ks

- =ﬂ Pages from 03-Highways_CT_FDP_0043-0128* = [ Insert Pages... Ctrl+Shift+«1 o

R o= 25000

Insert Blank Page... Ctrl+Shift+N

INSEIT LayEerea Fage...

Add the document by Insert from Scanner... @
. ] selecting Documel‘lt> Extract Pages... Ctrl+Shift+X

RELD

Split Docume ;
Split Document... SIDEWALE RAMA |
([ (TYPE $E}

Replace Pages... Ctrl+Shift+Y

Delete Pages... Ctrl+Shift+D 4?;?&2”1’?5“513';5
b 15D - GRANTTE
Rotate Pages... Ctrl+Shift+R STONE |CUREY

; WruRE

Crop Pages... Shift+Alt+0 3 (=1

Number Pages...

COPCRETE 5
H PAWING BRICK

Figure 171 - Attaching Comments
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5. Browse out to the PDF document you want to add and then select to insert after the last

page:
.
Insert Pages | E3 |
Insert Files
File Path Pages

4] | 20152-EC pof D\Usershcalkinsm...  All{1-3 of 3)

F Y

L

Options

[ Include Bookmarks [7] Use Filename as Page Label

[7] Include Fil Attachmerts Select After
and Last Page
"and then click

OK

) Page: |12 of 38 ¥

)

Figure 172 - Adding Comments

[] Merge Document Properties
[] Merge Layers

After

6. When all the resolutions have been applied, make sure to save the documents and

check them back into Projectwise.
7. Notify the Review Organizer that you have completed your resolutions.
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7.10 Locking the Review Documents after the Review

The Organizer shall change the state of the documents to make them document read-only after
the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in Projectwise to “Review
Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed”
as shown below:

qutney - - | g u

Ust | @ Geespatial
Label (User Defined) Desaription Main Category

Select View

Hew

Creckout (1) Right click on the
documents and select
"Change State>Next"

Copy Out

Export.

Start Studio Session. ..

Refresh Local Copy
Furge Local Copy

cut

Copy
Delete
Modify.
Modify Linear Attributes. ..
Modify Spatial Attributes. ..
Add Comment
Set »
— SendTo » I
Document Fropsties | Copy Lst To » Previe® | Dependency Service | Access Cartrc
i
— Batch Print o Propel
cT_cc
m SetFinal Status 0.
CTDOT
POF Change flename ts CT_Code e
Digital
| | Ecit attributes for multiple documents R
Old Audt Trail Report e
Status Checke

Version
File Reviinn

Figure 173 - Changing the State to Review

AWNE.COM:LIVUNUBCUMENTS 6. - FIOJECWISE AOMINISTIATIONIWL - AQMINISTAtors\ ¥ | = L0

List | @ Geospatial

bel (User Defined) Description Main Category  Sub Category Sub Category Description Application State

' B 01-General Ccon PRE-FD DOC_01 -Preliminary Docs ~ Acrobat PDF REVIEW COMPLETE
' Bl 03-+ighways con PRE-PD DOC_D1-Preliminary Docs ~ Acrobat PDF REVIEW COMPLETE
' B) o4-Traffic Ccon PRE-FD DOC_01 -Preliminary Docs ~ Acrobat PDF REVIEW COMPLETE

' a 05-Structures CON PREPD DOC_01 - Preliminary Docs Acrobat PDF REVIEW COMPLETE

:E 30% Specs I0C_01 - Prefiminary Docs REVIEW COMPLETE

- Bt e mossrosmenee NOtICE State column, M et s
the documents are
now in the Review
Complete state.

Figure 174 - Review Complete State
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2. Then right click on all the documents again and select Change State > Set Final Status.
This will lock the documents.

- General Bridge Mo. 05579 60% Submission Acrobat PDF

Mew [ Acrobat PDF
Acrobat PDF

Cpes Acrobat PDF

Open as Read-Only . Acrobat PDE

Open With... q Acrobat PDF

Markup f Acrobat PDF

View Acrobat PDF
Acrobat PDF

Check Out

Check In

Free

Copy Out

Export...

Import

Start Studio Session...

Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy

p |: Refresh Local Copy |

Purge Local Coy
| Document Properties I g = dency Viewer | Access Control | Components
Purge Workspace ”

«fj

|Rea| (Docum v”_

Cut -
MName 4 Document Security

Enter filter here 9 e =3 | ﬂ?ig | )( | U | / EF_-. | I-—L‘:] |

Paste...

Copy To...

Move To...

Rename...

Delete

DMScenform 3
Modify...

Modify Spatial Attributes...

Delete Audit Trail

Add Comment

Set 3
Send To 3
Copy List To »
Change State 3 ' Mext
Batch Print 3 e

Change...
Properties...

( Set Final Status

Change filename to CT_Code "W
Edit attributes for multiple documents I

Figure 175 - Setting Final Status

3. Send out Completion of Review Memo to all the personnel associated with the review
session indicating that the review session is over and all comments have been resolved
on the documents in Projectwise. Create a comment report of all the comments from
each review document and include that in the memo. Link to: Completion of Design
Review Memo
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Section 8 Design Phase Project Scheduling

A directive was issued to establish protocols and minimum requirements for design-phase
scheduling. Link to Directive: 2015-8-E. The Project Management group within the AEC
Application’s unit in cooperation with engineers from several engineering divisions, are
facilitating the implementation, training, maintenance, and evolution of the Scheduling
Directive.

An Engineering working group evaluated several scheduling software options to support the
mission statement. Microsoft Project 2010 was selected because it offers the following features
and advantages:

e Accommodates any number of milestones and tasks (i.e., easily scalable),

e  Graphically displays series and parallel tasks,

e Provides baseline and tracking Gantt charts,

e Displays the critical path,

e Ability to link notes and documents, and

e Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following
minimum requirements:
1. Includes all the activities identified by the Minimum Requirement Schedule
Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
Task Indicator columns are used to link applicable instructional and reference
documents,
Explanations for changes in task durations are added as task notes,
Tracking View/Gantt chart functions are used,
Task-level progress is tracked regularly,
Files are stored in the ProjectWise project container as indicated by the Digital

w

A

Project Development Manual, and
8. Microsoft Project files are maintained and current, with projected schedules in
accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs
are as follows:

e Bridge Design — Kevin Blasi and David Gruttadauria

e Consultant Bridge Design — Derick Lessard and Marc Byrnes

e Highway Design — Scott Bushee, Jordan Pike, and Vitalij Staroverov

e Consultant Design State Roads — Nilesh Patel and Meredith Andrews

e Trdffic Projects Design — Barry Schilling and Michael Chachakis

e Traffic Studies & Safety — Erika Lindeberg, Daniel Veronesi and Colin Baummer

e  Facilities Design — Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding
discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer
(Nicholas.Langer@ct.gov).
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The table below details the minimum tasks included in the template:

Table 3 - List of Minimum Tasks

Task Name

Project XXXX-XXXX

Project Initiation

Prepare and Submit PPI

Prepare and Approve RPM

Secure Funding/Authorization

Prel

iminary Design

Survey

NEPA/CEPA

Develop PD through Design Approval

Design Approval

Final Design

Prepare Semi-Final Design Submission

Prepare Final Design Submission

ROW Coordination

Prepare and Submit Final Accepted Property Maps

Acquire Properties

Permit Acquisition Process

Permit A

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

Permit B

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

Permit C

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

FDP

DCD

ADV

The Minimum Requirement Schedule template is stored in ProjectWise and can be found here:
AEC Scheduling Documents (Minimum Req)

ProjectWise user guidance is presented in section Error! Reference source not found..
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8.1 Microsoft Project File Set Up

The following steps show how to set up a Microsoft Project file:
1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise
V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:
IF 3

| www.bentley.com -

. COMMECTION client

. Dgn Index Service

. i-model ODBC Driver for Windows 7

. InRoads Group Vi (SELECTseries 2) Langer, Nicholas A.
. MicroStation V8i (SELECTseries 3]

. ProjectWise Deliverables Management || Documents
. ProjectWise V8i (SELECTseries 4) Pictures
E Administration - Geospatial Map Eni
E Map Author - Geospatial Map Engin Music
'ﬁ'pg ProjectWise Administrator =
B ProjectWise Explorer Computer
. Administrative Tools
. Documentation Tl e
. iDesktop Integration
. Tools Devices and Printers
. StormCAD VEi
Bluebeam Software Default Programs
Garmes
Google Earth Pro 8 Help and Support
1 Back

| Search programs and fites 2| NEEEE
Blecllalalrle e

Figure 176 — Launching Projectwise

2. Then double Click on CTDOT and then sign into ProjectWise with your username and
password. If this is your first time logging into Projectwise, you will be asked to
create a working directory, click Yes:

o ProjectWise Explorer V8i (SELECTseries 4]

Datasource View Tools Window Help
: = i :__fi,'.:. By 8p e EEEE @ : @ - |search
i da - & - BB :Address [

El--UJ Broisctlilicr Explorer Datasources Mame

' ProjectWise Explorer Log in

Datasource: | CTDOT

User Mame: PWOMLINE \Micholas.Langer

Password: ssssssss

Figure 177 — Logging Into Projectwise
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3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the
applicable division’s Scheduling Documents folder. The below example presents
where the Minimum Requirement Schedule Template is located:

B ProjectWise Explorer VBi (SELEC Tseries 4)

Datasource  Folder

0

'

=

Document  View Tools Window Help

@ : @& - search (O

Op

= HeR =5

+ P> iintertoce|CDOTDoe Code__v] [ Viewlpoiger ]

Q:l A LJ|> - [ﬁ Address |” NDocuments'04.00 - Engineering Libraries\Scheduling Directive\AEC Scheduling Documents [Minimum Reql, - D Go

Ll 03

1 - Traffic Counts

57 04,

.00 - Engineering Libraries

67 67 07 0 B B T T 6 B 6 6

04.02 - Asset Management
04.03 - Research Administration
04.06 - Project Management
AEC Applications

Bridge Structures
Construction

CTDOT Standard Drawings
Directives & Bulletins
Engineering Administration
Engineering Templates
Environmental Planning
Facilities

Highway

Hydraulics & Drainage
OSTA
Permit_Documentation

Proprietary Product Approvals 2
Rails
—-{_ Scheduling Directive )

AEC Scheduling Decuments (Minimum Req)
Bridge Division Scheduling Documents

Facilities & Transit Division Scheduling Documents
Highway Division Scheduling Documents

'y
'
&
&
4_ Traffic Division Scheduling Documents

AL

Traffic

List ‘. Geospatial

MName

Description

@-:..‘ Minimum Requirement Schedule Template ’

Minimum Requirement Schedule Template

# | AEC Schedule Task Library

mn

- 3 - Click speci

[

AEC ScheduleTask Library

fic division's

Scheduling folder

For Help, press F1

4:45 PM

Figure 178 - Schedule Templates

4. Right click on the most applicable template and select Copy

%

" ProjectWise Explorer V8i (SELECTseries 4)

Datasource

T ey

Folder Document View Tools Window Help

@ | #4 - search (O

o

fl]

b=

-

[p> Interface| CTDOT_Doc_Code -y

@+ - [ address (= pwiicidot projectwiseonline,com: CTDOT\Documents\04.00 - Engineering Libraries\Scheduling Directive\AEC ~ [P Go

02.0 - Asset - Bridges
021 - Asset - Bridges (under 20' Town owned)

-

List | ¥ Geospatial |
B

= 022 - A Sianal b Mame Description A
- .2 - Asset - Signal Intersections
LL: 023 - Ascet - S\gn Stru A7 AEC Schedule Task Library AEC ScheduleTask Library
- ‘ H H [= Master - Master Schedule Master - Master Schedule b
poaase-towns 4. Right Click | ZEVetr-Meste Master - Maste
(7 024_B - Asset - Towns = J
 ws-ase-suanz: the Template %m
[T 026 - Asset - Radio Toy Nicks AEC_DOC_M I
- 02.7 - Asset - Railroad Crossing Signals Open
-4 02.8 - Asset - Routes (For Standard Assets) Open as Read-Only
17 03.0 - Imagery -
Open With...
-4 031 - Traffic Counts e
=-{Z" 04.00 - Engineering Libraries Markup
- 04.02 - Asset Management View
{7 04.03 - Research Administration
{_" 04.06 - Project Management HrzdH e
-7’ AEC Applications CheckIn
- Bridge Structures Free
-{=" Construction Copy Out
{7 CTDOT Standard Drawings
--{_ Directives & Bulletins Export...
--{_ Engineering Administration Import
= Engineering Templates Start Studio Session...
| Environmental Planning
{7 Facilities Export Dependency Map(s)...
-E7 Highway Import Dependency Map(s)... |
-[" Hydraulics & Drainage < !
- OSTA Document Properties :Fo\del Update Server Copy e
{_" Permit_Documentation Refresh Local Copy
L= PPIRequests View: :(Defaub Purge Local Copy
-{" Proprietary Product Approvals _I
LL: Railz i o l,-" Prop Purge Workspace
= L- Scheduling Directive L | — MNam Cut
|7 AEC Scheduling Documents (Minimum Req)
: C
| B[ AEC Schedule Task Library 2. Select copy ey D
{7 Permit Acquisition Process rie Paste..
Y W
T Prepare and Approve RPM ol T T
1 Prepare and Submit Permits to Regulatory Authol Creat|
. Prepare and Submit PPI Upda R

Figure 179 - Copying a MS Project Schedule
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5. The next step is dependent upon if a project is in the Project Initiation Phase or has
progressed to Preliminary Design Phase. Project Initiation is typically complete
when Funding and Authorization is received, and a ProjectWise project container is
created. If a ProjectWise container has not been created, contact Julie Annino in
AEC Applications.

Projects in Project Initiation Phase

a. Ifthe project is in Project Initiation the MS Project schedule should be
pasted to the respective discipline specific Initiation Phase Scheduling
ProjectWise folder:

Figure 180 - Discipline Specific Initiation Phase Scheduling folders

L_: Proprietary Product Approvals
-7 Rails
=-{7 Scheduling Directive

== AEC Scheduling Documents (Minimum Reg)
E -4 AEC Initiation Phase Scheduling
-1 AEC Schedule Task Library
=" Bridge Division Scheduling Documents
‘; _' Bridge Initiation Phase Scheduling ’
1_, Bridge Schedule Task Library
=+ Facilities & Transit Division Scheduling Documents

( - Facilities Initiation Phase Scheduling ’
- racilities Schedule Task Library

=i Highway Division Scheduling Documents
-1 Highway Initiation Phase Scheduling >

1 Hwy Schedule Task Library

= Traffic Division Scheduling Documents

‘. i _' Traffic Initiation Phase Scheduling ’

1_, Traffic Schedule Task Library

-0 Traffic

Projects in Preliminary Phase

b. If the project is in preliminary design phase the schedule should be saved to

the ProjectWise 140_Project Administration folder under the project.

- ProjectWise Explorer Datasources
-l CTDOT (mjc-admin)
[ Documents

E||_, 01.0 - Projects - Active

&% 0001-0100

100_Contract_Plans (PDF)

it List IQ Geuspaiial|

Label (User Defined) = Description

110_Contract_Specifications_&_Permits (PDF)
120_Contractor_Submittalz (PDF)
130_Final_Engineering_Reports_and_Informatic

= com=g e e ential

140_Project_Administration|

150_GIS
210_Construction

220 FHWA
230_Contract_Administration
240_Contract_Development

Tt

nfidential

241_Contract_Development_Cenfidential
310_Review_Documents

W

320_Permit_Development
330_Design_Data

i-4_ 500_Pre_Design

084 Saved Searches

1-[/* 0001-0999

5. (1% 0004-0116

D[P 004-0118

v

Figure 181 - Project 140_Project Administration Folder

Issued 01-2016

172

Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

6. To paste the project file, right click on the folder and select Paste and then Yes.

' ProjectWise Explorer V8i (SELECTseries 4)

Datasource  Folder Document  View Tools Window Help

J = | =

o

@ : # - Search O

& -9 - L’j Address [=, pw:\\ctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0001-010

E|U_J ProjectWise Explorer Datasources
E‘hﬁ CTDOT (PWONLIME\Michelas.Langer)
E1-{Z Documents

=B

= OL0 - Projects - Active

* 0001-0100

- 100_Contract_Plans (PDF)

-1 110_Contract_Specifications_&_Permits (PDF)
1 120_Contractor_Submittals (PDF)

- 130_Final_Engineering_Reports_and_Information
|l EaginssingeRepartsalonf - -+

= —Project_Administration_Ce " al
{7 150_GIS

b4 210_Construction

- 220 FHWA

1 230_Centract_Administration

- 240_Contract_Development

- 241 Contract Development_Confidential
1. 310_Review_Documents

- 320_Permit_Development

b4 330_Design_Data

b4 500_Pre_Design

0% Saved Searches

™ 0001-0999
. /™ 0004-0116
0™ 0004-0118
-7 0004-0132
. ™ 0006-0122

m| »

List | @ Geospatial

Label (User Defin... File Nameg|

2.

< | [

Proiect Pronedies | Ealdar Pranad

View
New

Open

Open as Read-Only
Open With...
Markup

View

Check Out
CheckIn

Free

Copy Out

Export...
Import
Start Studio Session...

Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy

Purge Workspace

Move To...

Figure 182 - Save schedules to the 140 Project Administration Folder
7. Then click Advanced Wizard and click OK.
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8. Then click next until you get to the attributes screen shown below, then assign the

attributes as shown below:

Advanced Document Creation Wizard @
Define Document Attributes [
You should define environment specific document attributes. < N
&

Discipline Discipline Description
HW - Highways

Main Category ¢

SCHEDULES
Sub Category Sub-Category Descriptio
Warking Working Schedule

Project Number(s) Document Date (

attributes.

0001-0100
abel (User Defined) discipline
Project Schedule -
EDL';‘PL;’UTT
|
CTDOT Asset Tags
Bridge Mo(s) Building No(s)
Signal Intersections No(s) State Route No(s) -
Sign Structures No(s) Spnrlinl Ll
J Town No{s)
Railroad Crossing Signal No(s) J
]
| <Back || MNed> | [ Canecel

Figure 183 - ProjectWise Attributes

Then click next until the file uploads.
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10. Next open the project file.
11. Then click on the File menu, select Info, select the Project Information dropdown
and then Advanced Properties as shown below:

B . { | Gantt Chart Tools Projectl - Microsoft Projec
Task Resource Project View Acrobat Format

Information About Projectl | =

Organize Global Template

g Move project elements such as views, reports, and tables between two local files,
or between a local file and the global template file.

Organizer
——
Recent Project Information +
Nea . ~#igd] Advanced Properties
H View advanced and custom
properties of this project,
Print Buaj
See key statistics related to
Save & Send your project.
\\\\\\\\\\ Toway
Help fr::ue"ct Calendar ft_a_ndard

Figure 184 - Setting Advanced Project Properties

12. In the dialogue box that pops up, fill out the information as shown below:

MAL -Minimum Requirement Schedule Template Prop... -@
General | Summary | Statistics | Contents | Custom |
Title: Project X00K-3000 J
Subject: Write the type of Project/short description
Author: Mick Langer
Manager: Project Manager Mame
h Company: |State of Connecticut Dept of Transportation j
Category:
Keywords: 1. Some information
Comments: must be provided after
Proj. Initiation, such as
Hyperlink Proj. No. & PM Name
base:
Templake:
|:| Save preview picture 2
‘| Ok D Cancel

Figure 185 - Project Information
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13. Next set the project start date by selecting the File menu > select Info, then select
the date as shown below:

Lid | Gantt Chart Tools Projectl - Microsoft Project
Task Resource Project View Acrobat Format

Information About Projectl

- Organize Global Template
E k Move project elements such as views, reperts, and tables between twoe local files,
or between a local file and the global template file.

Organizer
Info ’
o Select a Start Date

Recent Project Information ~

New 10;1!20150

Print Finish Date 4 October, 2015 2

" Schedule from 50 Mo Tu We Th Fr Sa
Current Date 12 3

Save & Send ciatus Dt 4 5 & 7 8 310

_'_c 11 12 13| 14/ 15 16 17

Help Project Calendar 18 19 20 21 22 23 24
Priority 25 26 27 28 29 30 31

] Options

B s

Figure 186 - Setting the Start Date

8.2 Basic MS Project Function

This section presents the following schedule basic terminology and functions:
e Scheduling Terminology
e Task Relationships (Predecessors and Successors)
e Adding, Renaming, Indenting and Deleting a Task
e Adding/Adjusting Durations
e lLead and Lag Times
e Adding Hyperlinks
e Combining Multiple Projects
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8.2.1 Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule
using task names, durations, start and finish dates on the left, and bar charts presenting these
dates and durations to the right.

RlH9- I+ Gantt ChartTools Minimum Requirement Schedule Template - Microsoft Praject

File Task  Resource | Project | View  ProjectWise Format
= [ = Status Date: [H4] 3/23/15 = s
® E g 4 [Z] B o dE = i o {&
| k) B | == i 34

= update Project
Subproject Project  Custom Links Between WBS Change Calculate Set Move Visual Reports Compare Spelling

Information Fielde  Brmicet +" Wartinn Tima | Braiart Bacatne v Project Reports Projects
, Grey Bar - Parent Task

I rt H I Stat Report
Task Indicator Column = sper
‘ @ [esk Name . |_w e | [[June 1 [October 11 [February2i  [ulyi #  [November 11 [March 21 [August 1

s/z4 [ 7/26 | 9/27 [11/29] 1/31 [ 4/3 | 6/5 | g7 [ 10/9 [12/11] 2/12 | 4/16 | 6/18 | 8/20 |10/

o ~ Project XXXX-XXXX 38.65 mons Project JOOOCX0XC 7
= 1Project Initiation 17 mons Project Initiation G v
2 @ 1.1Prepare and Submit PPI 10 mons ‘reﬁrw—
RN 1.2 Prepare and Approve RP - Prepare and Approve RPM Milestone
4 1.3 Secire Fundin;?Authori. Red - crltlcal Path W
5 = 2 Preliminary Design 6 mons Preliminary Design
(4 2.1Survey 3 mons / Survey E::
7 2.2 NEPA/CEPA 6 mons Blue - Non Critical Task NEPA/CEPHE;!
= Develop PD through Design Approval 6 mons
Hyper"nk Design ippmval ¢ e 0 mons Design Approval 9/7
10 = 3 Final Design 13 mons Final Design 'r

Figure 187 - Basic Terms

Task Indicator Column - Present task Notes and Hyperlinks.

Milestone - A major schedule date, such as an FDP.

Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the
Child Tasks.

Critical Path - Shown in Red, signifies the task relationships that control major milestone dates.
Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

8.2.2 Task Relationships (Predecessor and
Successors)

Predecessor is a task which has a start or finish date that affects the start or finish of another
task.

Successor is a task which has a start or finish date that is affected by another task.
There are different ways of defining task relationships, these are

e Finish-to-Start: This is the default dependency in Microsoft Project in which the successor
cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by
FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

o Task  |TaskName - |Duration  Start + |Finish + Predecessors , || Mar6,'16 __|Mar13,'16 __|Mar20,'16 _ [Mar27,'16

Mode SIMTIW[T[F[s[SIMITIW[T[F[S[S[M[TW[T[F[s[S[M[TIW[T[F[S
1

2

3 = Predecessor 10 days Mon 3/7/16  Fri 3/18/16 i ‘ﬁ

& < Successor 10 days Mon 3/21/16  Fria/1/16 3

Figure 188 - Finish to Start relation

e  Start-to-Start: The successor cannot begin until the predecessor begins. The successor task
can start at any time after predecessor begins. Start-to-Start relationship is designated by
SS.
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o Task  |Task Name ~ |Duration Start Finish

- - -

Predecessors ., | |Mar6, '16 [Mar 13, '16 [1
sMITIW[T[F[s[s[m[T[w[T[F[s]

Predecessor 10 days Mon 3/7/16  Fri3/18/16

= Er
= Successor 10 days Mon 3/7/16  Fri3/18/16 ‘ 355 ’ I
I E

Figure 189 - Finish to Finish relation

B e e

e  Finish-to-Finish: the successor cannot be completed until the predecessor is completed.
The successor can be completed at any time after the predecessor is completed. Finish-to-
Finish task relation is denoted by FF.

(5 ) Task . |Task Name - |Duration _ [start - |Finish + |Predecessors _, || [Mar6,'16 Mar 13,16 |
Mode SIM[TIW[TF[s[s[M[TIW[TTF[s]
1
2
3 = Predecessor 10 days Mon 3/7/16  Fri3/18/16 C ‘J
4 S Successor 6 days Fri 3/11/16 Fri 3/18/16 3FF ( ¢
| - =

Figure 190 - Start to Finish relation

e  Start-to-Finish: the successor cannot be completed until the predecessor begins. The
successor can be completed at any time after the predecessor has started. The Start-to-
Finish task relation is denoted by SF.

Predecessor 10 days Mon 3/7/16  Fri 3/18/16 &
Successor 6 days Fri 2/26/16 Mon 3/7/16  3SF G +

o
o0 gb

Figure 191 - Start to Finish relation

The schedule should have a Predecessors column where task relationships can be defined. To
define a task relation, enter the Task ID and the Task Relationship in the associated task’s
Predecessor Cell. For example, in the Figure below the PPl is a predecessor and the RPM is a
successor task. The PPl must Finish before the RPM can Start. This relationship is denoted in the
RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the
Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is
a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is
not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.
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Microsoft Project

B9 &=

Task | Resource  Project  View  ProjectWise Format
= [l %o - . . > o= . [~] % = ﬁ d S| b Notes
. caton e ? % SRR Suemkonmad = I L:‘; 7. Predec:essorle =] petails
Gomtt | paste S nter I U | &-A- Thd @8 = &5 “2Respec Links Maruoly [N | nspect Move Mode | o Column rmation s —
| v Task ID Font [0 Schedule Tasks ya Properties
¥ 7
finimurm *ulrament Schedule Template (
@ [ToskName . |Duration _ [start . |Finish . |Predeced®rs [October 11 TFebruary 21
7/26 | 9/27 [11/29] 1/31 | a/3 |
EN = Project XXXX-XXXX 34.65 mons Fril12/4/15  Wed 8/1/18 | tet xoooco0x T
1 = 1 Project Initiation 13 mons Fri 12/4f15 Thu 12/1/16 ject Initiation §pe—————
2 @ 1.1 Prepare and Submit PPI 6 mons Fri 12/4/15 Thu 5/19/16 and Submit PP |
3 % 1.2 Prepare and Approve RPM 4 mons Fri 5/20/16 Thu 9/8/16 2 Prepare and Approve RPM
1 @ 1.3 Secure Funding/Authorization 3mons Fri9/9/16 Thu 12/1/16 3 \ Secure Funding/Auth
5 = 2 Preliminary Design 6 mons Fri 12/2/16 Thu 5/18/17 FS relation
6 2.1Survey 3mons Fri12/2/16 Thu 2/23/17 4
7 2.2 NEPA/CEPA 6 mons Fri 12/2/16 Thu 5/18/17 4
8 2.3 Develop PD through Design Approval 6 mons Fri 12/2/16 Thu 5/18/17 755
9 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/18/17 8
10 - 3 Final Design 13 mons Fri 5/19/17 Thu5/17/18

Figure 192 - Linking tasks

If the Predecessors column is not shown in the template, double click in the “Add New Column”
cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the
current columns. If Add New Column is not shown right click on any column label and select
Insert Column and then start typing in Predecessors, as presented below:

Gantt Chart Tools mToJe
Format

Task Resource Project View Developer

% @ :_'ﬁ Llg {‘% Critical Tasks =Y @ —_ = e e e e
] ‘e a [ column settings - S [ sl E’ = 21 %l gl | == =
s'l;:icets Gndv\mes Layout Clgls::n ] Custo Fields Forvmat [ Late Tasks Basslme Slwpeage & & & Py Py Py
Format Columns Bar Styles
§| ° Task Name - |Duration . |Start - |Finish - I
i 0 ~ Project 44,85 mons Mon 8/3/15 Wed 1/9/19
1 = Project Initiation 6 mons Mon 8/3/15  Fri1/15/16
2 |ew PPI 2 mons Mon 8/3/15  Fri9f25/15
3 @ RPM Process 4 mons Mon 9/28/15  Fri1/15/16
4 = preliminary Design 12mons  Wed6/15/16 Tue5/16/17
5 Project Start up(Survey, NEPA, Design Data) 6 mons Wed 6/15/16 Tue 11/29/16
3 Develop PD through Design Approval 6 mons Wed 11/30/16 Tue5/16/17
7 ROW OBL 0 maons Tue 6/13/17  Tued/13/17
8 = Final Design 19 mons Wed 5/17/17 Tue 10/30/18

Figure 193 - Add new column

m—
Format

Resource Project View Developer
Ligld = Ly Critical Tasks & [ — —
| lumn Settings - Slack '—7_ __ 21 %l gl =] =] =]
C[Qlij:\‘ytn f Custom Fi Format . Baseline Slippage & & & & P Py
Format Columns Bar Styles
EE o Task Name « |Duration _ |Start « Finish | _ I
1 o ~ Project 44.85 mon: Mon 8/3/15_\WBla o =
1 = Project Initiation 6 mons [lamed Fri lfPreIevele Start
2 e PP 2 Mon 8/3/15  Fri 9/ FTor o
ERRL N RPM Process Click hereamons Mon 9/28/15  Fri 1/ Project Engineer (Text2 )
4 = Preliminary Design 12 mons Wed 6/15/16 Tue 5;;23?%’%"@&' (Text1) z
5 Project Start up{Survey, NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 1
& Develop PD through Design Approval 6 mons ‘Wed 11/30/16 Tue 5/16/17 Start t_vpulg
7 ROW OBL 0 mons Tue 6/13/17 Tue 6/13/17 "Predecessors’
8 = Final Design 19 mons Wed 5/17/17 Tue 10/30/18
8 = ROW acquisition Process 18 mons Wed 6/14/17 Tue 10/30/18
0 @ Prepare and submit maps to ROW 6 mons Wed 6/14/17 Tue 11/28/17

Figure 194 - Adding predecessor column
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8.2.3 Adding, Renaming, Indenting and Deleting a
Task

Adding a Task
To add a task, right click on the task which will follow the new task and select Insert Task. For
example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select

Insert Task, as shown below:
1016-03-09_Project Schedule HW_Draft_0001-0100

o Task Name ~ |Duration  _ |Start - |Finish ~ |Predecessors
0 = Project 0001-0100 3g.r- - amiatam aadmadan
1 = 1 Project Initiation 17r
} 1. nght click an
2 @ 1.1 Prepare and Submit PPI
-

s @ 1.2 Prepare and Approve RPM am ex|st|ng task to insert a
4 % 1.3 Securrcr.l:.t;f.__h..u_ _L_i__a.:_._z — 3m

aliori - A" -
E = 2Preliminai el sm New task dlrectly above
6 2.15urve B 4 D A ee g Im..._ s [
7] ¢ 2.2neppfrrea Y lsmons Fri 3/24/1? Thu 9/?/1? 4
8 2.3 Devel r—tees roval 6 mons Fri3/f24/17 Thug/7/17 755
E] 2.4 Desigl = Copy Cell 0mons Thu 9/7/17 Thu9/7/17 g
10 - 3 Final Desig ‘b Paste 13 mons Frio/8/17 Thu9/6/18
11 3.1 Prepa Paste Special... nission 7 mons Fri9/8/17 Thu 3/22/18 9
iz 27Preng T Scrollto Task 5mons Fri3/23/18 Thu 8/9/18 11
i3 2 m 9mons Frigfsf17 Thu 5/17/18
14 Derete Tack ccepted Property Maps 3mons Fri9/8/17 Thu 11/30/17 9
15 3.3.2A 6mons Fri 12/1/17 Thu 5/17/18 14

Manually Sehedul .

16 = 3.4Permi f anually senedule 13 mons Friof8f17 Thu 9/6/18
17 3.4 p| o AuteSchedule 7 mons Frio/8f17 Thu 3/22/18
15 @ 3.4.] B Assign Resources... rmits to Regulatory Authority 3 mons Frig/s/17 Thu 11/30/17 7
ig 3.4.1 Eill Down eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 18
20 -'3.4.2P Clear Contents 7 mons Fri 9/8/17 Thu 3/22/18
21 3.4.] B2 Information rmits to Regulatory Authority 3 mons Fri9/8/17 Thu 11/30/17 1855
22 3.4.] o N . eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 21

" otes..
23 -343P 2 mons Fri 1/26/18 Thu 9/6/18

E Add to Timeline
24 3.4.9 rmits to Regulatory Authority 2 mons Fri1/26/18 Thu 3/22/18 22FF,19FF
25 341 Hperink.. eview and Issuance of Permit 6 mons Fri 3/23/18 Thu9/6/18 22,19
25 [ 1n

Figure 195 - Adding a Task

Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)

Task: Inforniuatlcm ZZ
I Genera }Predecessors ] Resources] .ﬁ.d'u'anced] Motes ] Custom Fleldsl

uame:t PPI , 2 Duration: 2 mons : |:| Estimated

Percent complete: | 0% = Priority: | 500 =

Schedule Mode: () Manually Scheduled

@ Auto Scheduled
Dates
Start: Mon 8315 - Einish: Fri 9/25/15 -

[ bisplay on Timeline
[] Hide Bar

[ rollup 'I'h.en C].iCk

|

Cik

[

Figure 196 - Renaming a task

_J‘) Cancel ]
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Outdenting & Indenting

Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left
of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of
the preceding, outdented ‘Parent’ task. Parent task durations are populated by their
accumulative child task durations, therefore, parent task durations should not be manually
entered. To set your task as a child or “sub-task”, select the row you would like to modify and
click the Indent Button in the main toolbar area shown:

= |+ .f_‘.'-_rJ.i.'.'_‘.';-_i_'U,;g_=;|
Task Resource Project View ProjectWise Format
= [ Cut -
o E & Cu Calibri i1 - P ES S MarkonTack -
ol 53 Copy ~ M A . .
an aste - - il | =3 c5 T i
Chart = - \}’ Format Painter o E— @ EEAp
View Clipboard Font Schedule
i
e Task Name OUtdent & - |Duration
: Indent Buttons
0 = Project XOOCK-XXXX 34.65 mor
1 = 1 Project Initiation 13 mons?
2 % 1.1 Prepare and Submit PPI 6 mons
3 - 1.2 <New Task>
s @ 1.3 Prepare and Approve RPM 4 mons
5 % 1.4 Secure Funding/Authorization 3 mons

Figure 197 - Outdent and indent

Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By
entering zero for the duration the MS Project will view the task as a milestone, if a report is
generated the report will present all zero duration tasks as milestones. This may confuse report
reviewers. A small duration may push back critical milestone dates. It is therefore
recommended that project managers manually delete and revise predecessor and successor
relations, as described below. To delete a task right click on it and select delete task. (Do Not
Delete the Base Template Tasks in Bold)

[} Task Name - |Duration . |Start - [Finish . |Predecessors | [July 21 | may 1 | February 11 | November 21 |Sey
7/7 [11/24] 4/13 [ 8/31 [ 1/18 | 6/7 [10/25] 3/13 [ 7/3:

o ~ Project paw 4 e 44,85 mons Mon 8/3/15 Wed 1/9/19 e

alibri - - :

1 = Project Initial /GEO 6 mons? Mon 8/3/15  Fri1/15/16 pm— 0%

2 e PPl B D A-= R 2mons Mon 8/3/15  Frig/25/15 =o%

3 | [ Demo Jamons?  Mong/3/15  Fris/25/15 =|o%

. @ RPM Proce ® CutCel 4 mons Mons/28/15 Fri1/15/16 2

5 = preliminaryp =3 opy Cel 12mons  Wed 6/15/16 Tue 5/16/17

6 Project Sta - 1 Data) 6 mons Wed 6/15/16 Tue 11/29/16 AF5+5.35 mons

7 Develop Pl I 6 mons Wed 11/30/16 Tue 5/16/17 6

8 ROW OBL T Scroll to Task 0 mons Tue 6/13/17  Tue 6/13/17 7FS+dwks

9 = Final Design Insert Task 19mons  Wed5/17/17 Tue 10/30/18

10 = ROW acqui 18 mons Wed 6/14/17 Tue 10/30/18 8

u & Prepare ry — 6 mons Wed 6/14/17 Tue 11/28/17

12 (& Acquire * Manualy Schedule 12mons  Wed 11/29/17 Tue 10/30/18 11

13 = Permit Acg | ) Aute Schedule 12mons  Wed5/17/17 Tue 4/17/18

14 Prepare @ Assign Resources.., llatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 7

15 |& Acquire Eill Down 8 mons Wed 9/6/17 Tued/17/18 14

16 Prepare Fit Clear Contents 18 mons Wed 5/17/17 Tue 10/2/18 7

17 By B mromation 1min Wed 10/21/18 Wed 10/31/18 9

18 |& FDP o Mot 0 mons wed 10/31/18 Wed 10/31/18 17

otes...
19 DCD el 0 mons Wed 12/12/18 Wed 12/12/18 18FS+6 ewks
T Addto Timeline
20 ADV 0 mons Wed 1/9/19  Wed 1/9/19  19FS5+4 ewks

B, Hyperlink...
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When a schedule is started the user should remove tasks that do not relate and estimate all
other pertinent task durations. It is critical to note if the task being deleted is a predecessor.
You can determine this by following the lines stemming from a task in the Gantt chart. If a task is
erroneous and must be deleted, but is also a predecessor for other tasks that should not be
deleted, the successor task must be corrected. Failing to update a new predecessor will likely

disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be
deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the
ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be
the new predecessor. See the task relationship and Gantt chart prior to task deletion:

Manually| Auto || Inspect Move Mode

jantt | Paste By A | b= | 88 | €2 5 3
1aarr1t' af ) J Format Painter B US> A W |88 | S5 vRespectlinks Schedule |Schedule v
fiew Clipboard Font Schedule Tasks
I hTask Name VDuratior ] Start VFinisl' VPredecessors % Du
(3 ) - - v - v .
728 1.2.3.5 Preliminary Hydraulic Analysis S51days Tue Tue 16 0% )
11/24/15 2/2/16
1.2.3.6 Hyw/Traffic/Landsc oordination 1day Tue Tue 16 0%
11/24/15 11/24/1
1.2.3.7 Utility Coordination ~ Delete 15days Tue Mon 16 Change 0%
11/24/15 12/14/1 to 19
1.2.3.8 Kick-Off Meeting 1day Wed Wed 18 days 0%
__ New predecessor ID 12/9/15  12/9/1
21 29 1.2.3.9 ABC Analysis 10days Wed Tue 0%
2/3/16 2/16/1
22 &l 177 AN NEN A OTD Tiimn Rainlamnann . R e Tem Ton ac nos
Figure 199 — Before task deletion table
|October November December January February
[ B [ Mm [ E B [ M [ E B [ M [ E B | M [ E B [ M [ E
Hyw/Traffic/Landscape Coordination Eiﬁ%—-
Utility Coordination : > 0%
Kick-Off Meeting T 0%
ABC Analysis 0%
Figure 200 — Before task deletion Gantt chart
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See Task relationship and Gantt chart after task deletion:

o Task Name . |Duratior _ |Start  _ |Finisk _ |Predecessors - |% - Du
Comp

16 &9 1.2.3.4 Survey 64days Wed Mon 15 0%
8/26/15 11/23/1 [

17 1.2.3.5 Hyw/Traffic/Landscape Coordination 1day Tue Tue 16 0%
11/24/15 11/24/1

18 & 1.2.3.6 Utility Coordination 15days Tue Mon 16 0%
11/24/15 12/14/1

19 1.2.3.7 Kick-Off Meeting 1day Wed Wed  17FS+10days 0%
12/9/15 12/9/

20 2@ 1.2.3.8 ABC Analysis 10days Tue Mon 0%
12/15/15 12/28,

21 2@ 1.2.3.9 RSR or STR. Type Development 46days Tue Tue 16 0%

11/24/15 1/26/16

Figure 201 — Post task deletion and predecessor update table

[October [ November [December [January I
o I - S T [ = - " [ S Y T =

0%

Hyw/Traffic/Landscape Coordination E"—W

Utility Coordination E 0%

. T Kick-Off Meeting T 0%
Notice the critical

path has changed ABC Analysis (< 0%

RSR or STR. Type Development IO‘J:

Figure 202 - Post task deletion and predecessor update Gantt chart

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS
Project automatically reconfigures the schedule to show the new critical path. The critical path is
shown in red and highlights the task relationships that determine a projects finish date.
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8.2.4 Adding, Renaming and Deleting a Task
Adding a Task
To add task, right click on the task which will follow the new task (which is the lower task), then
select Insert Task. For example, to add a new task after PPI right click on the next task which is
RPM Process as shown below:

- Cewpernes e s s iy
o Task Name - |Duration _ |Start - |Finish ~ |Predecessors ;fl
o = Project 44.85 mon: Mon 8/3/15 Wed 1/9/19
1 ' Project Initiation 6 mons Mon 8/3f15  Fri 1/15/16
: e PPI 2 mons Mon 8/3/15  Fri9/25/15
s & | RPM Process lamons  Monog/2s/1s Fril/isfie 2
4 = Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
5 Project Start up(Survey, MEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 3FS+5.35 mons

Figure 203 - Adding a Task

The task will be added as shown below:

1 = Project Initiation & mons? Mon 8/3/15  Fri 1/15/16

1 e PRI 2 mons Mon 8/3/15  Fri9/25/15

3 <New Task> 0.05 mons? Mon 8/3/15  Mon 8/3/15

s @ RPN PTocess Tmons 15 CTHRE P S S 7 T L ]

5 = Preliminary Design 12mons  Wed6/15/16 Tue 5/16/17

& Project Start up(Survey,NEPA,Design Data) & mons Wed 6/15/16 Tue 11/29/16 4F5+5.35 mons

Figure 204 - Naming a new added task

Then rename your task by right clicking as shown below.

Renaming a Task
Tasks can be renamed by double clicking on a task to be edited. Then in the pop up window
under General tab you can edit the task name. (Do Not Rename base template task)

Task Inforr:;i;ation 22
-
l: Genera }Predecessors ] Resources ] Advanced ] MNotes ] Custom Fields ]
Mame:‘ FPPI ’ 2 Duraton: 2 mons : |:| Estimated
Percent complete: 0% : Priority: 500 :
Schedule Mode: () Manually Scheduled
@ Auto Scheduled
Dates
Start: Mon 8/3/15 -  FEinish: Fri 9/25/15 -

[ pisplay on Timeline
[ Hide Bar

[T rollup 'I'h.en C].iCk

|

Coc ) cone

Figure 205 - Renaming a task
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Deleting a Task
To delete a task simply right click on it and select delete task (Do Not Delete base template

task)
() Task Name - |Duration . |Start - Finish . |Predecessors _[|[uly 21
Y ~ Project . ” — 44.85 mon: Mon 8/3/15 Wed 1/9/15
alibri - A’ 3
1 = Project Initial @ 6 mons? Mon 8/2/15  Fri 1/15/16
R ;
2 2R PRI B I H-A-=BRE 2 mons Mon8/3/15  Fri9/25/15
3 | | Demo lamons?  mong/z/1s  Frisjas/1s
FRC N RPM Proce & Cut Cel 4mons Mon9/28/15 Fri1/15/16 2
5 = preliminary g =3 Copy Cel 12mons  Wed 6/15/16 Tue 5/16/17
6 Project Sta - | Data) 6 mons Woed 6/15/16 Tue11/29/16 4F5+5.35mons
7 Develop PI | 6 mons Wed 11/30/16 Tue5/16/17 6
8 ROW OBL B scollto Task 0 mons Tue 6/13/17  Tue 6/13/17  7FS+dwks
9 = Final Design Insert Task 19 mons Wed 5/17/17 Tue 10/30/18
10 - ROW acqui 18 mons  Wed6/14/17 Tue 10/30/18 8
1 (& Prepare Py - 6 mons Wed 6/14/17 Tue 11/28/17
WManually Schedul
12 & Acquire T MEIUTNEECLE 12mons  Wed 11/29/17 Tue10/30/18 11
13 - Permit Acg . Auie Scheduls 12mons  Wed5/17/17 Tue4/17/18
14 Prepare 8 Assign Resourees... llatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 7
p ry Ag

15 & Acquire Fill Down 2 mons Wed 9/6/17 Tue4/17/18 14
16 Prepare Fit Clear Contents 18 mons Wed 5/17/17 Tue10/2/18 7
17 i

=0 = mrormation.. 1min Wed 10/31/18 Wed 10/31/18 3
18 (@ FDP o] et 0 mons Wed 10/31/18 Wed 10/31/18 17

Motes...
18 DCD - 0 mons Wed 12/12/18 Wed 12/12/18 18F5+6 ewks
= Addto Timeline

20 ADV 0mons Wed 1/9/19  Wed 1/9/19  19F5+4 ewks

B Hyperlink...
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Figure 206 - Deleting a task

[ May 1 |February 11 | November 21 |Seq
7/7 [11/24] 4/13 [ 8/31 [ 1/18 [ 6/7 [10/25] 3/13 [ 7/3:
Q:l::
==y 0%
= 0%

=|o%
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8.2.5 Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click
the Duration Cell to the right of the task and enter the task’s estimated period and the
applicable unit, as presented below:

e Mons: for months

o  Whks: for weeks

e Days: fordays

e Hrs: forhours

e Mins: for minutes

Task Name Duration Start Finish Predecessors

1. Rename the Task s —
o = Project 44.85 mon: Mon 8/3/15 Wed 1/3/19 5
1 = Project Initiation / 6 mons Mon 8/3/15  Fri 1/15/16 2. Type in the g
2 Bl PPI 2 mons Maon 8/3/15  Fri g 25 ke Duration
3 C__ Demo j CZ mons _)m??ﬁ Fri 9/25/15
a @ RPM Process 4 mons Mon 9/28/15  Fri 1/15/16 2
= = Neallmicnaem: Mac e AN wt~nAd clariac Towm rlacias

Figure 207 - Adding durations

If the duration unit is already entered, then the duration value may directly entered, without
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations
are automatically calculated by their subtask durations.

If a parent duration is manually entered, select the parent task and re-select Auto Schedule.
This will recalculate the appropriate parent duration, based on its child tasks. See below:

IEII H9- |+ Gantt Chart Tools
Resource Project View ProjectWise Farmat
= j ‘H’ Cut Calibri Fit - D EMES S varkonTad - 2 [ | rﬁ
Gantt | Paste A conr (Blr u &-A-| g 5 53 Manually| Auto Ifspect Move Mod'e
Chart ~ - < Format Painter = - @989 | = 5 TV Respectlink Schedule|Schedule - - -
View Clipboard
— — Make sure Auto
12-U2_Froject >chedule_RW_Dre
o Task Name SChed ule is selected -~ » |Finish - |Predecessors | é';;:l |
0 ~ Project 0001-0100 38.65 mons Fri 12/4/15 Wed 11/21/18 Project O
1 ='1 Project Initiation 17 mons Fri 12/4f15 Thu 3/23/17 Project
2 @B 1.1 Prepare and Submit PPI 10 mons Fri 12/4/15 Thu 9/8/16 repare and ¢
3 @ 1.2 Prepare and Approve RPM 4 mons Frigf9/16 Thu 12/29/16 2
s @ 1.3 Secure Funding/Authorization 3 mons Fri 12/30/16 Thu 3/23/17 3
5 | = 2 Preliminary Design Fri 3f24f17 Thu 12/28/17
6 2.15urvey 3 maons Fri 3/24/17 Thu 6/15/17 4
7 2.2 NEPA/CEPA 6 mons Fri 3/24/17 Thu9/7/17 4

Figure 208 - Auto Schedule
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8.2.6 Lead and Lag Times

In defining a task relation, a task may have to be delayed or started early.
o The Lead time will tend to push your duration and a plus sign is used.
e The Lag time will tend to shorten your duration and a minus sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a
plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

Gantt Chart Tools roject 10000
Farmat

Task Resource Project View Developer
% @ 2y Ligll == == )}}J Critical Tasks = = P— pe—y ey pe—y pe—y e =
—L! . B, Column settings ~ =[O slack E’ _; 21 %:l %l gl 21 — E
S‘I't:'r:s Grldvllnes Layout CI:Isuer:‘tn ] Custom Fields Forvmat [ Late Tasks Bassllne Sllpeage & & & & & &
Format Columns Bar Styles
= @ |[TeskName - |puration _ [start . |Finish - |Predecessors o | [ouly:
Y 7/7
o = Project 44.85 mon: Mon 8/3/15 Wed 1/5/15
1 = Project Initiation 6 mons Mon 8/3/15 Fri 1/15/16
2 2 PPI 2 mons Mon 8/3/15  Fri 9/25/15
s @ RPM Process 4 mons Mon 8/28/15  Fri 1/15/16 2
4 =/ Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
5 Project Start up(Survey,NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 3F5+5.35 mons
& Develop PD through Design Approval 6 mons wed 11/30/16 Tue 5/16/17 5
7 ROW OBL 0 mons Tue 6/13/17 Tue 6/13/17 6FS+4 wks
8 = Final Design 19 mons Wed 5/17/17 Tue 10/30/18
= ~ ROW acquisition Process 18 mons wed 6/14/17 Tue 10/30/18 7
10 (& Prepare and submit maps to ROW 6 mons Wed 6/14/17 Tue 11/28/17
1 |& Acguire Properties 12 mons Wed 11/29/17 Tue 10/30/18 10
12 = Permit Acquisition Process 12 mons Wed 5/17/17 Tue 4f17/18 Task
13 Prepare & Submit Permits to Regulatory Agencie 4 mons Wwed 5/17/17 Tue 9/5/17 6 -
14 & Acquire Permits 3 mons wed 9/6/17  Tue 4/17/18 13 relation
15 Prepare Final Design Submission 18 mons wed 5/17/17 Tue 10/2/18 & with lead
16 1 min Wed 10/31/18 Wed 10/31/18 8 l time
17 [& | FDP [oynons Wed 10/31/18 Wed 10/31/18 15
18 DCD ons wWed 12/12/18 Wed 12,!12,!18‘ 17F5+6 ewks '
19 ADV 0 mons wed 1/9/19 wed 1/9/19 1 EWKS

Figure 209 - Task relation

This can also be set by right clicking on a task and selecting Information.

Then go to the

Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship
type and then a positive duration for a lead time or a negative duration for a lag time in the Lag

column.

Task Information

o —

| S|

General Predecessars l Resources] Aduanced] Motes ] Custom Fields]

Mame: DCD Duration: 0 mons |:| Estimated
Predecessors:
FDP -
jin] Task Mame Type Lag (|
[ 17 FoP | = JFinish—to-Start {(FS) Sew

5c ) [ eme )
Figure 210 - Task relation in Project Information
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8.2.7 Adding Notes and Hyperlinks to a Task
Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.”
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the
baseline. The note should be placed in the respective task’s indicator column. The note should
state:

e The date of the entry,

e The person writing the note,

e Justification for the task duration adjustment and
e Recommended: Recipient Notification.

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to
outline a step where project team members who may be interested or are directly impacted by
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is
recommended that a notification email be sent to the relevant recipients and that the
correspondence is saved to the subject project’s 140 Project Administration folder in
ProjectWise. The recipients may typically include:

e AEC’s Project Management Unit —Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov

e Finance, such as the Office of Capitol Planning.

e Design Engineers within the Project Manager’s division.

e The group involved with the duration change or the group affected by the change, if
applicable. For example, if the 6 month estimated duration for a project survey needs to
be pushed back, the respective survey supervisor who is involved with the task should
be included as a recipient in the notification email.

The purpose of the recipient list is to improve communication between units and to harvest
project data. Meaning, AEC will collect a repository of duration change notes in order to
continuously reevaluate and improve schedule templates.

To add a note right click on a task and select Notes... as shown below:

0 = Project 44.85 mon: Mon 8/3/15 Woed 1/9/19

1 = Project Initiation 6 mons Mon 8/3/15  Fri 1/15/16

2 2 PPI 2 mons Mon 8/3/15 Frig9/25/15

3 @ Calibri 1 LS = 4 mons Mon 9/28/15  Fri 1/15/16 2

4 B Z %A - oesch - : 12 mons Wed 6/15/16 Tue 5/16/17

5 ey e e €Y, MEPA, Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 3F5+5.3¢

5 |_ 01: ot CeTI =~ rough Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 5

7 2 Enpy&” 0 mons Tue 6/13/17 Tue 6/13/17 6FS+dw

8 B ;me 19 mons Wed5f17/17 Tue 10/30/18

= - on Process 18 mons Wed 6/14/17 Tue 10/30/18 7

10 (& Paste Special... submit maps to ROW 6 mons Wed 5/14/17 Tue 11/28/17

11 @& T SeolitoTask berties 12 mons Wed 11/29/17 Tue 10/30/18 10

1z Insert Task tion Process 12 mons Wed5/17/17 Tue 41718

13 Delete Task ubmit Permits to Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 6

14 |3 & Manually Schedule mits 8 mons wed 9/6/17  Tue 4/17/18 13

15 = auto schedule besign Submission 18 mons Wed 5/17/17 Tue 10/2/18 &

15 By 1min wed 10/31/18 Wed 10/31/18 8

17 (@ | B Assign Resources.. 0 mons Wed 10/31/18 Wed 10/31/18 16

18 Fill Down 0 mons Wed 12/12/18 Wed 12/12/18 17FS+6e

19 Clear Contents 0 mons Wed 1/9/19 Wed 1/9/19 18FS+d e
E Information...
k] MNotes..

E  Addto Timeline

Tacking tant

&, Hyperlink...

Figure 211 - Adding Notes
Then type/insert your notes in the popup window.
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The other option to access the notes window is to double click on the task and in the Task
Information window and click on the Notes tab.

Adding Hyperlinks to a Task

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and
reference documents.” For all templates, hyperlinks shall be used to link a task to a division
specific Schedule Task Library folder located in the Scheduling Directive PW folder. Contact your
SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that
contains the permit’s regulatory document, suggested points of contact or experts, pre-written
memorandums, etc... These documents must be added, actively maintained and updated.
Division SME’s and AEC shall be the active maintainers of the division library modifications.
When a document is incorrect or has been superseded it is critical that users report this to a
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users
go through their SMEs to hyperlink documents, but the procedure is explained below.

To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink

=

RPN b 7 5y e A - eo g5 52 - 4mons Mon 9/28/15  Fri1/15/16 2
= Preliminary oosign 12 mons wed 6/15/16 Tue 5/16/17

Projel w  cutcen esign Data) 6 mons Wed 6/15/16 Tue 11/29/16 3FS5+5.35 mons
Devel oo Cony cen orowval 6 mons Wed 11/30/16 Tue5/16/17 5
ROW OF B paste 0 mons Tue 6/13/17 Tue 6/13/17  6FS+4 wks
=~ Final De| ;am speciat.. 19 mons wed 5/17/17 Tue 10/30/18

9 - ROW| = 18 mons Wed 6/14/17 Tue 10/30/18 7
10 & prg = ScrolltoTask ROW 6 mons Wed 6/14/17 Tue 11/28/17
11 |& Ac Insert Task 12 mons wed 11/29/17 Tue 10/30/18 10
12 -~ Perm Delete Task 12 mons Wed 5/17/17 Tue 4f/17/18
13 Pre & manually schedule Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 [3
14 & AN (]  aute Schedule 8 mons Wed 9/6/17  Tue4/17/18 13
15 Prep n 18 mons wed 5/17/17 Tue10/2/18 6
15 By & Assion Resources.. 1 min wed 10/31/18 wed 10/31/18 8
17 | FDP Eill Down 0 mons Wed 10/31/18 Wed 10/31/18 16
18 Dco Clear Contents Omons Wed 12/12/18 'Wed 12/12/18 17FS+6 ewks
15 ADV =0 information... 0 mons wed 1/9/19 wed 1/9/19 18FS+4 ewks

o] Motes..
ZE Addto Timeline

&, Hyperlink...

Figure 212 - Adding Hyperlink

Then in the following window, insert web address\navigate to a file.
Insert Hyperlink (% | —=—

Link to: Text to display@nd j
Look in: C My Documenis _II

Existing File or

Web Page . t ArciIS \ - Bookmark. ..
= 1, Bridge Final.zip - .
Foider | Camtasa Studio You may use this to
Place in This ; FME .
Document Browsed | GIS DataBase pomt to| a ﬁlf.'.
Pages My Data Saurces
ﬂ ; My FME Workspaces
CreateNew | | pecent | My Shapes Web link Then
Document Files , OneNote Notebooks .
| pp / - chck

Address: G_tﬂ::ff‘d\".i\"a\' .ct.govdotsi/site default.asp )’ Iy OK

4l
E-mail Address
‘ OK T) Cancel ]

Figure 213 - Add link/browse to a file

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link
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Edit Hyperlink

T |-t

Link to:

Existing File or
Web Page

Place in This
Document

Create New
Document

E-mail Address

Text to display: pw:\\ctdot. projectwiseonline. com: CTDOT \Documents Y04, 0% 20-3620Engi

Look in: *| My Documents IE‘
Carent | & ArGIS - | [ Bookmark... |
urren y < "
el 1, Bridge l.:II‘IELZID. |E|
. Camftasia Studio
. FME
Browsed . GIS DataBase
Pages My Data Sources
. My FME Workspaces
Recent =} My Shapes
Files . OneMote Motebooks 1
. pp S
"
Address: pw:W:bdot.project\n'iseonline.com:CTDO'I"‘oDocuments\,D4.0‘b‘nz[J—‘}’nZDEngiZl "

Then click here = ([ ox ) cancel |

Figure 214 - Removing a link

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator

column.

8.2.8 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several
schedules from the same file. MS Project provides this ability through the Subproject combine
function. As outlined in Section 8, schedules must be stored in the project container:
140_Project Administration folder. However, to use the combine function, MS Project schedules
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive.
Schedules located in a local network can then be combined using the subproject tool. Exporting
is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1.

Browse to the ProjectWise Project container’s 140 _Project Administration folder.

Right click the Project Schedule and select Export, as shown below:

;ﬂ ProjectWise Explorer V8i (SELECTseries 4)

Datasource Folder Document View Tools

Window Help

@ © 34 - search IO

+ [ iInterface| CTDOT_Dac_Code =N

wrllrbrnt nrnia e anm lina rame TNOT\Documents\01.0 - Projects - Active'0001-01000140_Project_Administ = [;" Go

O O O e B R B e B R

=+ 010 - Projects
&-[% 0001-0100

THET

2. Right Clic T i [ @ Goopal

Label (User Defin...
100_Cor

110_Contract_Specifications_8&_Permits (PDF)

- [1* 0009-0094

Issued 01-2016

File Name

3 (E AEC Example Proi JC({- XX mon

Documert Properties | Project P

P

Figure 215 - Schedule Export
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120_Contractor_Submittals (PDF) New '
130_Final_Engineering_Reports_and_Information Open
dal=baginesinaeiapasmbgnfidential
- - - o] Read-Onl
7 140_Project_Administration pen as head-Lnly
it ministration_Confidential Open With...
iry Markup
= View
My
vy Check Out
. Check In
1. Browse to Project -
Admin Folder Copy Out
-{" 330_Design_Data Export...
-4 500_Pre_Design Import
# Saved Searches
- Start Studic Session...
-2 0001-0999 3. Click Export
3'1-: 0004-0116 Export Dependency Map(s)...
0004-0118
i-:’t 0004-0133 Import Dependency Map(s)...
(% 0006-0122 Update Server Copy
53 o
£+ 0007-0182 Refresh Local Copy
7-{/* 0007-0182 & 0170-3155 <
[ 0007-0183 Purge Local Copy

Purge Workspace
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2. Highlight Export and Click Next as shown below:

Document Export Wizard

=

Welcome to the Document Export
Wizard

Choose an action to perform
(@) Export - Locks file, changes can be re-imported ,

(7) Send to Folder - Crea nmanaged local copy

The Export option will lock an
selected documents so they 1 ] c
later imported using DOCUMEN v ~ s

lick Export

2. Click Next

< Back [ MNext = ] Cancel ]

Figure 216 - Export Option

3. Browse to the network folder where you will keep the schedule file image. This
network file will likely be in the division specific X-Drive>all_data-folder.

NOTE: DO NOT DELETE THE EXPORTED FILE

The floppy disk means that the file has been exported so the schedule is now read only. A user
can still access the Project file by double clicking it and opening the file as Read Only.

Jocuments\01.0 - Projects - Active'\0001-01004140_Project_Administ + [;> Gao

i List |. Geospatial

Label (User Defin...  File Name Description
AEC Example Proj )OO0 X000 mpp The ﬂOPPy disk means AEC Exarnple Proj JO00- 3000

the file is exported

Figure 217 - Exported File

4. Create a new “Master” MS Project file that will be used as the container for the
combined Subprojects. This Master Schedule file can be stored in the local network
drive (such as the X-Dirve) or on ProjectWise. Browse to the local network schedule
(the one stored in the X-Drive) and click Insert as shown below:
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Project  Custom Links Between WBS Change Calculate  Set Move Visual Reports Compare | Spelling
Information Fields Projects -~ Working Time | Project Baseline - Project Reports

Properties Schedule Status Reports Proofing
=
= start
B Tu=10/515
@ [tk - [Taskname - |puration _ [start - |Finish - |Predecessors _ |ResourceNames . |  Add New Column .
Mode T s
I
[B] Insert Project -
vl
@U’lﬁ » Libraries » Documents » - [ 42 || search Documents o
Organize + Mew folder == - @
& [B] Microsoft Project  Documents library e
Includes: 2 locations
“ ¥ Favorites MName Date modified Type Size
B Desktop
8 Downloads 1 ArcGIS 3/16/20153:38 PM  File folder
%] Recent Places |\ Camtssia Studio 9/18/201511:50 AM  File folder
o = 1y FME 0/22/201412:38 PM  File folder
4 [ Libraries | GIS DataBase 3/20/201510:39 AM  File folder
| ¢ [% Decuments My Data Sources 8/5/2015 2:06 PM File folder
b @l Music L. My FME Workspaces 10/24/2014 1:20 PM File folder
&> [ Pictures My Shapes 7/25/2014 1:04 P File folder
> B Videos |\ OneNote Notebooks 2/26/201511:19 AM  File folder
L4 I opp 1 015 3:17 PM File folder
4 % Computer || Project resources 6,/5/2015 12:49 PM File folder
© &L, OSDisk (C3) b Snagit 5/27/201511:57 AM  File folder
b Data (D:) (EH] Highway Template2__.mpp 8/10/2015 10:45 AM  Microsoft Praject ... 439 K
= :

& & GIS Data (L)

> 8 mROnDS nusnrnacy o - “Then Click here ' '

ODBC... Link to project

File name: Browse to vour file ~ [ Micr Project Files (*.mpp;® ~
Tools  ~ Insert |+ Cancel

Figure 218 - Subproject

The schedule has been inserted into the Master Schedule, where it can be actively updated and
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s
outline symbol.

D" g saGaale GanttChart Tools icr
File Task Resource Project View Developer Format
p Status Date: [ 10/6/15 s
L H [ = B & 55 Sl =
c L glUpdate Project jj
Subproject Project  Custom Links Between WBEBS Change Calculate Set Move Visual Reports Compare | Spelling
Information Fields Projects = ‘Working Time Project Baseline ~ Project Reports Projects
Insert Properties Schedule Status Reports Proofing
Thu 9/24/15 Sat 11/14/15
2 | | Today | Aug28,'16 Oct23,'16 Dec18,'16 Feb12,'17 Apr9,'17  lun:
T
£ B
E
o Task . Task Name ~ |Duration . |Start - |Finish ~ |Predecessors _ |Resource Names Add New Column
Mode T [
898 days  Fri9/18/15 Wed 2/27/19 ——

1 |® = roject 1- signing
2 |® ?Q roject 2-signinig 897 days Mon 8/3/15 Wed 1/9/19

Click the plus signs to expand

Figure 219 - Added Subprojects

A user can view the most updated schedule via the ProjectWise file by right clicking the schedule
file and selecting Update Server Copy as shown below:
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List |. Geospatial|

Li Llllecr Dafio, Bl blacoc
%" : i

| -
11. Right click i

n as Read-Only
exported schedule ..
Markup

View

Check Out
CheckIn
Free

Copy Out

2. Click Update Expott...
Server Copy Import

Start Studio Session...
Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy ’
Refresh Local Copy

Purge Local Copy o

[ s .| DPrriact Dranariz

Figure 220 - Update server copy

5. This step updates the ProjectWise schedule from the local network image file that is
maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.

6. To Import a project schedule back into ProjectWise the user must right click on the
ProjectWise schedule and click Import. As shown below:

List | @ Geospatial |
L abalileseDafin Fils hlaros
é[f%‘ AEC Example Proj JoO0X- X0t eonn

\ ‘ Open
Open as Read-Only

1. Right click _
Open With...
exported schedule Markup

View

Check Out
Check In

2. Click Import Free

Copy Out

Export...
Import
Start Studio Session...

Figure 221- Import

7. If you look back to the local server where the project image file had been saved,
you will notice that it is no longer there, this is because the file has been imported
back into ProjectWise. Now the file can once again be managed directly from
ProjectWise. If a user wishes to maintain their schedule continuously from their
master schedule, they should avoid importing the schedule. Once a file is imported
the user must re-export and re-add the schedule to their master schedule.
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8.3 Tracking the Project

8.3.1 Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not
be re-baselined unless there is a major scope change. Re-baselining requires Engineering
Administrator approval.

1. To set the baseline, under the Project tab select set baseline and select Set
Baseline from the dropdown as shown below

ighway AEC__.mpp = Mict
File Task Resource 1\/|ew Developer
”F‘ j@ 7 @) = “Jg—"‘g status Date: 32305 “ 5 g3 y
L g Update Project
Subproject Project  Custom Links Between WBS Change 3 Visual Reports Compare | Spelling
Information Fields Projects v Working Time Bl j 3 Reports Projects
Insert Properties =% SetBaseline... Status Reports Proofing
, — ¢ S ) 4
o Task iTask Name &t Clear Baseline ation  |Start + |Finish + |Predecessors 11
Mode T | €
- = 3 L
0 =3 Project XXXX-XXXX 38.7 mons Thu 10/1/15 Wed 9/19/18 )
1 2 = 1 Proiect Initiation 11 mons Thu 10/1/15 Wed 8/3/16 lec

Figure 222 - Set Baseline Dropdown

2. Inthe dialog box that pops ups, keep the default values and click OK.

Set Baseline =

@ﬂ baseline

Baseline -

Set interim plan
Scheduled Start/Finish
Starti/Fimish i
Fegs
@) Eptire project
Selected tasks

Foll up baselines:
Toe all summary tasks

Erom subtasks into selected surmmary taskis)

Click OK

Figure 223 - Setting a baseline

Re-Baselining
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be
set in accordance with the following:

1. Go to Projects > Set Baseline > Set Baseline.
2. Then select Set Interim plan, select Baseline from the copy drop down button, then
select Baseline 10 for the Into dropdown list.
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Set Baseline @
(1) Select the "Set © setbaseine
~

Baseline
Interim Plan”™

Copy: {Baseline

For:

_
(4) Make sure this is e
Roll up baselines:
selected To gl summary tasks
From subtasks into selected summary task(s) (5) Se I ect O K
( OK ) Cancel

Figure 224 - Re-Baselining

3. Next, go to Project > Set Baseline> set Baseline.
4. Then in the dialog box that pops up just click OK to save a new Baseline.

Set Baseline £3

@ Set baseline

Baseline -

) setterm gan Keep the default
::13 values and select
o OK

(@) Entire project
() Selected tasks

Roll up baselines:

To all summary tasks

From subtasks into selected summary

Sedf=s Default

Ce e

Figure 225 - Re-Baselining

5. When a pop up window asks you if you want to overwrite click yes

Microsoft Project 2%

Baseline has already been used on Thu 2/11/15. Are you sure you want to overwrite the data in this baseline?

L D[ ]

Figure 226 - Re-Baselining

6. After the project has been re-baselined add a note to the top left Identifier cell
located in the Project No. row. The note should include the details outlined in the
Adding Notes and Hyperlinks to a Task section. The recipient list should include all

parties affected by the base-line adjustment.
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iR Be3 B il 5 = Y

Resource View Format

Task

Subproject Project  Custom Links Between WES Change Calculate Set Move Update Visual Reports Compare | Spelling
Information Fields Projects - ‘Working Time Project Baseline = Project Project Prot uals | Reports Projects
Insert Properties Schedule Status Reports Proofing
@ Task - Task Name - Duration - Start - Finish - Predecessors - Add
y Mod
o = - P RTATATA'RTATAS i
O?— Put a note here 44.65mons  Fri12/4/15  Wed 5/8/19
1 = = 1Project Initiation 21 mons Fri 12/a/15 Thu 7/13/17
: ol = 1.1 Prepare and Submit PRI 10 mons Fri 12/4/15 Thu9/8/16
: & = 1.2 Prepare and Approve RPM 8mons Fri 9/9/16 Thu 4/20/17 2
4 e T 1.3 Secure Funding/Autharization 3 mons Fria/21/17 Thu 7/13/17 3

Figure 227 - Re-Baselining Note

After the project has been re-baselined change the view to a Tracking Gantt view.

1. Inthe left dark grey bar shown below, right click and select Tracking Gantt.

| = R R Gantt Chart Tools _New Minimum Requiremnts__ - Microsoft Projes

Task Resource Project View Format
E E Metwork Diagram ~ ,_=-3Resource Usage ~ Al » Highlight: [Mo Highlight] = Timescale: li_"l @ i
J Calendar ~ .3 Resource Sheet - Z = W Filter: [Mo Filter] - [18] Weeks - _&
Gantt Tas Team = Sort  Outline Tables Zoom Entire Sele
Usage - ﬂ Other Views = Planner~ [ Other Views = - - - Group by: [No Group] - - Project Ta
Task Views Resource Views Data Zoom
o Task _ Task Name . |Duration . |Start - |Finish

Mod
= = Project XXXX-XXXX 34.65 mons  Fri 12/4/15 Wed 8/
=2 = 1 Project Initiation 13 mons Fri 12/4/15 Thu 12/1
= 1.1 Prepare and Submit PPI 6 mons Fri12/4/15 Thu 5/1¢
=) 1.2 Prepare and Approve RPM 4 mons Fri5/20/16 Thu9/8/
=) 1.3 Secure Funding/Authorization 3 mons Frig/f9/16 Thu 12/1
2 =2 Preliminary Design nght click on this portlon of 6 mons Fr! 12/2/16 Thu 5/18
2 2.1 Survey 3 mons Fri12/2/16 Thu 2/23
G . the window 6 mons Fri12/2/16 Thu 5/1¢
=S .3 Develop PD through Design Approval 6 mons Fri 12/2/16 Thu 5/18
= 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/18
= ='3 Final Design 13 mons Fri5/19/17 Thu 5/137
=S 3.1 Prepare Semi-Final Design Submission 7 mons Fri5/18/17 Thu 11/3
2 3.2 Prepare Final Design Submission 5 mons Fri12/1/17 Thu 4/1¢
2 =' 3.3 ROW Coordination 9 mons Fri5f19/17 Thu 1/25
= 3.3.1 Prepare and Submit Final Accepted Property Maps 3 mons Fri5/19/17 Thu 8/1C
= 3.3.2 Acquire Properties 6 mons Fri8/11/17 Thu 1/25
= = 3.4 Permit Acquisition Process 13 mons Fri 5/19/17 Thu 517
= = 3.4.1 Permit A 7 mons Fri 5/19/17 Thu 11/13
= 3.4.1.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/19/17 Thu 8/1C
2 3.4.1.2 Regulatory Authority Review and Issuance of Permit 4 mons Fri 8/11/17 Thu 11/3
2 = 3.4.2 PermitB 7 mons Fri5f19/17 Thu 11/3
= 3.4.2.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/19/17 Thu 8/1C
2 3.4.2.2 Regulatory Authority Review and Issuance of Permit 4 mons Fri 8/11/17 Thu 11/3
= = 3.4.3 Permit C 8 mons Fri 10/6/17 Thu 517
= 3.4.3.1 Prepare and Submit Permits to Regulatory Authority 2 mons Fri 10/6/17 Thu 11/3
= 3.4.3.2 Regulatory Authority Review and Issuance of Permit 6 mons Fri12/1/17 Thu 5/17
=
=S 5FDP 0 mons Wed 5/23/18 Wed 5/2
2 6 DCD 0 mons Wed 7/4/18 Wed 7/4
2 7 ADV 0mons Wed 8/1/18 Wed 8/1

Figure 228 - Changing to a Tracking Gantt

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the
one on top is the actual duration. If there is a slip in a task schedule it will be shown as an
offset.
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QOfr 3, 2015 [atr 4, 2015 [atr1,2016 [atr2,2016 [atr3,2016 [atr 4, 2016 [atr1,2017 [atr2,2017 [atr3,2017 [atr4,2017
Jul [Aug [Sep | oct [Nov | Dec [ Jan [Feb [ Mar | Apr [May [ Jun [ Jul [Aug [Sep | Oct [Nov | Dec [ Jan [Feb[Mar [ Apr [May[ Jun | Jul [ Aug [ sep [ Oct | Nov [ Dec
&
Project Initiation G — 17/1
P d Submit PPI §
repare and Submit PRI (\ Current (Actual)

0%

Prepare and Approve RPM

Secure Fanding/Authorization

Preliminary Design P 0%
0%
NEPA{CEPAL—: 0%
g 0%
Design Approval o 5/18
Final Design :
Prepare Semi-Final Design Submission 5" g

Figure 229 — Tracking Gantt view

2. Next to change the table of tasks to the tracking mode, click on the left upper corner
cell to select the entire schedule, then right click and select tracking.

Tory REE L ry e sl

Project XXXX-XXXX Thu 10/1/15 %
Project Initiation Thu 10/1/15 olect nitiation P——— §/3
T itest/schedule e 0%
e
Prepare and Approve REM B 0%
Sccure Funding/Authoriation & 8/3

Reauest survey po 8/3
Develop PD Submissior] S 0%

ROW Activitiet s 0% |
Design Approval-30% & 1/18
19 " Final Design OF

Prepare Semi-Final Design Submission & o%

11 mon: Permit Acquisition Process o
4
OFP Review ) 0%
OEEP Review ¢ & 3 0%

Authorize ROW £ 3 o%
Generate Property Maps & o
Last Final Property Maps Delivered to ROW ¢ 10/25

Conduct Evaluations/Negotiations s 0%
Acquie Properties E— Pk
- 3 0%

Dumeny Tesk 10%
e
e
o 919

Figure 230 - Changing to tracking table

The table of tasks will now be in the tracking mode,

3. Then click save.

8.3.2 Recording Task Progress

The project manager will be required to record the project progress by keeping an up to date
record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:

1. Click on a task.
2. Then in the task menu select the appropriate % complete as shown below:
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Gantt Chart Tools

ighway_AEC__.mpp icroso

Project View Developer Format 3
=== i #
.; == K cut X Q - % |:|—| 3 y
E Calibri |11 - ?Mark onTrack = o [aa! ; e
0 53 copy - . = = :
Gantt Paste B J U | &~ A~ T w | =2 cWMERespect Links Manually| Auto Inspect Move Mode Task Summary Milestone | I
Chart~ ~ < Format Painter = - Sthedule |Schedule - - - -
View Clipboard Font Fl Schedule Tasks Insert
Task Name - |Act.Start  _ |Act.Finish  |% Comp. - Rem. Dur. Add New Colun| |1 September 1
1
0 |~ Project XXXX-XXXX Thu 10/1/15 NA 4% 1.71 mons 3 ons - |
1 - Project Initiation Thu 10/1/15 NA 25% 2.89 mons 8.66 mo! Then select the &
2 Define scope/cost est./schedule Thu 10/1/15 MNA 25% 1.75 mons 5.25 mons ]
P % to update
3 PPI MA MNA 0% 0 mons 0 mons
L « Prepare and Approve RPM i Fri4/29/16 NA 25% 1 mon 3 mons ti
=&
5 Secure Funding/Authorizati MA MNA 0% 0 maons 0 mons
2] = Preliminary Design NA NA 2% 0 mons 6 mons
7 . . e - - .
Make sure the task to be updated is
& Develop PD Submission
s ROW Activities

clicked on (Selected)

Fimcicn Aeenaeal A0S nin a nos [ — [ —

2

Figure 231 - task update tools

Important Note: When the task is completed, do not select 100% complete. You will need

to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will
calculate the actual finish date instead of recording the physical date the task was completed.

In the tracking Gantt, the task will show the percent complete of the task as shown below:

3%

024

Figure 232 - Updated task view

Coémpleted

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the

following figure.
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[December 11 [April 21 1 [lanuary 11 [May 21

[October 11 [February 21 [luly 1 [November 11 [March 21 [August 1

9/27 [11/29[1/31 [ 4/3 [ &/5 [ 8/7 [10/9 [12/11[2/12 [ 4/16 [ 6/18 [ 8/20 [10/22[12/24] 2/25 [4/29 [ 7/1 [ 9/2 [11/4] 1/6 [3/10 [5/12 [7/14[9/15 [1
b ) 5%

ation QP P 12/1

Preliminary Design [ 53

== 0%
: 0%

By 25%
> = =
RZO% Slipped from the baseline
0%
Design Approval ‘:|-5+1&—
Final Design f P 6%
Prepare Semi-Final Design Submi: ‘ié%
0%
T M
Prepare and Submit Final Accepted il na 125%
S——
Acquire D%
Permit Acquisition Process ¥ 0%
Pl 0%
Prepare and Submit Permits to Regulatory Authori
Regulatory Authority Review and Issuance of Permit
¥ ¥ 0%
===
o
0%

1 1’0%
< Q—Iff 17
< 11/28

< 4 12/26

Figure 233 - Tracking View
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8.4 Generating Reports and Summaries

Microsoft Project provides different forms of reports and visual summaries. MS Project has
three reporting options:

1. Standard Reports
2. Custom Reports
3. Visual Reports

Standard Reports

Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs,

assignments and workload.

Under Overview the following is reported:

Project Summary
Top-Level Tasks
Critical Tasks
Milestones
Working days

Under Current the following is reported:

Un started Tasks

Tasks Starting Soon

Tasks In-Progress
Completed Tasks

Should have Started Tasks
Slipping Tasks

Under Cost the following is reported:

Under Assignments the following is reported:

Cash Flow

Budget

Overbudget Tasks
Overbudget Resources
Earned Value

Who does what

Who does what when
To-do List

Overallocated Resources

Under Workload the following is reported:
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To access these report options go to Project > Reports

[LI0"  AdSRa k] ‘.‘;m.:a:a.u.‘,a._| Highway AEC_mpp - Microsaft Project )

“Jask Resaurce

ew Developer Format

HB

=3 % Status Date: 312315
=

. :I] Update Project
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Task Name . |ActStart  ActFinish . %Comp. . ActDur . Rem.Dur. | AddNew Colum | [uly1 [November 21 [April 11 [September 1 [ianuary21 [lune1l  [Novemberl [March2l [August1l
6/7 | 8016 [10/25] 1/3 [3/13 [5/22 [ 7/31 [ 10/a [12/18[ 2/26 [ 57 [7/16 [92a [ 123 [ 2jiaaj2 [ 7)1 [ 9f [1
0|~ Project XXXX-XXXX Thu 10/1/15 NA 6% 2.33mons  36.87 mons L 0 6%
1 = Project Initiation Thu 10/1/15 NA 34%  3.94mons 7.61mons Initiation /S ————————my /18
2 Define scope/cost est.fschedule Thu 10/1/15 NA 25%  1.75mons 5.25mons i@lﬁ%
3 PRI NA Reports [ %] /13
4 Prepare and Approve RPM Frid/29/16 repaie and Approve RPM 50%
5 Secure Funding/Authorization NA e A Secure Funding/ Authorization <) 8/18
i - .
6 = Preliminary Design NA m a . Preliminary Desigr| TpE——1y 3
7 NA § 8/18
8 Develop PD Submission NA Develop PD Submissior} 0%
o Qerview... Current. Costs... .
£l ROW Activities NA| ROW Activities?==" 0%
10 Design Approval-30% NA| o Design Approval-30%4r 2/2
11 = Final Design NA DUUU Final Design W 0%
12 Prepare Semi-Final Design NA e Prepare Semi-Final Design Submissi 0%
Submission
. o Assignments... Workload... Custom... ; -
13 = Permit Acquisition Process NA Permit Acquisition Process 0%
ﬁ% 1 QEP Review NA NA 0% 0mons Imons. OFEP Rwiew:@ym
‘; 15 DEEP Review NA NA 0% 0mons 8mons DEEP Revi 0%
= T3 = ROW Arnusisitinn Prarese NA NA 0% Nmone 1amone 0%

Figure 234 - Report options
Custom Reports

A custom report has the ability to customize the report based on templates in the following
categories:

e Task
e Resource
e Monthly Calendar
e Crosstab
To access custom report tool, go to Project > Reports > and double click on Custom

‘Gantt Chart Tools ighway_AEC_. icr roj
iew Developer Format A
= = Status Date: [if] 3/23/15 ==
== = (== ¥
L) il = &
. ] l‘f'} ='| update Project AJ
Subpraoject Project  Custom Links Between WES Change Calculate  Set Mave visual {Reports Fompare | Spelling
Information Fields Projects - Working Time | Project Baseline ~ Project Reports Projects
Insert Properties Schedule Status REparts Proofing
Task Name ~ |Act.Start  , |Act Finish . % Comp.  |Act.Dur. . |Rem.Dur. - Add New Colum | _[July 1 November 21 | A
6/7 | 8/16 [10/25] 1/3 [ 3/1
O = Project XXXX-XXXX Thu 10/1/15 NA 6% 2.33 mons _ 36.87 mons —_—
. P - n A
- e —
1 Project Initiation e - - —— g Initiation §J
2 Define scope/cost est./schedule — — @l
s il ; +
G Prepare and Approve RPM m E Prepare and Approve RPM =
5 Secure Funding/Authorization . i Secure Funding/Autk
6 = Preliminary Design Prelimin:
7 Overview... Current
£ Develop PD Submission Develop PD ¢
El ROW Activities ..% ROV
10 Design Approval-30% & II/
i1 = Final Design
- . Assignments. .. W
iz Prepare Semi-Final Design Prepare !
Submission
12 = Darmit Aranicitinn Drarace nA M oz Amane 11 mane

Figure 235 - Custom Reports
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Then the report to be edited is first selected from the list of available custom report. Next, click
the Edit button. The dialog will show the current report’s setting and all the available report

settings.
= Project Initiati e 5 3%  3.94mons 7.61 mons Initiation §j e 8/18
Define scope/cos| Sl P5% 1.75 mons 5.25 mons _JElﬁ%
PPI Reports: 0% 0 mons 0 mons 4713
Prepare and Appr| | Resource Usage ,2 B0% 2 mans 2 mons Prepate and Approve RPM 50%
N Resource Usage (material) H 3 irati
Secure Funding/4 Recource Usage (nork) ’ 0% 0 mons 0 mons Il 5| Secure Funding/Authorization 8/18
= preliminary Design | | Should Have Started Tasks — 0% o [|Design| Py (3
YDESEN || g ke Task Report g =5
0% o )‘lB/lB
itony petails | Sort | -
Develop PD Sub Tasks In Progress = 0% 0 0%
ROW Activities || Tasks Starting Soon 0%  0f| Neme:  Task iviti 0%
- To Do List . - ¥
Design Approval- Top Level Tasks o 0% ) Period:  Entire Project - Design Approval-30%4¢1, 2/2
= Final Design 0% 0 Final Design
Prepare Semi-Fin| 0% ] : hi-Final Design Submissi 0%
ub ! Table:  Entry -
= Permit Acquisition Process NA NA 0% 0| |lermit isition Process
OEP Review NA NA 0%  og Ot MlTess M Ll [ tee | OFP ReviewcL] o%
DEEP Review NA NA 0% 0| [Zshow summary tasks DEEP Rpview,
= ROW Acquisition Process NA NA 0% od)| [leray bands v
Authorize ROW NA NA 0% [ thorize ROW 0%
y NA NA 0% 0 Generate Property Mapsc) a
Last Final Property Maps Delivered NA NA 0% [} Last Final Property Maps Delivered to RO
to ROW ~ m T
Conduct Evaluations/Negotiations NA NA 0% 0mons 2mons F Conduct Evaluations/Negotiation:
Acquire Properties NA NA 0% 0maons 7 mons Acquire Propertic
Prepare Final Desizn Submission NA NA 0% 0mons 8 mons —_—

Figure 236 - Customizing a report template

Other than the Definitions tab you may utilize details and sort tabs for further customization.

Visual Reports

Unlike the standard/customized reports which are text based, visual reports present the report
graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio
pivot-diagrams.

To access go to Projects tab > Visual Reports

Highway_AEC_.mpp - Microsoft Project

= 538

Visual Rfports Compare = Spelling

BH9- -

Task  Resource | Froject | View  Developer Format
= E (=9 HD

Subproject  Project Custom Llinks Between WBS  Change  Calculate  Set  Move

= E Status Date: 5 3/23/15

='| Updste Project

Information Fields  Projects ~  WorkingTime | Project Baseline - Project Projects
Insert Properties Schedule Status Reports Proofing
Task Name - |Act.Start  , |ActFinish . |%Comp. . Act.Dur. . |Rem.Dur. - | Add New Colum [ [luly 1 [November 21 [April 11 [September 1 [lanuary21 )
6/7 | 8/16 [10/25[ 1/3 [3/13 [ 5/22 | 7/31 [ 10/9 [12/18] 2/26 | 5/7
0 |~ Project XXXX-XXXX Thu 10/1/15 NA ' —— - ==
. L Visual Reports - Create Report [
1 = Project Initiation Thu 10/1/15 NA P P
2 Define scope/cost est./schedule Thu 10/1/15 NA Select Template Select the
5 PPl NA NA h e —— appropriate tab for
4 Prepare and Approve RPM Fri 4/29/16 NA | Tasksummary | Resourcesummary | Assignmentsummary | , your intended goal
5 Secure Funding/Authorization NA NA Al | TaskUsage | ResourceUsage | AssignmentUsage | -
& = Preliminary Design NA NA T ol DNew Template... ) 0%
7 NA NA 9] Baseline Report (Metric) EResource Remaining |
8 Develop PD Submission NA NA ] Baseline Report (US) %]Rm”"efmus Repo - | ===
= o
B ROW Activities NA NA =) Baseline Work Report T Resource Status Repo L.
= =) Budget Cost Report =] Resource Work Availa oo Y.
10 Design Approval-30% NA NA 5 Budget Work Report B Resource Work Summm O 2/2
11 = Final Design NA NA =1 Cash Flow Report (2] Task Status Report (M| Jl Design
12 Prepare Semi-Final Design NA NA 4H) Cash Flow Report (Metric) (2] Task Status Report (U i
Submission 2] Cash Flow Report (US)
9H) Critical Tasks Status Report (Metric)
= E . -
- Permit Acquisition Process NA NA ] Critical Tasks Status Report (US) = ¥
c . OEP Review NA NA =) Eamed Value Over Time Report l l P Review,
o IR DEEP Review NA NA "_]Resnur:EAva!\ah!\!ty Report (Metric) _J DEEP R
< = ROW Acquisition Process NA NA Resource Availability Report (US)
g . < i ] 3
= B Authorize ROW NA NA —— |8 i Tabl fze ROW
Ge pert s NA NA Select level of usage data to indude in the rapovt\m.g_/—\mﬁ of available report Generate Property May
15 I nal Property Maps Delive
Last Final Property Maps Delivered NA NA [Flinchude report templates from: Temp[ates perty Maps
to ROW
Modify... .
20 Conduct Evaluations/Negotiations NA NA == Conduct Evaluations,
21 Acguire Properties NA NA
22 i i issi 4 T:
Prepare Final Design Submission NA NA Then Clle ‘ lew
23 NA NA
24 FDP NA NA
e - VAR (=

26 ADV NA e L Tmons i T
Figure 237 - Visual Reports
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Section 9 CTDOT Project Location - Under
Development

This section details the required information/documents that need to be submitted to CTDOT to
locate all of our projects on a GIS (Geographic Information System).

The lead designer shall be responsible for providing the information/documents detailed in the
following tables when filling out or updating the Project Asset Form located on the Projectwise

Project Information Webpage at the following link:

Projectwise Composite Data

This information/document needs to be submitted or updated at the following project
milestones:

e RPM

e Design Approval

e Final Design

The following tables detail what needs to be provided on the Project Asset Form for various
project types. If your project type is not listed, contact AEC applications for guidance:

Mathew.calkins@ct.gov or John.Rinaldi@ct.gov

Project Milestone - RPM

Project Type Required Instructions
Information/Document
Highway Paving Routes and Mileage Section 8.1.1
Guide Rail, Barrier, Safety Improvements | Routes and Mileage Section 8.1.1
All other highway projects Google Earth KML
Bridge Bridge Preservation projects Route and Mileage Section 8.1.2
Bridge Maintenance projects Route and Mileage Section 8.1.2
Bridge Replacement or Superstructure Google Earth KML Section 8.1.3
Replacement
Retaining Wall Projects Google Earth KML Section 8.1.3
Sign Support Projects List of sign supports in the Section 8.1.2
project
Traffic Traffic Signals List of traffic signals in the | Section 8.1.2
project
Signing Route and Mileage Section 8.1.1
Pavement Markings Route and Mileage Section 8.1.1
Rumble Strip Route and Mileage Section 8.1.1
Facilities New Facility or Rehab of Existing Facility | Google Earth KML Section 8.1.3
Rail Project Google Earth KML Section 8.1.3
Rails ‘ Rail Project Google Earth KML Section 8.1.3
District Wide
Projects
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State wide
Projects

Project Milestone — Design Approval

Project Type Required Instructions
Information/Document
Highway Paving Updated Routes and Mileage if | Section 8.1.1
necessary
Guide Rail, Barrier, Safety Updated Routes and Mileage if | Section 8.1.1
Improvements necessary
All other highway projects Microstation Project Polygon Section 8.2.1
File
Bridge Bridge Preservation projects Updated list of bridges in the Section 8.1.2
project if necessary
Bridge Maintenance projects Updated list of bridges in the Section 8.1.2
project if necessary
Bridge Replacement or Microstation Project Polygon Section 8.2.1
Superstructure Replacement File
Retaining Wall Projects Microstation Project Polygon Section 8.2.1
File
Sign Support Projects Updated list of sign supportsin | Section 8.1.2
the project if necessary
Traffic Traffic Signals Updated list of traffic signalsin | Section 8.1.2
the project if necessary
Signing Updated Routes and Mileage if | Section 8.1.1
necessary
Pavement Markings Updated Routes and Mileage if | Section 8.1.1
necessary
Rumble Strip Updated Routes and Mileage if | Section 8.1.1
necessary
Facilities New Facility or Rehab of Existing Microstation Project Polygon Section 8.2.1
Facility File
Rail Project Microstation Project Polygon Section 8.2.1
File
Rails Rail Project Microstation Project Polygon Section 8.2.1
File
District Wide
Projects
State Wide
Projects
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Project Milestone — Final Design and Construction

Project Type Required Instructions
Information/Document
Highway Paving Updated Routes and Section 8.1.1
Mileage if necessary
Guide Rail, Barrier, Safety Improvements Updated Routes and Section 8.1.1
Mileage if necessary
All other highway projects Updated Microstation Section 8.2.1
Project Polygon File
Bridge Bridge Preservation projects Updated list of bridges in Section 8.1.2
the project if necessary
Bridge Maintenance projects Updated list of bridges in Section 8.1.2
the project if necessary
Bridge Replacement or Superstructure Updated Microstation Section 8.2.1
Replacement Project Polygon File
Retaining Wall Projects Updated Microstation Section 8.2.1
Project Polygon File
Sign Support Projects Updated list of sign Section 8.1.2
supports in the project if
necessary
Traffic Traffic Signals Updated list of traffic Section 8.1.2
signals in the project if
necessary
Signing Updated Routes and Section 8.1.1
Mileage if necessary
Pavement Markings Updated Routes and Section 8.1.1
Mileage if necessary
Rumble Strip Updated Routes and Section 8.1.1
Mileage if necessary
Facilities New Facility or Rehab of Existing Facility Updated Microstation Section 8.2.1
Project Polygon File
Rail Project Updated Microstation Section 8.2.1
Project Polygon File
Rails Rail Project Updated Microstation Section 8.2.1
Project Polygon File
District Wide
Projects
State Wide
Projects
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9.1 Project Location - RPM

9.1.1 Route and Mileage

The lead designer shall provide all routes and mileages for project in accordance with the
following:

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

Slice Gallery «

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

Project Asset Form

Data View Form

Export to XML or C3SV

Manage My Projects Lists

I |
| |
| Data Import Log ‘
| |
| |
| |

Edit Users

Figure 238 - Project Asset Form

3. Select the project from the drop down or if it is a new project click “Add Project”.

Project Asset Form

| | Number of projects: | 1555 Gotquja - Add to My Projecks [ Add Project_| [ ] Delete Project || Save Pro
Select Project or if it

is a new project click
Add Project

Figure 239 - Selecting Project

4. To get the route and mileage for a project you will need to go to the ALIM system
found here:  ALIM System
5. Next add the route and mileages to the Project Asset Form.
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9.1.2 List of Assets for the Project

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

Slice Gallery =

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

| Project Asset Form |

| Data View Form |

| Data Import Log |

| ExporttoXMLorcsv |

| IManage My Projects Lists |

| Edit Users |

Figure 240 - Project Asset Form

3. Select the project from the drop down or if it is a new project click “Add Project”.

Project Asset Form

L] Number of projects: 1555 | Go tquje N Add to My Projeck [ Add Project | [ ] Delete Project || Save Pro
Select Project or if it

is a new project click
Add Project

Figure 241 - Selecting Project

4. Onthe form add all of the assets in this project.
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1.

Project Asset Form

Add to My Projects | Add Project | ‘ Delete Project U Save Project Data J
— S

Select records: Number of projects: | 1555 | Go to Project: | |0003-0109
Project No: 0003-0109 Inherited Projects:

Contract Number:

Location
Towns: Routes:
Milepoint Start
Milepoint Eng
Biovee™ | Add Asset Information

Assets / and then click Save

ridge Nos: ement Treatment | P roj ect Data
etaining Wall Nos: ign Structures: Edit...
ignal System Nos:

TJesign Intormation

Py Do

Project Manager: ‘ V| Project Manager's Email: |

Consutant Engineer | v| [ Add... | Project Engincer | v
Project End Date: l:| End Date Reason:

User ID Of Creator: ’Sysmm— Creation Date: ’m
User ID Of Modifier: lSystem— Last Modification Date: ’m

Figure 242 - Adding Assets

9.1.3 Project Polygon Creation and Submission

The following shows how to create and submit a project polygon KML file for project location.
The project polygon is created in Google Earth and attached to the Project Asset Form located
on the Projectwise Project Information webpage.

Open Google Earth.

2. Zoom into the location of the project or use the search tool to locate the area of the

project.
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& Google Earth

¥ Search

‘ 2800 Berlin Turnpike, Newington, CT ’ Search
W Museums in New York, NY

Get Directions History

Type in an address
for your project

é;é 2800 Berlin Turnpike, Newington, CT 06111,
USA

re

B [/ X

v Places

4 E@ My Places
4 [V| &3 Sightseeing Tour
Make sure 3D Buildings
layer is checked
(V]84 Start tour here
[¥] The Eiffel Tower

m

Located in Paris, France
[¥] Christ the Redeemer

Located in Rio, Brazil

[¥] The Grand Canyon

Figure 243 - Searching in Google Earth

3. Next select the polygon tool to place a polygon around your project.
&S Google Earth

File Edit View Tools Add Help

¥ Search

2800 Berlin Turnpike, Newington, CT]| Search
ex: Museums in New York, NY

Get Directions History

@ 2800 Berlin Turnpike, Newington, CT 06111,
USA

Figure 244 - Polygon Tool

4. Next Type the project number in the name field and a description in the description
field as shown below:
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Google Earth - New Polygon =]

Game: Project #0123-1234 ) ‘-—-_ Type in Project H#
Description | Style, Color | View | Altitude |/and PrOjECt

[ addiink... | [Addimage... |

Description
CTDOT Main Building Facility Uparade )

[ Ok ] ’ Cancel

Figure 245 - Polygon Settings

5. Next adjust the style and color of the polygon to the settings shown below, do not
click OK after you update the settings:

Google Earth - New Polygon E]

Mame: Project #0123-1234

Style, Color | view | Altitude

Line:

Color: [ width: 3.0 [] Opacty: 100% : ,

Area ‘
Color: pacity: 100% =

~

Set Color to orange
and width to 3.0 and
area to Outlined

7] random

[ o _-]\ Cancel
Do NOT click ok ——— &=

until after the
polygon(s) are
drawn

Figure 246 - Polygon Style
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6. Next draw the polygon for the project. This polygon should encompasses the whole

Google Earth - New Polygon

Name:  Project £0123-1234

Desaription | Style, Color | View | Alitude |

project and include all the roads that this project will affect. Then click OK.

Lines

color: [ width: 3.0 [+] Opadty: 100%

Area

[7] Random

Draw polygon and
then click OK

S=E65014 Google

Figure 247 - Drawing the Polygon

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located
in the places area, which is in the left hand side of the screen, of Google Earth. Then redraw the

polygon by going back to step 3.
[+ JiF]
Places

- W] 5t Peters Basilica

Located in Vatican City

- [¥] The London Eye

Located in London, England

- [¥] The Titanic

- [¥] The Forbidden City

Located in China

- Mount Fuji

Located near Tokyo, Japan

- || Google Headquarters

- [V Project #0123-1234
CTDOT Main Building Facility

- O Temporary Places
Q@

¥ Layers

4 E‘@ Primary Database
- F

Borders and Labels

Places

b = Photos

- V1= Roads

> [l 30 Buildings
d DQ Ocean

d D'ﬁ‘ Weather

> D\:-? Gallery
I =

Located in the North Atlantic Ocean

( Delete
-

Right Click
and Select
Delete

It

Cut

JE——

Rename

Save Place As...
Share with Google Earth Community

Email...

Snapshot View

Properties

Figure 248 - Deleting a Polygon
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7. If the project has multiple sites, go back to step 3 and create another polygon(s).
After you create all your polygons they will be listed in the places area in Google
Earth.

E X

The London Eye -

Located in London, England
[¥] The Titanic

Located in the North Atlantic Ocean

The Forbidden City

Located in China

Mount Fuji

Located near Tokyo, Japan

Google Headquarters AII Sites for

e

1) Project #0123-1234 Prolect
Site 1
[V]{") Project #0123-1234 8
Site 2 - "\
Be Temporary Places et |
Q| + ¥
¥ Layers Earth Gallery » |
4 [@ = primary Database

> @ P Borders and Labels
H m [31 Plarec

Figure 249 - All Sites for Project

8. After all the sites are made they need to be added to the temporary places area in
Google Earth so a combined KML file can be saved. To add them to the temporary
places simply drag and drop all the sites into that area as shown below:

Issued 01-2016 212 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

[+ e

E ! he London Eye

Located in London, England
[¥] The Titanic
Located in the North Atlantic Ocean

[¥] The Forbidden City

Located in China

[¥] Mount Fuji

Located near Tokyo, Japan

EGoog]e Headquarters sites into the

Located in Mountain View, California

/temporary places

(V] Project #0123-1
Site 2 E
Q| 4 ¥
v Layers Earth Gallery »

4 '9 Primary Database
> @ P Borders and Labels
@ Places

Figure 250 - Drag all the Sites into the Temporary Places

9. Next to save a KML file with all the polygons in it right click on Temporary Places and
select Save Place As:

[ + ¥, x
¥ Places

- [¥]The London Eve -

Located in Londen, England

- [¥] The Titanic
Located in the Morth Atlantic Ocean Rig ht cl ick on

- [¥] The Forbidden City
Located in China Temporary Places and
select Save Place As

- Mount Fuji

Located near Tokyo, Japan

- Google Headquarters

w, Califarnia

Add 3

Copy
Delete Contents

Save to My Places

Save Place As...

Emnail...

¥ Layers

¢ [0 = Primary Database Snapshot View
's IP Borders and Labels
Places
: = Photos
- V= Roads

Figure 251 - Saving the KML File
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10. Next type in the project number for the file name and select KML for the file format.
Then select the folder on your computer where you want to save the file too and click

Save.

@ Save file... @
@U'|I Desktop » i | "' S ki £
Organize v MNew folder 4= - @
T Favorites n Name Size Item type =

Bl Desktop & | Temporary Places.kml 6 KB KML File

& Downloads

=l Recent Places

@ Mew Internet Shortcut
@ MNew Projectwise User

1KB Internet Shi
1KB Internet Shy

_ [#BCTCore 1KB Internet Shi
o Libraries 1 ) 92-522 File folder |
3 Documents . New folder File folder
J? Music . DPD Revision History File folder
[ Pictures Lpr File folder
B Videos m . Contractor Submittal Cove File folder
| AECOSim Workspace files Type in Project # for File folder
1M Computer J Survey CGS File folder
& osDisk (€ Lesp Test the name and select Sl folder
Data (D) . Warking Dgaffii ubmitta File folder
=]
@ GIS Data (L) . Digj i€ _Video KML for the format File folder +
% traops (\idot-sdceng01v) (P:) - y/ - ’ b
C File name: | IO E0PER PRI ) ‘/ -
e\re as type: Il(ml (*.keml) j ']
—
= Hide Folders save | Concel |

Figure 252 - Saving the KML File

11. Go to the Projectwise Project Information Webpage: Projectwise Project

Information

12. Click on the Project Asset Form.

Slice Gallery «

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

Project Asset Form

Data View Form

Export to XML or CSV

Manage My Projects Lists

I |
| |
| Data Import Log ‘
| |
| |
| Edit Users ‘

Figure 253 - Project Asset Form

13. Select the project from the drop down or if it is a new project click “Add Project”.
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Project Asset Form

] Number of projects: | 1555 Gotanje '\ Add to My Projec| | Add Project || l Delete Project H Save Proj
Select Project or if it

is a new project click
Add Project

Figure 254 - Selecting Project
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14. Next attach the KML file to the Project Asset Form by clicking on Browse and then
select the file:

Project As

1555

Go to Project: ‘ 01600145 ‘
Project No: IO 160-0145 Inherited Projects: I

Click on Browse and

Select records: ‘ |AH V‘ ‘ Number of projects:

Location then select the file to
Towns: I il D
Milepoint Start |
Milepoint End: |
( Browse... )Download Attachment: || Delete Attachment
Assets

Bridge Nos: I Pavement Treatment: I
Retaining Wall Nos= | Sien Structures: [
Signal System Nos: I

Design Information
Drimary Designer:
Project Manager: | Project Manager's Emait |
Consultant Engincer: | Project Engincer: |
ProjectEnd Date: | End Date Reason:
User ID Of Creator- [System Creation Date [8111/2014 9.41.02 AM
User ID Of Modifier: [System Last Modification Date:  |10/1/2014 9:12:01 PM

Figure 255 - Attaching the KML File
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15. After you have selected the file click on attach file:

Project Assc

1555 ‘GotoProject:‘ 0160-0145 ‘

Project No: IO 160-0145 Inherited Projects: I
—

When combined with other project(s)

‘ Select records: ‘ |A|| V| ‘ Number of projects:

Location . .
Toume l—CIlck attach file i |
Milepoint Start: |
Milepoint End: [
';\Ugerg\cmkingmj@egm( Browse... ‘ Download Attachment | | Delete Attachment
"
Assets

Bridge Nos: I Pavement Treatment- I
Retaining Wall Nos: | Sign Structures: |
Signal System Nos: I

Design Information
Primary Designer:
Project Manager: | Project Manager's Emai: |
Consultant Engineer- | Project Engineer: |
Project EndDate: | End Date Reason:
User ID Of Creator: |System Creation Date: [8/11/2014 9:41:02 AM
User ID Of Modifier- [System Last Modification Date:  [10/1/2014 9:12:01 PM

Deleted selected attachment.

Figure 256 - Attaching the KML File
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9.2 Project Location - Design Approval through
Construction

The following shows how to create and upload a refined project polygon file at and after the
Design Approval milestone of a project. The file shall be created by the lead designer in
accordance with this section and uploaded into the 140_GIS folder of the applicable project in
ProjectWise. For projects that were previously located using the assets or route and mileage
this section does not apply. If changes are made to projects found using assets or route and
mileage update that project information in accordance with Section 8.1.

9.2.1 Project Polygon

The lead designer is responsible for creating the project polygon dgn and kml files using
Microstation. The following section details what needs to be included in the polygon and how
to make the project polygon file for different project types.

If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or
John.Rinaldi@ct.gov for guidance.

If a project has more than one site, all the polygons for that project must be included in one
project polygon file. All the polygons for each intersection shall be in one file.

Highway Projects that Touch Pavement

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or
temporary work area extends beyond that. Below is an example of what to include:

uuuuuuuuuuu 1

Include Temporary

Project Limits
Work Areas

on Local Roads

Slope limits inside of Slope limits outside of
the ROW, draw to the the ROW, draw to the
ROW line slope limits

Figure 257 - Project Extents
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The image below is an example of what a typical project polygon will look like after it is drawn in
Microstation.

Figure 258 — Project Polygon example

Highway Projects that DO NOT Touch Pavement

This type of project could involve, but not limited to the following:
e Guard rail replacement
e Barrier replacement
e Noise barriers

Retaining walls

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, temporary work areas, portions of local affected roads, all affected assets, etc. The
polygon should be drawn up to the right of way line unless the slope limits or temporary work
area extends beyond that. If there is only a ROW line on one side of the project, draw the
polygon relatively close to the edge of the work area. Below is an example of a noise barrier
project and shows what to include:

Draw relatively
close to work area. '

Include any
temporary
work areas

BEGINNING OF PROJECT
42-311

Figure 259 - Highway Project without Full Depth Reconstruction

Issued 01-2016 219 Version 3.11



Connecticut Department of Transportation — Digital Project Development Manual

Full Bridge Replacement or Superstructure Replacement that Touch the Roadway

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or
temporary work area extends beyond that. Below is an example of what to include:

*

4 Project Limits on

N

;
sl

e

= eSS
— Connect Slope Limits
—Across Waterway

par——
U
|
|
it
L

el
:\ f.‘-__l

as7ifnl
|\

i'\ . :&" L ﬁ'-zaif-cé}\lc. SIDE}
[ L ' & Limits of Temporary

b s
ATGH BASIN,
\yq.mos-mﬁﬁ

L
ez Vg 04|

Tjﬁ \| \Work Area

Figure 260 - Bridge Polygon Example

Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway
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Facilities Project

The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel
the facility is located on. Any slope limits or work being done outside of this ROW line shall be
included in the polygon. Below is an example of what to include:

Flgure 261 - Facilities Prolect E
v "

n

i5-010 FOR SALT SHED CORPE“ ELEVATIONS AMD SEE
WOSALY SHED COORDINAT

I0US LOT GEOMETRY AND RADIL SEE DWG NO. C-007.

F ESTASLISHMENT 1S FOR TOPSOR AND TEMPORARY SEEDING
’L‘AD DIRECTED Y THE ENGINEER. REFER TO LDS-002 FOR

&
IRY AND FINAL SETDING 15 SUBIECT TO THE DISTCTION OF
BASED ON SOIL, SLOPE AND SEASONAL CONDITIONS. y

Limits of
~ Construction

8 M TOTAL . 4

INTALL &'HIGH 34 WiDe | i
OOUBLE SWING GATE » o

—— . gy 720 JB

o <
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9.2.2 Project Polygon File(s) Creation

The following steps explain how to create and submit the Project Polygon file. One polygon file
shall be created for each project. If the project consists of multiple “sites,” the file shall include
multiple polygons.

1.

Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be
referenced. This can usually be found within the ground survey file title block. If there
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

In House CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT

seed file located in the W: Drive. See folder address below:
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

Note: If your project is NAD 27 FT still use the 83FT seed.

@ Select Seed File - \\sh3dgs18'CTDOT_VB_Workspaces\Workspace\Standards\seed'\ Geospatial\ )

Lock in: Geospatial e E-
. Name / Date modified Type Size
ool 2D _Poly 27FT.dgn 7/17/201412:59 PM  Bentley MicroStati... 31KB
RecentPlaces 2930 poiy 27Mdan TA7/20141:10 M Bentley MicroStati... 31K
8/26/201412551 PM  Bentley MicroStat... 87 KB
! /& 2D_Poly_83M.dgn 7/17/2014 1:03 PM Bentley MicroStati... 31KB

Desktop

° g

@\

Libraries

Computer
“w

Network

File name: CT_Design_3D_W8i.dgn M

Flesoftype: [ MicroStation DGN s (“dgn) v] | Concel |

3.

Figure 262 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D _Poly 83FT Seed File

Reference the Highway Design file into the newly created file using true scale off and
1:1

Issued 01-2016 222 Version 3.11


http://www.ct.gov/dot/lib/dot/documents/aec/2d_poly_83ft.zip

Connecticut Department of Transportation — Digital Project Development Manual

1] References (1 of 1 unigue, 1 displayed)

= = =
Tools  Settings
B - ] sd o] e 2]2020] 53] 2] 5]25] @) i iode! (Bondaes =)
St ¥ 4 File Name Maodel Description Logical Crientation Presentatior
1 HW _HWY 012 Design Design Design Coincident Wireframe
4 m b
Scale | 1.000000 1.000000 Botation §00°00°00" Offset X | 0.000 Y |D.L

achments: Display Ovemides: | Allov

L d

EIT G |8 67 I 2] tew

Figure 263 — MicroStation reference file settings
Verify that the tentative coordinates of this file match the referenced design (using
stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match, if
they do not check that the scale of the reference is 1:1. If your project is NAD 27 FT we

will move the reference file so the coordinates are correct. To move the reference file
do the following:

a. Select Reference File.
b. Select Move Reference:

1] References (1 of 1 unique, 1 displayed) E\' [=] '@
Tools  Settings m
-1 f | s
:: ﬁ| -ﬂé, X \)| [d | n j;| _'1 | Q‘ }('j| Hilte Mode: | Boundaries
St ¥ 4 File Name Model escription Logical Crientation Presentatior
1 HW_HWY _012... Design Design Design Coincident Wireframe
1 T P
Scale | 1.000000 . | 1.000000 Rotation | 00°00°00" Offzet X | 0.000 Y |0C
’_rr 11 FJJFJFJ’_JJ Mested Attachments: [No Mesting ¥ | Display Ovemides: | Allov
Mew Level Display: [Config Varable ¥ | Georeferenced: [Mo

Figure 264 - Move Reference

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box
key in XY=0,0 and click Enter.
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% Hignway Uperacons

|

Highway
i Key-in — @ M) References (1 of 1 unique, 1 display:
— Key-In XY=0,0 and SR,
or=0.1) El Tocls  Settings
- — =
Landscay hit enter -] ] s | g]l¢
Property '5* i Sot ¥ |§ FieName Mod
structurd [* ‘ 1 HW_HWY 012 Desi
Location| |accldaw
acclisnap & Al T
Traffic
\{ Crawing
4 Drawing
Ay Terrain 1
Scale | 1.000000 2| 1.00
B Y Bl <[ &
New Lewvel Display: |Config Variable =
—I_"nTasks “ 4 Projgct Explorer I

-

| 'f ~ [E NAD 83 FT Views ~ | J |22 ¢|sle]7]el i X|z1572z3 ¥Y|[5e2427

@e Reference > Enter point to move from

> Reference attached

Lavinues v

Figure 265 - Key In

d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the

'\E Highway Operations

Key-In Box key in DL=400124.9,500038.9.

Highway
Hluminal
Landscap
Property
Structurg
Location
Traffic
\a Drawing
4 Drawing

A Terrain

2P Kev-in

2 ) References (1 of 1 unique, 1 dit

— = 1
-~ i By e 4

5 * e Key-ln - E:Zr_q;::v_mz..
poosian [ DL=400124.9,500038.9
T Then Hit Enter

4

Scale | 1.000000

BT Gluf Sk
MNew Level Display: | Config Variable

| 2 Tasks [ Project Exp

Crer J

-

v '~ (¥ NAD 83 FT Views v

X|[2157.869 Y|[1582233

-

b‘[\:'I__\re Reference > Enter point to move to ’ Reference attached
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Now the tentative coordinates of this file should match the referenced design (using stationing,

grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”)

6. Then place a closed polygon(s) using the shape tool or the smart line tool.

7. After the polygon has been placed, turn off all reference displays and fit the polygon to

the view.

8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml

file to Google Earth.

Do this by choosing: File> Export> Google Earth.

9. Google Earth should then automatically open and zoom to the Project Polygon(s)

vicinity.

9.2.3 Project Polygon File(s) Submission

The Project Polygon files shall then be uploaded into ProjectWise in accordance with the

following:
1. Loginto ProjectWise

2. Browse to your project’s 140_GIS folder in ProjectWise Explorer

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface

4. Dragand drop the file into the 140_GIS folder using the Advanced Wizard

0 100_Contract_Plans (PDF)

L__ 110_Contract_Specifications (PDF)
.’ 120_Contractor_Submittals (PDF)
1__, 130_Engineering_Reports

[0 140_GIS

+L- 210_Censtruction

& | Op 2, g;g; @ @4 - search [ Boundany* + [ :Interface| CIDOT Doc_Code
L'-_'_ Address - [>G0
..1_,:?* 0170-2876 Lst | Geospatial|

Label (User Defined)

# B Boundary
# & | Boundary

Description

Project Limits - Southbury, Weston
Project Limits - Southbury, Weston

Figure 267 — ProjectWise project polygon folder example

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and
assign the attributes shown in Table 5 of Appendix E

6. Click Next until the file uploads.

7. When upload is complete, the Lead Designer shall send an email to the following
people including links to the documents in Projectwise. To do this, click on the
document and then highlight and copy the address located in the Address Bar. Then

paste it in the email:

John.Rinaldi@ct.gov (AEC),

Mathew.calkins@ct.gov (AEC)

Henok.Abdisssa@ct.gov (AEC)

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to

the label attribute.
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Section 10 Rights of Way (ROW) Files

This section details the submission of the following Rights of Way (ROW) Files:
e Property Maps Files (.dgn and PDF)
e Parcel Polygon Files (.dgn and KML)

These files shall be submitted at the Project Milestone — Design Approval and updated as
necessary as the project moves through design and construction.

10.1 Submission of the Property Maps Files

The .dgn and PDF files for a Property Map shall be uploaded to CTDOT'’s Projectwise site in
accordance with the following:
1. Loginto Projectwise.
2. Browse out to your project and upload the Property Map DGN and PDF into the
05_Property_Maps folder and 310_Review folder respectively as shown below:

™ # & | 0p 2 EEEE @ © B - Search [0 sasset* - B V\EWIFU\der vl InterfECEIchOT_Du:_Cude vDackgl
¢' s ‘i> - I,Il Address L.N pw:t\ctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0170-2876" - DGO
% 0170-2864_New Landon - Lt | @8 Geospaial|
% 01702875 Name = Description
-2 B A7100_C Pl PD FOP,DCO,FP,Addend d C Order Pl
tract struct
" 100 Contract_Plans (PDF) [£/100_Contract Plons (PDF)  DCD,FP, Addenda, and Construction Order Plans
[ 110_Contract_Specifications (PDF) i /L— 110_Centract_Specifications (PDF) Contract Specifications
-’ 120_Contractor_Submittals (PDF) | | /L— 120_Coentractor_Submittals (PDF) Contractor Submittals Working Drawings, Shop Drawings, etc,
-{Z7 130_Engineering_Reports P> 130_Engineering_Reports Soils, Archaeological and otherReports
-0 140_GIS A0 e e
210_Construction Pqi=pal ruction’s Documents
= A
{T 220 FHWA s 0 Property Map PDF FHWA's Review

- 230_Contract_Administration 230 ting and Award

e - = = g

i 240_Contract_Development K A 240 Shall be u ploaded ssing - PS&E Documents
iffential

-4~ 241 Contract Development C Al here apment Confidential
[ 310 _Review_Documents > A310 Review

-4 320 Permit_Applications A2 320_permit_appuications Permit Applications
= 330_Des\g.n._Data. A2 330_Design_Data Design documents; CAD, Comps, Estimates, et.
-~ 340_Administration A7 340_Administration Project Lead - Administration Documents
L jg;_ﬁdm[;mstratmﬂ_CUnf\deﬂt\ﬂ Alow om “TTST S “sistrators Confidential Information
£ 500_Pre Design
cepts, & Surve
= 01 Planning f)“ Property Map DGN - ¥
-7 02_Concepts
e e P
T 03 Central_Survey shall be uploaded
- 04 District Surve

{2 05_Property_Maps hel’e
4 Saved Searches
{1 0170-3009

Figure 268 - Uploading Property Maps

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface.

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder

5. For each file, continue to click Next in the Advance Wizard until you get to the
Attributes screen and assign the attributes shown in Table 5 of Appendix E

6. Click Next until the file uploads.

8. When the files are uploaded, the creator of the Property Map shall send an email to
the following people including links to the documents in Projectwise. To do this, click
on the document and then highlight and copy the address located in the Address Bar.
Then paste it in the email:

e ROW Supervising Coordinator - Robert.lke@ct.gov

e ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov,
Shandi.Wong@ct.gov

e Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov

e Appropriate Project Coordinator - Steven.Degen@ct.gov,
Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.lreland@ct.gov

To submit a revision to the property maps, use the same steps above but add “Revised” to the
label attribute.
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10.2 Parcel Polygon File(s)

The Parcel Polygon files shall be created by the creator of the property map and represents the
area to be acquired by the State. It should be accurately based on existing property lines and
proposed Rights of Way lines. These files shall be submitted at the Project Milestone — Design
Approval and updated as necessary as the project moves through design and construction.

10.2.1  Parcel Polygon File(s) Creation

The following steps explain how to create and submit the Parcel Polygon CAD file(s). One file
shall be created for each parcel - only permanent land and easement acquisition areas.

When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the
Property Map shall also be submitted into ProjectWise in accordance with this manual, see
section 9.

TEMP. EARTH

RETAINING /
SYSTEM / %

PROPOSED

TEMPORARY
COFFERDAM

WINGWALL

(TYP.) LIMIT OF D.R.O.W.
PROPOSED PROPOSED RIPRAP
15" DIA. SPLASH PAD

R.C. PIPE

Figure 269 — Property Map parcel area example

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map
is in. This is usually found within the referenced ground survey file title block

2. IN House CTDOT Staff — Then create a new MicroStation design file using the correct
seed for the datum in the project located in the W: Drive. See folder address below:
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

Select Seed File - CTDOT_V8_Workspa

Look in: Geospatial - @ e

c g

[0

Date modified Type Size
7/17/201412:59 PM  Bentley MicroStati... 31KB
7/17/2014 10 PM Bentley i

8/26/201412:51 PM  Bentley (N
7/17/2014 1:03 PM Bentley MicroStati... 31KB

File name: CT_Design_3D_Véidgn - Open

Files of type: MicroStation DGN Files {*dgn). - | Cancal |

Figure 270 - Seed File
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Consultant Staff: Download the seed files using this link: Geospatial Seeds
3. Reference the Property Map file into the newly created file using true scale off and 1:1

7] References (1 of 1 unique, 1 displayed) EI =] @

Tools Settings

-] ] ad o | gl ]| )20 )30 53] el [ 27| O sep e e (Boundaies )

St ¥ 4 File Name Model Description Logical Crientation Presentatior
1 HW_HWY_012... Design Design Design Coincident Wireframe

4| [ | b

Scale | 1.000000 - | 1.000000 Rotation Y00°00°00" Offset X | 0.000 Y | 0C
EEW ’5|1I|EJJEEFJEQJ Nested Mtachments: Display Ovemides: | Allov

Figure 271 - Reference File

4. Verify that the tentative coordinates of the new file match the Property Map (using
stationing, grids, etc.)

5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).

Then place a closed polygon using the shape tool or the smart line tool.

7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the
creation of property maps. The task contains “Shape for GIS” tools which can be used
for polygon creation:

o

Tasks v I X J Tasks v |
CT Property Maps [
¥ Tasks = l | P
T 9 LY [ °-0
J 58 S ﬁ :f L9 ;[_j)—l’ —3< o j ﬂ";-ﬂ,vi%-fj?v'f fi‘v_;]-% Sk
_-_'_}"»_'_P p A, 5 v;}f S o B _;J_l‘-—Lh 2 N\ @ ¥ l._.l
;}“' b ._). J,E\), Av \‘)n —,'»
CT Architectural ll
- < ROW Lines v
CT Highways adl
- # Map Info v
CT Illumination v
® Notes v
CT Landscape ~
A Dimensions v
CT Site Design wd
~* Internal Use Map Preparation v
CT Structure Bridge -0 1=
i Utilities v
CT Traffic i
CT Sheet Composition ad
CT Publishing v _ & € Shape for GIS (no arcs)
CT Location Survey e @ VIShapefOf GIS (with arcs)
CT Property Maps ol

Figure 272 — Custom MicroStation tasks
8. After the polygon has been placed, turn off all reference displays and fit the polygon to
the view.
9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml
file to Google Earth by choosing: File> Export> Google Earth.
10. Google Earth should then automatically open and zoom to the Project Polygon vicinity.
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10.2.2 Parcel Polygon File Submission

The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following.
[Note that if the parcel geometry remains unchanged with subsequent Property Map revisions,
it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted]
1. Loginto ProjectWise
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project.

B Dp 2, - En @ @4 - search [0 Boundany® + [ | Interface| CTDOT_Doc_Code

[ : Address * oo
..I_,:N 0170-2876 - Lst | @ Geospatial |

1-- 100_Contract_PIan5_FPDF_'l Label (Uzer Defined) Description

- 110_Contract_Specifications (PDF) ; - .

120_Contractor Subrmittals (PDF) # B Boundary Project Limits - Scuthbury, Weston

" - = ; . .

‘ 130_Engineering_Repors # & | Boundary Project Limits - Southbury, Weston

210_Construction

1__,_ 140_GIS

Figure 273 - ProjectWise parcel polygon folders example

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface.

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder

5. For each file, continue to click Next in the Advance Wizard until you get to the
Attributes screen and assign the attributes shown in Table 5 of Appendix E

6. Click Next until the file uploads.

9. When the files are uploaded, the creator of the Property Map shall send an email to
the following people including links to the documents in Projectwise. To do this, click
on the document and then highlight and copy the address located in the Address Bar.
Then paste it in the email:

e ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov,
Shandi.Wong@ct.gov

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to
the label attribute.
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Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam

These steps only need to be completed the first time using Bluebeam or when the user logs into
a new computer.

R

Bluebeam
Revu

1. Open Bluebeam by selecting the desktop icon:

If you do not have a desktop icon, select Start>Bluebeam Software. Right click on Bluebeam
Revu, select Send To>Desktop (create shortcut). This will place the Bluebeam icon on your
desktop:

PW_Delet.., EED Estimator... Rename)

» | Seriptiogic Corporation
'i@ section wizard

) AutoTrack 'i@ SiteManager

) BASINS » | SiteManager Training
) BCAP4O » ) sMs 10.0

) Bentley * ) sMs 101

) Bentley Cvil Engineering » i) snagns

> | Snagh Studio

» |7 Spectra Precision
D) Help ,
» |5] sluebeam Administrator

Open

» =
{7 "

StormCAD  StormCAD
V8i for Mi... v8i

P Y Y Y Y Y Y Y w vow w

am Stapler

o Bl Restart POF Printer i
f consans. RIGNECHCK B Som5———  copu
™) Engineering Applications o) Endpoin
EPA SWMM 5.0 @) TDS Survey Works_ S22 for Viruses...
) Estimator ) TextPad 3 Compress to ZIP + Options...

) Filezilla FTP Client ) Trimble Data Tran S Compress to "Revu.2ip" .
) Gadwin Systems

™) Google Sketchup 7

) Google SketchUp 8

) GPS Pathfinder Office 2.90
) GPSurvey

2 v Select Send To
) HY8Energy

) Hy-8

) Hydraflow Hydrographs 2004
) Hydraflow Storm Sewers 2003
) Hydraulic Toolbox

J Bluebeam POF Printer
¥ sluebeam Stapler
£ Compressed (zipped) Folder

-

crea

Yy v Y v v vy v v w

) InterVideo WinDVD Y Bing Maps 30
) K-Lite Codec Pack M checkras
) LightScribe Direct Disc Labeling {3 Fishxing V3 beta
) McTrans & HOS 5 Chart Calculator 1.5.8
» &) Microsoft Office & Internet Explorer
, (T Microsoft Siiverlight (%) Outlook Express
) MicroStation 4 paintneT
* ) NVIDIA Corporation € Pathfinder Office C g

@' Pathfinder Office Project Changer
Qm«wmm
.. Remote Assistance

, ) Oracle - OraClient10g_home
) Pathfinder Office 2.51
d Support ) PENNDOT Programs

{7) PowerArchiver 2001 & samwin

) PrimoPDF (2) Windows Media Player

) QSE Software Suite 4 Windows Movie Maker

) RAM Concept 2.1 ) Google Earth »

Windows XP Profess

) RAM Connection 4 B Textrad

. | 28 P ) RAM Structural System

[EPBLOS DM o row

Y Y Y Y Y YT Y YTYTYT YT YTYYTYYTYYTY YY YO

Figure 274 - Creating Desktop Shortcut
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2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on the settings icon in the top right hand corner and click Preferences as shown
below. If you cannot find the settings icon in the top right, go to the Edit menu and
select Preferences.

Figure 275 - Bluebeam Preferences

4. Click on File Access and make sure the box is checked as shown below: If ProjectWise is not
listed click on Add

i o)

Preferences @

Camera S Recents

Uocumen [¥] Enable Recent Fil ltems in Rec -
able Recent Files e::clzmec Check th|5 ]

Fomme Show preview of POF
General

Document Management Systems 0 pt I 0 I'I
Grid & Snap

Hypedinks | i i | SNEreroint Upuons... ]
Import/ Export 3 Always show selection dialog

Markup [+f] Enable batch checkdn when closing Sets

Markups Tab
Mavigation | Tvpe Location Status
FOFAA -

Presentation c I l G k Ad d

Rendering
Rendering 3D
Sets

Sets (Advan...

Signature ( >
Sketch Tools &7

[ Impart H Export ] [ QK ][Eancel]

Figure 276 - Projectwise Integration
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5. Then click Load and enter in your Projectwise Username and password.

Add Document Management System E
Tpe: oo 13 ()
DataSource™ ‘ -
Login Mame: PWOMLINE Mathew Calkins
Password:
= Checkolt on Open
[ Checkout on Open from Hyperini
= )=

Figure 277 - Integrating Projectwise

After you click Log in the status should read Logged In as shown below:

Preferences

Documert
File Access
General

Grid & Snap
Import/Export
Marup
Markups Tab
Mavigation
FDF/A
Presentation
Rendering
Rendering 30
Signature
Snapshot
Spelling
Startup
Studio

Tablet
WebTab

Recents
Enable Recent Files

Show preview of PDF

ftems in Recent Files:

Recent histary limit: |!}I}Da~,rs vl [ Clear ]

Document Management Systems
[] Toolbar integration onfy
Always show selection dialog

[ SharePoint Options... ]

Status
Logged In

Location
ctdot projectwiseanline com:CTDOT

Type
ProjectWise Vi

£3
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6. Inthe General section in the User area type in your name (First Initial and Last Name),
title, and your office name. An example for me would be M. Calkins TE 2 AEC
Applications. An example for a district construction user would be J. Smith TE 3 D2

Construction.

Preferences

(1) Click (2) Type i
< ype in

Document

Import/Export

Maricup Allow Multiple Instances

Markups Tab

Navigation Enable Auto-Complete

PDF/A Enable Single Key Shortcuts with Form Fields

Presentation

Rendering Enable JavaScript

Rendering 3D

Signature Show Splash Screen

Snapshot Find Hyperlinks in PDF Cortert

Speling (3) Make sure
Startup Dark Light L~

%ubdlg Brgrness: ] / these are
ViebTab unchecked

CD Classic Mode [ Classic Menu )

—

Figure 279 - General Preferences

7. Update the markups options to match the following:

Preferences
Document Maricup
File Access
General 6 Reuse Markup Tools \
Grid & Snap Chynamically Set as Default properties

c% Autosize Texd Box and Callout Marups * Make sure these

Navigation Embed Forts

PDF/A Show Author and Date in Pop-Ups options are selected
Presentation
gendering 3D [] Copy selected text into Text Marups
ignature - 2 . -
Sngapshot (Highlight, Underine, Squigaly, Strikethrough)
Speling Retain Layer Info. when copying Markup.
g:ig:f [] Use Relative Paths for Hyperinks and Actions
Tablet Set 'Open in New Window” option for Hyperinks and Actions

WebTab
Defautt Image Encoding:
\ Drag Behavior for Shapes: j

Figure 280 - Markup Preferences
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8. Update the markups tab options to match the following:

Preferences E|

Document Markups Tab
File Access
General Zoom Fit Marups when selected __)
Grid & Snap -

Import/Export [] Use Rich Texd for Comments

METIP Wrap Comment Text

Markups Tab Fitered Annctation Dim Percent: C h ec k

FDF/A [ Exclude Fittered Markups on Export
Presentation
Rendering
Rendering 30
Signature
Snapshaot
Speliing
Startup
Studio

Tablet
WebTab

=

Figure 281 - Markup Preferences

9. Click on the Signature tab and set the algorithm to SHA-1.

P "

Preferences

Signature

*

Camera

Document
File Access
Farms Digital 1Ds:  D:\Usershcalkinsmj®AppData“Roaming Blusbeam So E]

Genersl Trusted Identities:  [:\Users'calkinem] \AppData* Roaming Bluebeam So [:]
Grid & Snap

Hypertinks @mhm: SHA-T - )
Markup

Markups Tab
Mavigation
Presentation

Rendering

Rendering 30 set to SHA'1

Sets

Sets (Advan...

< Signature
ools

Snapshot

Spelling hd

| impott | [ Export | [ ok || cancsl |

Password Timeout: |5 = Minutes

m

Figure 282 - Signature Setting
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10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web

Tabs is unchecked. This will open any hyperlink that is in a PDF document using Internet

Explorer instead of Bluebeam. This is the last preference you will need to update so you

can click Ok at the bottom right now.

Preferences

Document WebTab
File Access

Grid & Snap ) .
Import/Export [] Open POF Hyperinks in WebTabs

Markup Open web PDFs in split-view

General Mways swi = 5 when they are created

Markups Tab
N:Vi;;isona [ Use standardized favorites: |

PDF/A Show script emors
Presentation

Rendering
Rendering 3D
Signature
Snapshot
Spelling

Click

Studio
(o *

[ Edit Web Favortes... ]

Click

[ Import ][ Bxport ]

OK ! ancel

Figure 283 - Webtab Preferences
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Downloading the CTDOT Bluebeam Profile

Download this file and save it to your desktop: CTDOT Bluebeam Profile

2. Double click on the profile in the zipped folder on your desktop.

m| powerhrchiver 2001 - as-built_profile.zip

File Edit View Actions Tools Options Help

& 3.0 TR T ¥

Mew Open Favorites Add Extract Delete Wiew CheckOut
Ma | Madified | Size | Ratio | Packed | Path
(542 CTDOT fo-Buiks Profile b p] T/BLNIZEI8AM  BEFEE3 EEY 26067
Double click on
this file
P Selected 1 fle, 555 kB [ Total T file, 555 kB [245 k] ¥}
Figure 284 - Importing the Bluebeam Tools
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Appendix B - Usability of PDF Docume

Usability of PDF Documents

This section contains information about viewing digital contract documents.

Structure of Digital Plans
Final Design Plans, Addendums, and Design Initiated Change Orders

nts

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents

digitally signed by the Designer. Addendums and Change Orders are also submitted
subset, with only the changed sheets. For example, an Addendum that affects the 0
Subset will require the submission of a 03-Bridge_A1 subset.

as discipline
3-Bridge

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example

of a project’s discipline subsets in Projectwise:

L) List | @ Geospatial
Label {User Defined) Description Main Category | Sub Category Sub Category Description
ra @ 01_General 01 _General_revision.pdf CON FFL Plans_04 - Final Plans {adv)
# B 0z_Revisions 02 _revisions_ce.pdf COM FPL Plans_04 - Final Plans {adv)
ra @ 02_Revisions_ADL 02 _Revisions_a01 COoN ADP Plans_05 - Addenda
ra @ 03_Highway CON FFL Plans_04 - Final Plans {Adv)
7 @ 03_Highway_A01 03_Highway _a01 rev Con ADP Plans_05 - Addenda
ra B 04_Traffic 04_Traffic,pdf CON FFL Plans_04 - Final Plans {adv)
' B 05-Landscape 05_Landscape revl.pdf COM FPL Plans_04 - Final Plans {adv)
ra @ 06-Structures Bridge 02695 Structure Plans CON FPL Plans_04 - Final Plans {adv)
/' B CTDOT_HIGHWAY_STD chdot_highway _std.pdf CON 51D Flans_10 - Standard Drawings
r @ CTDOT_TRAFFIC_STD ctdot_traffic_std.pdf COon STD Plans_10 - Standard Drawings

Figure 285 - Discipline Subsets in Projectwise

As-Built’s
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

Application

Acrobat FDF
Acrobat PDF
Acrobat PDF
Acrobat FDF
Acrohat PDF
Acrobat FDF
Acrobat PDF
Acrobat PDF
Acrobat FDF
Acrohat PDF

The PDF digital plans have the following functions when the digital contract plans are created in

accordance with this manual:
Turn levels on and off
Search for all text on the documents.
PDF plans are measurable
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Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier
viewing of the contract sheets. See below for turning levels on and off:

@ 2w Fl=  Edi Documert  Form Makup  Measure Help

= - .‘v“v\\\\-

Frint E-mail = Image Hyperlink
HORL$mE S

Booo CT_CON_FPL_D026-0118_06-5TRUCT... =

Turn levels on
and off by clicking
here

STATE OF CO
DEPARTMENT OF T
oF EnamEERING

Yre
Figure 286 - Turning Levels On and Off
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Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a
certain pay item.

See below for searching the PDF Plans for text.

Aw EYREE Scarch Tab PoS.... - ENCREN

Type in what
you want to
search for or select

an object to search for

@ Text |Cuncrele

O Wisual Get Rectangle

Select Current -
wes o P@0€ OF Whole

I —— document

Search Pages

[] Search File Properties
Search Form Fields
[ Search Markups
[[] Case Sensitive

[] whale ‘waords Only

FOR 3680 MM 3 [583 W4 CONCRETE BOX CULVERT

QUTLET INVEFT ELEVATION = 8.76
FNR EOA MM Y A8 WM CORCRETE R FI0 UFRT

™ Search options 1

SUBBASE WATERIAL STATICALLY ROLLED DT VIERATORY)
I MEMBAAKE WATERPROOFING (WOVEN GLASS FAERIC)

E DESCRIPTION OF WORK

3 = 1. IMSTALL HANOLING WATER SYSTEM. N || . RUCTURES. pdf

el 2. INSTALL COFFERDAM, CONSTRUCT CUTOFF WALLS, RETURN WALLS AND WINGWALL'

g 3 4.CLOSE ROUTE 143 AHD DETOUR TREFFIC SFE 'NAINTEMSNCE AMD PRATECTION [p.1] MM CONCRETE BOX CULVERT 1.

ol OF TRAFFIC* SPECTAL PROVISION,

g o TEFIC SFECIAL POV, {p.1] MM COMCRETE BEO% CULVERTE...
5. IRSTALL PRECAST COMCRETE BON CULVE [p.1] MM COMCRETE BOX CULYERT O...
£ CONSTRUCT MOSINGS AND HEADWALLS.

Tt PR A0 MG b | Search Results {p.1] MM CONCRETE BOX CULVERTA..
£ CONSTRICT RORDHAY STAUCTIFE 440 (p.1) PRECAST COMCRETE BOX CUL..
(p.1) EOX COMCRETE CULVERT 3600..
VENERAL BOTES ¢ [p.1] BOX CONCRETE CULVERT 3600..
L S ooy | oty oow FORY BIE (20041, SUFFLENENTAL {p.1] COMCRETE DEFORMED STEEL ...
2 S e T I I T B (AT CONEIETS Hly il
BRIDGE DESIGH HAKLAL (2903% [p.1) PRECAST COMCRETE RO CULY.
P, 3 ALOMRE 06O STFESSES i £+ 35 v {p.1] COMCRETE CUREING, SEE HIGH...
FC - 21 MA (p.1) PRECAST COMCRETE BOX CULY.

Z 148 %ﬁwsﬁ'&mﬁm TN CRE0E 420 ?ﬁiﬁﬁ 165 b P-

B :

— VELLED WIRE FAGRIC  VETH dig) o FS (EMSLELL 5 (p.1] PRECAST COMCRETE BOX CULV...

! A LVE LD 1L {p.1] FOR COMCRETE FORMLINER P4, .

5, FOUMDATION PRESSURES :SEE WINGWALL DETAILS SHEET . [p.1) COMCRETE." [IMSTALLING PRE...
s.mm;sum pALL mﬁmlgu &[‘g ;:E'Eng ﬁrﬁw&e%ﬁm JTFDﬂTstsnTw [p.1) COMCRETE COVER : ALL REINF...
TREE (BN PLAEE. TE CMITTED DIGITS SLL o5 ACELNED TO BE ZERDS. {p1] 0F CONCRETE SHALL BE BEVEL
INIT | AMOUNT | 7.CuASS "W CONGRETES CLASS "W CINCRETE SHALL BE USED FOR CAST-B-PLACE CONCRETE {p.1] 01-COMCRETE FOR STRUCTURE. ..
b L - 1) CONCRETE: CLASS " CONCRE
™ i) B.SILICOKE JOBNT SEAL @ SEE SPECIAL PROVISION 'SECTION G.81-COWCRETE FOR STRUCTURES® [D. ] - o
W | = | 9 EXPOSED EDGES 1 EXPOSED EDGES OF COMCRETE SHALL BE BEVELED 25 MM X 25 MM UNLESS [D.1] COMCRETE SHALL BE USED FO...
DIMERSIORED OTHERWISE.

[p.1] CASTAN-PLACE CONCRETE TH..
(p.1] CONCRETE

Lol COMCEETE EOD DOCCACT COkd )

3 [

-

Figure 287 - Searching for Text in PDF Plans
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Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not
need to be created for on desk measuring.

See below for measuring in PDF.

S X 1 % 30 S geaby-d X W P Measuring Tool E

B

2. Select specific
measuring tool

1. Set Scale
Recalculate

N T
'5 MM_HMA S8.5 subkect: | \
42,600 by g g Example of a W15z MM Fvia ST HIGHWAY TTEM). Lt | ‘

measurement Dt |
55 2600 15880 33 00_ e | 550 Scak: 1rm—100mm
TYP) HLOA T~ WESTBOUND EASTBOUND ~[SHLDR |~ SIDEWALK B Total
Y, Lenglts 2500 im 37458 o
(TYP) |8 ROUTE 148 hiea o 0
>< BLLLC. concr | G i :
- P . y . . . Angle: ] ]
gwij_/:\ 5.0 2.0% 2.0, 6.8y 2.0 ; < e @ @
———————————— F-—-a___ olume: ] ]
— T ] - Counn i i
\ WW2B Cloar
WHzh L| 450 MM NATURAL STREAM BED MATERIAL
A}

+

SUBBASE MATERIAL STATICALLY ROLLED (NOT VIBRATORY)
SECTION A ON MEMBRANE WATERPROOFING (WOVEN GLASS FABRIC)

SCALE 1168 v

- WALL —_—
1. INSTALL HANDL

=

1+153.321

Figure 288 - Measuring Tool
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Digital Specification
The FDP specification package will be one PDF document and located in the
110_Contract_Specifications folder. This package includes all specifications, Notice to
Contractors, Wage information, etc.

The Addendum specifications prepared in the same way as the FDP specification package and
will also be located in the 110_Contract Specifications folder.

The Design Initiated Change Order specifications will be contained in one PDF document located
in the 110_Contract Specifications folder when they are released to the Contractor.

Some useful features on the digital specification package are:
e Search for any text in the document, see Searching Digital Plans
e Bookmarks for each section in the specification package

f? Qo File E dit Documert Faim Markup & Y Help

TReE o= q R 3 BN

Open Frint E-mail Studio e Image Hyperlink

Em-SERUEE:

TABLE OF CONTI

] Note: This Table of Co
] contract with the sole

herein; and no claims st
of Contents shall not be

B-8 v BB summay -

Figure 289 - Bookmarks in the Spec. Package
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Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay
Pages. Compare Documents will compare two documents and create a third document that
clouds all the changes. Overlay pages will create a third document where the pages of
document A will become one color and the pages of document be will become another color.
When the pages are overlaid you will be able to see the changes from the difference in these
two colors. Both of these tools can be used for single and multipage PDF documents. The
following shows how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to
compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

f? (o File Edit Wiew Document Form Markup Measure "window Help

S m-q

Frint E-mail Studio

U.l.I.l.|1.|.I.|.E|.I.|.B.|.I.|

+ HRecents
@ _COMN_FDP__01-General pdf Completion
@ _CON_DCD_ | i

ue... By submitting thes farm it signifies 1
contract plans.

Figure 290 - Compare Documents

3. Inthe window that pops up you will notice the two documents that were just opened.
Click OK to run the document compare as shown below:
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Compare Documents rz|
Di LA
Document; |d:\pw_working'\pwonline\mic-admin\dmsBS “ | [I]
|41l Pages (1 - 36) v |of 36 Documents
File [1of1]: CT_COWM_FPL_01 ?D-SDBSIVEIID 04-... that were
Pagesz Range [1-36
opened
Dacunent B
Document; |d:\pw_wc-rking\pwnnline\mic-admin'\dmsBE vl D
(4l Pages (1 - 36) v |of 36
b anual Alignment:
Select Windaw ] [ Pick Paints ]
Summary Beport;
Other Options:
Split-zcreen view [spnchronize] [ Tum an Dimmer
Comparison tppe; | Frinted Documents [zame printer]” v | -._._,,.—n C I ic k 0. K
| dvanced. || AddFies | (| ok [) Cancel |

Figure 291 - document Compare
Overlay Pages

1. Open the Revised document first and then open the original document that you want to

compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

@ File Edit View Document Form Markup Measure W

= « ® v B

EewmESESE- BE «» =

New

‘ Overlay Pages...
.

Select Document>

Comparison> Overlay
Pages

Figure 292 - Overlay Pages

3. Inthe window that pops up you will need to select which pages of each document you
want to overlay. To do this double click on a file, then in the window that pops up type
the pages you want to overlay. The example below shows pages 1-28. Once you select
the pages you want to overlay click OK.
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SIALTFE FRULIFY

| LKW P VD VA

Overlay Pages... 'Eﬂ
o To set which pages
Documernt Color ayer Pages
& | fAddendum No. 3.pdf ] Addendum Mo. 3 1of 203 u to Overlay d 0 u ble
- Addendum No. 4 pdf B Addendum No 4 1of 28 CliCk OI’I a file
’ |
.....
Figure 293 - Overlay Pages
Add Layer @
Layer
Source:  Addendum Mo. 3.pdf - D "
Pages 1-28 - uf@ *__ . H Type in which
Layer: @ Create Mew: Addendum No. 3 - I
B pages to overlay
C eEm i then click OK
Appearance [Base Layer]
Color: E]
Background:
Opacity: 1000 %
Blend: | Nomal fnone) -
[
| — r
& 1.00 Absolute
ffsed 0.00 Inches Center
0.00 = nter
Reset ' ncel

igure 294 - Overlay Pages
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Appendix C - Using the Set File

Opening the Set File

Double click on the set file from Projectwise and open as shown below: This may take a while

please be patient. Note
times.

: The first time opening a set file will take longer than any subsequent

L List | @ Geospatial
Description Main Category | Sub Category | Sub Categary Description Application Fie Updated
(/) on-consoldated 5o b Set con cns Plans_08 - Consolidated S/Z32003 11:02:12 AW {2
Oe-Structurd Structural Sheets o FPL Plans_04 - Final Plans (adv) Acrobat POF sjz2ja0lz 2427 P Sj20
/ Bloi-General Title Shest won FRL Plans_04 - Final Plans (Adv) Atrobat PDF 5/22/2013 S:10:41 PM 520
7 B CTDOT_TRAFFIC STD Traffic Standards con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/22/2003 2:38:09PM 5[0
# Bl cToot_HigHway_sTD o FPL Plans_04 - Final Plans (Adv) Acrobat PDF 5/22{2013 213703 PN /20
# B o3-supporting Dacs won FRL Plans_04 - Final Plans (Adv) Atrobat PDF S[21/2013 11:29:01 AM 520
/7 Bl 0z-Reviions con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2003 1:0L:14PM Sf
/ Bl os-architectural con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2003 1:00:16 FM {20
# B 10-Environmental o FPL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2013 12:58:47 PM 5/2(
/Bl os-Electrical won FRL Plans_04 - Final Plans (Adv) Atrobat PDF 5/20/2013 12:58:46 PM  5j20
— | 7 Blos-Mecharical i £o Slanc .. Finalol batone SE46PM 520
# B 11-Treaffic Tr i 58:40PM 520
s g 07-Plurbing Pl ] UST4TPM 5[0
/ Bloacivil Cif| | Select \ D - SPEOLPM  5/20
ouble click on
Program -
’ \ the set file and
Mame Description - En
(&% Bluebeam Revu Set heam Revt CI ICk 0 K arelBlusheam RevulRevuiRevu exe" ", No
<

Document Prapeties | Froject Properties

Froperty name
w»

Name
Folder Name
Envirarment
File Hame:
wiorkflow

=

Created By
Updated By
Fie Updated By
Status

Version

[Jopen dacument as read-only
Click here for a st of suagested document

vigwers

File Revision

>
\

Local File Revision|
Local File Directar:
Shareable

) R

Figure 295 - Opening a Set File

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a

thumbnail view. To view a sheet, simply click on that sheet and it will open up.

Q S File Edit cument Form

=

Frint E-mail

B wm T ESE-DE

Open

CT_CON_FPL_0001-0001_02-Revisions pdf

# CT_CON_FPL_0D01-0001_01-General &

CONNECTICUT [

4 5 5 A CH

Click on a thumbnail

_and the sheet will
-open on the right

UsETTS
T 1 DISTRICT 2

TT g

STATE OF CONNECTICUT

Figure 296 - Viewing a Plan Sheet from a Set File
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Marking Up a Set File
1. Open up the set file by following Section 1.4.1. You will notice on the left hand side of
the screen will be thumbnails of all the sheets in the set file.

Rulers  Interface

@ CT_CON_ADP_0102-0278_01-04_TYP_AD2

SALE THEATMENT MLESS OTMERWISE SHECIFIED In-
TP—4.TIP=7. (SEE WISCELLAEOUS. CETAIL SSEETS
FOR SWALE ETALLS |

sex AL B

All the sheets in the project
will be shown in the thumbnail
view -

SWALE TRCATMEMT UNLESS OTERNISE SPECIFIED T
TIP4,TTR-T, (SEE MISCELLAMEDVS DETALL SHEETE
FOR SWALE DETAILE)

ot Yz H
u T ¢
STA, 2+660 10 Ze707 ST, 2883 T
\EQEND
- W 0.8 (PLACED 4 THRGE chuLeR FILL
R R R CoAETE car
00 - HA 505 (50R WARIMA LIFY)
e - WA 51 FLACE TN TWO WAL LIFTSH S = Hua 0.5 (S0mm MaxTien LIFT )
250w PROCESSED ADRECATE. BASE Shem - i 0.5
NATEs BEFT OF FROCESSED ACGHEGATE Subast Skl 6€ EXESTING FoC.B.C. (Atiem & 1145em) VARTES ~ shak 50,375 | Sowm MAZTMM LIPS
ENEREASED 7O 450em AT THE FILLOVING LOCATEDRS: SEE SHAULDER TREATMENT MiGW 510G OF Sac = WA 0.5 (50mm WAXTMI LIFT)

130 30 ASEE DETATL OM ST TWP-A2) 1 emen
24780 TO 24420 UIMIMM TROS3 SLOPE 4% OF 45 SHOW O CROSS SECTIONS T
20400 T0 3020 METAL BEAM RALL (SEE FLANS FOR LINTS) 1

a2 300 10 34420 150m 1 TIMINGUS COMCRETE L1 O30 045 Fobi. FODT B

3 COHCRETE ¢ R
34655 T 24110 Tibem COE
2300 TO 300 e “rii - chms s

34300 10 3e438

STATE OF CONNE
JEPARTMENT OF THANSPOITATION

Figure 297 - Sheets in the Set File
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.
You will notice that sheet opens up on the right:

@ CT_CON_ADP_0102-0278_01-04_TYP_A02 >

Scroll down to the
sheet that is to be
marked up and click

on it. You will notice it — - o
opens up on the right. S %4 -

=i
-5
-
=i
-4
-
-3
-
-
~if

[P —— - \_@ E g/s. s>/
_ TIPS urTe (SEE VESELNEDA BT SHETS v Ttz B
P SR BETARLS ) o §
o pE Las synsone i
WL SEETION ST 5|
STh, 2+560 10 2e101 sta, 23 1
et

® rom - w508 imceo e
g
0m - W 54 (BLAEE Du T . LIFTE)
By —
T8 e ) . 1 omen
ks 10 2se20 o
petide] & i s 2 o s e
Si3m 1 doene o e
it e s M
Tt 10 1m0 fosagh < Y i
ety i - oo
perdiged o .
i
T T - . S — :
= — & STATE OF CONNECTICUT = .
— s [ DEPARTMENT OF TRANSPORTATION -
N — — . EPARTMENT OF T TATH "
Pt = (e L
] i | | e A
| = =

|V Fiter §
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3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this,
right click on the lock and select Check Out.

» 2 - ot -
= 5,
% A L P P B M M 9 1
CT_CON_FPL_0102-0278_01-01_GEM pdf
i
r
@ DEPAR~
/-|LDCATIDN oF
T
ENDING OF STATE
PROJECT W0, K2-278
165 §TA 44300

Right click on the lock _
and select Check Qut ———

01.01.001

AOIE

Figure 299 - Checking Out a Document

4. Notice the lock changes to a Check and you will be able to markup the document.

New Open

Save . -ma Studio

B wEEom - SEeVER:

y ER & BE CT_CON_ADP_0102-0278_01-04_TYP_AD2 =

SEE DETAIL B
ST TrR-1z

[
STA. 24520 TO 2+660

Figure 300 - Checking Out a Document for Editing
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5. To mark up the plans use the tools located in the tool chest shown below:

BOLSE: DD Aw o |Bik|5|L LT RTS8 4

aL=4

Click on the . TREATMENT UNLESS 0

5 TYP-T. (SEE MISCELLANE
too' CheSt SWALE DETAILS)

L R ey Markup the plans using - [ComtcionSsted s Conctucion St

STA. 2+420 TO 2+653 the CTDOT As Built Tools \ | hs-Buit Stamps Tizerzmin
= |As-Buitt Stamps This sheet comected

As Built S s Secton
Example\’  sew  Teeosme

PROPOSED 1-91 SB WIDENING

EXISTING 1-95 NE Callout Use to Add a Callout

£ | :

EXISTING GROUND

Line Use to Cross Out

3 X aOn NNEBr>
i

366m __ 366m _, _ 366m __ 360m . 3.60m
LANE LANE LANE LANE SHLDR -~
1 t 1 1 JP— o o
-
_ -~ Group Cross Out
VARIES veries| vaRIES | 2.00% .00% 7 Cloud

®_/®/EE DETAIL A

ON SHT TYP-12

SWALE TREATMENT UNLESS OTHERWISE SPEC
TYP-6+TYP-7. (SEE MISCELLANEOUS DETAI

o]
i

Figure 301 - Marking up the Plan Sheets
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6. When finished, click Save and then right click on the Check and select “Check In”.

New Open Save . E-nnadl Sttudio
REwTEOE-SHevelin-
an y u

n
B

u
|
-

T

Then right click on

the check and select
Check In
& I-95
TING T-35 58 EXTSTING I-95 NB
@2 59
; . 366m ., 366m MED. 366m . 366m . 366
LANE LANE 520 500 LANE LANE LAN!
i LM

1 ! ] 1 1

RPN

Figure 302 - Saving Markups and Checking Into Projectwise
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Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows
how to search a set file:
1. Click on the Search Set file icon and then type in what you want to search for as shown

below:

R R Fle  Edt sw  Document  Fom  Makup  Measurs

vk u

Hews

a g
B -EeE

A VAL TR 5 # ) |ee
-mE . [
Type in what you > e

want to search for

Select "Current Set"

Click on the
search set file
icon

CT_CON_FPL 01350270 01.01 - General pelf

| Catch Basin

e

Current Set v |

Search Pages

[] Search File Propetties
Search Form Fislds
[ Search Markups

[] Case Sensitive

01.01.02 [ Whale ‘wWaords Only

Figure 303 - Searching the Set File
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Creating a Consolidated PDF of the Files in the Set File

Bluebeam allows you to create a consolidated pdf of all the files in a set file. The following
shows how to create a consolidated pdf:
1. Select the Publish Icon and select Combine:
{(-’ [ File Edit View Document Form Markup Measure

Combine...

Package

Figure 304 - Consolidating Files

Window

2. Next keep the default settings and click OK on the dialog box shown below:

Combine PDF Files (23w

Insert Files

»

Filz Path Pages

E] CT_CON_FDP_0M70-315... PW.ctdotproject...  1-12of 126 |
CT_CON_FDP_0M70-315... PW.ctdot project...  1of 3
CT_CON_FDP_M70-315... PW.ctdotproject...  13-17of 126

w | | CT_CON_FDP_0N70-315... PW.ctdotproject.. 2of 3
CT_CON_FDP_0170-315... PW.ctdotproject..  18of 126
CT_CON_ADP_0170-315... PW.ctdotproject.. 1of2

T "™kl COiD 0170 215 DAL - A e i T e Y e

l.m |

&

Keep default

Options
Include Bookmarks [7] Use Filename as Page Label Setti ngs a“d
[] Include File Attachmerts / .
Merge Documert Properties CI ICR OK
Merge Layers
Figure 305 - Consolidating Files
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3. Bluebeam will then create a consolidated file of all the PDF in the set file.

Edit View Document Form Markup Measure Window Help

Tomae = EBFE 7

Print E-ma Create e Batch A Markups

Document1*®

~~ Consolidated PDF of all

the files in the Set File

BOL$E:/

Figure 306 - Consolidated File
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Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.
Printing the entire set will print all the sheets in the set file. Printing the latest revisions will
print the most up to date sheets and not print the previous revisions. Printing the previous
revisions will only print the sheets that were changed by a revision.
The following shows how print a set file:

1. Select the print set file icon and select the desired option:

r() fvu  File Edit Wiew Crocument Farm Markup Measure Window

b —— L o . v 4 . —]
v Ik 9 < B
Studio Security Sigriatu

Mewy Open Save Frint E-mail res Pages

2 W R A-N-F-1 R 1 K .

o Select the arrow on the
St v e print icon and select the

desired option

01.01.01

_—
01.01.02

Figure 307 - Printing a Set File
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Appendix D - Consultant Submittal Review
Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile
imports all the commenting tools in the correct format.
Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file
located in the zip file and the profile will be imported.
After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

I+ £ -
In the tool chest P

select the Submittal N —
- * LCTDOS - hopAsforking Drawing Beview Tools
stamp and click

— Subject Comment

th e d e I ete ico n ‘ - S ubmittal Contractor Submittal
- Review Stampl
- Highlight
= Highlight
é Text Box |Jze to Add et
& Callout IJze to Add a Callout
IJze to Cloud
@ s Corections
/ Line IJze ta Cross Out
4» CTDOT &
4 CTDO

Figure 308 - Deleting the Stamp

2. Next Consultant Designers will need to save the following stamp to their computer and
edit it to add their company name and address. The following will show how to do that:

3. Save this stamp file to your computer in a folder somewhere called Blubeam Stamps.
Note: The stamp file will be a PDF. Form 816 - Consultant Submittal Review Stamp or

January 2015 Supplemental Form 816 Stamp — Consultant Submittal Review Stamp

Supplementals
4. Open the stamp file using Bluebeam.
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5. Update the Company Name and Address as shown below:

Consultant_Submittal_Review &

W 285%284 Inches

SUBMITTAL REVIEW
DESIGNER'S REVIEW

Confarms [ rejectes [}
C sosNoted ] N action Required []
Revise and Resubmit []

DESIGNER'S REVIEW 1S FOR GENERAL CONFORMANCE WIT,

/

Click on this and edit so
it reads the company name
and address

Figure 309 - Updating Stamp for Company Name and Address

After the company name and address is updated it should look like this:

™ 286 % 284 Inches

SUBMITTAL REVIEW

DESIGNER'S REVIEW

Conforms I:l Rejected I:I
Conforms as Noted I:l No Action Required I:I

Revise and Resubmit |:|

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN CONCEPT AND CONTRACT DOCUMENTS,
MARKINGS OR COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIANCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM. THE CONTRACTOR REMAINS RESPONSIELE FOR
DETAILS  AND ACCURACY, FOR  CONFIRMING  AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.
BL Companies 150 Trumbull St, Hartford, CT 06103

&[User
. &lUser]

B Date:

Figure 310 - Updated Stamp

6. After the stamp is updated click save.
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7. Next go to Markup>Stamp> and Select Change Stamp Folder.

JocurneEnk Form Markup Measure Window

Frint E-miail _ _ )
Congultant_Submittal

CTDOT_Submittal
1_11 - Environmel =

R

Click on Markup
ol then Stamp
then change stamp folder

159-0181_11 - E...

ittal_Review.pdf

Change Stamp Folder.. .

I
Figure 311 - Changing the Stamp Folder

T =ENVIRUNMENTAL

8. Browse out to where the submittal review stamp has been saved and click OK:

Browse out to the
folder where the
Gwoanns  Stamp is located
‘3 m ;zru\?;rt:;hces and CIiCk OK
2 Recycle Bin
AdobeCA

Mew Folder

E
g,

||||||||||

frsom 150 old watermarks

Al IC5) POF Forms

B @ Revisions Forms
15 school

[#-15) 5TC FORMS

[ Make Mew Folder [} Cancel

Figure 312 - Browsing to the Stamp

9. Now when you click on Markup>Stamp it will be in the list.
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10. Next go into the tool chest and open the “Recent tools” as shown below:

Sattings

X, Bluebeam Studia Projects -

v o /9
[ | .

| & I

1) My Tools
Recent Tools
Sequernce
Curves
Shapes
Svmbols
Procfreading Symbaols
CTDOT Review Tools
CTDOT ShopWorking Drawing Review Tools
CTDOT As Built Tools

Sequence Tools

4F LiUul
4 CTDOT

Figure 313 - Bluebeam Recent Tools

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown
below:

Markup Measure

consultant_submittal_review, pdf 5

consultant_submitt. .pdf

Document1* & Markup Stamp
and then select
the stamp

Figure 314 - Placing a Stamp in Bluebeam
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12. Select Conforms when the javascript window pops up and click OK:

Submittal Review x|

JavaScnph wWindow

— Actian

S:' Ennfnrma i~ Conforme as Moted  © Fevize and Resubmit © Fejected © Mo Action Fequired

— Reviewer's [nformation

Date: [10/8/2013

Figure 315 - Bluebeam Stamp

13. After the stamp has been placed you will see the stamp in the recent tools. Drag it from
the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

In the tool
chest drag the
recently placed

stamp and drop 1001 g i i T
it into this tool — o Comment
bar Submittal

+ Recent Tt

Highlight
Highlight
Text Bowx IJze to Add text

Callout ze to Add a Callout

|Jze to Cloud

Claud Comections

Line IJze to Crose Out

CTDOT &
CTDOT

4
L]
4

Figure 316 - Adding the Custom Stamp to the Tool Chest
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14. Then Save Profile so the stamp will always be in the Tool Chest.

Wiew Document Markup

- -
T
=) - ﬂ
=
Frint E-mzil Studio Toolbars

b « -
= .

GO tO' View, Financial In
then click on the

E tirnatian

0 fice

arrow and then an
8 save profile Si ol

Tz alek

BEEELEE

Fuil Screen

E B

Getting Started. pdf

o]

Figure 317 - Saving Bluebeam Profile
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Appendix E - Projectwise Attributes Table

Table 4 - Projectwise Attribute Assignments —Contract Plans and Contract Specifications

Attributes
Document Discipline | Main Sub Label Description Asset Tags
Category Category

Contract Plans — Upload to the 100_Contract_Plans Folder
Contract CT CON FDP . Name of the subset, 01-General . Asset Tags shall only
Plans CT CON DCD for the General subset. The be assigned to the

CT CON DCD2 label should match what is listed contract plan

CcT CON FPL on the title sheet. subset(s) that detail

. FDP and DCD submittals shall an asset in a high
always have the same label. level detail. For

. CTDOT standard drawing shall example, the subset
be “CTDOT_HIGHWAY_STD” and that contains bridge
“CTDOT_TRAFFIC_STD". plans shall be tagged

e For Information Only subsets, with that asset. If
FIO must be included in the there are multiple
Label, 11_AT&T_FIO. bridges detailed in a

subset, the subset
cT CON ADP e ADP and ACD submittals shall shall be tagged with
CT CON ACD have the same label as the FDP both bridge nos.
CcT CON DCO plans with the addition of A##
on the end. For example, 01- e  DONOT tag the 01-
General_At# General, 02-

e DCO Submittals shall have the Typeina Revisions, CTDOT
same label as the FDP plans with useful Highway Standards,
the addition of C## on the end. description and CTDOT Traffic
For example, 01-General_C## Standards with Asset

Tags since they do
not detail the asset
in a high level of
detail.

. To assign the asset
tag select the
applicable bridge
no(s), sign
structure(s), or signal
intersection(s) that
is/are associated
with the document.
Hold CTRL to select
multiple asset
numbers.

Set File CT CON Set File 00-Set File NA
Contract Specifications — Upload to the 240_Contract_Development Folder except for CSP specs, upload these to the
110_Contract_Specifications folder
Contract CT CON FSP FDP Specs. Typeina Do not assign asset tags to
Specificatio | CT CON FSR Revised FDP Specs. useful specifications
ns CT CON ASP Addendum # Specs. description
CT CON ASR Revised Addendum Specs.
CcT CON CSpP Change Order # Specs.
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Table 5 - Projectwise Attribute Assignments - Supplemental Contract Documents

Attributes
Document Discipline | Main Sub Label Description Asset Tags
Category Category
Supplemental Contract Documents — 240_Contract Development Folder
Proposal Estimate CcT CALCS Estimates Proposal
Proposal Estimate CcT MISC Flnal Proposal Est. Checklist
Checklist
Federal Estimate CcT CALCS Estimates Federal
Calendar Day Estimate | CT CALCS Estimates Calendar Day
Final Design Report CT REPORT Final Final Design
Categorical Exclusion CcT MISC Final Categorical Exclusion
Design Approval Letter | CT APPROVAL Final Design Approval
Environmental Permits | CT PERMIT Permits . Inland Wetland
. SHPO
. Flood Management
. Environment Review
. Natural-Water
Resources
. Tribal
. Endangered Species Type a useful N/A
. Fisheries description
DBE/SBE Approval with | CT APPROVAL Final DBE/SBE Approval
percentages
Commitment List CcT MISC Final Commitment List
Agreements CT AGREEMENT | Final Name of the Agreement
Proprietary ltem CcT APPROVAL Final Proprietary ltem
Approval
Standalone CcT MISC Final Trans. Man. Plan
Transportation
Management Plan
Document,
taken from the final
design
report
Item List for CcT MISC Final CNS Item List
Contractor Submittals
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Table 6 - Projectwise Attribute Assignments — Engineering Reports, GIS Documents, and ROW

Documents
Attributes
Document Discipline | Main Sub Label Document Description Asset Tags
Category Category Date
Engineering Reports — Upload to 130_Engineering Reports Folder
Hydraulic Report CcT REPORT Final Hydraulic
Hydraulic Report Data CT REPORT Final Hydraulic Data
Scour Report CT REPORT Final Scour
Scour Report Data CT REPORT Final Scour Data Type in Assign
Floodway Report CT REPORT Final Floodway Featured Applicable
Floodway Report Data CT REPORT Final Floodway Data Crossed asset tags
Final Drainage Report CcT REPORT Final Final Drainage
Final Drainage Report cT REPORT Final Final Drainage Data
Data Date of
Geotechnical Report CT REPORT Final Geotechnical Report A useful
Task 110 CcT REPORT Final Task 110 description.
Task 220 CT REPORT Final Task 220 N/A
Underground Storage cT REPORT Final Underground Storage
Tank System Closure Tank System Closure
Reports Reports
Rehabilitation Reports CT REPORT Final RSR Assign
Load Rating CcT REPORT Final Load Rating Applicable
asset tags
GIS Documents — Upload to the 150_GIS folder
E;c)gjs)ct Polygon File CcT CAD Misc Boundary Ffro!'ect
Project Polygon File CcT CAD Misc Boundary I.I:m:]s(s_)
(.KM2)
ROW Parcel CcT CAD Misc Parcel Serial (Town#) i.e. A useful
Microstation File (.dgn) Parcel 004 (157) N/A description N/A
ROW Parcel CcT CAD Misc Parcel Serial (Town#) i.e. such as
Microstation File (.KMZ) Parcel 004 (157) property
owner’s
name (e.g
CL&P)
ROW Documents —Property Map (.dgn) to 500_Pre-Design>05_Property_Maps Folder , Property Map (.pdf) to the
310_Review_Documents folder
Property Map (.dgn) CcT CAD MAP Parcel Serial (Town#) i.e. A useful
Parcel 004 (157) description
Property Map (.pdf) CcT CAD MAP Parcel Serial (Town#) i.e. such as
Parcel 004 (157) N/A property N/A
owner’s
name (e.g.
CL&P)
Table 7 - Projectwise Attribute Assignments — Contractor Submittals
Attributes
Document Discipline | Main Category Sub Label Document Description Asset Tags
Category Date
Contractor Submittals — 120_Contractor_Submittals
Working Drawings | CTR CONTRACTOR Working Item Number Assign
for Permanent Drawings Applicable
Structures asset tags
Working Drawings | CTR CONTRACTOR Working Item Number Assign
for Temporary Drawings Applicable
Structures asset tags
Shop Drawings CTR CONTRACTOR Shop Iltem Number Assign
Drawings Date of Type a useful Applicable
Submittal description asset tags
Product Data CTR CONTRACTOR Product Data | Product Data Title Assign
Applicable
asset tags
Submittals CTR CONTRACTOR Submittals Item Number Assign
Applicable
asset tags
RFI CTR CONTRACTOR RFI RFI - # N/A
RFC CTR CONTRACTOR RFC RFC - # N/A
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Table 8 - Projectwise Attribute Assignments — Discipline General Attributes

The following table shows attributes that are available for each discipline. The table shows SB
for Structure Bridge, but the attributes are available to all the disciplines.

Attributes
Document Discipline | Main Sub Category Label Document Description Asset Tags
Category Date

Design Documents — 140 Project Administration Folder for Final Versions of Documents and 330_Design Data Folders for Draft Versions of
Documents
Agreements SB AGREEMENTS | Draft or Final Agreement No. or Assign Applicable asset tags

Name
Analysis SB ANALYSIS Draft or Final Title of Analysis Date Assign Applicable asset tags
Approvals SB APPROVAL Draft or Final Title of Approval Assign Applicable asset tags
Design Models SB CAD Design Title of Design, i.e. N/A N/A

Master Design
Sheet Models SB CAD Sheet Drawing No. i.e. N/A N/A

PLN-1 or S-1
Misc. DGN File SB CAD Misc Title of file N/A N/A
Resource Files SB CAD Resource Title of file N/A N/A
(Microstation
Data or
Preference
Files)
Maps SB CAD MAP Title of Map Date N/A
Draft Dgn Files SB CAD DRAFT Title of file N/A N/A
Asset related SB CAD ASSET Title of file N/A Assign Applicable asset tags
Microstation
file
Estimate SB CALCS Estimates Title of Estimate Date N/A
Calculations Calc.
Quantity SB CALCS Quantity Title of Quantity Date N/A
Calculations Calc.
Design SB CALCS Design Title of Design Calc. | Date Assign Applicable asset tags
Calculations
Invoices SB INVOICE Invoices Title of Invoice Date of Invoice N/A
Letters SB LETTERS Draft or Final Title of Letter Date of Letter Assign Applicable asset tags
Photos B MEDIA Photos Date or Title of N/A Type a useful =07,

description

Photos
Videos SB MEDIA Videos Date or Title of N/A N/A

Videos
Presentations SB MEDIA Presentations Title of N/A N/A

presentation
Meeting SB MEETING Draft or Final Title of Meeting Date of N/A
Related document Meeting
Documents
Memos SB MEMO Draft or Final Title of Memo Date of Memo N/A
Miscellaneous SB MISC Draft or Final Title of Document N/A N/A
Documents
Permit Related SB PERMIT Permits Title of Permit Date N/A
Documents Document
Reports SB REPORT Draft or Final Title of Report Date of Report Assign Applicable asset tags
Requests SB REQUEST Draft or Final Title of Request Date of N/A

Request
Schedules SB SCHEDULES Draft or Final Title of Schedule Date. If N/A
or Working working no
date required
Scopes SB SCOPE Draft or Final Title of Scope Date of Scope Assign Applicable asset tags
Specs. SB SPECS Draft or Final
Ground Files SB SURVEY Ground Ground File Date N/A
GPS Documents | SB SURVEY GPS Title of Document Date N/A
DEM SB SURVEY DEM Title of Document Date N/A
Documents
Survey Control SB SURVEY Control Title of Document Date N/A
Documents
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